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Purposes & Benefits of Tabs3 Reports
The following table shows the various reports in Tabs3 including their purposes and benefits.

Note: If you are trying to choose between multiple reports that contain similar information, Knowledge Base Article R11697,
“Tabs3 Report Finder,” can help you narrow it down to exactly the report you need.

Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

Accounts Receivable by
Invoice Report

Shows how much was billed
and is due by specific invoice
for each client. Optionally
include detailed billed
amounts by timekeeper and
cost types for each statement.

Allows you to review
receivables as open invoice
items.

As needed.

Accounts Receivable by
Timekeeper Report
(Platinum Only)

This report shows how much a
client owes for fees to each
working timekeeper.
Optionally shows fees by
aging period and total fees
due for all timekeepers.

Allows you to review fees due
filtered by each working
timekeeper.

As needed.

AgedWork-In-Process
Report

Provides an aging report of
unbilled fee and cost
transactions by client.

Allows tracking of unbilled
amounts at a glance.
Particularly useful for
monitoring unbilled costs.
Ideal for tracking delayed
billings, forgotten projects,
and income projection.

As needed.

Allocated Payments Report Shows how payments were
allocated to fees, expenses,
advances, sales tax, and
finance charge. When printing
a detail report, amounts
allocated to individual
timekeepers and cost types
are also included. This report
is based on the payment
allocation date.

Provides an audit trail of how
each payment was allocated.

As needed.

Cash Receipts Report Shows all payments in a
specific date range. It will
optionally show the
breakdown of the payment to
Fees, Finance Charge,
Expenses, Advances, or
Unallocated. It can include
both payments from the
ledger file as well as work-in-
process payments.

Ideal for balancing to daily
bank deposit slips and
assisting in account
reconciliation.

As needed.
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Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

Category Productivity
Report

Shows how your firm’s billing
is broken down by category.
The format of this report is the
same as the Timekeeper
Productivity Report.

Used to monitor a category’s
billable and non-billable
activity and compare it to the
firm’s average to determine
time utilization for each area
of practice. It can also be used
to monitor each category’s
accumulated unbilled time.
Use it to locate the weakest
and strongest areas in the firm
based on earnings per hour.

Usually run monthly. It can be
run for any month or range of
months within the current
fiscal year.

Client Analysis Report A date-based report that
provides monthly
comparisons of Billed Hours,
Amounts, and Payments by
client for an individual month
or a range of months.
Optionally include and
compare Hours Ratios,
Payment Ratios, Billed Rates,
Effective Rates, Non-Billable
Hours, Non-Billable Amounts,
Write Offs, Net Write-Ups/
Write-Downs, and Courtesy
Discounts.

Ideal for comparing
performance in specific areas
because customizable
columns let you determine
which information you want
to focus on. Ability to include
courtesy discount as a
separate column makes this
report useful for reviewing
courtesy discount amounts.

As needed.

Client Budget Report Shows billed and unbilled
hours, fees, and costs for
clients with budgets set up.
Client budgets are entered on
the Rates tab in the client file.
The report makes a
percentage comparison of the
hours, fees, and costs billed
and in work-in-process to the
budgeted figures.

Ideal for monitoring flat fee
clients. Useful for identifying
clients that are approaching
or have exceeded budget
projections.

As needed.

Client Funds Report This report shows client funds
activity with beginning and
ending balances for a
specified date range.

Review all client funds
activity, client funds balances
and grand totals.

As needed.

Client Inactivity Report Provides the ability to identify
clients and matters with no
activity in a specified time
frame. Specify the period of
inactivity as the last number
of days, weeks, months, or
years and the types of items
you want used to determine
inactivity.

Easily determine which
matters need follow up and
which matters can be marked
inactive.

As needed.

Client Labels This report allows you print
labels in multiple formats for
select clients based on the
information from specified
fields in the client file.

Easily generate mailing labels
for a group of clients based
on criteria such as location,
category, or originating
timekeeper.

As needed.
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Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

Client Ledger Report Shows the history of billing
and payment activity for each
client. Includes payments,
fees, expenses, and advances.
Optionally includes finance
charge, sales tax, write offs
only, balance due, detail billed
information by individual
working timekeeper, and Cost
Type for each statement.

Replaces manually kept ledger
cards. It allows you to find
within seconds exactly when
a payment was received or
when a bill was sent. Ideal for
reviewing detailed write offs
by including only clients with
write offs.

As needed. If not run
monthly, consider running it
quarterly or annually.

Client List Shows a detail or summary
client listing by client number
or name for specified clients.

Gives quick and easy access
to client information
including contact name,
address, phone number, and
more.

As needed.

Client Productivity Report Provides total billed hours,
amounts, write-ups/write-
downs, write offs, and the
effective hourly billing rate for
each client. The report
optionally includes unbilled
totals along with the average
age of the unbilled amounts.

Helps determine which clients
could be considered preferred
based on their profitability to
the firm. Also helps determine
which clients are undesirable.
Generate a write off report to
review net write offs by
including only clients with
write offs.

As needed.

Client Rate Report This report shows billing rate
codes for each client.
Optionally includes fee and
cost rate tables and
timekeeper level rates and
codes.

Provide a comprehensive
report of default billing rates
for each timekeeper for each
client.

As needed.

Client Realization Report Used to evaluate the
profitability of clients by
showing the amounts
collected on specific billings.
Optionally include fees
broken down by working
timekeeper and costs broken
down by cost type for each
client.

The report includes billed
information for a specified
date range, the realized value
compared to actual time
spent, and receipts applied
(i.e. collections) to the billed
information, thereby
effectively combining billing
realization and collection
realization on a single report.

As needed.
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Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

Collections Report This report is used to assist
with the collection of
receivables and helps identify
which clients require
additional collection efforts.
Summary and detail report
formats are available. Includes
total amount billed, amount
paid, percentage paid,
amount due for all
outstanding invoices, date
and amount of last payment,
and number of days since last
payment. Optionally includes
contact information, invoice
detail, WIP and billing history,
and detail write off and
payment information.

Provides the necessary
information in a single report
making it easier to make
decisions regarding how to
proceed with collections
efforts. Shows the average
number of days between
payments making it easy to
identify deviations in client
payment trends.

As needed.

Conflict of Interest Report Allows you to perform a
conflict of interest check
using up to eight different
search values. You can
optionally include client
information, contact
information, client notes, fee,
cost, and payment
transactions, and the archive
files in the search. A Conflict
of Interest Report can be
generated when conflicts are
found.

Provides a written record of
conflicts found. Conflicts are
underlined allowing for quick
review. Optional phonetic
searching helps find typing
and spelling errors.

As needed.

Data Entry Lists
Fee
Cost
Payment
Client Funds

Data Entry lists are used to
provide archived and work-in-
process transactions that can
be accessed using one of the
data entry programs. Separate
entry lists can be printed
based on the current View
Options settings.

Provides the ability to
instantly print the items in
your data entry list without
leaving the data entry
window.

As needed.

Detail Accounts Receivable
Report

Shows aged past due fees,
expenses and advances along
with pertinent client
information (i.e., phone #,
contact name) and unbilled
fees, expenses, and advances.

Use the last billing date and
aged breakdown of fees and
costs to determine if reminder
statements should be sent. It
can also be used to check the
average age of unbilled fees
and costs. Optionally include
clients’ billing instructions,
billing history, and work-in-
process. Platinum users can
also include a detailed
breakdown of fees by
timekeeper and costs by cost
type.

As needed. Usually monthly.
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Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

Detail Work-In-Process
Report

Provides a detailed report of
unbilled fee and cost
transactions by client. This
report can be used for
verification of fee, cost and
payment transactions prior to
printing billing statements.
Aged accounts receivable
information is also shown.
Client funds balances are
shown for clients with a client
funds balance.

Used as a tool for making
billing decisions such as text
changes, write-ups/write-
downs, rate adjustments and
whether or not to bill. Some
firms use this report for pre-
bills. Optionally includes
clients’ billing instructions.

As needed. If not printing it
monthly, consider printing it
quarterly.

E-mail Statements Report Provides a history of
statements successfully sent
to clients via SMTP, or sent to
the Outbox using Microsoft
Outlook. Shows the contact to
whom the e-mail was
addressed, the To address, the
PDF file name of the
statement, the date it was
sent, and what user sent the
statement.

Quickly determines whether
and when an e-mail statement
was sent, to which e-mail
address, and whether the
updated statement was later
undone.

As needed.

Fee Compensation Rules
Report

This report provides a
summary of the fee
compensation rules specified
for each matter, grouped by
either matter or timekeeper.

Review fee compensation
rules for specific timekeepers
or matters without having to
open each matter in Tabs3.

As needed

Pre-Bill Tracking Report This report includes the client
name, work description, pre-
bill date, whether the
statement is “on hold” or has
been reviewed, whether a final
statement has been run, and
the statement batch number.

Quickly pinpoint which
clients have not been
reviewed, which clients have
not had final statements run,
and which clients are “on
hold”.

As needed.

Pre-Update Statements
Report

Shows the amounts that have
been processed on final
statements and are ready to
be updated by the Update
Statements program. The
report shows amounts for
previous balance, fees,
expenses, advances, finance
charge, payments, and
balance due.

Allows you to easily review
which clients will be updated
and also check for clients that
should not be updated.

Immediately before running
the Update Statements
program.

Productivity Report by
Category for each
Timekeeper

Shows the hours and amounts
for fees billed year-to-date by
category for each timekeeper.

Shows the firm which
timekeepers are the specialists
in different areas of practice
based on effective billing
rates.

Monthly. Shows cumulative
year-to-date totals.
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Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

Productivity Report by
Transaction Code for each
Timekeeper

Shows the hours and amounts
for fees billed year-to-date by
transaction code for each
timekeeper.

Helps guide timekeepers in
making certain types of work
more efficient and productive
by reviewing the average
billing rate for each
transaction code.

Monthly. Shows cumulative
year-to-date totals.

Recap of Hours Report Shows billable and non-
billable hours worked for
individual timekeepers during
a selected period of time in a
calendar-like format. Totals
for each day and week are
shown for each timekeeper.

Provides the ability to quickly
spot missing time sheets.

As needed.

Receipt Allocation Report Shows the allocation of
receipts (payments) for each
client. The report shows billed
amounts and allocation of
receipts towards those billed
amounts for individual
working timekeepers, fee
compensation timekeepers,
expenses and advances (by
Cost Type), fee sales tax,
expense sales tax, advance
sales tax, and finance charge.
Allocations can be shown by
working timekeeper or include
fee compensation allocations.
The report can be run for up
to two user-defined periods
and can optionally include
differences for the two
periods as well as percentage
changed comparison figures.
Optionally include write offs,
billed hours, amount due, and
unallocated payments.

This report can be used as a
primary means to determine
profit distribution based on
amounts collected vs.
amounts billed for each
timekeeper. Flexible sorting
options allow you to sort the
clients in descending order by
receipts, billed amounts,
billed hours, effective rates,
and write offs, thus making it
easy to identify the most
profitable clients.

As needed. Usually monthly.

Split Billing Report This report show the current
split billing settings for the
specified main client as well as
the associated split matters,
their allocations, and
statement settings.

Provides a quick summary of
split billing settings for each
matter.

As needed.

Summary Accounts
Receivable

This report shows amounts
due in each of the aging
periods defined on the
Options tab in Tabs3
Customization.

Past due amounts are easily
monitored. Also, gives the
firm a quick total of accounts
receivable for each
timekeeper-in-charge.

As needed. Usually monthly.
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Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

SummaryWork-In-Process
Report

Provides a summary report of
unbilled fee and cost
transactions by client. Aged
accounts receivable
information and client funds
balances are also shown. A
report with totals only can be
printed.

Quick summary of clients’
status for partner-in-charge
to review unbilled and billed
dollars due for each client.
Assist in income projections.

As needed.

Task Code Billing Report This report shows both billed
and unbilled task based billing
transactions for a variety of
ranges and sort orders.
Transactions can be sorted by
task code and
activity/expense code.

A flexible report that can be
saved to a disk file in a variety
of output formats. Many firms
submit this report on disk to
satisfy their clients’ task code
billing requirements. Can be
saved to a disk file for various
output formats.

As needed.

Task Code Budget Report This report shows billed and
unbilled amounts for
expenses and activities for
each task of each phase.

Regularly review status of task
code billing clients.

As needed.

Timekeeper Analysis Report Provides billed and paid
information for timekeepers
broken down by month. The
report includes an analysis of
Billed Hours, Original Hours,
Billed Amounts, and gross
receipts by timekeeper for an
individual month or a range of
months. Optionally includes
Hour, Amount, and Receipt
Ratios, as well as the Billed
Rate and Effective Rate.

Provides an option to group
by timekeeper or month, thus
allowing you to analyze the
information included on the
report by month for each
timekeeper, or to compare
each timekeeper within each
month.

As needed.

Timekeeper Productivity
Report

Shows the billed productivity
amounts and hours for each
timekeeper by month and
year-to-date. It also shows the
effective billing rate, as well as
all the timekeeper’s write-ups,
write-downs, and write offs. In
addition, the report shows the
total billable and non-billable
hours and amounts entered
into Tabs3 for each
timekeeper.

Used to monitor a
timekeeper’s billable and non-
billable activity and compare
it to the firm’s average to
determine individual time
utilization. It can also be used
to monitor each timekeeper’s
accumulated unbilled time. In
addition, the report helps
determine each timekeeper’s
write-ups/write-downs and
can also aid in the decision as
to who receives what size of
bonus.

Usually run monthly. It can be
run for any month or range of
months within the current
fiscal year.

Timekeeper Profitability
Report

This report shows billed fees,
overhead, and profit for each
timekeeper for any range of
months in the current fiscal
year. Net profit and a
percentage of billed fees are
also shown.

Track monthly profit for each
timekeeper.

As needed.
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Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

Timekeeper Realization
Report

Used to evaluate the
profitability of individual
timekeepers by showing the
amounts collected on specific
billings. Fees are broken down
by working timekeeper.

The report includes billed
information for a specified
date range, the realized value
compared to actual time
spent, and receipts applied to
the billed information all on a
single report.

As needed.

Timekeeper Status Report Shows work-in-process and
accounts receivable
information by primary,
secondary, or originating
timekeeper. Amounts are
broken down by fees,
expenses and advances.

Allows the timekeeper in
charge to review the status of
his or her files. Useful in
balancing accounts receivable
and work-in-process from
month to month.

As needed.

Top Client Report Provides the ability to print a
report of your top clients or
matters based on your
preferred criteria.

Easily see which clients have
the highest work-in-process,
billed information, write offs,
paid information, unallocated
payments, and current
amount due for a specified
time frame.

As needed.

Transaction File List Gives the firm the flexibility to
access archived and work-in-
process transactions and
subtotal/total on desired
criteria. Up to 3 levels of
sorting and subtotaling are
allowed. Reference numbers
can be included for easy
editing.

An extremely flexible and
powerful report that can
generate a combined report
of billed and unbilled
transactions for any range of
dates, timekeepers, clients,
categories, and/or transaction
codes for a variety of
purposes. Can be saved to a
disk file for various output
formats.

As needed.

Unallocated Payments
Report

Shows partial or fully
unallocated payments for
each client.

This report provides a detail
breakdown of the Unallocated
Payments figure from the
Receipt Allocation Report.

As needed.

Verification Lists
Fee
Cost
Payment
Client Funds

Verification lists are used to
verify transactions that have
been added using one of the
data entry programs, changed
by a program in Tabs3 (e.g.,
Update Statements, Write-
Up/Write-Down, etc.) or
imported from an external
source (e.g., Tabs3 Remote,
etc.). Separate verification lists
are maintained for each User
ID.

Verification lists can serve as
an audit trail for accounting
purposes. They also allow
data entry operators to check
their work after each data
entry session.

Usually printed after each
data entry session, daily or
weekly. Should be deleted
periodically.
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Purposes and Benefits of Tabs3 Reports

Report Purpose Benefit When to Run

Write-Up/Write-Down
Report

Shows write-ups, write-downs
and net write-ups/write-
downs by client by timekeeper
for a specified date range. The
write-up and write-down
amounts are broken down
into fees, expenses, and
advances. This report can
include billed time, unbilled
time, and hours that were
written up or down.

Ideal for tracking write-down
trends for specific clients and
timekeepers.

As needed.
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Optional Report Footer
The software can be configured to include an optional footer on the reports.
The footer includes the day of the week, date, and time the report is printed.
You can optionally include a horizontal ruling line and the initials of the User ID
who prints the report.

The footer is configured at the printer level for each workstation in the
Advanced Printing Options window (File | Print Setup | Advanced Printing
Options).

The following is an example of a footer with the user initials and horizontal ruling line.

DKH Monday  11/28/2016 9:51  am

Timekeeper List

Date: 11/28/2016 Tabs3 Timekeeper List Page: 1
Jensen, Martin & Anderson, P.C.

Timekeeper Rate 1 Rate 2 Rate 3 Rate 4 Rate 5 Rate 6 Lvl

1 MLJ Michael L. Jensen 250.00 275.00 200.00 200.00 225.00 0.00 1
2 PAM Paula Ann Martin 225.00 250.00 185.00 175.00 215.00 0.00 2
3 RPA Ronald P. Anderson 160.00 190.00 115.00 105.00 145.00 0.00 2
4 ROB Robert O. Burns 200.00 150.00 250.00 400.00 100.00 300.00 7
5 KIM Kendra I. Michaels 150.00 175.00 125.00 0.00 0.00 0.00 3
6 DHB Daniel H. Brady 70.00 85.00 50.00 0.00 0.00 0.00 5
7 CB Cheryl Bradley 65.00 80.00 45.00 0.00 0.00 0.00 5
8 JAN Jennifer A. Noonan 100.00 110.00 90.00 0.00 0.00 0.00 4
9 JIM Jason I. Masterson 150.00 160.00 130.00 0.00 0.00 0.00 3

10 JPP Jimmy P. Praum 50.00 75.00 25.00 0.00 0.00 0.00 6
39 OLD *Old / Archived Timekeepers 0.00 0.00 0.00 0.00 0.00 0.00 9

Date: 11/28/2016 Tabs3 Timekeeper List Page: 1
Jensen, Martin & Anderson, P.C.

Timekeeper Rate 1 Rate 2 Rate 3 Rate 4 Rate 5 Rate 6 Lvl

1 MLJ Michael L. Jensen 250.00 275.00 200.00 200.00 225.00 0.00 1

Jan: 10,000 Feb: 10,000 Mar: 10,000 Apr: 10,000
Overhead May: 10,000 Jun: 10,000 Jul: 10,000 Aug: 10,000

Sep: 10,000 Oct: 10,000 Nov: 10,000 Dec: 10,000

2 PAM Paula Ann Martin 225.00 250.00 185.00 175.00 215.00 0.00 2

Jan: 10,000 Feb: 10,000 Mar: 10,000 Apr: 10,000
Overhead May: 10,000 Jun: 10,000 Jul: 10,000 Aug: 10,000

Sep: 10,000 Oct: 10,000 Nov: 10,000 Dec: 10,000

3 RPA Ronald P. Anderson 160.00 190.00 115.00 105.00 145.00 0.00 2

Jan: 10,000 Feb: 10,000 Mar: 10,000 Apr: 10,000
Overhead May: 10,000 Jun: 10,000 Jul: 10,000 Aug: 10,000

Sep: 10,000 Oct: 10,000 Nov: 10,000 Dec: 10,000

Task Folder Reports | File Lists | Timekeeper List

The list shown is a Timekeeper List. It shows the information in the timekeeper file. This list can be printed in numerical or
alphabetical order and can be single or double spaced. It can optionally include timekeeper overhead amounts when it is
printed by a user assigned to the “Manager” access profile. The first list shown is printed in numerical order and is single spaced.
The second list shown below includes overhead amounts.

Definitions for Timekeeper List
Date The date the list was printed.
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Timekeeper Timekeeper number, initials and name. An * next to the timekeeper name indicates the timekeeper is
marked inactive.

Rate 1 Hourly billing rate #1 (usually the normal billing rate).

Rates 2-6 Hourly billing rates #2-6 (optional, user defined).

Lvl Timekeeper level number.

New Rate
Effective Date

The date the new rates are effective and the corresponding new rates for hourly billing rates # 1-6.

Overhead
Overhead amounts entered in the Timekeeper Profitability Amounts window in the timekeeper file.
This information can only be included if the list is printed by a user assigned to the “Manager”
access profile.

Timekeeper Level List

Date: 11/28/2016 Tabs3 Timekeeper Level List Page: 1
Jensen, Martin & Anderson, P.C.

Timekeeper Level

1 Senior Partner
2 Partner
3 Associate
4 Paralegal
5 Secretary
6 Law Clerk
7 Of Counsel
8
9

Task Folder Reports | File Lists | Timekeeper Level List

The Timekeeper Level List shows the information in the optional timekeeper level description file. Nine timekeeper level
descriptions can be defined. Timekeeper levels can be used for optionally defining an hourly billing rate for each level of
timekeeper for each client. A Timekeeper Analysis Report and most Timekeeper Productivity reports can be printed in timekeeper
level order. A Fee Recap by timekeeper level can be printed on statements.
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Definitions for Timekeeper Level List
Date The date the list was printed.

Timekeeper Level Level number and description.

Category List

Date: 11/28/2016 Tabs3 Category List Page: 1
Jensen, Martin & Anderson P.C.

Category Code Set

1 Personal Injury
5 Wills/Trusts/Estates

10 Workers' Compensation
15 Probate P
20 Tax Law
25 Real Estate B
30 Foreclosure B
35 Family Law
40 Business Law
45 Trademarks/Copyrights/Patents
50 Criminal Law
55 Insurance Defense L
60 General Litigation L

Task Folder Reports | File Lists | Category List

The list shown is a Category List. This list shows the information in the category file. Up to 999 categories can be defined.
Categories are used to classify fee services into related groups for purposes of producing productivity reports by category of
work.

Definitions for Category List
Date The date the list was printed.

Category Category number and description.

Code Set Task Based Billing Code Set assigned to the category.
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Cost Type Description List

Date: 11/28/2016 Tabs3 Cost Type Description List Page: 1
Jensen, Martin & Anderson, P.C.

Expense Description Advance Description

Type 0: Type 0:Miscellaneous Miscellaneous
Type 1: Type 1:Phone Filing Fees
Type 2: Type 2:Photocopies/Faxes Processor Fees
Type 3: Type 3:Travel Expense Witness Fees
Type 4: Type 4: Medical Records
Type 5: Type 5:
Type 6: Type 6:
Type 7: Type 7:
Type 8: Type 8:
Type 9: Type 9:

Task Folder Reports | File Lists | Cost Type List

The Cost Type Description List shows the information in the optional Cost Type description file. Up to 20 Cost Types can be
defined (10 for expenses and 10 for advances). Cost Types are used to group similar types of costs. The Transaction File List and
Client Ledger Report optionally show amounts billed by Cost Type. The Allocated Payments Report shows how payments are
allocated to each Cost Type. The Receipt Allocation Report shows amounts billed and paid by Cost Type.

Definitions for Cost Type Description List
Date The date the list was printed.

Expense/Advance Type The number assigned to the Cost Type.

Description The Cost Type description.
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Transaction Code List

Date: 11/28/2016 Tabs3 Transaction Code List Page: 1
Jensen, Martin & Anderson, P.C.

Effective
Tcode Codes Description QB Amount Rate New Rate Date

1 FEE 0F0N 0.00 0.000 0.000 mm/dd/yyyy
2 OSC 0F0N Outside conference with 0.00 0.000 0.000 mm/dd/yyyy
3 TC 0F0N Telephone conference with 0.00 0.000 0.000 mm/dd/yyyy
4 OF 0F0N Open file 0.00 0.000 0.000 mm/dd/yyyy
5 LT 0F0N Letter to 0.00 50.000 75.000 12/31/2016
6 REC 0F0N Receipt of 0.00 0.000 0.000 mm/dd/yyyy
7 PP 0F0N Plan and prepare for 0.00 0.000 0.000 mm/dd/yyyy
8 DAR 0F0N Draft and revise 0.00 0.000 0.000 mm/dd/yyyy
9 RA 0F0N Review and analyze 0.00 0.000 0.000 mm/dd/yyyy

10 LR 0F0N Legal research 0.00 0.000 0.000 mm/dd/yyyy
11 CA 0F0N Court appearance 0.00 0.000 0.000 mm/dd/yyyy
12 INV 0F0N Investigation of 0.00 0.000 0.000 mm/dd/yyyy
13 ATT 0F0N Attended 0.00 0.000 0.000 mm/dd/yyyy
14 COM 0F0N Communicate with 0.00 0.000 0.000 mm/dd/yyyy
15 UP 0F0N Update files/records 0.00 0.000 0.000 mm/dd/yyyy
16 OCW 0F0N Office conference with 0.00 100.000 150.000 12/31/2016
17 WO 4F4N Write off per
18 MIS 5F4N (miscellaneous fee) 0.00 0.000 0.000 mm/dd/yyyy
19 IM 0F2N Initial meeting. 0.00 0.000 0.000 mm/dd/yyyy
20 NB 0F2N Non-billable time 0.00 0.000 0.000 mm/dd/yyyy
21 DES 4F4N (description only)
22 PF 6F0N (progress fee)
23 DP 0F0N Deposition of 0.00 0.000 0.000 mm/dd/yyyy
24 RR 0F0N Receipt and review of e-mail 0.00 0.000 0.000 mm/dd/yyyy

100 MA 5A4N0 (miscellaneous advance) 0.00 0.000 0.000 mm/dd/yyyy
101 PRO 0A0N2 Processor fee 85.00 0.000 0.000 mm/dd/yyyy
102 CF 0A0N2 Courier fee 0.00 0.000 0.000 mm/dd/yyyy
103 OPF 0A0N3 Outside professional fee 0.00 0.000 0.000 mm/dd/yyyy
104 MED 0A0N4 Medical records 0.00 0.000 0.000 mm/dd/yyyy
105 SF 0A0N3 Sheriff's fee 45.00 0.000 0.000 mm/dd/yyyy
106 OLR 0A0N0 Online legal research 0.00 0.000 0.000 mm/dd/yyyy
107 TRA 0A0N0 Transcription fees 0.00 0.000 0.000 mm/dd/yyyy
108 EX 0A0N0 Trial exhibits 0.00 0.000 0.000 mm/dd/yyyy
109 FF 0A0N1 Filing fee 105.00 0.000 0.000 mm/dd/yyyy
110 DOC 0A0N2 Document preparation/typing 0.00 20.000 0.000 mm/dd/yyyy
111 LAT 0A0N1 Late Fees 0.00 0.000 0.000 mm/dd/yyyy
250 LD 0E0N1 Long distance telephone charges 0.00 0.000 0.000 mm/dd/yyyy
251 COP 0E0N2 Photocopy charges 0.00 0.200 25.000 12/31/2016
252 ML 0E0N3 Mileage to/from 0.00 0.575 0.000 mm/dd/yyyy
253 POS 0E0N0 Postage 0.00 0.000 0.000 mm/dd/yyyy
254 TEX 0E0N3 Travel expense 0.00 0.000 0.000 mm/dd/yyyy
255 FAX 0E0N2 Fax 0.00 1.000 0.000 mm/dd/yyyy
256 ME 0E0N0 (miscellaneous expense) 0.00 0.000 0.000 mm/dd/yyyy
900 PYM 1 0N Payment
950 DEP 0E0N0 Deposit to client funds 0.00 0.000 0.000 mm/dd/yyyy
951 WD 0E0N0 Withdrawal from client funds 0.00 0.000 0.000 mm/dd/yyyy
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Date: 11/28/2016 Tabs3 Transaction Code List Page: 2
Jensen, Martin & Anderson, P.C.

The 'Codes' column is made up of 5 different codes, each defined by its
relative code position:

Position 1 Transaction Code Type
0 = Normal
1 = Regular Payment
2 = Fee Payment
3 = Cost Payment
4 = Description Only
5 = Miscellaneous
6 = Progress Fee
9 = Finance Charge Credit

Position 2 Transaction Type
F = Fee
E = Expense
A = Advance

Position 3 Bill Code
0 = Billable / Printable
1 = Non-billable / Non-printable
2 = Non-billable / Printable
3 = Billable / Non-printable
4 = Billable / Always Print

Position 4 Taxable
Y = Yes
N = No

Position 5 Expense Cost Type Advance Cost Type
0 = Miscellaneous 0 = Miscellaneous
1 = Phone 1 = Filing Fees
2 = Photocopies/Faxes 2 = Processor Fees
3 = Travel Expense 3 = Witness Fees

4 = Medical Records

Task Folder Reports | File Lists | Transaction Code List

The term transaction code refers to the types of activities or services performed that relate to fees, cost advances, and client
expenses billed to clients and the resulting payments made by the clients. Up to 999 transaction codes can be defined. The list
can be printed in numerical or alphabetical order and can be single or double spaced. The list shown is printed in numerical
order and is single spaced.

Definitions for Transaction Code List
Date The date the list was printed.

Tcode Transaction code number and optional alpha representation.

Code Position 1: Type The Type determines how Tabs3 treats the transaction code. The eight different transaction code
Types are shown at the bottom of the list.

Code Position 2:
Expense/Advance/Fee

“E” = Expense transaction code, “A” = Advance transaction code or “F” = Fee transaction code. Fee
transaction codes cannot be used in the Cost and Payment data entry programs. However, expense
and advance transaction codes generally can be used in the Fee data entry program.

Code Position 3:
Bill Code

This position represents the Bill Code. The Bill Code determines the transaction code’s default billing
and print status. “0” = billable and printable. “1” = non-billable and non-printable, “2” = non-
billable and printable, “3” = billable and non-printable, “4” = billable and always print.

Code Position 4:
Taxable

“Y” (Yes) or “N” (No). Designates whether the transaction code is taxable.
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Code Position 5:
Cost Type (0-9)

This position represents the Cost Type assigned to the transaction code. Each expense and advance
transaction code can be classified as one of twenty different Costs Types (10 for expenses and 10 for
advances). The Transaction File List and Client Ledger Report optionally show amounts billed by
Cost Type. The Allocated Payments Report shows how processed payments are applied to each Cost
Type. The Receipt Allocation Report shows amounts billed and paid by Cost Type.

Description Shows the description defined for the transaction code.

QB “Y” (Yes) indicates the transaction code is configured to integrate with QuickBooks.

Amount Optional amount for each transaction code used for value billing.

Rate Optional rate for each transaction code. Three decimal places provide extra flexibility when ½ cent
per unit is required, such as $0.225 per mile.

New Rate Optional new rate for each transaction code.

Effective Date The date the new rate for each transaction code is effective.

Billing Frequency List

Date: 11/28/2016 Tabs3 Billing Frequency List Page: 1
Jensen, Martin & Anderson, P.C.

Report
ID Description Character Default

Contngcy Contingency Billing Clients C
Demand Bill on Demand Clients D
Hold Clients on Hold H
Monthly Monthly Clients M D
QuarterA Quarterly Billing (Jan, Apr, Jul, Oct) Q
QuarterB Quarterly Billing (Feb, May, Aug, Nov) R
QuarterC Quarterly Billing (Mar, Jun, Sep, Dec) S

Task Folder Reports | File Lists | Billing Frequency List

Billing frequencies are used to define how often a client is billed. They can also be used for selecting batches or groups of
clients when running statements and reports. An unlimited number of billing frequencies can be defined.

Definitions for Billing Frequency List
ID Billing Frequency ID assigned to the billing frequency. The Billing Frequency ID can be a maximum

of 8 characters.

Description The billing frequency description. The description can be a maximum of 40 characters.

Report Character The character that will be shown on reports for clients assigned to the billing frequency. The report
character prints immediately following the Client ID on most client-based reports.

Default The billing frequency with a “D” in the “Default” column is the billing frequency that will be
assigned to new clients. Only one billing frequency will be marked as the default.
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Location

Date: 11/28/2016 Tabs3 Location List Page: 1
Jensen, Martin & Anderson, P.C.

ID Description

Columbus Columbus Office
Kearney Kearney Office
Lincoln Lincoln Office
Omaha Omaha Office

Task Folder Reports | File Lists | Location List

If your firm has multiple offices, each client can be assigned to a specific location. Reports and statements can then be
generated for the clients assigned to a specific location. If you will only be maintaining information for a single office, you do
not need to define locations in Tabs3. An unlimited number of locations can be defined.

Definitions for Location
ID Location ID assigned to the location. The Location ID can be a maximum of 8 characters.

Description The location description. The description can be a maximum of 40 characters.

Task Code List
The Task Code List shown on the following pages includes the task codes that have been defined for use with task based billing
clients. The task codes shown are suggested by the Uniform Task-Based Management System and are included by default with
Tabs3.

Definitions for Task Code List
ID Task Code ID. The Task Code ID consists of four or five characters. The first one or two characters are

always a letter combination and the remaining three characters are numbers identifying the task
code. For Phase/Task codes, the letters represent the task code set. For Activity codes, the first
character is always the letter “A”. Similarly, for Expense codes, the first character is always the letter
“E”.

Description The task code description. The description can be a maximum of 70 characters.

Tcode The transaction code assigned to the task code. Only Activity codes and Expense codes can be
assigned a transaction code.
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Date: 11/28/2016 Tabs3 Task Code List Page: 1
Jensen, Martin & Anderson, P.C.

ID Description Tcode

B100 Administration
B110 Case Administration
B120 Asset Analysis and Recovery
B130 Asset Disposition
B140 Relief from Stay/Adequate Protection Proceedings
B150 Meetings of and Communications with Creditors
B160 Fee/Employment Applications
B170 Fee/Employment Objections
B180 Avoidance Action Analysis
B185 Assumption/Rejection of Leases and Contracts
B190 Other Contested Matters (excluding assumption/rejection motions)
B195 Non-Working Travel
B200 Operations
B210 Business Operations
B220 Employee Benefits/Pensions
B230 Financing/Cash Collections
B240 Tax Issues
B250 Real Estate
B260 Board of Directors Matters
B300 Claims and Plan
B310 Claims Administration and Objections
B320 Plan and Disclosure Statement (including Business Plan)
B400 Bankruptcy-Related Advice
B410 General Bankruptcy Advice/Opinions
B420 Restructurings

C100 Fact Gathering
C200 Researching Law
C300 Analysis and Advice
C400 Third Party Communication

L100 Case Assessment, Development and Administration
L110 Fact Investigation/Development
L120 Analysis/Strategy
L130 Experts/Consultants
L140 Document/File Management
L150 Budgeting
L160 Settlement/Non-Binding ADR
L190 Other Case Assessment, Development and Administration
L200 Pre-Trial Pleadings and Motions
L210 Pleadings
L220 Preliminary Injunctions/Provisional Remedies
L230 Court Mandated Conferences
L240 Dispositive Motions
L250 Other Written Motions and Submissions
L260 Class Action Certification and Notice
L300 Discovery
L310 Written Discovery
L320 Document Production
L330 Depositions
L340 Expert Discovery
L350 Discovery Motions
L360 Discovery On-Site Inspections

Task Code List - Page 1
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Date: 11/28/2016 Tabs3 Task Code List Page: 2
Jensen, Martin & Anderson, P.C.

ID Description Tcode

L390 Other Discovery
L400 Trial Preparation and Trial
L410 Fact Witnesses
L420 Expert Witnesses
L430 Written Motions and Submissions
L440 Other Trial Preparation and Support
L450 Trial and Hearing Attendance
L460 Post-Trial Motions and Submissions
L470 Enforcement
L500 Appeal
L510 Appellate Motions and Submissions
L520 Appellate Briefs
L530 Oral Argument
L600 Identification (NOS)
L601 Discovery Planning
L602 Interviews
L609 Quality assurance and control
L610 Preservation (NOS)
L611 Preservation order
L612 Legal hold
L619 Quality assurance and control
L620 Collection (NOS)
L621 Collection/Recovery
L622 Media Costs
L623 Media/ESI Transfer, Receipt, Inventory
L629 Quality assurance and control
L630 Processing (NOS)
L631 ESI stage, preparation and process
L632 Scanning - Hard Copy
L633 Foreign language translation
L634 Exception handling
L639 Quality assurance and control
L650 Review (NOS)
L651 Hosting costs
L652 Objective and Subjective coding
L653 First pass document review
L654 Second pass document review
L655 Privilege review
L656 Redaction
L659 Quality assurance and control
L660 Analysis (NOS)
L670 Production (NOS)
L671 Conversion of ESI to production format
L679 Quality assurance and control
L680 Presentation (NOS)
L690 Project Management (NOS)
L693 Review Planning & Training

P100 Project Administration
P200 Fact Gathering/Due Diligence
P210 Corporate Review
P220 Tax
P230 Environmental

Task Code List - Page 2
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Date: 11/28/2016 Tabs3 Task Code List Page: 3
Jensen, Martin & Anderson, P.C.

ID Description Tcode

P240 Real and Personal Property
P250 Employee/Labor
P260 Intellectual Property
P270 Regulatory Reviews
P280 Other
P300 Structure/Strategy/Analysis
P400 Initial Document Preparation/Filing
P500 Negotiation/Revision/Response
P600 Completion/Closing
P700 Post-Completion/Post-Closing
P800 Maintenance and Renewal
P900 Transactional Advice and Opinion
P920 Ongoing Relationship Advice
P930 Other

PA100 Assessment, Development, and Administration
PA110 Fact Investigation and Development
PA120 Analysis/Strategy
PA130 Document/File Management
PA140 Budgeting
PA199 Other Assessment, Development, or Administration
PA200 Patent Investigation and Analysis
PA210 State-of-the-Art Investigation
PA220 Patentability Investigation
PA230 Clearance Investigation
PA240 Validity Investigation
PA250 Publication Watches
PA260 Infringement Investigation
PA270 Status Investigation
PA299 Other Patent Investigation and Analysis
PA300 Domestic Patent Preparation
PA310 Provisional Application Preparation - Domestic
PA320 Non-Provisional Application Preparation - Domestic
PA330 Design Application Preparation - Domestic
PA340 Plant Patent Preparation - Domestic
PA350 Continuing Application Preparation - Domestic
PA360 Validation Patent Application Preparation - Domestic
PA399 Other Patent Application Preparation - Domestic
PA400 Domestic Patent Prosecution
PA410 Information Disclosure Statement - Domestic
PA420 Preliminary Amendment - Domestic
PA430 Official Communication - Domestic
PA440 Quasi-Judicial Administrative Proceedings - Domestic
PA450 Post-Issuance Remedial Action - Domestic
PA499 Other Patent Prosecution - Domestic
PA500 International Patent Preparation
PA510 Provisional Application Preparation - International
PA520 Non-Provisional Application Preparation - International
PA530 Design Application Preparation - International
PA540 Plant Patent Preparation - International
PA550 Continuing Application Preparation - International
PA560 Validation Patent Application Preparation - International
PA599 Other Patent Application Preparation - International

Task Code List - Page 3
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Date: 11/28/2016 Tabs3 Task Code List Page: 4
Jensen, Martin & Anderson, P.C.

ID Description Tcode

PA600 International Patent Prosecution
PA610 Information Disclosure Statement - International
PA620 Preliminary Amendment - International
PA630 Official Communication - International
PA640 Quasi-Judicial Administrative Proceedings - International
PA650 Post-Issuance Remedial Action - International
PA699 Other Patent Prosecution - International
PA700 Other Patent-Related Tasks
PA710 Opinion Preparation
PA720 Portfolio Analysis and Management
PA730 Assignments and Security Interests
PA740 Licensing

TR100 Assessment, Development, and Administration
TR110 Fact Investigation and Development
TR120 Analysis/Strategy
TR130 Document/File Management
TR140 Budgeting
TR199 Other Assessment, Development, or Administration
TR200 Trademark Investigation and Analysis
TR220 Registerability Investigation
TR230 Clearance Investigation
TR240 Opposition Investigation
TR250 Publication Watches
TR260 Enforcement Investigation
TR270 Status Investigation
TR299 Other Trademark Investigation and Analysis
TR300 Domestic Trademark Application Preparation
TR310 Application Preparation and Filing - Domestic
TR399 Other Domestic Trademark Application Preparation and Filing
TR400 Domestic Trademark Prosecution and Renewal
TR410 Affidavits, Petitions, Extensions, Declarations and Other Filings
TR420 Preliminary Amendment - Domestic
TR430 Official Communication - Domestic
TR440 Quasi-Judicial Administrative Proceedings - Domestic
TR499 Other Trademark Prosecution - Domestic
TR500 International Trademark Application Preparation and Renewals
TR510 Application Preparation and Filing - International
TR599 Other International Trademark Application Preparation and Filing
TR600 International Trademark Prosecution and Renewal
TR610 Affidavits, Petitions, Extensions, Declarations and Other Filings
TR620 Preliminary Amendment - International
TR630 Official Communication - International
TR640 Quasi-Judicial Administrative Proceedings - International
TR699 Other Trademark Prosecution - International
TR700 Other Trademark Related Tasks
TR710 Opinion Preparation
TR720 Portfolio Analysis and Management
TR730 Assignments and Security Interests
TR740 Licensing
TR750 Domain Names - gTLDs
TR760 Domain Names - ccTLDs
TR770 Quasi-Judicial Administrative Proceedings - Domain Names

Task Code List - Page 4
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Date: 11/28/2016 Tabs3 Task Code List Page: 5
Jensen, Martin & Anderson, P.C.

ID Description Tcode

TR799 Other Trademark Prosecution

WC100 Initial Assessment of Case and/or Issue and Outcomes
WC110 Fact Investigation/Development
WC120 Analysis/Strategy
WC130 Experts/Consultants
WC150 Budgeting
WC160 Settlement/Resolution
WC180 Alternative Fee Arrangements
WC200 Pleadings/Preliminary Proceedings
WC210 Pleadings
WC230 Conferences with Judge
WC280 Alternative Fee Arrangements
WC300 Discovery/Document Production
WC310 Written Discovery
WC320 Document Production/Acquisition
WC330 Depositions
WC340 Expert Discovery
WC350 Discovery Motions
WC360 Discovery On-Site Inspections/Visits
WC380 Alternative Fee Arrangements
WC400 Hearings/Trial Practice
WC410 Fact Witnesses
WC420 Expert Witnesses
WC430 Written Motions/Submissions
WC440 Hearing Preparation and Support
WC450 Hearing
WC460 Post-Hearing Conferences/ Motions/Submissions
WC470 Assertion of Subrogation Claims on behalf of employer/carrier
WC480 Alternative Fee Arrangements
WC500 Appellate Practice
WC510 Appellate Proceedings/Motion Practice
WC520 Appellate Briefs
WC530 Oral Argument/Post Submission Practice
WC580 Alternative Fee Arrangements

A101 Plan and prepare for 7
A102 Research 10
A103 Draft/revise 8
A104 Review/analyze 9
A105 Communicate (within legal team) 14
A106 Communicate (with client) 14
A107 Communicate (opponents/other outside counsel) 14
A108 Communicate (other external) 14
A109 Appear for/attend 13
A110 Manage data/files/documentation 15
A111 Other 18
A112 Billable Travel Time 254
A113 Communicate (witnesses) 14
A114 Communicate (experts) 14
A115 Medical Record and Medical Bill Management 15
A116 Training 10
A117 Special Handling Copying/Scanning/Imaging (Internal) 15

Task Code List - Page 5
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Date: 11/28/2016 Tabs3 Task Code List Page: 6
Jensen, Martin & Anderson, P.C.

ID Description Tcode

A118 Collection-Forensic 12
A119 Culling & Filtering 15
A120 Processing 15
A121 Review and Analysis 15
A122 Quality Assurance and Control 9
A123 Search Creation and Execution 10
A124 Privilege Review Culling and Log Creation 15
A125 Document Production Creation and Preparation 8
A126 Evidence/Exhibit Creation and Preparation 7
A127 Project Management 7
A128 Collection Closing Activities 9

E101 Copying 251
E102 Outside printing 251
E103 Word processing 251
E104 Facsimile 255
E105 Telephone 250
E106 Online research 106
E107 Delivery services/messengers 102
E108 Postage 253
E109 Local travel 254
E110 Out-of-town travel 254
E111 Meals 254
E112 Court fees 109
E113 Subpoena fees 101
E114 Witness fees 103
E115 Deposition transcripts 107
E116 Trial transcripts 107
E117 Trial exhibits 108
E118 Litigation Support Vendors 103
E119 Experts 103
E120 Private Investigators 103
E121 Arbitrators/Mediators 103
E122 Local counsel 103
E123 Other professionals 103
E124 Other 256
E125 Translation 110
E126 Drawings 103
E127 Patent and Trademark Records 110
E128 Searching and Monitoring 103
E129 Official Fees 101
E130 Post-Issuance Patent Maintenance and Trademark Renewal Fees 101
E131 Late Fees 111

X101 Copies/Blowbacks/Printing-Black & White (Internal) 251
X102 Copies/Blowbacks/Printing-Color (Internal) 251
X103 Copy Service (External) 251
X104 Special Handling Copying/Scanning/Imaging (Internal) 251
X105 Word Processing 110
X106 Facsimile 255
X107 Telephone-Local 250
X108 Telephone-Long Distance 250
X109 Telephone-Mobile 250

Task Code List - Page 6
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Date: 11/28/2016 Tabs3 Task Code List Page: 7
Jensen, Martin & Anderson, P.C.

ID Description Tcode

X110 Conference Call/Video Call/Webinar Charges 106
X111 Online Legal Research 106
X112 Delivery Services/Messengers 102
X113 Postage 253
X114 Local Travel 254
X115 Out-of-Town Travel 254
X116 Meals 254
X117 Court and Governmental Agency Fees 103
X118 Eviction Costs 105
X119 Foreclosure Costs 105
X120 Title Insurance Costs 106
X121 Immigration Costs 103
X122 Late Fees 111
X123 Publication Costs 110
X124 Publications/Books/Treatises 110
X125 ATE Premiums/Insurance 103
X126 Witness Fees 103
X127 Deposition Transcripts 107
X128 Trial Transcripts 107
X129 Trial Exhibits 108
X130 Medical Records Costs 104
X131 Medical Records Analysis 104
X132 Medical Record Service Provider Fees 104
X133 Private Investigators, Investigative Reports, and Investigation Fees 103
X134 Arbitrators/Mediators 103
X135 Local Counsel 103
X136 Appraiser/Appraisal Fees 103
X137 Experts, Consultants, Other Vendors and Professionals 103
X138 Litigation Support Vendors 103
X139 Translation 103
X140 Special Purpose Location/Office Rental 100
X141 Special Purpose Moving and Storage Fees 103
X142 Settlement Costs 103
X143 Bank Fees 111
X200 Drawings 108
X202 Patent and Trademark Searching and Monitoring 106
X203 Patent and Trademark Prosecution Application Official Fees 109
X204 Patent and Trademark Prosecution Post-Issuance Fees 109
X205 Official Fees, Patent and Trademark Opposition Fees 109
X206 IP Annuity Payments 100
X207 IP Holdbacks 100
X300 Discovery/eDiscovery Collection-Forensic 106
X301 Discovery/eDiscovery Collection-Third Party 106
X302 Discovery/eDiscovery Culling & Filtering 106
X303 Bates Stamping/Control Numbers 110
X304 Discovery/eDiscovery Review and Analysis 106
X305 Discovery/eDiscovery Privilege Review Culling and Log Creation 106
X306 Discovery/eDiscovery Document Production Creation and Preparation 106
X307 Electronic Media Cost 106
X308 Discovery/eDiscovery Technical Services-Other 106
X309 Discovery/eDiscovery Evidence/Exhibit Creation and Preparation 110
X400 Software License/User Access Fee 100
X401 Subscription Fee 103

Task Code List - Page 7
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Date: 11/28/2016 Tabs3 Task Code List Page: 8
Jensen, Martin & Anderson, P.C.

ID Description Tcode

X402 Transaction Fee 103
X403 Hardware Costs 100
X404 Hosting Fees - Internal 106
X405 Data Storage Fees - Internal 106
X999 Other 100

Task Code List - Page 8

Task Code Set List

Date: 11/28/2016 Tabs3 Task Code Set Description List Page: 1

Character Description

B Bankruptcy Code Set
C Counseling Code Set
L Litigation Code Set
P Project Code Set

PA Patent Code Set
TR Trademark Code Set
WC Workers' Comp Set

Task Folder Reports | File Lists | Task Code Set List

The Task Code Set List shows the defined task code sets and their associated descriptions.

Definitions for Task Code Set List
Character Character assigned to the task code set. There are over 600 task code sets that can be defined. Each

set is assigned a one- or two-character label from AA-ZZ with the exception of letter “E”, which is
reserved for Expense codes and the letter “A”, which is reserved for Activity codes.

Description The task code set description. The description can be a maximum of 20 characters.
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Text Macro List

Date: 11/28/2016 Tabs3 Text Macro List Page: 1
Jensen, Martin & Anderson, P.C.

Macro ID Text

ATT attended
CA court appearance
CCT carbon copy to:
CF courier fee
COM communicate with
CRTA court appearance
DAR draft and revise
DOM Petition for Dissolution of Marriage and related documents
EN enclosure
FF filing fee
INT interrogatories
INTDOC Interrogatories and Request for Production of Documents
INV investigation of
LD long distance telephone charges
LM left message
LR legal research
LT letter to
LWT Last Will and Testament
MED medical records
ML mileage to/from
MSJ Motion for Summary Judgement
NOA Notice of Appearance
NONPAY concerning past due balance. Discussed setting up a monthly payment schedule.  No more

work will be done until a good faith payment is made.
OC office conference with
OLR online legal research
OPF outside professional fee
OPP opposing counsel
OPPDOC  opposing counsel regarding discovery and production of documents
OSC outside conference with
PNG Plea of Not Guilty

Task Folder Reports | File Lists | Text Macro List

The Text Macro List shows the text macros that have been defined using the Text Macro Maintenance program. Text macros can
be used to speed up data entry by automatically inserting commonly used words or phrases when a Macro ID is typed with a
space immediately after it. For example, you might have a Macro ID named “DAR” with the text “draft and revise”. When the
Macro ID “DAR” is typed followed by a space or selected via the Text Macro lookup window, it is automatically replaced with the
text “draft and revise”.

Definitions for Text Macro List
Macro ID Macro ID assigned to the text macro.

Text The replacement text for the text macro. When the Macro ID is typed during data entry, it will
automatically be replaced with this text.
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GLS Integration Setup Report
Date: 11/28/2016 GLS Integration Setup Report Page: 1

Jensen, Martin & Anderson, P.C.

Unapplied Payment Allocation by Single Debit & Credit

Debit Account Credit Account Journal

1110.00 Operating Account 2270.00 Unapplied Payments 2 Receipts

Fee Allocation by Working Timekeeper

Timekeeper Debit Account Credit Account Journal

All Other 1110.00 Operating Account 4100.01 Fee Income - MLJ 2 Receipts
1 Michael L. Jensen 1110.00 Operating Account 4100.01 Fee Income - MLJ 2 Receipts
2 Paula Ann Martin 1110.00 Operating Account 4100.02 Fee Income - PAM 2 Receipts
3 Ronald P. Anderson 1110.00 Operating Account 4100.03 Fee Income - RPA 2 Receipts
4 Robert O. Burns 1110.00 Operating Account 4100.04 Fee Income - ROB 2 Receipts
5 Kendra I. Michaels 1110.00 Operating Account 4100.05 Fee Income - KIM 2 Receipts
6 Daniel H. Brady 1110.00 Operating Account 4100.06 Fee Income - DHB 2 Receipts
7 Cheryl Bradley 1110.00 Operating Account 4100.07 Fee Income - CB 2 Receipts
8 Jennifer A. Noonan 1110.00 Operating Account 4100.08 Fee Income - JAN 2 Receipts
9 Jason I. Masterson 1110.00 Operating Account 4100.09 Fee Income - JIM 2 Receipts
10 Jimmy P. Praum 1110.00 Operating Account 4100.10 Fee Income - JPP 2 Receipts

Cost Allocation by Cost Type

Cost Type Debit Account Credit Account Journal

All Other Expenses 1110.00 Operating Account 4400.00 Expense Income 2 Receipts
All Other Advances 1110.00 Operating Account 1210.00 Client Cost Advances 2 Receipts

Finance Charge Allocation by Single Debit & Credit

Debit Account Credit Account Journal

1110.00 Operating Account 4800.00 Finance Charge Income 2 Receipts

Progress Fee Allocation by Single Debit & Credit

Debit Account Credit Account Journal

1110.00 Operating Account 4300.00 Undistributed Fee Income 2 Receipts

Fee Sales Tax Allocation by Single Debit & Credit

Debit Account Credit Account Journal

1110.00 Operating Account 2240.00 Sales Tax Payable 2 Receipts

Advance Sales Tax Allocation by Single Debit & Credit

Debit Account Credit Account Journal

1110.00 Operating Account 2240.00 Sales Tax Payable 2 Receipts

Expense Sales Tax Allocation by Single Debit & Credit

Debit Account Credit Account Journal

1110.00 Operating Account 2240.00 Sales Tax Payable 2 Receipts

Client Funds Integration by Single Debit & Credit

Debit Account Credit Account Journal

Cost Entry Integration by Tcode

Tcode Debit Account Credit Account Journal

250 Long distance telephone charges 8090.00 Telephone 1110.00 Operating Account 1 General
251 Photocopy charges 8040.00 Office Supplies 1110.00 Operating Account 1 General
253 Postage 8120.00 Postage 1110.00 Operating Account 1 General

Accrual Posting
Accrual Posting Disabled

Type Debit Account Credit Account Journal Description

Task Folder Integration | GLS Integration Setup | Print GLS Integration Setup Report

The GLS Integration Setup Report is available when Tabs3 is configured to integrate with General Ledger Software (GLS). For
each GLS Integration type, the report shows the integration Posting Method, Debit and Credit Accounts, and Journal to be used
in GLS.

Definitions for GLS Integration Setup Report
Date (heading) Used for reference only.

(PostingMethod) Depending on the type of integration, Category, Cost Type, Location, Tcode, Timekeeper, or Type
will be listed. A list of all configured transaction types within that Posting Method will be listed.

Debit Account GLS Debit Account.
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Credit Account GLS Credit Account.

Journal GLS Journal Number.

Description If Tabs3 is configured to allow accrual posting to GLS, each posting type (i.e., Fee A/R, Expense A/R,
etc.) can be configured with a 40-character description, which will be included on the GLS journal
entry.

Detail Client List
Date: 11/28/2016 Tabs3 Client List Page: 1

Jensen, Martin & Anderson, P.C.

101.00P  Williams/John
Williams/John  

Date Opened:  08/16/2015
RE: State v. Williams

P: 002 PAM Bus: 21225 Amberwood Location: Omaha
S: 001 MLJ Chicago IL  60662 Rate Code: 0
O: 001 MLJ Category: 050

Criminal Law
Contact: John Williams

Business: 770-598-2354x45691 Home: 770-598-2442
Business Fax: Mobile:

E-mail: jw2000@net.com
Stmt Delivery: Mail/E-mail E-mail Template: EXAMPLE2

Flat Amount: 579.90

102.00C  Gilbert/Andrew C.
Gilbert/Andrew C  

Date Opened:  07/08/2015
RE: Auto Accident

P: 002 PAM Bus: 8974 Weatherby Road Location: LA
S: 001 MLJ Roswell NM  88277 Rate Code: 1
O: 003 RPA Category: 065

Personal Injury
Contact: Andrew C. Gilbert

Business: 929-885-9055 Home:

Business Fax: Mobile:

E-mail: Gil_Man@yahoo.com
Stmt Delivery: Mail

120.01C  Klein/Daniel P. Inactive
Klein/Daniel P.  

Date Opened:  06/14/2014
RE: Klein vs. Simmons Construction

P: 003 RPA 

Mttr: 795 North Apple 

Date Closed: 11/15/2015
S: 004 ROB Sacramento CA  98654 Location: LA
O: 002 PAM Rate Code: 1

Category: 010
Workers' Compensation

Contact: Daniel P. Klein
Business: 916-665-9889 Home:

Business Fax: Mobile:

E-mail: dpklein@gmail.com
Stmt Delivery: Mail

121.01M  Phillips/Marcus
Phillips/Marcus  

Date Opened:  06/28/2016
RE: Real Estate Acquisition

P: 001 MLJ Bus: 27550 Cottonwood Drive Location: LA
S: 003 RPA San Bernardino CA  92408 Rate Code: 2
O: 001 MLJ Category: 025

Real Estate
Contact: Marcus Phillips

Business: 909-884-7525 Home: 909-863-7184
Business Fax: Mobile: 909-450-1240

E-mail: markp@emach.net
Stmt Delivery: Mail

Date: 11/28/2016 Tabs3 Client List Page: 2
Jensen, Martin & Anderson, P.C.

200.01M  Peterson Insurance Co.
Peterson General  

Date Opened:  07/15/2015
RE: *General Legal Counsel

16-5678923
P: 001 MLJ Sec: 5th & Turner Location: Omaha
S: 003 RPA Malcolm NE  68633 Rate Code: 1
O: 002 PAM Category: 040

Business Law
Contact: Paul Franklin

Business: 402-435-1739x512 Home: 402-421-4677
Business Fax: Mobile: 402-474-8605

E-mail: pfranklin@petersoninsurance.com
Stmt Delivery: Mail

Notes: Peterson Insurance Co. requires that we submit bills using the Litigation task code
set.

Custom Fields: 1 Peterson_Case_ID #98742-L
2 Policy_No 92-365277-56

Secure Users: CHERYL Cheryl Bradley
JEN Jennifer A. Noonan
MLJ Michael L. Jensen

415.00M *  MegaConstruction Corporation
MegaConstruction  

Date Opened:  10/07/2015
RE: Corporate Merger - Megabuilders and BuilderCorp

P: 003 RPA Bus: 3 Building Center, Suite 2100 Location: LA
S: 002 PAM 201 E 48th Street Rate Code: 1
O: 004 ROB Manhattan NY  10017-1538 Category: 040

Business Law
Contact: James R. Tatiki, Sr.

Business: 212-555-1232 Home:

Business Fax: 212-555-1234 Mobile:

E-mail: jt@megaconcorp.com
Stmt Delivery: None
Bill To Name: James R. Tatiki, Sr.

Address: PO Box 72345
201 E 48th Street
Manhattan NY  10017-1538     

E-mail: jt@megaconcorp.com
Stmt Delivery: E-mail E-mail Template: EXAMPLE2

Number of Clients printed:  6

Task Folder Reports | Client Reports | Client List

The list shown above is a Detail Client List in Client ID order. The Options tab includes parameters that enable you to print a
detail or summary list, include secure clients, include secure clients only, include clients with a matter address, include matter
address clients only, print only one file per client, start each client on a new page, print client notes (detail list only), and print
custom fields (detail list only). The number of clients included is shown at the bottom of the list.

Definitions for Detail Client List
(client) Client ID, client name, name search, work description, miscellaneous lines (if entered), selected

address, contact, four selected phone numbers, e-mail address, and statement delivery option. The
letter after the Client ID represents the billing frequency. An asterisk preceding the work description
or miscellaneous lines indicates that the information will not be included on the client’s statement.

* (After the Client ID and billing frequency) indicates the client will be assessed a finance charge on
past due amounts.

P (After the Client ID and billing frequency) indicates the client is set up for progress billing.

P: Primary timekeeper for reporting purposes (number and initials).

S: Secondary timekeeper for reporting purposes (number and initials).

O: Originating timekeeper for reporting purposes (number and initials).
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Inactive (Above the Date Opened) indicates the client is inactive.

Date Opened Date the client file was opened.

Date Closed Date the client file was closed. This field will not print if the Date Closed is “MM/DD/YYYY” (i.e., not
closed).

Location Location assigned to the client. The location will not print if the client has not been assigned to a
location.

Rate Code Default billing rate code assigned to the client.

Category Default 3-digit billing category assigned to the client. The category description prints below the
category number.

Flat Amount Flat amount assigned to the client if the client is set up as a flat fee client (i.e., the client’s billing rate
code is “0”).

Stmt Delivery The delivery method prints whether the client is set up to receive statements via Mail, E-mail, Both,
or None.

Bill To Name The Bill To name, address, e-mail, and statement delivery method are printed only when either the
client is set up to be billed to a third party or the client is set up to have a duplicate statement sent
to a third party.

Courtesy Disc Courtesy discount percentage or amount assigned to the client. This field prints only if the client is
assigned a courtesy discount.

E-mail Template The client’s e-mail template is shown if the client is set up to receive e-mail statements.

Notes Client notes can optionally be included.

Custom Fields Custom fields can optionally be included.

Secure Users Users assigned to a secure client are listed last for the client.

Summary Client List

Date: 11/28/2016 Tabs3 Client List Page: 1
Jensen, Martin & Anderson, P.C.

Client Name Description Contact Primary Phone

100.00M Dawson/Charles L. Settlement of Grandfather's Estate Chuck Dawson  714-884-7525 JPP
101.00M Barrett/Karen Apartment Management Karen Barrett  402-466-1234 DHB
102.00M Richardson/Harold *Manage personal finances                                      Harold Richardson  716-253-4510 RJB
200.01M I Jefferson Insurance Co. Automobile Accident Mike Johnson 402-464-2200 RJB
200.02C Jefferson Insurance Co. Hail Damage - Palmer farm Mark Allen 402-464-2200 RJB
200.03M Jefferson Insurance Co. Acquisition of Mid-State Insurance Mike Johnson 402-464-2200 RJB
300.00Q McBride/John Management of Estate Trust John McBride  402-425-2315 RJB
350.00M Carter/Arthur J. Protection of New Wave Patent Art Carter  402-438-8424 MLJ
400.00R Lutz/Jody Manage trust account for Jody Jody Lutz  402-598-2354 JPP
450.00M Able/Paul & Mary Parent's Estate Paul Able 402-322-1459 RJB
500.00M I Lyons/Mr. & Mrs. Art Audit of Federal Income Taxes Art Lyons  402-545-2780 DHB
550.00M Federated Casualty, Ltd. Andrew C. Gilbert v. Federated Casualty Samantha Kessler 402-421-2850 RJB
600.00M Ace Manufacturing Company General Legal Counsel Al Jones 402-435-1739 MLJ
600.01M Ace Manufacturing Company Workers' compensation claim Al Jones 402-435-1739 MLJ
600.02M Ace Manufacturing Company Maintenance of insurance policies Al Jones 402-435-1739 MLJ
700.00M First National Bank General File Lynn Traver 402-466-3785 RJB
750.00M Harrison Investments Purchase of Real Estate Donald Harrison  402-466-7334 DHB
751.00M Harrison/Bradley Purchase of Real Estate Bradley Harrison  204-939-4545 DHB
850.00H White/Kelly Divorce Kelly White  402-474-4336 DHB
900.00M Sherman/Natalie K. Divorce Natalie Sherman  402-465-7030 DHB

Number of Clients printed:  20

Note:  Secure Clients and/or transactions may have been excluded.

Task Folder Reports | Client Reports | Client List

The client list above is a Summary Client List in numerical order. The Options tab includes parameters that enable you to print a
detail or summary list, include secure clients, include secure clients only, print only one file per client, start each client on a new
page, double space the report, print client notes (detail list only), and print custom fields (detail list only). The number of clients
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included is shown at the bottom of the list. A message is shown at the end of the sample list indicating that secure clients may
have been excluded.

Definitions for Summary Client List
Client Client ID. The letter after the Client ID represents the billing frequency.

I Inactive clients are indicated by the letter “I” following the billing frequency.

Name Client name (first 42 characters of the selected Contact ID, not Full Name).

Description Client work description (first 37 characters).

* (In front of the work description) indicates the work description will not be printed on the client’s
statement.

Contact Contact name (first 24 characters of the selected Contact ID, not Full Name).

Primary Phone Client’s primary phone number. The number shown is determined by the phone number displayed
in the first phone selector in the Client file.

(timekeeper) Primary timekeeper initials are shown next to the phone number if the list is not printed in
timekeeper order.

Client Rate Report

Date: 11/28/2016 Tabs3 Client Rate Report Page: 1
Jensen, Martin & Anderson, P.C.

Client Name Work Description Billing Rate Code

1.00M Administrative Account RE:  For tracking all Firm and interest adjustments 1 - Timekeeper Rate 1

100.00M Larson/Michael RE:  Larson v. Bel-Cor 1 - Timekeeper Rate 1

101.00M Williams/John RE:  State v. Williams 0 - Flat Fee Amount: 579.90     

102.00M Gilbert/Andrew C. RE:  Auto Accident 1 - Timekeeper Rate 1

120.01M Klein/Daniel P. RE:  Klein vs. Simmons Construction 1 - Timekeeper Rate 1

121.01M Phillips/Marcus RE:  Real Estate Acquisition 2 - Timekeeper Rate 2

200.01M Peterson Insurance Co. RE:  General Legal Counsel 1 - Timekeeper Rate 1
Custom Fee Rate Table for Timekeepers
001- MLJ 250.00 002- PAM 225.00 003- RPA 225.00 005- KIM 150.00 009- JIM 150.00 010- JPP 80.00
Custom Cost Rate Table for Task Codes
E101 0.095 E109 0.445

200.02M Peterson Insurance Co. RE:  Maintenance of Insurance Policies 1 - Timekeeper Rate 1
Shared Fee Rate Table with Client (200.01)
Shared Cost Rate Table with Client (200.01)

415.00M MegaConstruction Corporation RE:  Corporate Merger - Megabuilders and BuilderCorp 1 - Timekeeper Rate 1
Custom Fee Rate Table for Timekeepers
001- MLJ 500.00 002- PAM 450.00 003- RPA 450.00 004- ROB 750.00 005- KIM 350.00 006- DHB 180.00
007- CB 180.00 008- JAN 250.00 009- JIM 350.00 010- JPP 220.00
Custom Cost Rate Table for Transaction Codes
107- TRA 150.000 251- COP 0.250 252- ML 0.450

850.00M White/Kelly RE:  Divorce 1 - Timekeeper Rate 1

850.01M White/Kelly RE:  Last Will & Testament 1 - Timekeeper Rate 1

850.02M White/Kelly RE:  Medical Care of Brianne 1 - Timekeeper Rate 1

Task Folder Reports | Client Setup Reports | Client Rate Report

The Client Rate Report shows the client rate information. You can include fee and cost rate tables, timekeeper level rates and
codes, or the client’s billing rate code. The Options tab includes parameters that enable you to include fee and cost rate tables,
timekeeper levels rates/codes and billing rate codes.

Definitions for Client Rate Report
Date The date the report was printed.

Client Client ID followed by the billing frequency.
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Work Description Client’s work description.

Billing Rate Code Billing rate code assigned on the Rates tab of the Client file. If the billing rate code is “0” (i.e., the
client is a flat fee client), the Flat Fee Amount will also be shown.

Custom Fee Rate Table Indicates that a fee rate table has been set up for the client. The timekeeper number and initials are
followed by the rate per hour for each timekeeper in the fee rate table.

Custom Cost Rate Table Indicates that a cost rate table has been set up for the client. The tcode or expense code are
followed by the rate for each tcode or expense code in the cost rate table.

Shared Client Rate Table Indicates that the client is sharing another client’s rate table.

New Rates Effective Includes the date the new rates are effective, as specified in the fee or cost rate table, as well as lists
the new rates.

Timekeeper Levels The hourly rate or billing rate code is shown for each timekeeper level. This is shown only when the
client’s Timekeeper Level Type option on the Rates tab of the Client file is set to Rate or Code.

Fee Compensation Rules Report

Effective Ending From To
Fee Compensation Timekeeper Type Percent Taken From Date Date Amount Amount

101.00 M Williams/John
State v. Williams

FIRM 15.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00

1 Michael L. Jensen Orig 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 1,000.00

2 Paula Ann Martin Orig 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 1,000.00

3 Ronald P. Anderson Orig 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 1,000.00

121.01 M Phillips/Marcus
Real Estate Acquisition

FIRM 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00

1 Michael L. Jensen Orig 25.00% Selected mm/dd/yyyy mm/dd/yyyy 0.00
(LVL 4, LVL 5, LVL 6)

3 Ronald P. Anderson Orig 25.00% Selected mm/dd/yyyy mm/dd/yyyy 0.00
(LVL 4, LVL 5, LVL 6)

200.01 M Peterson Insurance Co.
General Legal Counsel

FIRM 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00

2 Paula Ann Martin Orig 25.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 1,000.00

415.00 M MegaConstruction Corporation
Corporate Merger - Megabuilders and BuilderCorp

FIRM 20.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00

4 Robert O. Burns Orig 25.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 100,000.00

850.00 M White/Kelly
Divorce

FIRM 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00

4 Robert O. Burns Orig 35.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 5,000.00

5 Kendra I. Michaels Orig 15.00% Selected mm/dd/yyyy mm/dd/yyyy 0.00
(DHB, CB, JAN, JIM)

5 Kendra I. Michaels Prim  25.00% Selected 01/01/2016           07/31/2016 0.00
(DHB, CB, JAN, JPP)

Date: 11/28/2016 Tabs3 Fee Compensation Rules Report Page: 1
Jensen, Martin & Anderson, P.C.

This report is grouped by client.
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Effective Ending From To
Client Name/Work Description Type Percent Taken From Date Date Amount Amount

Fee Compensation Timekeeper:  FIRM

101.00 Williams/John 15.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00
State v. Williams

121.01 Phillips/Marcus 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00
Real Estate Acquisition

200.01 Peterson Insurance Co. 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00
General Legal Counsel

415.00 MegaConstruction Corporation 20.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00
Corporate Merger - Megabuilders and BuilderCorp

850.00 White/Kelly 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00
Divorce

Fee Compensation Timekeeper:  1 Michael L. Jensen

101.00 Williams/John Orig 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 1,000.00
State v. Williams

121.01 Phillips/Marcus Orig 25.00% Selected mm/dd/yyyy mm/dd/yyyy 0.00
Real Estate Acquisition (LVL 4, LVL 5, LVL 6)

Fee Compensation Timekeeper:  2 Paula Ann Martin

101.00 Williams/John Orig 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 1,000.00
State v. Williams

200.01 Peterson Insurance Co. Orig 25.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 1,000.00
General Legal Counsel

Fee Compensation Timekeeper:  3 Ronald P. Anderson

101.00 Williams/John Orig 10.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 1,000.00
State v. Williams

121.01 Phillips/Marcus Orig 25.00% Selected mm/dd/yyyy mm/dd/yyyy 0.00
Real Estate Acquisition (LVL 4, LVL 5, LVL 6)

Fee Compensation Timekeeper:  4 Robert O. Burns

415.00 MegaConstruction Corporation Orig 25.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 100,000.00
Corporate Merger - Megabuilders and BuilderCorp

850.00 White/Kelly Orig 35.00% ALL - All Timekeepers mm/dd/yyyy mm/dd/yyyy 0.00 5,000.00
Divorce

Fee Compensation Timekeeper:  5 Kendra I. Michaels

850.00 White/Kelly Orig 15.00% Selected mm/dd/yyyy mm/dd/yyyy 0.00
Divorce (DHB, CB, JAN, JIM)

850.00 White/Kelly Prim 25.00%  Selected  01/01/2016   07/31/2016 0.00
Divorce (DHB, CB, JAN, JPP)

Date: 11/28/2016 Tabs3 Fee Compensation Rules Report Page: 1
Jensen, Martin & Anderson, P.C.

This report is grouped by fee compensation timekeeper.

Date: 11/28/2016 Tabs3 Fee Compensation Rules Report Page: 1
Jensen, Martin & Anderson, P.C.

Effective Ending From To
Fee Compensation Timekeeper Type Percent Taken From Date Date Amount Amount

102.00 Gilbert/Andrew C.
Auto Accident

No Fee Compensation Rules Defined.

300.00 McBride/John
Copyright Infringement

No Fee Compensation Rules Defined.

Task Folder Reports | Client Setup Reports | Fee Compensation Rules Report

The Fee Compensation Rules Report shows the fee compensation rules information. You can group the report by client or fee
compensation timekeeper as shown above. The report can be run for all fee compensation timekeepers or for specific fee
compensation timekeepers. The Options tab includes parameters that enable you to group the report by client or fee
compensation timekeeper. Alternatively, the Options tab includes the ability to show only clients with no fee compensation
rules defined (page 35). The Format tab includes options that let you to include the fee compensation rules dates and amounts
columns.

Definitions for Fee Compensation Rules Report
Date The date the report was printed. Used for reference and has no bearing on the report itself.
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Type Timekeeper Type. Available types include “Prim” for primary timekeeper, “Sec” for secondary
timekeeper, and “Orig” for originating timekeeper. This column is left blank if the rule is for the
FIRM fee compensation timekeeper.

Percent The percentage of working timekeeper fee receipts that will be allocated to the selected timekeeper
or the firm.

Taken From “ALL” - All Timekeepers”, “Selected” (shown timekeepers with initials or level numbers), an
individual timekeeper’s number and name, or a specified timekeeper level (shown with the “TK
Level” description).

Effective Date Date the fee compensation rule goes into effect.

Ending Date Cut-off date for the fee compensation rule.

From The lowest total fee income amount received for the fee compensation rule to be effective.

To The highest total fee income amount received for the fee compensation rule to be effective.

When Grouped by Client
Client Client ID.

Name/Work Description Client name and work description. An asterisk before the work description indicates that the work
description will not be included on the client’s statement.1

(fee compensation
timekeeper)

Timekeeper number and name. “FIRM” indicates that the fee compensation rule is for the FIRM fee
compensation timekeeper.

(shared rules table with
client)

Indicates that the client is sharing another client’s fee compensation rules table. Client ID 250.00 in
the report on the previous page is sharing a fee compensation rules table with client 100.00.

When Grouped by Fee Compensation Timekeeper
(client) Client ID, billing frequency, name and work description. The letter after the Client ID represents the

billing frequency. An asterisk before the work description indicates that the work description will
not be included on the client’s statement.1

Fee Compensation
Timekeeper

Timekeeper number and name. “FIRM” indicates that the fee compensation rule is for the FIRM fee
compensation timekeeper.

1Not shown on either sample report.
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Split Billing Report

Date: 11/28/2016 Tabs3 Split Billing Report Page: 1
Jensen, Martin & Anderson, P.C.

Fee % Exp % Adv %

Main Client: 415.00 MegaConstruction Corporation

Fee Options: Split both Hours and Amount: Yes
Split Hours and then calculate Amount: No
Split Fee Credits: No
Split Non-billable and Zero Amount Fees: No

Cost Options: Split both Units and Amount: Yes
Split Units and then calculate Amount: No
Split Cost Credits: No
Split Non-billable and Zero Amount Costs: No

Split Matters:
415.00 MegaConstruction Corporation 50.0000 50.0000 67.0000

Show pre-split values on statements: Yes
Show Split Billing Summary on statements: Yes (Detail)

416.00 Tatiki, Sr./James R. 50.0000 50.0000 REM

Show pre-split values on statements: No
Show Split Billing Summary on statements: Yes (Summary)

100.0000 100.0000 100.0000

Task Folder Reports | Client Setup Reports | Split Billing Report

The Split Billing Report shows the clients that are set up for split billing along with their split fee percentages. Each client who is
set up as a Main Client is printed followed by the specified Split Matters and their percentages. This report can be printed for a
range of clients. The work description can optionally be included for each client.

Definitions for Split Billing Report
Date The date the report was printed.

Client/Name The Main Client’s Client ID, name and work description (optional) will be shown followed by the
Client IDs, names and work descriptions of the Perform Split Billing Clients. The Main Client will have
its fees and costs split among the Split Matters when the Perform Split Billing program is run.

Fee% The percentage of each fee transaction that will be allocated to the client when the Perform Split
Billing program is run. “REM” indicates that the remaining fee percentage will be allocated to this
client.

Exp% The percentage of each expense transaction that will be allocated to the client when the Perform
Split Billing program is run. “REM” indicates that the remaining expense percentage will be
allocated to this client.

Adv % The percentage of each advance transaction that will be allocated to the client when the Perform
Split Billing program is run. “REM” indicates that the remaining advance percentage will be
allocated to this client.

* (Following the total for a client) indicates that one of the Split Matters is set up to receive the
remaining fee, expense or advance percentage. When the Perform Split Billing program is run, the
client shown with “REM” will receive the remaining percentage of the fees, expenses or advances.
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Data Entry Lists

Date: 11/28/2016 Fee Entry List by Transaction Date Page: 1
Jensen, Martin & Anderson, P.C.

Include Archive: No

Transaction Date: 11/28/2016

Hrs to
Client ID/Name Ref # BC H/P Tmkr Bill Amount Description

100.00 Larson/Michael 11 P 2 3.50 787.50 Legal research
Larson v. Bel-Cor

100.00 Larson/Michael 12 P 2 2.25 506.25 Draft and revise legal opinion to be forwarded to Labour Plating Company
Larson v. Bel-Cor on their culpability.

415.00 MegaConstruction Corporation 2 P 1 1.00 500.00 Prepare Employee Handbook
Corporate Merger - Megabuilders and BuilderCorp

850.00 White/Kelly 5 P 2 0.50 112.50 Review and analyze medical status reports on Brianne White
Divorce

850.00 White/Kelly 4 P 2 1.50 337.50 Letter to Robert White re: signing medical release forms for Brianne.
Divorce

Billable 8.75 2,243.75
Non-Billable 0.00 0.00

Total 8.75 2,243.75

Date: 11/28/2016 Cost Entry List by Client Page: 1
Jensen, Martin & Anderson, P.C.

Include Archive: No

102.00 Gilbert/Andrew C.
Auto Accident

Ref # BC H/P Date Amount Description

1 P 10/25/2016 6.75 Photocopy charges.
2 P 10/25/2016 17.78 Postage
3 P 11/25/2016 85.00 Medical records
4 P 07/29/2016 34.50 Mileage to/from client at hospital
5 P 08/23/2016 17.80 Photocopy charges
6 P 08/26/2016 75.00 Online legal research

Total 236.83

Date: 11/28/2016 Payment Entry List by Client Page: 1
Jensen, Martin & Anderson, P.C.

Include Archive: Yes

121.01 Phillips/Marcus
Real Estate Acquisition

Ref # H/P Date Amount Description

ARCH P 08/23/2016 267.00 Payment
ARCH P 09/27/2016 167.50 Payment
ARCH P 10/28/2016 269.93 Payment

4 P 11/09/2016 5,000.00 Payment

Total 5,704.43
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Date: 11/28/2016 Client Funds Entry List by Client Page: 1
Jensen, Martin & Anderson, P.C.

Include Archive: Yes

121.01 Phillips/Marcus
Real Estate Acquisition

Ref # Type Date Amount Description

ARCH D 06/15/2016 2,500.00 Opening deposit to client funds for work to be done.
ARCH W 08/23/2016 267.00 Withdrawal to pay fees billed.
ARCH W 09/30/2016 167.50 Withdrawal to pay fees billed.
ARCH W 10/31/2016 269.93 Withdrawal to pay costs.

Credit Cards 0.00
Deposits 2,500.00

Payments 0.00
Withdrawals 704.43

Total 1,795.57

Task Folder
Transactions | Fee/Cost/Payment/Client Funds | (Print List)

The reports shown on pages 38 and 39 are examples of Data Entry Lists from the Fee, Cost, Payment, and Client Funds Entry
programs. This list can be printed from within the Fee Entry, Cost Entry, Payment Entry, and Client Funds Entry windows. The
contents of this list depends on the options specified in the associated View Options window. The sort order of the records is
based on the sort column selected in the list.

The first report shows an example of a Fee Entry List by Transaction Date, including work-in-process transactions for all users
and timekeepers. The second report shows an example of a Cost Entry List by Client, including work-in-process transactions for
a single client. The third report shows an example of a Payment Entry List by Client, including work-in-process and archived
transactions for all users, sorted by transaction date. The fourth report shows an example of a Client Funds Entry List, including
archive transactions for all users and timekeepers.

Receipts
Date: 11/28/2016 Payment Receipt Page: 1

Jensen, Martin & Anderson, P.C.

Client ID: 415.00 MegaConstruction Corporation
Corporate Merger - Megabuilders and BuilderCorp

Statement #: 75371                                                                                      Received By:                CATHY
Receipt Type: EFT Date: 11/28/2016
Reference: 13

Description: Payment

Amount: 30,000.00

Date: 11/28/2016 Deposit Receipt Page: 1
Jensen, Martin & Anderson, P.C.

Client ID: 850.00 White/Kelly
Divorce

Receipt Type: Client Funds Deposit Received By:                CATHY
Reference: 1 Date: 10/31/2016

Description: Deposit to client funds

Amount: 750.00

Payment Receipt Client Funds Deposit Receipt

Task Folder
Transactions | Payment/Client Funds | (Print Receipt)

Receipts can be printed for both work-in-process payments and client funds deposits. When printing a receipt for payments, the
receipt displays general information about the payment transaction, such as the Client ID,Work Description, Statement #,
Date, Description, and Amount. When printing a receipt for client funds deposits, the receipt displays general information
about the deposit, such as the Client ID,Work Description, Receipt Type, Date, Description, and Amount.

- 39 -



Tabs3 Report Pack

Fee/Cost Verification Lists

Date: 11/28/2016 Fee Verification List Page: 1
Jensen, Martin & Anderson, P.C.
User:  SUSAN  Susan C. Long

Trans Date S H T B R Tcode Hours Hours
Ref# Client Tkr Cat Date Entered R P X C C Task Code Rate Worked to Bill Amount

5 102.00 RJB 20 11/11/2016 11/11/2016 B P 3 200.00 0.25 0.25 50.00 Telephone conference with Harold
Richardson/Harold

6 102.00 RJB 20 11/11/2016 11/11/2016 B P 7 200.00 0.25 0.25 50.00 Plan and prepare for conference with
Harold

Richardson/Harold
10 200.03 RJB 40 11/14/2016 11/14/2016 B P 1 1 250.00 1.50 1.50 375.00 Office conference with Mike Johnson

concerning upcoming meeting with
President of Mid-State

Jefferson Insurance Co.
2 400.00 RJB 5 11/14/2016 11/14/2016 B P 10 250.00 0.50 0.50 125.00 Legal research of banking rules and

regulations
Lutz/Jody

Billable 2.50 2.50 600.00

2 550.00 MLJ 55 11/14/2016 11/14/2016 B P L110 A102 225.00 1.25 1.25 281.25 Research Brown vs. United Insurance
Federated Casualty, Ltd.

Billable 1.25 1.25 281.25

2 900.00 DHB 35 11/14/2016 11/14/2016 B P 3 175.00 0.25 0.25 43.75 Telephone conference with Mrs.
Sherman regarding conversation with
representative from Union Bank and
Trust.

Sherman/Natalie K.
4 101.00 DHB 25 11/14/2016 11/14/2016 B P 3 175.00 0.25 0.25 43.75 Called Steve Catton of Certified

Appraisals to arrange for him to
appraise all properties managed by
Karen Barrett. Steve plans to have
all appraisals complete by
mid-December.

Barrett/Karen
Billable 0.50 0.50 87.50

4 100.00 JPP 15 11/03/2016 11/03/2016 B P 1 150.00 1.25 1.25 187.50 Office conference with Mr. Dawson
Dawson/Charles L.

5 100.00 JPP 15 11/07/2016 11/07/2016 B P 1 5 150.00 0.50 0.50 75.00 Letter to client's banker
Dawson/Charles L.

Billable 1.75 1.75 262.50

Billable 6.00 6.00 1,231.25
Non-billable 0.00 0.00 0.00
Grand Total 6.00 6.00 1,231.25

Client Checksum = 255,503

Changed Entries
New
6 102.00 RJB 20 11/11/2016 11/11/2016 B P 7 200.00 0.25 0.25 50.00 Plan and prepare for conference with

Harold
Richardson/Harold

Old
6 102.00 RJB 20 11/11/2016 11/11/2016 B P 2 7 200.00 0.50 0.50 100.00

Total Transaction Count = 10
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Date: 11/28/2016 Cost Verification List Page: 1

Jensen, Martin & Anderson, P.C.
User:  SUSAN  Susan C. Long

Trans Date H T B R Tcode
Ref# Client E/A Date Entered Src P X C C Task Code Tmkr Rate Units Amount

1 100.00 E 11/02/2016 11/14/2016 B P 51 5 0.150 25.00 3.75 Photocopy charges
Dawson/Charles L.

2 100.00 E 11/07/2016 11/14/2016 B P 50 5 0.000 0.00 6.75 Long distance telephone charges
Dawson/Charles L.

2 300.00 A 11/07/2016 11/14/2016 B P 8 70 1 0.000 0.00 75.00 Filing fee
McBride/John

3 550.00 E 11/11/2016 11/14/2016 B P L100 E110 2 0.000 0.00 23.50 Mileage to/from Omaha
Federated Casualty, Ltd.

6 200.03 E 11/11/2016 11/14/2016 B P 55 1 0.000 0.00 4.50 Facsimile costs
Jefferson Insurance Co.

4 400.00 A 11/14/2016 11/14/2016 B D 72 5 0.000 0.00 *deleted* Courier fee
Lutz/Jody

Billable 113.50
Non-billable 0.00
Grand Total 113.50

Client Checksum = 165,003

Changed Entries
New
6 200.03 E 11/11/2016 11/14/2016 B P 55 1 0.000 0.00 4.50 Facsimile costs

Jefferson Insurance Co.
Old
6 200.03 E 11/11/2016 11/14/2016 B P 55 1 0.000 0.00 3.50

New
1 100.00 E 11/02/2016 11/14/2016 B P 51 5 0.150 25.00 3.75 Photocopy charges

Dawson/Charles L.
Old
1 100.00 E 11/02/2016 11/14/2016 B P 51 5 0.150 20.00 3.00

Deleted Entries
4 400.00 A 11/14/2016 11/14/2016 B P 72 5 0.000 0.00 24.15 Courier fee

Lutz/Jody

Total Transaction Count = 9

Task Folder Transactions | Fee/Cost | Esc

The reports shown are examples of the Fee Verification List and the Cost Verification List. When a transaction is added or edited,
the entry is added to the verification list for the user making the entry. The Fee Verification List can be printed in entry order,
timekeeper order or timekeeper order by transaction date. The Cost Verification List can be printed in entry order, transaction
code order or transaction date order. You can optionally include the client name and work description. You can include the
timekeeper number or initials. The Fee Verification List shown shown is printed in timekeeper order with initials whereas the Cost
Verification List shown is printed in entry order with timekeeper numbers instead of initials. The Cost Verification List is not
subtotaled because it was printed in entry order instead of sorted by transaction code or date. The Fee Verification list shown
includes the client name and work description whereas the Cost Verification List includes only the client name. Fee and cost
verification lists can be printed in portrait or landscape orientation.

Definitions for Fee/Cost Verification Lists
Ref # Reference number identifying the transaction for editing purposes.

Client Client ID.

Tkr (fee list)
Tmkr (cost list)

Timekeeper number or initials shown on the transaction. [Note: An “***” in this column indicates the
timekeeper record no longer exists (i.e., deleted or renumbered).1]

Cat (fee list) Category assigned to the transaction.

E/A
(cost list)

Expense/Advance. “E” indicates the transaction is an expense and “A” indicates the transaction is an
advance.

Trans Date Date of the transaction.

Date Entered Date the transaction was entered.

SR (fee list)
Src (cost list)

Source code that indicates the source of the transaction. “B” = Tabs3 Billing, “R”1 = Tabs3 Remote,
“P”1 or “C”1 = PracticeMaster, “D”1 = Data Capture Device, “T”1 = Trust Accounting Software, “A”1 =
Accounts Payable Software, “Q”1 = QuickBooks. Lowercase codes indicate that the transaction has
been split using Perform Split Billing (e.g., “b” indicates a split transaction that originated in Tabs3
Billing).

HP Status field of the transaction. “H”1 = Hold, “P” = Print, “D” = Deleted, “S”1 = Save.
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TX Sales tax rate code that will be used to calculate sales tax when a statement is printed. No code will
print if the sales tax rate code is “0” (i.e., no sales tax). Up to 9 sales tax rates can be defined in Tabs3
Customization.

BC Bill Code (0-4). The Bill Code defines the transaction code’s default billing and print status. No code
will print if the Bill Code is “0”. “0” = billable and printable. “1”1 = non-billable and non-printable,
“2”1 = non-billable and printable, “3”1 = billable and non-printable and “4” = billable and always
print.

RC (fee list) Rate Code (0-9). The rate code indicates which billing rate Tabs3 uses. No code will print if the rate
code is “0”. “0” indicates that Tabs3 has used the default billing rate.

RC (cost/payment list) Rate Code (0, 7 or 8). The rate code indicates how the Amount is determined. No code will print if
the rate code is “0”. “0” indicates that the operator entered the amounts. “7” indicates that Tabs3
retrieved the Rate from the transaction code file, allowed the operator to enter the number of units,
and then automatically calculated the amount. “8” indicates that Tabs3 retrieved the Amount from
the transaction code file.

Tcode/Task Code Transaction code number. For task based billing clients, the task codes entered will be shown
instead of the transaction code.

Rate Rate used for calculating the amount.

Hours Worked
(fee list)

Hours worked.

Hours to Bill
(fee list)

Hours to bill. The hours to bill are multiplied by the rate to calculate the amount.

Units (cost list) Units. If a rate is specified, the units are multiplied by the rate to calculate the amount.

Amount Dollar amount of the transaction. If a new transaction (i.e., a transaction in the top part of the
verification list) has been deleted, the text “*deleted*” will be shown in the Amount column. The
original transaction amount will be shown in the “Deleted Entries” section of the list.

(description) Description of the transaction. Statement comments are shown with strikethrough characters1.

(client) The client’s name and work description are optionally printed below the description of each
transaction. The fee list shown includes both the name and work description. The cost list shown
includes only the name.

Changed Entries Any transactions that are edited will be listed under the Changed Entries section. The transaction
under the “New” heading reflects the changes. The transaction under the “Old” heading reflects the
transaction before the changes. The description shown in the Changed Entries section reflects the
new description only.

A critical field was changed. A final statement must be rerun for this client. 1When this message
is shown for a changed transaction, a statement cannot be updated until a new final statement is
run for the client.

Deleted Entries Any transactions that are deleted will be listed under the Deleted Entries section.

Total Transaction Count Total number of transactions on the list including changes and deletions. Each changed transaction
(i.e., both old and new) counts as one transaction.

1Not shown on either sample report.
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Recap of Hours Report

Date: 11/28/2016 Tabs3 Recap of Hours Report Page: 1
From November 01, 2016 Thru November 30, 2016

001 Michael L. Jensen

Sunday Monday Tuesday Wednesday Thursday Friday Saturday Total

Nov 1, 2016 2 3 4 5
Billable 8.00 6.00 6.00 7.75 27.75

Non-billable 1.00 1.00
Total 8.00 6.00 7.00 7.75 28.75

6 7 8 9 10 11 12
Billable 8.00 4.43 7.00 6.00 6.00 31.43

Non-billable 1.75 1.75
Total 8.00 4.43 7.00 6.00 7.75 33.18

13 14 15 16 17 18 19
Billable 6.65 7.50 6.00 3.50 7.25 30.90

Non-billable

Total 6.65 7.50 6.00 3.50 7.25 30.90

20 21 22 23 24 25 26
Billable 7.85 12.10 8.90 5.00 6.90 40.75

Non-billable 1.00 1.00
Total 7.85 12.10 8.90 5.00 7.90 41.75

27 28 29 30
Billable 1.00 1.00

Non-billable

Total 1.00 1.00

Billable 131.83
GRAND TOTALS: Non-billable 3.75

Total 135.58

Task Folder Reports | Transaction Reports | Recap of Hours Report

The Recap of Hours Report can be very useful in finding missing timeslip entries. The report includes theHours Worked for one
or more timekeepers during a specified date range. This report does not useHours to Bill. For example, on Monday, November
21, 7.85 hours were entered for timekeeper Michael Jensen. Daily and weekly totals are shown as well as grand totals for each
timekeeper. Optionally, daily totals only can be included, and the daily totals can be shown shaded if the total is less than a
specified number of hours, thus providing an easy-to-use exception report.

This report includes transactions that are in work-in-process and transactions that have been billed and updated. Transactions
that are on “hold” (i.e., Status field is set to “Hold”) are also included. Work-in-process transactions that are “saved” (i.e., Status
field is set to “Save”) are included. Likewise, “saved” transactions that have been updated are included.

This report can be produced for a range of dates and working timekeepers. Inactive timekeepers or timekeepers with no activity
can optionally be excluded from the report. Each timekeeper’s information can optionally start on a new page of the report.

Definitions for Recap of Hours Report
Date The date to the left of the heading is the date the report was produced. The date range on the report

is shown below the report title.

(date range) The beginning and ending dates selected for the report.

Day Day of the month.

Billable Number of billable hours for each day. Credit transactions are included.

Non-billable Number of non-billable hours for each day. Credit transactions are included.
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Total Total of billable and non-billable hours for the day and week. Grand totals are also shown.

Transaction File List

Date: 11/28/2016 Detail Transaction File List Page: 1
Jensen, Martin & Anderson, P.C.

Trans H Tcode/ Stmt # Hours
Client Date Tmkr P Task Code Rate to Bill Amount Ref #

Client ID 100.00 Larson/Michael
100.00 09/23/2016 1 P 19 250.00 1.00 250.00 1Initial Client Meeting
100.00 09/26/2016 1 P 1 250.00 0.10 25.00 3Open Workers' Comp Case
100.00 09/27/2016 1 P 1 250.00 0.50 125.00 2Consultation with Susan Nichols re: potential witness
100.00 10/25/2016 8 P 5 100.00 0.50 50.00 9Request for employment records.
100.00 10/25/2016 8 P 1 100.00 0.10 10.00 6Verify receipt of medical records request.
100.00 10/28/2016 1 P 1 250.00 2.50 625.00 4Attend deposition of Susan Nichols.
100.00 10/28/2016 3 P 1 160.00 0.60 96.00 8Meeting with Labour Plating to discuss compensation.
100.00 10/28/2016 1 P 1 250.00 2.00 500.00 5Appointment at Mr. Larson's office to ensure that proper

environment is available for him to return to work with
modifications necessary to medical status.

100.00 11/15/2016 8 P 1 100.00 0.10 10.00 7Confirm Fee Agreement signed and returned.
100.00 11/23/2016 1 P 1 250.00 1.40 350.00 10Reviewed file; worked on estate plan documents;

studied and analyzed additional information needed;
call to client regarding same.

100.00 11/28/2016 2 P 10 225.00 3.50 787.50 11Legal research
100.00 11/28/2016 2 P 8 225.00 2.25 506.25 12Draft and revise legal opinion to be forwarded to Labour

Plating Company on their culpability.

Total for Client ID 100.00 Billable 13.45 3,059.75 Larson/Michael
Non-billable 1.10 275.00 Larson v. Bel-Cor

Total 14.55 3,334.75

Client ID 101.00 Williams/John
101.00 08/30/2016 3 A 10 160.00 1.25 200.00 ARCHLegal research.
101.00 08/30/2016 1 A 19 250.00 0.30 75.00 ARCHInitial Client Meeting
101.00 09/16/2016 1 A 18 250.00 2.50 625.00 ARCHPrepared for conference with client.
101.00 09/21/2016 2 A 250 5.75 ARCHLong distance telephone charges.
101.00 09/23/2016 1 A 251 7.50 ARCHPhotocopy charges.
101.00 09/23/2016 2 A 250 10.50 ARCHLong distance telephone charges.
101.00 09/23/2016 2 A 253 2.90 ARCHPostage.
101.00 09/26/2016 1 A 250 6.75 ARCHLong distance telephone charges.
101.00 09/27/2016 1 A 3 250.00 0.25 62.50 ARCHTelephone conference with client.
101.00 09/30/2016 1 A 253 2.50 ARCHPostage.
101.00 10/18/2016 3 P 255 1.25 23Facsimile costs.
101.00 10/21/2016 3 P 102 47.50 22Courier fee Federal Express.
101.00 10/21/2016 2 P 1 225.00 2.00 450.00 45Office conference with client.
101.00 10/25/2016 2 P 1 225.00 1.10 247.50 42Reviewing documents.
101.00 10/25/2016 2 P 1 225.00 0.20 45.00 46Talked to Mr. Williams
101.00 10/25/2016 3 P 1 160.00 2.00 320.00 47Office conference with Mr. Williams.
101.00 10/25/2016 2 P 3 225.00 0.25 56.25 49Telephone conference with client.
101.00 10/25/2016 2 P 3 225.00 1.00 225.00 50Telephone conference with Mr. Williams.
101.00 10/25/2016 2 P 3 225.00 0.25 56.25 51Telephone conference with client.
101.00 10/26/2016 3 P 1 160.00 3.25 520.00 48Office conference with Mr. Williams.
101.00 10/28/2016 2 P 251 7.35 24Photocopy charges.
101.00 10/28/2016 3 P 251 30.00 25Photocopy charges.
101.00 10/28/2016 1 P 9 250.00 3.00 900.00 41Review and analyze case status.
101.00 10/28/2016 1 P 1 250.00 0.50 150.00 43Legal Research.
101.00 10/28/2016 1 P 10 250.00 1.50 450.00 44Legal research.
101.00 10/31/2016 2 P 106 4.00 26Online legal research
101.00 10/31/2016 P 900 1,617.65 6Payment
101.00 11/15/2016 1 P 9 250.00 1.50 375.00 3Review and analyze research and prior cases.
101.00 11/18/2016 1 P 5 250.00 1.25 312.50 1Letter to client.
101.00 11/25/2016 1 P 1 250.00 1.50 375.00 4Reviewed correspondence from opposing counsel;

telephone conference with opposing counsel re:
settlement; telephone call to court clerk re: continuing
trial date.

Total for Client ID 101.00 Billable 22.80 5,383.50 Williams/John
Non-billable 0.80 187.50 State v. Williams

Total 23.60 5,571.00
Payments 1,617.65

GRAND TOTALS

Billable 36.25 8,443.25
Non-billable 1.90 462.50

Total 38.15 8,905.75
Payments 1,617.65
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Date: 11/28/2016 Summary Fee Transaction File List Page: 1
Jensen, Martin & Anderson, P.C.

Hours
to Bill Amount

Subtotal for Tcode 1 Billable 26.75 13,250.00
Non-billable 0.10 25.00

Total 26.85 13,275.00

Subtotal for Tcode 2 Billable 5.00 2,500.00

Subtotal for Tcode 3 Billable 0.50 87.50

Subtotal for Tcode 5 Billable 1.00 120.00

Total for Timekeeper 1 Billable 33.25 15,957.50
Non-billable 0.10 25.00

Total 33.35 15,982.50

Subtotal for Tcode 1 Billable 33.75 15,187.50

Subtotal for Tcode 2 Billable 5.00 2,250.00

Total for Timekeeper 2 Billable 38.75 17,437.50

GRAND TOTALS

Billable 72.00 33,395.00
Non-billable 0.10 25.00

Total 72.10 33,420.00

Task Folder Reports | Transaction Reports | Transaction File List

The Transaction File List is a means of sorting and listing fee, cost, and payment transactions stored in Tabs3. The information on
the report can be output in a standard report format or a variety of export formats. The Transaction File Lists shown on pages 44
and 45 are just two examples of the many combinations possible. The list shown on page 44 is a detail list that includes
transaction descriptions. The primary sort order is by Client and the secondary sort order is by Date. The client name and work
description print to the right of the subtotal.

The list shown on page 45 is a summary list for fees. The primary sort order is by Timekeeper and the secondary sort order is by
Transaction Code. Note that the timekeeper name and transaction code description print to the left of the subtotals.

The Options tab includes parameters that enable you to print a detail or summary report as well as specify the type of
transactions you want to include on the report. The Format tab allows you to specify which columns you want to include and if
you want to print the report in portrait or landscape orientation. All columns are optional, but at least one column must be
selected. The Sort tab for this report differs from the standard Sort tab. It allows you to select three sort orders, select to
subtotal on any of the sort orders, subtotal by statement date or transaction date, and start the first sort on a new page.

Complete details regarding export formats available and the file layout can be found in Help under “Export Data Format.”

Definitions for Transaction File List
Client Client ID.
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User ID1 User ID.

Entry Date1 Date the transaction was entered.

Trans Date
Transaction Date.

Stmt Date1
Statement Date.

Tmkr
Timekeeper number or initials. Timekeeper numbers/initials are not shown for payment transactions.
Cost transactions not assigned to a timekeeper will be shown with a timekeeper number of “0”.

E/A
Cat1

For costs, “E” will be shown for expenses and “A” will be shown for advances. For fees, the category
number will be shown.

Src1 Source code that indicates the source of the transaction. “B” = Billing, “T” = Tabs3 Trust Accounting
Software, “A” = Tabs3 Accounts Payable Software, “R” = Tabs3 Remote, “D” = Data Capture Device,
“P”or “C” = PracticeMaster, “Q” = QuickBooks. No source code will print if the source code is “B”
(i.e., Billing). Client funds payments will have a source of “M” for manual funds payments or “A” for
automatic funds payments. Lowercase codes indicate that the transaction has been split using
Perform Split Billing (e.g., “b” indicates a split transaction that originated in Tabs3 Billing).

HP Status field: “P” = Print, “H”1 = Hold, “S”1 = Save, “A” = Archived, “U”1 or “s”1 = Billed but not
Updated.

Receipt Type1 For payments only. Cash, Check, Credit Card, Other, Client Funds, EFT, Unknown.

Check Number1 Shown only for payments whose Receipt Type is Check.

Ref./Memo1
Optional reference or memo regarding the receipt. If the Receipt Type is Check, the Tabs3 client ID
will be placed in this field. If integrating with GLS, this information is saved to the Reference field in
the GLS journal entry. If the payment was created automatically from a TAS payment to firm (i.e.,
Source = “T”), this field will contain the Memo field from the TAS transaction.

TX1 Sales tax rate code that will be used to calculate sales tax when a statement is printed. No code will
print if the sales tax rate code is “0” (i.e., no sales tax). Up to 9 sales tax rates can be defined in Tabs3
Customization.

BC1 Bill Code (0-4). The Bill Code defines the transaction code’s default billing and print status. No code
will print if the Bill Code is “0”. “0” = billable and printable, “1” = non-billable and non-printable, “2”
= non-billable and printable, “3” = billable and non-printable, and “4” = billable and always print.

RC (fees)1 Rate Code (0-9). The Rate Code indicates which billing rate Tabs3 uses. No code will print if the rate
code is “0”. “0” indicates that Tabs3 has used the default billing rate.

RC (costs)1 Rate Code (0, 7, or 8). The Rate Code indicates how the Amount is determined. “0” indicates that the
operator entered the amounts. “7” indicates that Tabs3 retrieved the Rate from the transaction code
file, allowed the operator to enter the number of units, and then automatically calculated the
amount. “8” indicates that Tabs3 retrieved the Amount from the transaction code file. No code will
print if the Rate Code is “0”.

CT1 The transaction’s Expense or Advance Cost Type. For payments, the Cost Type will be zero.

Tcd Transaction code number. If task based billing clients are included on the list, the label for this
column will be “Tcode/Task Code”. The task codes entered will then be shown instead of the
transaction code for task based billing clients.

Stmt #
Rate

Hourly billing rate. If payments are included, the statement number the payment was processed
against is shown in this column. A statement number will only appear for payment transactions if a
statement number was specified during data entry.

Units1 The units for each cost transaction.

Hours Worked1 The number of hours worked for each fee transaction.

Hours to Bill
The number of hours to bill for each fee transaction.

Amount
Amount of each transaction.

- 46 -



Tabs3 Report Pack

(description) Transaction description. Statement comments are shown with strikethrough characters.

Ref # Reference number identifying the work-in-process transaction for editing purposes (optional).
“ARCH” will print for transactions from the archive files; these transactions cannot be edited.

Progress Billable1 Subtotal for “progress billing” fee transactions (Type “6” transactions).

Progress Non-billable1 Subtotal for non-billable “progress billing” fee transactions (Type “6” transactions).

1Not shown on either sample report.

Task Code Billing Report

Date: 11/28/2016 Detail Task Code Billing Report Page: 1

Jensen, Martin & Anderson, P.C.

Trans H Tcode/ Stmt # Hours
Client Date Tmkr P Task Code Rate to Bill Amount Ref #

Phase ID L110 Fact Investigation/Development
550.00 10/06/2016 1 U L110 E106 60.00 1Online research.  Client Identifier:  BRADY550.00

Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

550.00 10/06/2016 4 U L110 A102 175.00 1.00 175.00 1Research Hapton vs. Interstate Insurance.
Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

550.00 10/06/2016 4 U L110 A103 175.00 0.50 87.50 2Draft/revise response to complaint.
Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

550.00 11/14/2016 2 P L110 A102 225.00 1.25 281.25 6Research Brown vs. United Insurance
Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

Total for Phase ID L110 Billable 2.75 603.75 Fact Investigation/Development

Phase ID L120 Analysis/Strategy
550.00 10/10/2016 1 U L120 A106 250.00 0.25 62.50 3Phone call with Sam Kessler.

Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

Total for Phase ID L120 Billable 0.25 62.50 Analysis/Strategy

Phase ID L130 Experts/Consultants
550.00 10/10/2016 1 U L130 A108 250.00 1.00 250.00 4Phone call with Tom Alberts of Alberts Investigations

regarding Gilbert v. Federated to discuss previous
experience investigating arson, testifying in court, and
payment for services.  (First report will be completed by
the end of the month.)
Alberts was recommended by J. Edgerton of Edgerton &
Lowe.
Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

Total for Phase ID L130 Billable 1.00 250.00 Experts/Consultants

Phase ID L190 Other Case Assessment, Development and Administration
550.00 11/11/2016 2 P L190 E110 23.50 3Mileage to/from Omaha

Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

Total for Phase ID L190 Billable 0.00 23.50 Other Case Assessment, Development and Administration

Phase ID L250 Other Written Motions and Submissions
550.00 10/10/2016 1 U L250 E101 6.75 2Copying

Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

550.00 10/10/2016 1 U L250 A103 250.00 1.00 250.00 5Draft/revise motion for change of venue.
Federated Casualty, Ltd.
Andrew C. Gilbert v. Federated Casualty

Total for Phase ID L250 Billable 1.00 256.75 Other Written Motions and Submissions

GRAND TOTALS

Billable 5.00 1,196.50

Task Folder Reports | Transaction Reports | Task Code Billing Report

The Task Code Billing Report is a means of printing transactions that have been entered for task based billing clients. The
information on the report can be output in a standard report format or a variety of export formats. The format and options
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available for the Task Code Billing Report are similar to those available for the Transaction File List. The report shown on page 47
is a detail report and includes transaction descriptions. The primary sort order is by Client and the secondary sort order is by
Phase/Task. The client name and work description print below each transaction and the phase/task description prints to the
right of the secondary subtotal.

The Transactions tab is similar to the standard Transactions tab except that the Tcodes range is replaced with separate
Phase/Task and Activity/Expense ranges. The Options tab includes parameters that enable you to print a detail or summary
report as well as specify the type of transactions you want to include on the report. The Format tab allows you to specify which
columns you want to include and choose portrait or landscape orientation. All columns are optional, but at least one column
must be selected. The Sort tab for this report differs from the standard Sort tab. It allows you to select from three different sort
orders, select to subtotal on any of the sort orders, subtotal by statement date or transaction date, and start the first sort on a
new page.

Complete details regarding export formats available and the file layout can be found in Help under “Export Data Format.”

Definitions for Task Code Billing Report
Client Client ID.

User ID1 User ID.

Entry Date1 Date the transaction was entered.

Trans Date
Transaction Date.

Stmt Date1
Statement Date.

Tmkr
Timekeeper number or initials. Timekeeper numbers/initials are not shown for payment transactions.
Cost transactions not assigned to a timekeeper will be shown with a timekeeper number of “0”.

E/A
Cat1

For costs, “E” will be shown for expenses and “A” will be shown for advances. For fees, the category
number will be shown.

Src1 Source code that indicates the source of the transaction. “B” = Tabs3 Billing, “T” = Tabs3 Trust
Accounting Software, “A” = Tabs3 Accounts Payable Software, “R” = Tabs3 Remote, “D” = Data
Capture Device, “P”or “C” = PracticeMaster, “Q” = QuickBooks. No source code will print if the
source code is “B” (i.e., Billing). Client funds payments will have a source of “M” for manual funds
payments or “A” for automatic funds payments. Lowercase codes indicate that the transaction has
been split using Perform Split Billing (e.g., “b” indicates a split transaction that originated in Tabs3
Billing).

HP Status field: “P” = Print, “H”1 = Hold, “S”1 = Save, “A”1 = Archived, “U” or “s”1 = Billed but not
Updated.

Receipt Type1 For payments only. Cash, Check, Credit Card, Other, Client Funds, EFT, Unknown.

Check Number1 Shown only for payments whose Receipt Type is Check.

Ref./Memo1
Optional reference or memo regarding the receipt. If the Receipt Type is Check, the Tabs3 client ID
will be placed in this field. If integrating with GLS, this information is saved to the Reference field in
the GLS journal entry. If the payment was created automatically from a TAS payment to firm (i.e.,
Source = “T”), this field will contain the Memo field from the TAS transaction.

TX1 Sales tax rate code that will be used to calculate sales tax when a statement is printed. No code will
print if the sales tax rate code is “0” (i.e., no sales tax). Up to 9 sales tax rates can be defined in Tabs3
Customization.

BC1 Bill Code (0-4). The Bill Code defines the transaction code’s default billing and print status. No code
will print if the Bill Code is “0”. “0” = billable and printable, “1” = non-billable and non-printable, “2”
= non-billable and printable, “3” = billable and non-printable, and “4” = billable and always print.

RC (fees)1 Rate Code (0-9). The Rate Code indicates which billing rate Tabs3 uses. No code will print if the rate
code is “0”. “0” indicates that Tabs3 has used the default billing rate.

RC (costs)1 Rate Code (0, 7, or 8). The Rate Code indicates how the Amount is determined. “0” indicates that the
operator entered the amounts. “7” indicates that Tabs3 retrieved the Rate from the transaction code
file, allowed the operator to enter the number of units, and then automatically calculated the
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amount. “8” indicates that Tabs3 retrieved the Amount from the transaction code file. No code will
print if the Rate Code is “0”.

CT1 The transaction’s Expense or Advance Cost Type. For payments, the Cost Type will be zero.

Tcode
Task Code

For fees and costs, this represents the Phase/Task code and Activity or Expense code entered for the
transaction. For payments, this is the transaction code entered for the transaction.

Stmt #
Rate

Hourly billing rate. If payments are included, the statement number the payment was processed
against is shown in this column. A statement number will only appear for payment transactions if a
statement number was specified during data entry.

Units1 The units for each cost transaction.

Hours Worked1 The number of hours worked for each fee transaction.

Hours to Bill
The number of hours to bill for each fee transaction.

Amount
Amount of each transaction.

(description)
Transaction description. Statement comments are shown with strikethrough characters.

Ref #
Reference number identifying the work-in-process transaction for editing purposes (optional).
“ARCH” will print for transactions from the archive files; these transactions cannot be edited.

Progress Billable1 Subtotal for “progress billing” fee transactions (Type “6” transactions).

Progress Non-billable1 Subtotal for non-billable “progress billing” fee transactions (Type “6” transactions).

1Not shown on the sample report.

Criteria Page

Date: 11/28/2016 Detail Transaction File List Page: 1
Jensen, Martin & Anderson, P.C.

System Date: 11/28/2016 Time: 10:02 AM User ID: SUSAN

Client Selection Criteria:
Client ID:       101.00 Thru:       101.00
Name Search Key: Thru: Z
Primary Timekeeper: 1 Thru: 99
Secondary Timekeeper: 1 Thru: 99
Originating Timekeeper: 1 Thru: 99
Category: 1 Thru: 999
Open Date: mm/dd/yyyy Thru: mm/dd/yyyy
Include Client with a Close Date: Yes

Close Date: mm/dd/yyyy Thru: mm/dd/yyyy
Include Client without a Close Date: Yes
Billing Frequency: All
Location: All
Status Criteria: All

Transaction Selection Criteria:
Fees: Yes

Timekeeper: 1 Thru: 99
Date: mm/dd/yyyy Thru: 10/31/2016
Tcode: 1 Thru: 999
Category: 1 Thru: 999

Expenses: Yes
Advances: Yes

Timekeeper: 0 Thru: 99
Date: mm/dd/yyyy Thru: 10/31/2016
Tcode: 1 Thru: 999
Cost Type: 0 Thru: 9

Payments: Yes
Date: mm/dd/yyyy Thru: 10/31/2016
Tcode: 1 Thru: 999
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Date: 11/28/2016 Detail Transaction File List Page: 2
Jensen, Martin & Anderson, P.C.

Transaction File List Options:
Transaction Type Include Transaction Source Include

Work-In-Process Yes Billing Yes
Archived No Remote Yes

Data Import Yes
Billable Yes PracticeMaster Yes
Non-billable Yes Accounts Payable Yes

Trust Yes
QuickBooks Yes

Hold Yes
Print Yes Timekeeper Initials No
Save Yes
Normal No Client Name Yes

Work Description Yes
Detail or Summary Report: Detail
Dates under the Transaction Tab apply to Transaction Dates.
GLS Information No

Sort Options:
1st Sort Order: Client
      Subtotal: Yes
2nd Sort Order: Transaction Date
      Subtotal: No
3rd Sort Order: None
      Subtotal: No
Start 1st Sort on a New Page: No

Include Columns:
ClientID Yes
UserID No
EntryDate No
TransDate Yes
StmtDate No
Timekeeper Yes
ExpAdv No
Source No
Status Yes
ReceiptType No
CheckNum No
Ref/Memo No
TaxCode No
BillCode No
RateCode No
CostType No
Tcode Yes
Rate Yes
Units No
HoursWorked No
HoursToBill Yes
Amount Yes
Description Yes
RefNo Yes

Orientation: Portrait

A Criteria Page can optionally be printed at the end of a statement run and most reports. Criteria pages list all options and
criteria used for the generation of the report. The options listed on the Criteria Page are broken down by program tabs where
applicable. The Criteria Page shown on page 49 and page 50 is for a Transaction File List.
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Detail Work-In-Process Report
Task Folder Reports | Work-In-Process Reports | Detail Work-In-Process

The reports shown on pages 52 through 55 are examples of the Detail Work-In-Process Report.

l The reports shown on page 52 and page 53 are examples of the detailed version. The report on page 52 includes the
Write-Up/Write-Down Hours column, whereas the report on page 53 does not.

l The report shown on page 54 is an example of the summarized version.
l The report shown on page 55 is an example of the detailed version with user-selected columns.

The detailed report shows the detail of all fees, costs and payments entered for the client. The detailed report can be used to
review work-in-process prior to billing.

The summarized version includes totals only.

The user-edited version shown on page 55 includes only columns—in this example, only the date, timekeeper, rate, hours to bill,
amount, and description.

The Options tab includes parameters that enable you to specify what type of information is to be included on the report (e.g.,
clients with only a previous balance, include clients with only payments, etc.), the fee order, and the layout. The Format tab
allows you to customize the report by specifying which columns you want to include on the report as well as allows you to
specify what additional information you want to print, the report width, orientation, whether you want each client printed on a
new page, and whether transactions should be double spaced.
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Date: 11/28/2016 Tabs3 Detail Work-In-Process Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 3 Ronald P. Anderson

Client: 415.00M  MegaConstruction Corporation MegaConstruction Contact: James R. Tatiki, Sr.
Corporate Merger - Megabuilders and BuilderCorp Business: 212-555-1232
Primary Timekeeper: 3 RPA Category: 40 Business Law Business Fax: 212-555-1234
Secondary Timekeeper: 2 PAM Draft Template: Draft Rate Code: 1 E-mail: jt@megaconcorp.com
Originating Timekeeper: 4 ROB Final Template: Recap Date Opened: 10/21/2016
Previous Balance: 85,772.02

H T B R Hours Hours Write-Up/ Write-Up/
Date Tmkr Cat Src P X C C Tcode Ref # Rate Units Worked to Bill Down Hrs Amount Down Amt Description

Fees
11/21/2016 1 MLJ 40 P 1 4 500.00 4.25 4.25 2,125.00 Prepare Financial Disclosure Form
11/21/2016 1 MLJ 40 6 16 500.00 0.70 0.70 350.00 Receipt of request for changes to documents

from company.
11/23/2016 1 MLJ 40 P 1 10 500.00 6.00 6.00 3,000.00 Prepare Notice and Articles of Dissolution for

Megabuilder
11/24/2016 1 MLJ 40 P 1 7 500.00 5.00 5.00 2,500.00 Prepare Financial Disclosure Form
11/28/2016 1 MLJ 40 P 1 2 500.00 1.00 1.00 500.00 Prepare Employee Handbook

Billable Total:   1 Michael L. Jensen 16.95 16.95 8,475.00

11/22/2016 2 PAM 40 P 1 11 450.00 2.25 2.25 1,012.50 Prepare Notice and Articles of Dissolution for
Megabuilder

11/23/2016 2 PAM 40 P 1 8 450.00 5.00 5.00 2,250.00 Prepare Financial Disclosure Form
11/24/2016 2 PAM 40 P 1 5 450.00 8.00 8.00 3,600.00 Prepare Financial Disclosure Form

Billable Total:   2 Paula Ann Martin 15.25 15.25 6,862.50

11/25/2016 4 ROB 40 P 1 13 750.00 6.50 6.50 4,875.00 Prepare Notice and Articles of Dissolution for
BuilderCorp

11/25/2016 4 ROB 40 1 15 750.00 0.50 0.50 375.00 Review Status of Case

Billable Total:   4 Robert O. Burns 7.00 7.00 5,250.00

11/22/2016 6 DHB 40 P 1 1 180.00 6.25 6.25 1,125.00 Prepare Employee Handbook

Billable Total:   6 Daniel H. Brady 6.25 6.25 1,125.00

11/21/2016 7 CB 40 P 1 3 180.00 4.25 4.25 765.00 Prepare Financial Disclosure Form
11/22/2016 7 CB 40 P 1 6 180.00 2.25 2.25 405.00 Prepare Financial Disclosure Form
11/22/2016 7 CB 40 P 1 9 180.00 3.00 3.00 540.00 Prepare Notice and Articles of Dissolution for

Megabuilder
11/25/2016 7 CB 40 P 1 12 180.00 3.75 3.75 675.00 Prepare Notice and Articles of Dissolution for

BuilderCorp

Billable Total:   7 Cheryl Bradley 13.25 13.25 2,385.00

11/25/2016 8 JAN 40 P 1 14 250.00 3.00 3.00 750.00 Prepare Pre-Hiring Concerns Checklist

Billable Total:   8 Jennifer A. Noonan 3.00 3.00 750.00

Total Billable Fees 61.70 61.70 24,847.50

Payments
11/22/2016 900 12 -80,000.00 Payment

-80,000.00Total Billable Payments

R E C A P

Fees: 24,847.50
Previous Balance: 85,772.02Expenses: 0.00
Payments/Credits: -80,000.00Advances: 0.00

Total WIP: 24,847.50 Balance Due: 5,772.02 Total: 30,619.52

A/R: 0-30 31-60 61-90 91-120 121-180 181+

5,772.02 0.00 0.00 0.00 0.00 0.00
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Date: 11/28/2016 Tabs3 Detail Work-In-Process Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 3 Ronald P. Anderson

Client: 415.00M  MegaConstruction Corporation MegaConstruction Contact: James R. Tatiki, Sr.
Corporate Merger - Megabuilders and BuilderCorp Business: 212-555-1232
Primary Timekeeper: 3 RPA Category: 40 Business Law Business Fax: 212-555-1234
Secondary Timekeeper: 2 PAM Draft Template: Draft Rate Code: 1 E-mail: jt@megaconcorp.com
Originating Timekeeper: 4 ROB Final Template: Recap Date Opened: 10/21/2016
Previous Balance: 85,772.02

H T B R Hours Hours Write-Up/
Date Tmkr Cat Src P X C C Tcode Ref # Rate Units Worked to Bill Amount Down Amt Description

Fees
11/21/2016 1 MLJ 40 P 1 4 500.00 4.25 4.25 2,125.00 Prepare Financial Disclosure Form
11/21/2016 1 MLJ 40 6 16 500.00 0.70 0.70 350.00 Receipt of request for changes to documents

from company.
11/23/2016 1 MLJ 40 P 1 10 500.00 6.00 6.00 3,000.00 Prepare Notice and Articles of Dissolution for

Megabuilder
11/24/2016 1 MLJ 40 P 1 7 500.00 5.00 5.00 2,500.00 Prepare Financial Disclosure Form
11/28/2016 1 MLJ 40 P 1 2 500.00 1.00 1.00 500.00 Prepare Employee Handbook

Billable Total:   1 Michael L. Jensen 16.95 16.95 8,475.00

11/22/2016 2 PAM 40 P 1 11 450.00 2.25 2.25 1,012.50 Prepare Notice and Articles of Dissolution for
Megabuilder

11/23/2016 2 PAM 40 P 1 8 450.00 5.00 5.00 2,250.00 Prepare Financial Disclosure Form
11/24/2016 2 PAM 40 P 1 5 450.00 8.00 8.00 3,600.00 Prepare Financial Disclosure Form

Billable Total:   2 Paula Ann Martin 15.25 15.25 6,862.50

11/25/2016 4 ROB 40 P 1 13 750.00 6.50 6.50 4,875.00 Prepare Notice and Articles of Dissolution for
BuilderCorp

11/25/2016 4 ROB 40 1 15 750.00 0.50 0.50 375.00 Review Status of Case

Billable Total:   4 Robert O. Burns 7.00 7.00 5,250.00

11/22/2016 6 DHB 40 P 1 1 180.00 6.25 6.25 1,125.00 Prepare Employee Handbook

Billable Total:   6 Daniel H. Brady 6.25 6.25 1,125.00

11/21/2016 7 CB 40 P 1 3 180.00 4.25 4.25 765.00 Prepare Financial Disclosure Form
11/22/2016 7 CB 40 P 1 6 180.00 2.25 2.25 405.00 Prepare Financial Disclosure Form
11/22/2016 7 CB 40 P 1 9 180.00 3.00 3.00 540.00 Prepare Notice and Articles of Dissolution for

Megabuilder
11/25/2016 7 CB 40 P 1 12 180.00 3.75 3.75 675.00 Prepare Notice and Articles of Dissolution for

BuilderCorp

Billable Total:   7 Cheryl Bradley 13.25 13.25 2,385.00

11/25/2016 8 JAN 40 P 1 14 250.00 3.00 3.00 750.00 Prepare Pre-Hiring Concerns Checklist

Billable Total:   8 Jennifer A. Noonan 3.00 3.00 750.00

Total Billable Fees 61.70 61.70 24,847.50

Payments
11/22/2016 900 12 -80,000.00 Payment

-80,000.00Total Billable Payments

R E C A P

Fees: 24,847.50
Previous Balance: 85,772.02Expenses: 0.00
Payments/Credits: -80,000.00Advances: 0.00

Total WIP: 24,847.50 Balance Due: 5,772.02 Total: 30,619.52

A/R: 0-30 31-60 61-90 91-120 121-180 181+

5,772.02 0.00 0.00 0.00 0.00 0.00
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Date: 11/28/2016 Tabs3 Detail Work-In-Process Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 3 Ronald P. Anderson

Client: 415.00M  MegaConstruction Corporation MegaConstruction Contact: James R. Tatiki, Sr.
Corporate Merger - Megabuilders and BuilderCorp Business: 212-555-1232
Primary Timekeeper: 3 RPA Category: 40 Business Law Business Fax: 212-555-1234
Secondary Timekeeper: 2 PAM Draft Template: Draft Rate Code: 1 E-mail: jt@megaconcorp.com
Originating Timekeeper: 4 ROB Final Template: Recap Date Opened: 10/21/2016
Previous Balance: 85,772.02

H T B R Hours Hours Write-Up/ Write-Up/
Date Tmkr Cat Src P X C C Tcode Ref # Rate Worked to Bill Down Hrs Amount Down Amt Description

Billable Total:   1 Michael L. Jensen 16.95 16.95 8,475.00

Billable Total:   2 Paula Ann Martin 15.25 15.25 6,862.50

Billable Total:   4 Robert O. Burns 7.00 7.00 5,250.00

Billable Total:   6 Daniel H. Brady 6.25 6.25 1,125.00

Billable Total:   7 Cheryl Bradley 13.25 13.25 2,385.00

Billable Total:   8 Jennifer A. Noonan 3.00 3.00 750.00

Total Billable Fees 61.70 61.70 24,847.50

-80,000.00Total Billable Payments

R E C A P

Fees: 24,847.50
Previous Balance: 85,772.02Expenses: 0.00
Payments/Credits: -80,000.00Advances: 0.00

Total WIP: 24,847.50 Balance Due: 5,772.02 Total: 30,619.52

A/R: 0-30 31-60 61-90 91-120 121-180 181+

5,772.02 0.00 0.00 0.00 0.00 0.00

Billing History Hours Fees Expenses Advances Fin. Charge Payments

Billable: 1,840.45 746,422.50 642.00 0.00 3,211.24 664,503.72
Non-Billable: 0.00 0.00 0.00 0.00

Last Statement: 10/31/2016 Last Payment: 11/22/2016 Last Payment Amount: 80,000.00

Billing Notes & Instructions: 07/28/2016 02:36pm - An attention line must be included in statements
mailed to Mr. Tatiki.
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Date: 11/28/2016 Tabs3 Detail Work-In-Process Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 3 Ronald P. Anderson

Client: 415.00M  MegaConstruction Corporation MegaConstruction Contact: James R. Tatiki, Sr.
Corporate Merger - Megabuilders and BuilderCorp Business: 212-555-1232
Primary Timekeeper: 3 RPA Category: 40 Business Law Business Fax: 212-555-1234
Secondary Timekeeper: 2 PAM Draft Template: Draft Rate Code: 1 E-mail: jt@megaconcorp.com
Originating Timekeeper: 4 ROB Final Template: Recap Date Opened: 10/21/2016
Previous Balance: 85,772.02

Hours
Date Tmkr Rate to Bill Amount Description

Fees
11/21/2016 7 CB 180.00 4.25 765.00 Prepare Financial Disclosure Form
11/21/2016 1 MLJ 500.00 4.25 2,125.00 Prepare Financial Disclosure Form
11/21/2016 1 MLJ 500.00 0.70 350.00 Receipt of request for changes to documents from company.

Billable Total: Date 11/21/2016 9.20 3,240.00

11/22/2016 6 DHB 180.00 6.25 1,125.00 Prepare Employee Handbook
11/22/2016 7 CB 180.00 2.25 405.00 Prepare Financial Disclosure Form
11/22/2016 7 CB 180.00 3.00 540.00 Prepare Notice and Articles of Dissolution for Megabuilder
11/22/2016 2 PAM 450.00 2.25 1,012.50 Prepare Notice and Articles of Dissolution for Megabuilder

Billable Total: Date 11/22/2016 13.75 3,082.50

11/23/2016 2 PAM 450.00 5.00 2,250.00 Prepare Financial Disclosure Form
11/23/2016 1 MLJ 500.00 6.00 3,000.00 Prepare Notice and Articles of Dissolution for Megabuilder

Billable Total: Date 11/23/2016 11.00 5,250.00

11/24/2016 2 PAM 450.00 8.00 3,600.00 Prepare Financial Disclosure Form
11/24/2016 1 MLJ 500.00 5.00 2,500.00 Prepare Financial Disclosure Form

Billable Total: Date 11/24/2016 13.00 6,100.00

11/25/2016 7 CB 180.00 3.75 675.00 Prepare Notice and Articles of Dissolution for BuilderCorp
11/25/2016 4 ROB 750.00 6.50 4,875.00 Prepare Notice and Articles of Dissolution for BuilderCorp
11/25/2016 8 JAN 250.00 3.00 750.00 Prepare Pre-Hiring Concerns Checklist
11/25/2016 4 ROB 750.00 0.50 375.00 Review Status of Case

Billable Total: Date 11/25/2016 13.75 6,675.00

11/28/2016 1 MLJ 500.00 1.00 500.00 Prepare Employee Handbook

Billable Total: Date 11/28/2016 1.00 500.00

Total Billable Fees 61.70 24,847.50

Payments
11/22/2016 -80,000.00 Payment

-80,000.00Total Billable Payments

R E C A P

Fees: 24,847.50
Previous Balance: 85,772.02Expenses: 0.00
Payments/Credits: -80,000.00Advances: 0.00

Total WIP: 24,847.50 Balance Due: 5,772.02 Total: 30,619.52

A/R: 0-30 31-60 61-90 91-120 121-180 181+

5,772.02 0.00 0.00 0.00 0.00 0.00

Definitions for Detail Work-In-Process Report
Client Client ID, name and name search. The letter after the Client ID represents the billing frequency. The

information below “Client:” represents the work description and address information as well as the
timekeeper number and initials of the primary, secondary and originating timekeepers assigned to
the client. The previous balance, category, statement templates, bill to address, and date opened are
also shown for each client. The contact, phone numbers, e-mail address, and miscellaneous lines
are also shown. An “*” preceding the miscellaneous lines indicates that this information will not
print on the client’s billing statement.

Date Date of each transaction.

Tmkr Timekeeper number and initials. Timekeeper numbers are not shown for payment transactions.

Cat Optional column. Category number.

Src Optional column. Source code indicates the source of the transaction. A blank Source field
indicates the transaction was entered through Tabs3 Billing. “T” = Tabs3 Trust Accounting Software,
“A” = Tabs3 Accounts Payable Software, “R” = Tabs3 Remote, “D” = Data Capture Device, “P” or “C”
= PracticeMaster, “Q” = QuickBooks. All transactions on the sample report were entered through

- 55 -



Tabs3 Report Pack

Tabs3. Lowercase codes indicate that the transaction has been split using Perform Split Billing (e.g.,
“b” indicates a split transaction that originated in Tabs3 Billing).

HP Optional column. Status field. If the transaction has a Status of “Print,” nothing will show on the
report in order to make it easier to spot “Hold” and “Save” transactions. “H” = Hold, “S” = Save, “U”
or “s” = Billed but not updated.

TX Optional column. Sales tax rate code that will be used to calculate sales tax when a statement is
printed. No code will print if the sales tax rate code is “0” (i.e., no sales tax). Up to 9 sales tax rates
can be defined in Tabs3 Customization.

BC Optional column. Bill Code (0-4). The Bill Code defines the transaction’s default billing and print
status. No code will print if the bill code is “0”. “0” = billable and printable, “1” = non-billable and
non-printable, “2” = non-billable and printable, “3” = billable and non-printable, and “4” = billable
and always print.

RC (fees) Optional column. Rate Code (0-9). The Rate Code indicates which billing rate Tabs3 uses. No code
will print if the rate code is “0”. “0” indicates that Tabs3 has used the default billing rate.

RC (costs) Optional column. Rate Code (0, 7 or 8). The Rate Code indicates how the Amount is determined. “0”
indicates that the operator entered the amounts. “7” indicates that Tabs3 retrieved the Rate from the
transaction code file, allowed the operator to enter the number of units, and then automatically
calculated the amount. “8” indicates that Tabs3 retrieved the Amount from the transaction code file.
No code will print if the rate code is “0”.

Tcode Optional column. Transaction code number. No transaction code will be shown for task based
billing transactions.

Task Code Optional column. (Shown for task based billing transactions only.) Represents the Phase/Task code
and the Activity code or Expense code that were entered for each transaction.

Ref # Optional column. Reference number identifying the transaction for editing purposes.

Rate Optional column. Hourly billing rate.

Units Optional column. The units for each cost transaction.

Hours Worked Optional column. The number of hours worked for each fee transaction.

Hours to Bill Optional column. The number of hours to bill for each fee transaction.

Write-Up/Down Hrs Optional column. The Hours to Bill minus the Hours Worked. This figure is only displayed for
billable transactions.

Amount Optional column. Amount of each transaction.

Write-Up/Down Amt Optional column. Amount of the write-up/write-down. The word “Progress” in this column
indicates that the fee transaction is a Type 6 progress fee. The amount in this column is calculated
differently depending on whether or not the Write-Up/Write-Down Hours column is included.
When the Write-Up/Write-Down Hours column is included, the Write-Up/Write-Down column
includes the value of the hours adjusted along with the write-up/write-down amount. This figure is
only displayed for billable transactions.

Description Description of the transaction.

Totals Optional column. Totals for billable and non-billable amounts are shown for fees, progress fees,
expenses, advances, and payments.

Billing Notes &
Instructions

Optional column. Billing notes and instructions can optionally be entered on the Billing
Preferences tab of the Client file. If the Billing Notes & Instructions check box is selected for the
report, billing notes and instructions will be included on the report after the recap and optional
billing history.
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Note: Threshold billing amounts can optionally be entered on the Billing Options tab of the
Client file. If you elect to include clients that do not meet billing thresholds on the Detail Work-In-
Process Report, a message will be included after a client’s transactions if an amount does not
meet the client’s billing threshold.

Recap
Fees Total billable fees shown on the report (including transactions on hold).

Expenses Total billable expenses shown on the report (including transactions on hold).

Advances Total billable advances shown on the report (including transactions on hold).

Total WIP Total billable fees and costs shown on the report (including transactions on hold).

Previous Balance Client’s balance due from the client’s last updated statement.

Payments/Credits Total payments, fee credits, and cost credits on the report (including payments on hold).

Balance Due Client’s Previous Balance minus Payments/Credits.

Total Total WIP plus Balance Due.

A/R Aged accounts receivable balance due. The first amount on the line is the amount between 0 and 30
days past due. The second amount on the line is the amount between 31 and 60 days past due. The
third amount on the line is the amount between 61 and 90 days past due, etc. These amounts reflect
any payments shown on the report (payments on hold are not included). Aging is calculated by
comparing the statement date of outstanding client ledger statement records with the report date.
Aging brackets are defined on the Options tab of Tabs3 Customization.

Other WIP¹ Includes all billable hours, fees, expenses and advances for the client that are not included on the
report due to the selection criteria specified.

Budget Hours¹ Amount of budgeted hours specified on the Budget tab in the Client file.

Budget Amount¹ Budgeted amount specified on the Budget tab in the Client file.

Progress WIP¹ Total amount of Type 6 progress fees in work-in-process. Credit transactions and transactions on
hold are included. Progress WIP Tax is not included.

Progress Billed¹ Total amount of Type 6 progress fees billed since the last time the client was “reconciled.” This
amount is the same as the “Progress Billed” field on the A/R & Fund Balances tab of the Client file.

Progress Paid¹ Progress Billed (from the A/R & Fund Balances tab in the Client file) minus Progress Fees Due.

Fund Balance¹ Current client fund balance.

Minimum Balance¹ Minimum balance for client funds specified on the A/R & Fund Balances tab of the Client file.

Target Balance¹ Target balance for client funds specified on the A/R & Fund Balances tab of the Client file.

Trust Account Balance¹ If a trust account is present for the client, a message stating the balance for each trust account will
be printed. (The trust account balance is retrieved from Tabs3 Trust Accounting Software. The
terminology printed is retrieved from the Bank Account file in TAS.)

Billing History
The optional billing history includes previously billed amounts. The information is retrieved from the client ledger file. Amounts
are classified as billable or non-billable and consist of accumulated billed-to-date totals (regardless of the report’s beginning
and ending dates). The amounts do not include transactions in work-in-process.

The last statement date, last payment date and last payment amount are also shown (which is based on the date of the records
as opposed to the entry order). The last payment amount includes the total amount of payments received on the last payment
date (including both processed and WIP payments). A negative figure in the Last Payment Amount field indicates that the last
payment record in the client ledger file is a payment reversal record.

Billable Billed hours, fees, expenses, advances, finance charge, and payments.
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Write Off¹ Amount of fees, expenses, advances, and finance charge that has been written off.

Non-Billable Non-billable hours, fees, expenses, and advances that have been processed (i.e., final billed and
updated).

¹ Not shown on the sample report.

Summary Work-In-Process Report
Date: 11/28/2016 Tabs3 Summary Work-In-Process Report Page: 1

Jensen, Martin & Anderson, P.C.

Primary Timekeeper:  2 Pamela Ann Martin

Previous Hours Current
Balance to Bill Fees Expenses Advances Payments Balance

111.60200 Blair/Michael  33,559.83 12.90 1,741.50 17.22 2,162.22 -26,369.92 11,110.85
Blair v. Jefferson

105.50400 Homeland Insurance  4,989.13 29.00 3,979.50 10.40 269.74 -4,989.13 4,259.64
Karavel v. Homeland Ins. Credits: -7.00 -945.00 -945.00

Subtotals: 4,989.13 22.00 3,034.50 10.40 269.74 -4,989.13 3,314.64

105.60100 Homeland Insurance  2,291.16 46.70 6,366.00 62.20 7,187.75 -2,291.16 13,615.95
Anderson v. Homeland Ins.

100.60900 MegaConstruction Corp. U 5,582.48 7.70 1,054.50 0.00 0.00 -5,582.48 1,054.50
Corporate Merger

100.61300 MegaConstruction Corp. U 6,468.49 30.40 4,104.00 4.30 571.90 -6,468.49 4,680.20
Contract Evaluation

Totals for Primary Timekeeper 2 52,891.09 126.70 17,245.50 94.12 10,191.61 -45,701.18 34,721.14
Credits: -7.00 -945.00 -945.00

Subtotals: 52,891.09 119.70 16,300.50 94.12 10,191.61 -45,701.18 33,776.14
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Date: 11/28/2016 Tabs3 Summary Work-In-Process Report Page: 1
Jensen, Martin & Anderson, P.C.

Previous Hours Current
Balance to Bill Fees Expenses Advances Payments Balance

111.60200 Blair/Michael  33,559.83 12.90 1,741.50 17.22 2,162.22 -26,369.92 11,110.85
Blair v. Jefferson

Primary Timekeeper:  002  PAM A/R Info: 0-30 31-60 61-90 91-120 121-150 151+

Fund Balance: 500.00 Last Activity Dates:  0.00 0.00 0.00 7,132.80 0.00 57.11
Statement: 10/31/2016
Payment: 09/26/2016
Fees: 09/22/2016
Expenses: 09/29/2016
Advances: 09/12/2016

105.50400 Homeland Insurance 4,989.13 29.00 3,979.50 10.40 269.74 -4,989.13 4,259.64
Karavel v. Homeland Ins. Credits: -7.00 -945.00 -945.00

Primary Timekeeper:  002  PAM Subtotals: 4,989.13 22.00 3,034.50 10.40 269.74 -4,989.13 3,314.64
Courtesy Discount: 100.00 Last Activity Dates:

Statement: 10/31/2016 A/R Info: 0-30 31-60 61-90 91-120 121-150 151+

Payment: 09/02/2016 0.00 0.00 0.00 0.00 0.00 0.00
Fees: 09/26/2016
Expenses: 09/15/2016
Advances: 09/02/2016

Billing Notes & Instructions: Mail to Mr. Sticker every 45 days.

105.60100 Homeland Insurance 2,291.16 46.70 6,366.00 62.20 7,187.75 -2,291.16 13,615.95
Anderson v. Homeland Ins.

Primary Timekeeper:  002  PAM A/R Info: 0-30 31-60 61-90 91-120 121-150 151+

Last Activity Dates: 0.00 0.00 0.00 0.00 0.00 0.00
Statement: 10/31/2016
Payment: 10/24/2016
Fees: 09/26/2016
Expenses: 09/02/2016
Advances: 10/26/2016

105.61200 Homeland Insurance 457.20 49.10 6,562.50 41.80 434.98 -457.20 7,039.28
Martinson v. Homeland Ins.

Primary Timekeeper:  002  PAM A/R Info: 0-30 31-60 61-90 91-120 121-150 151+

Progress Billing: Last Activity Dates: 0.00 0.00 0.00 0.00 0.00 0.00
Progress WIP: 900.00 Statement: 10/31/2016
Progress Billed: 0.00 Payment: 09/29/2016
Progress Paid: 0.00 Fees: 09/27/2016

Expenses: 10/03/2016
Advances: 10/26/2016

Subtotals for 105  Homeland Insurance 7,737.49 124.80 16,908.00 114.40 7,892.47 -7,737.49 24,914.87
Progress Billing: Last Activity Dates: Credits: -7.00 -945.00 -945.00

Progress WIP: 900.00 Statement: 10/31/2016 Subtotals: 7,737.49 117.80 15,963.00 114.40 7,892.47 -7,737.49 23,969.87
Progress Billed: 0.00 Payment: 09/29/2016
Progress Paid: 0.00 Fees: 10/27/2016 A/R Info: 0-30 31-60 61-90 91-120 121-150 151+

Expenses: 10/03/2016 0.00 0.00 0.00 0.00 0.00 0.00
Advances: 09/26/2016

Totals 41,297.32 137.70 18,649.50 131.62 10,054.69 -34,107.41 36,025.72
Progress Billing: Credits: -7.00 -945.00 -945.00

Progress WIP: 900.00 Subtotals: 41,297.32 130.70 17,704.50 131.62 10,054.69 -34,107.41 35,080.72
Progress Billed: 0.00
Progress Paid: 0.00 A/R Info: 0-30 31-60 61-90 91-120 121-150 151+

Fund Balance: 500.00 0.00 0.00 0.00 7,132.80 0.00 57.11

Task Folder Reports | Work-In-Process Reports | Summary Work-In-Process

A Summary Work-In-Process Report shows the client’s previous balance and any fees, costs or payments in work-in-process. A
current balance is calculated and shown. The client funds balance is shown as well. Non-billable fees and costs are not
included. This report allows for a quick review of the client’s status.

The Options tab includes parameters that allow you to specify what type of information is included on the report (e.g., include
clients with only a previous balance, include only clients with payments, etc.). The Format tab allows you to optionally include
information such as accounts receivable information and last activity dates, as well as portrait or landscape orientation.

Clients with only non-billable transactions will not be included on the report. Likewise, clients with only billable transactions
that have zero Hours to Bill and zero Amount will not be included on the report.

Definitions for Summary Work-In-Process Report
Client Client ID, client name and work description. The letter after the Client ID represents the billing

frequency. An asterisk preceding the work description indicates the work description will not print
on the client’s statement1.

“U” A “U” to the right of the Client ID and name indicates the client has had a final statement run and is
ready to be updated.

Primary Timekeeper Primary timekeeper number and initials are shown below the Client ID if the list is not printed in
timekeeper order.

Previous Balance Balance due from the client’s last updated statement.

Hours to Bill2 Total billable hours in work-in-process within the selected date range.
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Fees2 Total billable fees in work-in-process within the selected date range. Type 6 progress fees are not
included.

Expenses2 Total billable expenses in work-in-process within the selected date range.

Advances2 Total billable advances in work-in-process within the selected date range.

Payments
Total payments. All payments are included regardless of the selected date range. Payments on hold
are included.

Credits Total hours to bill, fee, expense, and advance credits within the selected date range. Credits on hold
are included. This line only prints for clients who have credits.

Subtotals By column, calculated as Hours to Bill, Fees, Expenses, or Advances minus Credits. This line only
prints for clients who have credits.

Current Balance Previous Balance + Fees + Expenses + Advances minus Payments. If a client has credits, this column
will display Current Balance minus Credits, and then display the Current Balance including credits
on the Subtotals line.

Last Activity Dates Optional section. Date of last statement and last fee, expense, advance, and payment transactions in
work-in-process. “Last” refers to the record with the latest date. If no statements have been
updated, then no last statement date will print. Likewise, if there are no fee, expense, advance, or
payment transactions in work-in-process, then no date will print.

A/R Info Past due amounts that are based on the predefined aging periods. The default aging periods are 0-
30, 31-60, 61-90, 91-120, 121-180, and 181+. These amounts reflect any payments shown on the
report (payments on hold are not included). Aging is calculated by comparing the statement date of
outstanding client ledger statement records with the report date. The aging periods used are
defined on the Options tab in Tabs3 Customization.

Progress WIP Total amount of Type 6 progress fees in work-in-process. Credit transactions and transactions on
hold are included. Progress WIP Tax is not included.

Progress Billed Total amount of Type 6 progress fees billed since the last time the client was “reconciled.” This
amount is the same as the “Progress Billed” field on the A/R & Fund Balances tab of the Client file.

Progress Paid Progress Billed (from the A/R & Fund Balances tab in the Client file) minus Progress Fees Due.

Fund Balance Current client funds balance including all client funds transactions in work-in-process.

Trust Balance1 Total balance of all trust accounts for the client. This information is retrieved from Tabs3 Trust
Accounting Software.

Courtesy Discount Courtesy Discount percentage or amount from the Billing Options tab of the Client file.

Note: Threshold billing amounts can optionally be entered on the Billing Options tab of the Client file. If you elect to include
clients that do not meet billing thresholds on the Summary Work-In-Process Report, a message will be included if an amount
does not meet the client’s billing threshold.

Billing Notes &
Instructions

Billing notes and instructions can optionally be entered on the Billing Preferences tab of the Client
file. If the Billing Notes & Instructions check box is selected for the report, billing notes and
instructions will be included on the report.

1Not shown on the sample report.
2Non-billable transactions and credit transactions are not included. Credit transactions are shown on a separate line item.
Transactions on hold are included.
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Aged Work-In-Process Report
Date: 11/28/2016 Tabs3 Aged Work-In-Process Report Page: 1

Jensen, Martin & Anderson, P.C.

0-30 31-60 61-90 91-120 121-180 181+days Total

100.00 M Larson/Michael
RE: Larson v. Bel-Cor

  1 MLJFees: 1,653.75 1,281.00 125.00 0.00 0.00 0.00 3,059.75
Exps: 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Advs: 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Total: 1,653.75 1,281.00 125.00 0.00 0.00 0.00 3,059.75

 

102.00 M Gilbert/Andrew C.
RE: Auto Accident

  2 PAMFees: 1,166.00 1,952.50 410.00 282.00 282.00 0.00 4,092.50
Exps: 0.00 24.53 0.00 17.80 34.50 0.00 76.83
Advs: 85.00 0.00 0.00 75.00 0.00 0.00 160.00

Total: 1,251.00 1,977.03 410.00 374.80 316.50 0.00 4,329.33

 
120.01 M Klein/Daniel P.
RE: Klein vs. Simmons Construction

  3 RPAFees: 987.00 400.00 0.00 0.00 0.00 0.00 1,387.00
Exps: 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Advs: 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Total: 987.00 400.00 0.00 0.00 0.00 0.00 1,387.00

 

200.01 M Peterson Insurance Co.
RE: General Legal Counsel

  1 MLJFees: 5,600.00 0.00 0.00 0.00 0.00 0.00 5,600.00
Exps: 12.00 0.00 0.00 0.00 0.00 0.00 12.00
Advs: 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Total: 5,612.00 0.00 0.00 0.00 0.00 0.00 5,612.00

 
200.02 M Peterson Insurance Co.
RE: Maintenance of Insurance Policies

  3 RPAFees: 1,451.00 0.00 0.00 0.00 0.00 0.00 1,451.00
Exps: 4.28 0.00 0.00 0.00 0.00 0.00 4.28
Advs: 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Total: 1,455.28 0.00 0.00 0.00 0.00 0.00 1,455.28

Pymts: -1,451.00

 
   Subtotals for 200 Peterson Insurance Co.
Fees: 7,051.00 0.00 0.00 0.00 0.00 0.00 7,051.00
Exps: 16.28 0.00 0.00 0.00 0.00 0.00 16.28
Advs: 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Total: 7,067.28 0.00 0.00 0.00 0.00 0.00 7,067.28

Pymts: -1,451.00

Totals
Fees: 10,857.75 3,246.50 535.00 282.00 282.00 0.00 15,203.25
Exps: 16.28 24.53 0.00 17.80 34.50 0.00 93.11
Advs: 85.00 0.00 0.00 75.00 0.00 0.00 160.00

Total: 10,959.03 3,271.03 535.00 374.80 316.50 0.00 15,456.36

Pymts:                    -1,451.00

Task Folder Reports | Work-In-Process Reports | Aged Work-In-Process

The Aged Work-In-Process Report shows the age of all unbilled charges by client (including transactions on “hold” and
transactions that have been final billed but have not yet been updated). The Report Date is used to calculate the aging of the
work-in-process. The Options tab includes parameters that enable you to include all amounts for each working timekeeper,
include clients that do not meet billing thresholds and specify a minimum amount of work-in-process to print.
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The aging periods used by this report are always 0-30 days, 31-60 days, 61-90 days, 91-120 days, 121-180 days and 181+ days.
The aging periods from Tabs3 Customization are not used.

Definitions for Aged Work-In-Process Report
Client Client ID, client name and work description. The letter after the Client ID represents the billing

frequency. An asterisk before the work description indicates the work description will not print on
the client’s statement.1

0-30 Amount in WIP 0-30 days old from report date.

31-60 Amount in WIP 31-60 days old from report date.

61-90 Amount in WIP 61-90 days old from report date.

91-120 Amount in WIP 91-120 days old from report date.

121-180 Amount in WIP 121-180 days old from report date.

181+days Amount in WIP 181+ days old from report date.

Fees2 Billable fees within the selected date range (excluding Type 6 transactions and credit transactions).

Exps2 Billable expenses within the selected date range. Credit transactions are not included.

Advs2
Billable advances within the selected date range. Credit transactions are not included.

Pymts
All unprocessed payments regardless of date range (not aged, shown as total only). Payments on
hold are included.

Fee Cr1, 2 Fee credits in WIP within the selected date range (not aged, shown as total only). Fee credits will
only be shown if fees are included on the report.

Exp Cr1, 2 Expense credits in WIP within the selected date range (not aged, shown as total only). Expense
credits will only be shown if expenses are included on the report.

Adv Cr1, 2 Advance credits in WIP within the selected date range (not aged, shown as total only). Advance
credits will only be shown if advances are included on the report.

FeeWIP1, 2 Total fee transactions and fee credits in WIP excluding Type 6 transactions (only shown for progress
fee clients).

Progress Billed1 Total amount of Type 6 progress fees billed since the last time the client was “reconciled.”

Diff in WIP1 Fee WIP minus Progress Billed.

Progress WIP1
Total amount of Type 6 progress fees in work-in-process. Credit transactions and transactions on
hold are included. Progress WIP Tax is not included.

Progress Paid1 Progress Billed (from the A/R & Fund Balances tab in the Client file) minus Progress Fees Due.
(timekeeper) Primary timekeeper number and initials are shown when the report is not printed in
timekeeper order.

Note: Threshold billing amounts can optionally be entered on the Billing Options tab of the Client file. If you elect to include
clients that do not meet billing thresholds on the Aged Work-In-Process Report, a message will be included if an amount does
not meet the client’s billing threshold.

1Not shown on the sample report.
2 Transactions on hold are included. Non-billable transactions are not included.
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Cash Receipts Report

Date: 11/28/2016 Tabs3 Summary Cash Receipts Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 1 Michael L. Jensen

Amount Fees Fin Chg Expenses Advances Unallocated

100.00M  Phillips/Marcus 2,281.67 1,861.92 0.00 9.75 150.00 0.00
RE: Real Estate Acquisition

Payment Adjustments 260.00

120.00M  Berger/Randall 3,375.00 1,855.00 0.00 646.25 226.00 647.75
RE: Real Estate Investment

200.01M  Peterson Insurance Co. 959.75 826.84 0.00 28.91 104.00 0.00
RE: General Legal Counsel

Totals for Primary Timekeeper 1 6,616.42 4,543.76 0.00 684.91 480.00 647.75
Payment Adjustments 260.00

Date: 11/28/2016 Tabs3 Detail Cash Receipts Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 1 Michael L. Jensen

Pymt Date Amount Fees Fin Chg Expenses Advances Unallocated

100.00M  Phillips/Marcus 05/12/2016 300.00 F 300.00 0.00 0.00 0.00 0.00
RE: Real Estate Acquisition 09/08/2016 700.00 F 700.00 0.00 0.00 0.00 0.00

09/09/2016 587.67 511.92 0.00 0.75 75.00 0.00
09/22/2016 25.00 F 25.00 0.00 0.00 0.00 0.00
10/11/2016 50.00 F 50.00 0.00 0.00 0.00 0.00
10/11/2016 75.00 A 0.00 0.00 0.00 75.00 0.00
10/13/2016 150.00 F 150.00 0.00 0.00 0.00 0.00
10/13/2016 9.00 E 0.00 0.00 9.00 0.00 0.00
10/17/2016 125.00 F 125.00 0.00 0.00 0.00 0.00
10/21/2016 260.00 * 0.00 0.00 0.00 0.00 0.00

Subtotal 2,281.67 1,861.92 0.00 9.75 150.00 0.00
Payment Adjustments 260.00

120.00M  Berger/Randall 12/27/2015 350.00 163.75 0.00 111.25 75.00 0.00
RE: Real Estate Investment 01/04/2016 500.00 F 500.00 0.00 0.00 0.00 0.00

01/04/2016 100.00 E 0.00 0.00 100.00 0.00 0.00
01/04/2016 50.00 A 0.00 0.00 0.00 50.00 0.00
02/03/2016 450.00 85.00 0.00 365.00 0.00 0.00
03/04/2016 1,000.00 829.00 0.00 70.00 101.00 0.00
04/01/2016 75.00 * 75.00 0.00 0.00 0.00 0.00
05/02/2016 150.00 F 127.25 0.00 0.00 0.00 22.75
06/06/2016 300.00 40.00 0.00 0.00 0.00 260.00
06/15/2016 75.00 35.00 0.00 0.00 0.00 40.00
07/01/2016 75.00 E 0.00 0.00 0.00 0.00 75.00
07/01/2016 250.00 0.00 0.00 0.00 0.00 250.00

Subtotal 3,375.00 1,855.00 0.00 646.25 226.00 647.75

200.01M  Peterson Insurance Co. 10/13/2016 959.75 826.84 0.00 28.91 104.00 0.00
RE: General Legal Counsel

Totals for Primary Timekeeper 1 6,616.42 4,543.76 0.00 684.91 480.00 647.75
Payment Adjustments 260.00
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Date: 11/28/2016 Tabs3 Detail Cash Receipts Report Page: 1
Jensen, Martin & Anderson, P.C.

Payments From 01/01/2016 

Pymt Date Amount Fees Fin Chg Expenses Advances Unallocated Ref #

120.00M  Berger/Randall 02/03/2016 450.00* 371.25 0.00 42.75 36.00 0.00 1 MLJ ARCH
RE: Real Estate Investment 254.19003 Ronald P. Anderson Miscellaneous 9.87 Miscellaneous6.00

100.34004 Nicole Sampson Phone 32.88 Processor Fees30.00
16.72005 William Riley

03/03/2016 1,000.00 520.00 0.00 400.00 80.00 0.00 ARCH
520.00003 Ronald P. Anderson Miscellaneous 288.44 Witness Fees80.00

Phone 111.56
04/01/2016 75.00 75.00 0.00 0.00 0.00 0.00 ARCH

18.21001 Michael L. Jensen
8.19002 Jennifer A. Martin
5.83003 Ronald P. Anderson

16.38004 Nicole Sampson
7.28005 William Riley

19.11006 Candace T. Stone
05/02/2016 150.00 150.00 0.00 0.00 0.00 0.00 8

33.08001 Michael L. Jensen
14.88002 Jennifer A. Martin
19.99003 Ronald P. Anderson
33.48004 Nicole Sampson
13.85005 William Riley
34.72006 Candace T. Stone

06/07/2016 300.00 0.00 0.00 0.00 0.00 300.00 9
07/01/2016 75.00* 75.00 0.00 0.00 0.00 0.00 ARCH

51.35003 Ronald P. Anderson
20.27004 Nicole Sampson
3.38005 William Riley

07/01/2016 250.00 0.00 0.00 0.00 0.00 250.00 12

Payment Adjustments: 07/01/2016 -40.00 -31.25 0.00 -2.75 -6.00 0.00
-14.19003 Ronald P. Anderson Miscellaneous -0.87 Miscellaneous-5.00
-10.34004 Nicole Sampson Phone -1.88 Processor Fees-1.00
-11.72005 William Riley

Subtotal 2,260.00 1160.00 0.00 440.00 110.00 550.00
51.29001 Michael L. Jensen Miscellaneous 297.44 Witness Fees80.00
23.07002 Jennifer A. Martin Phone 142.56

837.17003 Ronald P. Anderson
160.13004 Nicole Sampson
26.13005 William Riley
53.83006 Candace T. Stone

GRAND TOTALS
2,260.00 1160.00 0.00 400.00 80.00 550.00

51.29001 Michael L. Jensen Miscellaneous 297.44 Witness Fees80.00
23.07002 Jennifer A. Martin Phone 142.56

837.17003 Ronald P. Anderson
160.13004 Nicole Sampson

26.13005 William Riley
53.83006 Candace T. Stone

Task Folder Reports | Management Reports | Cash Receipts

The reports shown on page 63 and page 64 are Cash Receipts Reports. The Cash Receipts Report shows payments in a specified
payment date range. The report optionally breaks down payments into Fees, Finance Charge, Expenses, Advances, and
Unallocated columns based on how the payments are allocated. Optionally, a further breakdown displays payment allocation to
individual timekeepers and cost types. Payment adjustments are optionally included and shown as separate line items. The
report includes payments from the ledger file and from work-in-process. Credits are not included in these amounts. The report is
first sorted by Client ID or Client Name Search and then by payment transaction date.

The Options tab includes a selection to make the report detailed or summary, a beginning and ending date range for payments,
and the options to include detailed payment allocation information, payment adjustments, and reference numbers.

Definitions for Cash Receipts Report
Date (heading) Used for reference only and has no bearing on the report.

Date range (heading) Shows the beginning and ending payment dates used for the report (if a range was specified).

(client) Client ID, client name and work description. The letter after the Client ID represents the billing
frequency. An asterisk preceding the work description indicates that the work description will not
print on the client’s statement.1

Pymt Date Payment transaction date.

Amount Amount of the payment. The letter following the payment amount indicates the payment type: “F”
indicates a fee payment (Type “2”), “E” indicates an expense payment (Type “3”), and “A” indicates
an advance payment (Type “3”). No letter indicates a regular payment (Type “1”). If a payment
adjustment has been made for a payment, an asterisk will be displayed next to the payment amount
on a Detail Cash Receipts Report. Because the amount shown in the Amount column represents the
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actual payment amount, you will find that when including the breakdown of applied payments, if
you add Fees + Fin Chg + Expenses + Advances + Unallocated, this amount will not match the
actual payment amount when a payment adjustment has been made.

Type/Check #1 Optional column. Identifies whether a payment is cash, check, credit card, client funds, or other.

Fees Optional column. Amount of the payment allocated to fees.

Fin Chg Optional column. Amount of the payment allocated to finance charge.

Expenses Optional column. Amount of the payment allocated to expenses.

Advances Optional column. Amount of the payment allocated to advances.

Unallocated Optional column. Amount of the payment that is unallocated.

Ref # Optional column. Reference number of payment transaction. This number can be used to retrieve
the payment from the payment file. “ARCH” indicates the payment has been billed and updated
(i.e., processed) and is in the archive file. Payments in the archive file cannot be directly edited.

Payment Allocation
Timekeeper & Cost Type
Information

Optional detailed payment allocation information. Selecting the Allocation Breakdown check box
on the Options tab shows the amounts allocated by timekeeper and cost type.

(timekeeper) Primary timekeeper number and initials are shown when the report is not printed in timekeeper
order.

1Not shown on the sample report.

Write-Up/Write-Down Report
Date: 11/28/2016 Tabs3 Write-Up/Write-Down Report Page: 1

Jensen, Martin & Anderson, P.C.

Write-Up Write-Down
Courtesy

Client Name/Description Fees Expenses Advances Fees Discount Expenses Advances Net

101.00M Williams/John 250.00 0.00 0.00 0.00 0.00 0.00 0.00 250.00 002 PAM
State v. Williams

102.00M Gilbert/Andrew C. 250.00 0.00 0.00 0.00 0.00 0.00 0.00 250.00 002 PAM
Auto Accident

121.01M Phillips/Marcus 0.00 0.00 0.00 575.00 0.00 0.00 0.00 -575.00 001 MLJ
Real Estate Acquisition

200.01M Peterson Insurance Co. 0.00 388.00 0.00 0.00 0.00 0.00 0.00 388.00 001 MLJ
General Legal Counsel

500.00 388.00 0.00 575.00 0.00 0.00 0.00 313.00

Date: 11/28/2016 Tabs3 Write-Up/Write-Down Report Page: 1
Jensen, Martin & Anderson, P.C.

Write-Up Write-Down
Hours Hours Courtesy

Client Name/Description Hours Value Fees Expenses Advances Hours Value Fees Discount Expenses Advances Net

101.00M Williams/John 0.00 0.00 250.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 250.00 002 PAM
State v. Williams

102.00M Gilbert/Andrew C. 0.00 0.00 250.00 0.00 0.00 1.00 250.00 0.00 0.00 0.00 0.00 0.00 002 PAM
Auto Accident

120.01M Klein/Daniel P. 3.10 623.35 0.00 0.00 0.00 0.00 0.00 623.35 0.00 0.00 0.00 0.00 003 RPA
Klein vs. Simmons Construction

121.01M Phillips/Marcus 0.00 0.00 0.00 0.00 0.00 0.00 0.00 575.00 0.00 0.00 0.00 -575.00 001 MLJ
Real Estate Acquisition

200.01M Peterson Insurance Co. 0.00 0.00 0.00 388.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 388.00 001 MLJ
General Legal Counsel

3.10 623.35 500.00 388.00 0.00 1.00 250.00 1,198.35 0.00 0.00 0.00 63.00

Task Folder Reports | Transaction Reports | Write-Up/Down Report

The Write-Up/Write-Down Report includes write-ups, write-downs and net write-up/write-down by timekeeper for each client
for a specified transaction or statement date range. Write-ups/write-downs can be generated several ways including the Write-
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Up/Write-Down Fees and Costs program, Adjust Flat Fee Clients program, Courtesy Discount, or by editing transactions. The
write-up and write-down amounts are broken down by hours, fees, expenses, and advances. Amounts for courtesy discounts
and the value of hour write-ups and write-downs are shown.

The Options tab includes parameters that enable you to include billed transactions (from the archive files), include unbilled
transactions (from work-in-process), include hours, specify a range of working timekeepers and specify a date range of
transactions to include, as well as choose portrait or landscape orientation. If hours are included, then separate columns for
Hours and Hours Value will be included on the report. Additionally, the Net figure on the report will change depending on
whether the Hours are included because the Hours Value will be included.

Definitions for Write-Up/Write-Down Report
Date (heading) Used for reference only and has no bearing on the report.

date range (heading)1 Shows the beginning and ending transaction dates used for the report (if a range was specified).

Client Client ID. The letter after the Client ID represents the billing frequency.

Name Client name.

Description Client’s work description. An asterisk preceding the work description indicates the work description
will not be printed on the client’s statement.1

Write-Up Hours2 Total hour write-ups within the selected date range. This number is the difference between Hours to
Bill and Hours Worked.

Write-Up Hours Value2 Total write-up amount based on hours worked [i.e., Amount minus (rate x hours worked) within the
specified date range].

Write-Up Fees Total fee write-ups within the selected date range.

Write-Up Expenses Total expense write-ups within the selected date range.

Write-Up Advances Total advance write-ups within the selected date range.

Write-Down Hours2 Total hour write-down within the selected date range. This number is the difference between Hours
to Bill and Hours Worked.

Write-Down Hours
Value2

Total write-down amount based on hours worked [i.e., Amount minus (rate x hours worked) within
the specified date range].

Write-Down Fees Total fee write-downs within the selected date range.

Courtesy Discount Total courtesy discount adjustment within selected date range.

Write-Down Expenses Total expense write-downs within the selected date range.

Write-Down Advances Total advance write-downs within the selected date range.

Net Total write-ups and write-downs. Includes Hours Value when Hours are included on the report. A
negative figure indicates a net write-down.

(timekeeper) Primary timekeeper number and initials are shown when the report is not printed in timekeeper
order.

1Not shown on the sample report.
2Only shown on the report if Hours are included on the report.
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Write-Up/Write-Down Verification List

Date: 11/28/2016 Write-Up/Write-Down Verification List Page: 1
Jensen, Martin & Anderson, P.C.

User: (BLANK) Blank User

Client Name/Description Type Old Total New Total Write-Up/Down

101.00 Williams/John                                     Fee 1,250.00 1,500.00 250.00
State v. Williams                                 Hours 5.00 5.00 0.00
Dated Thru 10/31/16
Timekeeper: 1 to 1

102.00 Gilbert/Andrew C.                                 Fee 1,500.00 1,000.00 -500.00
Auto Accident                                     Hours 6.00 6.00 0.00
Dated Thru 10/31/16
Timekeeper: 1 to 1

102.00 Gilbert/Andrew C.                                 Fee 1,000.00 1,500.00 500.00
Auto Accident                                     Hours 6.00 5.00 -1.00
Dated Thru 10/31/16
Timekeeper: 1 to 1

200.01 Peterson Insurance Co.                            E/A 12.00 400.00 388.00
General Legal Counsel

120.01 Klein/Daniel P.                                   Fee 1,387.00 1,387.00 0.00
Klein vs. Simmons Construction                    Hours 6.90 10.00 3.10

Totals Amount 5,149.00 5,787.00 638.00
Hours 23.90 26.00 2.10

Task Folder Transactions | Write-Up/Down | Esc

The Write-Up/Write-Down Verification List includes old and new totals for fees and/or cost transactions written up or down by
the Write-Up/Write-Down program by a specific user. When fees are adjusted, the hours are listed as well. Hours can also be
written up or down. If the Write-Up/Write-Down program was run with a specific transaction date range, the date range is
included below the client’s Work Description.

Definitions for Write-Up/Write-Down Verification List
Client Client ID for which the write-up/write-down was performed.

Type The type of transaction written up or written down. If both expenses and advances were adjusted,
this field will read E/A.

Old Total Transaction total prior to any write-ups/write-downs.

New Total Transaction total after any write-ups/write-downs.

Write-Up/Down The total amount written up or written down.
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Payment Adjustment Verification List

Date: 11/28/2016 Tabs3 Payment Adjustment Verification List Page: 1
Jensen, Martin & Anderson, P.C.
User: SUSAN Susan C. Long

Payment Apply to Total
Client Ref # Type Date Amount Stmt # Stmt # Applied

100.00 4 Fee 09/19/2016 300.00 373 0 300.00
Date of Adjustment: 09/19/2016

Stmt # Fees Expenses Advances Fee Tax Exp Tax Adv Tax Fin Chg Total

373 300.00 300.00

Payment Apply to Refund
Client Ref # Type Date Amount Stmt # Stmt # Amount

102.00 14 Regular 09/29/2016 150.00 393 0 85.00

Task Folder Transactions | Payment Adjustment | Esc

The Payment Adjustment Verification List shows the payments that have been reversed or refunded using the Payment
Adjustment program. The list shows detailed information about each payment that was adjusted. This list is a temporary list and
will be deleted if it is not printed at the time the payment is reversed or refunded.

Definitions for Payment Adjustment Verification List
Client Client ID for which the payment was adjusted.

Ref # Reference number assigned to the payment ledger record.

Type Payment type. Available payment types include “Regular,” “Fee,” “Expense”, or “Advance.”

Date Date of the original payment.

Payment Amount Payment amount.

Stmt # Statement number on which the payment was processed.

Apply to Stmt # Statement number entered on the payment transaction. If no statement number was specified when
the payment was entered, “0” will be shown.

Refund Amount Amount of the refund (shown for refunds only).

Total Applied Portion of the payment that had been applied to fees and costs (shown for reversals only).

Date of Adjustment The date used as the Date of Adjustment.

Stmt # / Fees / Expenses
/ Advances / Fee Tax /
Exp Tax / Adv Tax / Fin
Chg / Total

The statement numbers and amounts the payment applied to will be shown for each payment
reversal. The total amount shown will equal the Total Applied amount shown above.
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Split Billing Verification List

Date: 11/28/2016 Split Billing Verification List Page: 1
Jensen, Martin & Anderson, P.C.
User: CATHY Cathleen Trudore

Adjusted for Client: 415.00 MegaConstruction Corporation
RE:  Corporate Merger - Megabuilders and BuilderCorp

Batch #: 1

Hours Hours
Client Tmkr Cat Date Src BC RC Tcode Rate to Bill Worked Amount

Adjusting Transaction:
415.00 6 40 

11/11/2016 B 0 0 1 180.00 6.25 6.25 1,125.00 MegaConstruction Corporation
Prepare Employee Handbook

415.00 6 40 

11/11/2016 b 0 0 1 180.00 3.13 3.13 562.50 MegaConstruction Corporation
416.00 6  40  

11/11/2016  b 0 0 1 180.00 3.12 3.12 562.50 Tatiki, Sr./James R.

Total 6.25 6.25 1,125.00

Adjusting Transaction:
415.00 1 40 

11/17/2016  B 0 0 1 500.00 1.00 1.00 500.00 MegaConstruction Corporation
Prepare Employee Handbook

415.00 1 40 

11/17/2016  b 0 0 1 500.00 0.50 0.50 250.00 MegaConstruction Corporation
416.00 1 40 

11/17/2016  b 0 0 1 500.00 0.50 0.50 250.00 Tatiki, Sr./James R.

Total 1.00 1.00 500.00

Adjusting Transaction:
415.00 7 40 

11/10/2016  B 0 0 1 180.00  4.25 4.25 765.00  MegaConstruction Corporation
Prepare Financial Disclosure Form

415.00 7 40 

11/10/2016  b 0 0 1 180.00 2.13 2.13 382.50 MegaConstruction Corporation
416.00 7 40 

11/10/2016  b 0 0 1 180.00 2.12 2.12 382.50 Tatiki, Sr./James R.

Total                        4.25       4.25        765.00

Final record count for Client:  3

Task Folder Statement Preparation | Perform Split Billing | Esc

The Split Billing Verification List shows the transactions that were adjusted by the Perform Split Billing program. The list shows
the original transaction that was entered for the Main Client, and then shows the transactions that were created for the specified
Split Matters as a result of running the Perform Split Billing program. For each Main Client, fees are printed followed by the
expenses and advances.

Definitions for Split Billing Verification List
Client Client ID. The client name will print to the right of the Amount column.

Tmkr (fees) Timekeeper number.

Cat (fees) Category number.

Exp/Adv (costs)1 “E” = Expenses, “A” = Advances.

Date Date of the transaction.

Src Source of the transaction. “B” = Billing, “R”1 = Tabs3 Remote, “P”1 or “C”1 = PracticeMaster, “D”1 =
Data Capture Device, “A”1 = Tabs3 Accounts Payable Software, “Q”1 = QuickBooks. An uppercase
letter indicates that the transaction was split from the Main Client, while a lowercase letter indicates
that the transaction was added to a Split Matter.

BC Bill Code (0-4). The Bill Code defines the transaction code’s default billing and print status. “0” =
billable and printable. “1”1 = non-billable and non-printable, “2”1 = non-billable and printable, “3”1
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= billable and non-printable, and “4”1 = billable and always print.

RC (fees) Rate Code (0-9). The Rate Code indicates which billing rate Tabs3 uses. “0” indicates that Tabs3 has
used the default billing rate.

RC (costs)1 Rate Code (0, 7 or 8). The Rate Code indicates how the Amount is determined. “0” indicates that the
operator entered the amount. “7” indicates that Tabs3 retrieved the Rate from the transaction code
file, allowed the operator to enter the number of units, and then calculated the amount. “8”
indicates that Tabs3 retrieved the Amount from the transaction code file.

Tcode Transaction code number.

Rate Rate used for calculating the amount.

Hours to Bill (fees) Hours to bill.

Hours Worked (fees) Hours worked.

Amount Dollar amount for the transaction.

Total Total hours (fees only) and amounts of the resulting split fee transactions.

Deleted Transaction1 A transaction is deleted when the Perform Split Billing program is run if the Main Client is not
defined as a Split Matter.

Saved Transaction1 A transaction is saved when the Perform Split Billing program is run if the Main Client is not defined
as a Split Client and the transaction has “Save” in the Status field. The Hours and Amount fields are
changed to 0.00.

Final Record Count for
Client

Number of resulting transactions after the Perform Split Billing program has been run.

1Not shown on the sample report.
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Statement Template List

Date: 11/28/2016 Tabs3 Statement Template List Page: 1

Jensen, Martin & Anderson, P.C.

ID Description

Contngcy no fee amounts/standard costs
Draft full detail used for draft statements Default: Draft
Final standard fee & cost format (no recap) Default: Final  
Hours detail hrs (no amt)/total amt/std costs
Invoice no fee recap/subtotal costs by tcode
Recap detail format including timekeeper recap
Summary standard fees (w/totals only)/std costs

Date: 11/28/2016 Tabs3 Statement Template List Page: 1
Jensen, Martin & Anderson, P.C.

ID: Draft     full detail used for draft statements Default: Draft

Statement Type: Statement
Print Past Due Message: Aged Billing History: History with Hours
Beginning Note: Ending Note:
Include Notes for Each File: Yes Include Notes on Cover: Yes
Print Statement Comments on Draft Statements: Yes
Fee Format Code: Standard Include Date on Fees: Yes
Include Timekeeper Initials: Yes Include Description: Yes
Include Rate: Yes Total Non-billable Hours: Yes
Fee Hour Code: Detail Fee Amount Code: Detail
Paragraph Format: No Paragraph Fee Subtotal Format: No Subtotal
Fee Recap Format: Timekeeper
Include Level Desc in Recap: No Include Hours in Recap: Yes
Include Total in Recap: Yes Include Rate in Recap: Indiv. Rate
Expense Format: Standard Advance Format: Standard
Payment Format: Detail

Page 1 Layout:
Page 2 Layout:
Envelope Layout:
Cover Layout:

ID: Final     standard fee & cost format (no recap) Default: Final 

Statement Type: Statement
Print Past Due Message: Aged Billing History: Include History
Beginning Note: Payments Ending Note:
Include Notes for Each File: Yes Include Notes on Cover: Yes
Print Statement Comments on Draft Statements: Yes
Fee Format Code: Standard Include Date on Fees: Yes
Include Timekeeper Initials: Yes Include Description: Yes
Include Rate: No Total Non-billable Hours: Yes
Fee Hour Code: Detail Fee Amount Code: Detail
Paragraph Format: No Paragraph Fee Subtotal Format: No Subtotal
Fee Recap Format: No Recap
Include Level Desc in Recap: No Include Hours in Recap: Yes
Include Total in Recap: Yes Include Rate in Recap: Avg. Hourly
Expense Format: Standard Advance Format: Standard
Payment Format: Detail

Page 1 Layout: Final Statements | Page 1
Page 2 Layout: Final Statements | Continuation Pages
Envelope Layout: Final Statements | Envelope
Cover Layout: Final Statements | Cover Sheet
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Date: 11/28/2016 Tabs3 Statement Template List Page: 1
Jensen, Martin & Anderson, P.C.

ID: Draft     full detail used for draft statements Default: Draft

Client Name Work Description

D 100.00M Dawson/Charles L. Settlement of Grandfather's Estate
D 101.00M Barrett/Karen Apartment Management
D 102.00M Richardson/Harold Manage personal finances
D 103.00M Martin/Mary L. & Fred J. Private Adoption
D 200.01M I Jefferson Insurance Co. Automobile Accident
D 200.02C Jefferson Insurance Co. Hail Damage - Palmer farm
D 200.03M Jefferson Insurance Co. Acquisition of Mid-State Insurance
D 300.00Q McBride/John Management of Estate Trust
D 350.00M Carter/Arthur J. Protection of New Wave Patent
D 400.00R Lutz/Jody Manage trust account for Jody
D 402.00M Kiltzer/George Set up trust for children
D 450.00M Able/Paul & Mary Parent's Estate
D 500.00M I Lyons/Mr. & Mrs. Art Audit of Federal Income Taxes
D 550.00M Federated Casualty, Ltd. Andrew C. Gilbert v. Federated Casualty
D 600.00M Ace Manufacturing Company General Legal Counsel
D 600.01M Ace Manufacturing Company Workers' compensation claim
D 600.02M Ace Manufacturing Company Maintenance of insurance policies
D 750.00M Harrison Investments Purchase of Real Estate
D 751.00M Harrison/Bradley Purchase of Real Estate
D 800.00S ABC Insurance Company Death Benefits
D 850.00H White/Kelly Divorce
D 900.00M Sherman/Natalie K. Divorce

ID: Final     standard fee & cost format (no recap) Default: Final 

Client Name Work Description

F 103.00M Martin/Mary L. & Fred J. Private Adoption
F 200.01M I Jefferson Insurance Co. Automobile Accident
F 300.00Q McBride/John Management of Estate Trust
F 350.00M Carter/Arthur J. Protection of New Wave Patent
F 450.00M Able/Paul & Mary Parent's Estate
F 550.00M Federated Casualty, Ltd. Andrew C. Gilbert v. Federated Casualty
F 600.00M Ace Manufacturing Company General Legal Counsel
F 600.01M Ace Manufacturing Company Workers' compensation claim
F 600.02M Ace Manufacturing Company Maintenance of insurance policies
F 800.00S ABC Insurance Company Death Benefits

Task Folder Reports | File Lists | Template Lists | Statement Template List

The reports shown on pages 71-72 are examples of the Statement Template List. The Statement Template List shows the
statement templates that have been defined in the statement template file. The top report on the previous page simply lists the
statement templates that have been defined. The bottom report on the previous page shows the detailed options that have been
defined for each statement template (i.e., the Include Detail Template Information check box is selected). The report shown
above lists the statement templates that have been defined along with the clients that are assigned to each template (i.e., the
Include Clients Assigned to Each Template check box is selected).

Definitions for Statement Template List
ID Statement template ID. The statement template ID can be a maximum of 8 characters. The statement

template ID is followed by the statement template description.

Default: Draft (Shown to the right of the Template ID and Description.) This label will print for the default
statement template for draft statements.

Default: Final (Shown to the right of the Template ID and Description.) This label will print for the default
statement template for final statements.

Client Client ID. The letter after the Client ID represents the billing frequency.

(D/F) If the statement template is assigned as the draft statement template for the client, the letter “D” will
print in the leftmost column in front of the Client ID. If the statement template is assigned as the
final statement template for the client, the letter “F” will print in the leftmost column in front of the
Client ID.

I Inactive clients are indicated by the letter “I” following the billing frequency.
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Name Client Name.

Work Description Client work description.

E-mail Template List

Date: 11/28/2016 Tabs3 E-mail Template List Page: 1
Jensen, Martin & Anderson, P.C.

Template ID Description Use as Default

EXAMPLE Example Template Yes
EXAMPLE2 Alternate Example Template No

Task Folder Reports | File Lists | Template Lists | E-mail Template List

The reports shown are examples of the E-mail Template List. The E-mail Template List shows the e-mail templates that have been
defined in the e-mail template file. The top report simply lists the statement templates that have been defined. The second report
shows the detailed options that have been defined for each e-mail template (i.e., the Include Detail Template Information
check box is selected). The report shown above lists the statement templates that have been defined along with the clients that
are assigned to each template (i.e., the Include Clients Assigned to Each Template check box is selected).

Template ID: EXAMPLE
Description: Example Template
Use as Default: Yes

Client Client Name Work Description

100.00 Larson/Michael Larson v. Bel-Cor

Template ID: EXAMPLE2
Description: Alternate Example Template
Use as Default: No

Client Client Name Work Description

101.00 Williams/John State v. Williams
415.00 MegaConstruction Corporation Corporate Merger - Megabuilders and BuilderCorp
850.00 White/Kelly Divorce
850.01 White/Kelly Last Will & Testament
850.02 White/Kelly Medical Care of Brianne

Date: 11/28/2016 Tabs3 E-mail Template List Page: 1
Jensen, Martin & Anderson, P.C.

Definitions for E-mail Template List
Template ID E-mail template ID. The e-mail template ID can be a maximum of 20 characters.

Description The description entered for the e-mail template ID.

Use as Default "Yes" will print for the default e-mail template for new Bill To records. "No" will print for all other e-
mail templates.

E-mail Identification From Name, From Address, and Reply to Address defined for the e-mail template.

Additional Recipients Cc Recipients and Bcc Recipients defined for the e-mail template. Displays e-mail addresses for
those who will receive a copy or a blind copy of the client’s e-mail statement.

E-mail Message Subject and Body defined for the e-mail template. Variables will print within chevron characters.

Client Client ID of the client associated with the e-mail template. In the client file, the e-mail template is
defined in the Bill To record(s) listed in the Statement Delivery Options table on the Billing
Preferences tab.

Client Name Client name.
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Work Description Client work description.

Template ID: EXAMPLE
Description: Example Template
Use as Default: Yes

From Name: Jennifer A. Martin
From Address: jmartin@lawoffice.com
Reply to Address: billing@lawoffice.com

Cc Recipients:
Bcc Recipients: billing@lawoffice.com

Subject: Your statement from «Firm Name» is attached.

Body: Dear «Bill To Full Name»,
 
Your current statement dated «Statement Date» is attached.
 
Sincerely,
 
«Primary Timekeeper Name»
«Firm Name»
 
«User Initials»
 
This communication, along with any attachments, is covered by federal and state law governing electronic communications
and may contain confidential and legally privileged information. If the reader of this message is not the intended recipient,
you are hereby notified that any dissemination, distribution, use or copying of this message is strictly prohibited. If you have
received this in error, please reply immediately to the sender and delete this message.

Template ID: EXAMPLE2
Description: Alternate Example Template
Use as Default: No

From Name: Michael L. Jensen
From Address: mjensen@jensenlaw.com
Reply to Address: admin@jensenlaw.com

Cc Recipients:
Bcc Recipients: admin@jensenlaw.com

Subject: Invoice «Statement Number» for «Work Description»

Body: Client: «Client Full Name»
Matter: «Work Description»
 
Dear «Bill To Full Name»,
 
Thank you for your previous payment of $«Last Payment Amount», which was received on «Last Payment Date».
 
Your current statement dated «Statement Date» is attached. Please remit $«Balance Due».
 
We appreciate the opportunity to serve your legal needs.
 
Sincerely,
 
«Primary Timekeeper Name»
«Firm Name»
«Firm Address»
 
«Firm Phone Number»
 
Adobe Reader must be installed to view the attached statement. The free Adobe Reader software can be downloaded at
«Adobe Reader Link».
 
This communication, along with any attachments, is covered by federal and state law governing electronic communications
and may contain confidential and legally privileged information. If the reader of this message is not the intended recipient,
you are hereby notified that any dissemination, distribution, use or copying of this message is strictly prohibited. If you have
received this in error, please reply immediately to the sender and delete this message.

Date: 11/28/2016 Tabs3 E-mail Template List Page: 1
Jensen, Martin & Anderson, P.C.
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Statement Notes List

Date: 11/28/2016 Tabs3 Statement Notes List Page: 1
Jensen, Martin & Anderson, P.C.

Note ID Note Text

Finance A finance charge of 1% per month will be assessed on all accounts past due 30
days.

Payments Payments received after \S are not included on this statement.

Task Folder Reports | File Lists | Statement Notes List

The Statement Notes List shows the statement notes that have been defined in the statement notes file. Statement notes can be
assigned to statement templates and can print at either the top or bottom of the statement.

Definitions for Statement Notes List
Note ID Statement Note ID. The Statement Note ID can be a maximum of 8 characters.

Note Text The statement text. Up to 511 characters of text can be entered for each statement note.
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Statement Example 1

1621 Cushman Drive
Lincoln, NE  68512

° Fax ° E-mail billing@jmalaw.com
STATEMENT

A Law Firm Specializing in Personal Injury, Business and Family Law Federal ID No. 01-23456789

PRIVILEGED & CONFIDENTIAL

Account No.
RE:

Statement Date:
Statement No.

Page No.

To ensure proper credit, please include account number and statement date on remittance checks.  Thank you.

 

JENSEN, MARTIN & ANDERSON, P.C.

402-423-1440 402-423-2561

Jefferson Insurance Co.
American Charter Building
9th & West 'O' Streets
Suite 220
Lincoln, NE   68510-6330

200.03
Acquisition of Mid-State Insurance

11/30/2016
661

1

DRAFT STATEMENT
Fees

Rate Hours
11/21/2016 MLJ Put together proposal for Mid-State Insurance

Company. 225.00 3.50 787.50 1
PAM Office conference with Sam Reader. 160.00 1.25 200.00 2

11/22/2016 PAM Office conference with Peter Smith. 0.75 n/c 3
For Current Services Rendered 4.75 987.50
Total Non-billable Hours 0.75

Recapitulation
Timekeeper Hours  Rate  Total
Michael L. Jensen 3.50 $225.00 $787.50
Paula A. Madison 1.25 160.00 200.00

Sales Tax on Services 39.50

Expenses

10/11/2016 Long distance telephone charges. 25.52 1
11/21/2016 Mileage to/from Omaha. 100 miles @ 30 cents/mile 30.00 3

Total Expenses 55.52

Advances

10/11/2016 Processor fee. 35.00 2
Total Advances 35.00

Previous Balance $1,461.29

Total Current Work 1,117.52

Payments

11/11/2016 Payment - thank you. -500.00 1

Balance Due $2,078.81

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials Yes
Description Yes
Rate Yes
Total Non-bill Hrs Yes

Hours Detail
Amount Detail
Paragraph No Paragraph
Subtotal No Subtotal

Fee Recap Timekeeper
Hours Yes
Total Yes

Level Desc No
Rate Calculated Rate

Expense Format Standard

Advance Format Standard

Pymt Format Detail

Other Settings Summary
Letterhead Statement Designer custom page
layout, draft statement with reference numbers,
and statement comments.

Format Information
The statement shown above is a draft statement with reference numbers printed on the statement. A custom page layout
created using the Statement Designer includes a header and footer and also controls the starting position of the body of the
statement. Draft statements use the value entered in Line 3 of the Terminology tab of the Statement Customization window to
indicate that the statement is being run in draft format. The value for Line 3 can be changed as desired. The statement template
has been configured to include statement comments on draft statements. (Statement comments are shown with a strikethrough
character and will not be included on final statements.) Sales tax is assessed on fees only. The option to print the number of
hours on non-billable transactions is shown and the non-billable hours are totaled. The previous balance is configured to print
after fees and costs but before the “Total Current Work” line. A fee recap by timekeeper and rate is shown. (Note: Non-billable
hours are not included in the recap.)

Note: Duplicate statements, e-mail statements, and envelopes are not generated when draft statements are run. However,
cover statements are generated.
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Statement Example 2

Attorneys at Law

RE:

Page No.

Statement Date:

Statement No.
Account No.

1621 Cushman Drive ° Lincoln, NE  68512 ° Fax°

 

Jensen, Martin & Anderson, P.C.

Jefferson Insurance Co.
American Charter Building
9th & West 'O' Streets
Suite 220
Lincoln, NE   68510-6330

Acquisition of Mid-State Insurance

1

11/30/2016

651
200 03

402-423-1440 402-423-2561

Fees

11/21/2016 Put together proposal for Mid-State Insurance Company. 787.50

11/21/2016 Office conference with Sam Reader. 200.00

11/22/2016 Office conference with Peter Smith.
For Current Services Rendered 987.50

Recapitulation
Timekeeper Hours
Michael L. Jensen 3.50
Paula A. Madison 1.25

Sales Tax on Services 39.50

Expenses

10/11/2016 Long distance telephone charges. 25.52
11/22/2016      Mileage to/from Omaha. 30.00

Total Expenses 55.52

11/21/2016 Credit for overbilled mileage expense. -15.00
Total Credits for Expenses -15.00

Advances

10/11/2016 Processor fee. 35.00
Total Advances 35.00

Total Current Work 1,102.52

Balance Due $1,102.52

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials No
Description Yes
Rate No
Total Non-bill Hrs No

Hours No Hours
Amount Detail
Paragraph Date/Timekeeper
Subtotal No Subtotal

Fee Recap Timekeeper
Hours Yes
Total No

Level Desc No
Rate No Rate

Expense Format Standard

Advance Format Standard

Pymt Format n/a

Other Settings Summary
Invoice Statement Designer custom page
layout, expense credit.

Format Information
The Paragraph Format used on the statement shown above causes the fees for each date and each timekeeper to print in
separate paragraphs. A fee recap showing the hours for each timekeeper is included. Sales tax is assessed on fees. An expense
credit is shown. In order for credits to print on invoice format statements (i.e., statements with no previous balance and no
payments), you must select the Print credits on invoice format statements check box on the Options tab of Statement
Customization. This statement was printed using a Statement Designer custom page layout with a header, footer, and watermark
image.
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Statement Example 3

Note: Copy of E-mail only statement. mjohnson@jeffersonins.com

Statement No.

Page:

 

Statement Date               11/30/2016

7576

Jefferson Insurance Co.
American Charter Building
9th & West 'O' Streets
Suite 220
Lincoln, NE   68510-6330

1

Acquisition of Mid-State InsuranceRE:

Attn: Mike Johnson

Fees through 11/30/2016

Hours
11/09/2016

MLJ Put together proposal for Mid-State
Insurance Company 3.50

Michael L. Jensen 3.50

11/14/2016
PAM Office conference with Peter Smith,

insurance salesman for company. 1.75

11/15/2016
PAM Office conference with Sam Reader, Sally

Farrows, and John Darrington. 1.25
PAM Telephone conference with President of

Mid-State Insurance Company n/c

Paula Ann Martin 3.00

For Current Services Rendered 6.50 1,550.00
Total Non-billable Hours 0.50

Recapitulation
Title Hours  Rate  Total
Senior Partner 3.50 $250.00 $875.00
Partner 3.00 225.00 675.00

Sales Tax on Services 108.50

Total Current Work 1,658.50

Balance Due $1,658.50

 

JENSEN, MARTIN & ANDERSON, P.C.

1621 Cushman Drive
Lincoln, NE 68512

402-419-2200

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials Yes
Description Yes
Rate No
Total Non-bill Hrs Yes

Hours Detail
Amount Totals Only
Paragraph No Paragraph
Subtotal Timekeeper

Fee Recap Timekeeper Level
Hours Yes
Total Yes

Level Desc n/a
Rate Average Hourly

Expense Format No Expenses

Advance Format No Advances

Pymt Format n/a

Other Settings Summary
Firm Information Statement Designer
custom page layout and Fee heading.
Previewed e-mail only statement.

Format Information
The statement shown above displays the E-mail Statement footer that is included when a previewed statement for a client set up
to receive statements via e-mail only (i.e., not via mail or both) is printed from the Preview window. The footer allows you to
distinguish between statements that are to be mailed and statements that are sent to the E-mail Statements window to be sent
via e-mail. The footer is not included when a statement is printed directly to the E-mail Statements window.

This statement shows the fees subtotaled by timekeeper. An optional fee heading is shown. The Fee Cut-Off Date is included on
the fee heading line by entering a “\E” code on the fee heading line in Statement Customization (line 9 on the Terminology
tab). Non-billable transactions are indicated by “n/c” in the Amount column. A fee recap by timekeeper level is included. The
timekeeper initials and transaction description print on the line below the transaction date because of the Statement Width
specified in Statement Setup. A wider Statement Width would cause the information to print on the same line. Expenses and
advances are not being billed because of the Expense Format and Advance Format selected. The account number is not
included in the heading and the statement date is not spelled out. The client’s work description is included on the statement.
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Statement Example 4

Attorneys at Law
402-423-1440

Statement Date:
Statement No.

Account No.

Fax ° E-mail billing@jmalaw.com
1621 Cushman Drive ° Lincoln, NE  68512

Page       1402-423-2561

 

JENSEN, MARTIN & ANDERSON, P.C.

Jefferson Insurance Co.
American Charter Building
9th & West 'O' Streets
Suite 220
Lincoln, NE   68510-6330

11/30/2016
653

200.03

Fees

Hours
11/21/2016 Put together proposal for Mid-State Insurance Company. Office

conference with Sam Reader.

11/22/2016 Office conference with Peter Smith.

For Current Services Rendered 4.75 987.50

Recapitulation
Hours  Rate  Total

1.25 $160.00 $200.00
3.50 225.00 787.50

Sales Tax on Services 39.50

Expenses

Long distance telephone charges 25.52
Mileage to/from 30.00
Total Expenses thru 11/30/2016 55.52

Credit for overbilled mileage expense. -15.00
Total Credits for Expenses -15.00

Previous Balance $1,461.29

Total Current Work 1,067.52

Payments

11/11/2016 Payment - thank you. -500.00

Balance Due $2,028.81

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials No
Description Yes
Rate No
Total Non-bill Hrs No

Hours Totals Only
Amount Totals Only
Paragraph Date
Subtotal No Subtotal

Fee Recap Rate
Hours Yes
Total Yes

Level Desc n/a
Rate n/a

Expense Format Tcodes Subtotal Only

Advance Format Tcodes Subtotal Only

Pymt Format Detail

Other Settings Summary
Logo Statement Designer custom page layout
(logo removed), “Previous Balance” line after
fees and costs.

Format Information
The fees on the statement shown above are printed in paragraphs by date. A fee recap by rate is included. Sales tax is assessed
on services. The expenses and advances are subtotaled by transaction code. An expense credit is shown. The Previous Balance is
configured to print after fees and costs but before the “Total Current Work” line. A Statement Designer custom page layout is
used to include a header and footer.
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Statement Example 5

1621 Cushman Drive
Lincoln, NE  68512

° Fax ° E-mail billing@jmalaw.com
STATEMENT

A Law Firm Specializing in Personal Injury, Business and Family Law Federal ID No. 01-23456789

PRIVILEGED & CONFIDENTIAL

Account No.
RE:

Statement Date:
Statement No.

Page No.

To ensure proper credit, please include account number and statement date on remittance checks.  Thank you.

 

JENSEN, MARTIN & ANDERSON, P.C.

402-423-1440 402-423-2561

Karen Barrett
3010 South 14th Street
Lincoln, NE   68510

101.00
Apartment Management

11/30/2016
650

1

Previous Balance $1,085.32

Fees

Rate Hours
11/02/2016 Communicate with George Patterson regarding lease. 0.25 n/c

11/15/2016 Telephone conference with Karen. 225.00 0.50 112.50
Michael L. Jensen 0.50 112.50

11/02/2016 Office conference with Karen. 140.00 2.00 280.00

11/11/2016 Office conference with Karen regarding the payment of
damage deposits collected. 140.00 2.50 350.00
Paula A. Martin 4.50 630.00

For Current Services Rendered 5.00 742.50
Total Non-billable Hours 0.25

Recapitulation
Timekeeper Title Hours  Rate  Total
Michael L. Jensen Partner 0.50 $225.00 $112.50
Paula A. Martin Associate 4.50 140.00 630.00

Finance Charge 5.28

Balance Due $1,833.10

Your account is 30 days past due.

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials No
Description Yes
Rate Yes
Total Non-bill Hrs Yes

Hours Detail
Amount Detail
Paragraph No Paragraph
Subtotal Timekeeper

Fee Recap Timekeeper
Hours Yes
Total Yes

Level Desc Yes
Rate Calculated Rate

Expense Format n/a

Advance Format n/a

Pymt Format n/al

Other Settings Summary
Letterhead Statement Designer custom page
layout, summary past due message, “Total
Current Work” excluded.

Format Information
The statement shown above includes the description, rate, hours and amount for each transaction as well as total hours and
amounts. (Tip: When using this format, you may want to increase the Statement Width in Statement Setup.) The fees are
subtotaled by timekeeper. The fee recap shown includes the timekeeper name, title, hours, rate and amount billed. Expenses and
advances are not billed on this statement. The default “Total Current Work” line has been omitted by placing an asterisk in the
first character position of line 57 on the Terminology tab of Statement Customization. A summary past due message is shown.
Non-billable hours are printed and totaled on this statement. Finance charge is assessed on the previous balance. A Statement
Designer custom page layout is used to include a header and footer.
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Statement Example 6

ATTORNEYS AND COUNSELORS AT LAW
FEDERAL TAX ID #

Lincoln Office Omaha Office

1621 Cushman Drive
Lincoln, Nebraska  68512

(402) 423-1440
Fax:  (402) 423-2561

10400 West Dodge Road
Omaha, Nebraska  68108

(402) 397-1440
Fax:  (402) 397-1441

12-3456789

 

Jensen, Martin & Anderson, P.C.

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Page: 1
Harold Richardson 11/30/2016
1548 West 57th Street Account No: 102-00M
Rochester  NY  14603-8409 Statement No:  572

Manage personal finances
 
 

Previous Balance $3,658.35

Expenses

11/13/2016 Long distance telephone charges 6.75
11/14/2016 Photocopy charges 7.50
11/21/2016 Postage 2.50

Total Expenses 16.75
Sales Tax on Expenses 0.67

Total Current Work 17.42

Balance Due $3,675.77

Past Due Amounts
0-30 31-60 61-90 91-120 121-180 181+

3,243.14 0.00 182.88 249.75 0.00 0.00

 
 
 
 
 
 
 
 
 
 
 
 

Template Settings
Fee Format No Fees
Date n/a
Tmkpr Initials n/a
Description n/a
Rate n/a
Total Non-bill Hrs n/a

Hours n/a
Amount n/a
Paragraph n/a
Subtotal n/a

Fee Recap No Recap
Hours n/a
Total n/a

Level Desc n/a
Rate n/a

Expense Format Standard

Advance Format No Advances

Pymt Format n/a

Other Settings Summary
Aged past due information, Two Offices
Statement Designer custom page layout.

Format Information
Fees and advances are not billed because the Fee Format and Advance Format indicate no transactions are to be billed. An
expense heading is shown. Sales tax is assessed on expenses. Aged past due information is shown at the bottom of the
statement. The firm name and address shown at the top of the statement are part of a Statement Designer custom page layout.
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Statement Example 7

Note: Copy of E-mail only statement. jt@megaconcorp.com

Attn: James R. Tatiki, Sr. Page: 1
James R. Tatiki, Sr. 11/30/2016
PO Box 72345 Account No: 415-00M
201 E 48th Street Statement No:  7576
Manhattan  NY  10017-1538

Corporate Merger - Megabuilders and BuilderCorp

Previous Balance $85,499.22

Fees

Hours
11/07/2016

MLJ Prepare Financial Disclosure Form 4.25 2,125.00
MLJ Receipt of request for changes to documents from company. 0.70 350.00

11/09/2016
MLJ Prepare Notice and Articles of Dissolution for Megabuilder 6.00 3,000.00

11/11/2016
CB Prepare Notice and Articles of Dissolution for BuilderCorp 3.75 675.00
JAN Prepare Pre-Hiring Concerns Checklist 3.00 750.00
ROB Review Status of Case 0.50 375.00

For Current Services Rendered 18.20 7,275.00

Recapitulation
Timekeeper Hours  Rate  Total
Michael L. Jensen 10.95 $500.00 $5,475.00
Robert O. Burns 0.50 750.00 375.00
Cheryl Bradley 3.75 180.00 675.00
Jennifer A. Noonan 3.00 250.00 750.00

Expenses

Total Expenses 21.60

Advances

Total Advances 85.00

Total Current Work 7,381.60

Payments

11/08/2016 Payment -20,000.00

Balance Due $72,880.82

Past Due Amounts
Stmt Date Stmt # Billed Due
09/30/2016 7516 62,831.00 24,929.56
10/31/2016 7523 40,569.66 40,569.66

65,499.22

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials Yes
Description Yes
Rate No
Total Non-bill Hrs No

Hours Detail
Amount Detail
Paragraph No Paragraph
Subtotal No Subtotal

Fee Recap Timekeeper
Hours Yes
Total Yes

Level Desc n/a
Rate Transaction Rate

Expense Format Summary

Advance Format Summary

Pymt Format Detail

Other Settings Summary
Detail past due information.

Format Information
The statement shown above includes the description, hours, amount and Timekeeper initials for each transaction as well as total
hours and amounts. The expenses and advances are shown in summary format. Detail past due information is shown at the
bottom of the statement. A fee recap by timekeeper and individual transaction rate is shown. This statement was previewed for
an e-mail only client, and therefore a footer is included so that when printing from the preview window, statements for e-mail
only clients can be easily identified. The statement attached to the e-mail does not include the footnotes.
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Statement Example 8

 
 
 
 
 
 
 
 
 
 
 
 

For Professional Services Rendered Thru 11/30/2016

Attn: Mike Johnson
Jefferson Insurance Co. 11/30/2016
American Charter Building Account No: 200-03M
9th & West 'O' Streets
Suite 220
Lincoln  NE  68510-6330

Acquisition of Mid-State Insurance

 
 

Fees

Hours
11/21/2016 Put together proposal for Mid-State Insurance Company 3.50

Office conference with Peter Smith, insurance salesman for company. 1.75

11/22/2016 Office conference with Sam Reader, Sally Farrows and John Darrington. 1.25
Telephone conference with President of Mid-State Insurance Company 0.50 n/c
For Current Services Rendered 6.50
Total Non-billable Hours 0.50

Costs

Long distance telephone charges 25.52
Mileage to/from 30.00
Filing fee 15.00
Total Costs 70.52

Total Current Work 70.52

Balance Due $70.52

 

ATTORNEYS AND COUNSELORS AT LAW
FEDERAL TAX ID #

Lincoln Office Omaha Office

1621 Cushman Drive
Lincoln, Nebraska  68512

(402) 423-1440
Fax:  (402) 423-2561

10400 West Dodge Road
Omaha, Nebraska  68108

(402) 397-1440
Fax:  (402) 397-1441

12-3456789

 

Jensen, Martin & Anderson, P.C.

 
 

Template Settings
Fee Format Info Only
Date Yes
Tmkpr Initials No
Description Yes
Rate No
Total Non-bill Hrs Yes

Hours Detail
Amount n/a
Paragraph No Paragraph
Subtotal No Subtotal

Fee Recap No Recap
Hours n/a
Total n/a

Level Desc n/a
Rate n/a

Expense Format Tcodes Subtotal Only

Advance Format n/a

Pymt Format n/a

Other Settings Summary
Two Offices Statement Designer custom
page layout, heading line, contingency client,
statement number excluded.

Format Information
Tabs3 allows you to use date codes to include the statement date in the statement heading. The “For Professional Services
Rendered Thru 11/30/2016” line is included on one of the nine heading lines on the Headings tab of Statement Customization.
The “\S” date code is included on the heading line to include the Statement Date in the heading.

The statement also uses the “Info Only” Fee Format. This format is frequently used for contingency and “progress billing” clients.
This format code allows a range of fee transactions to print on the statement and not be billed. Costs can still be billed. Non-
billable hours are printed and totaled. Advances and expenses are combined rather than being totaled separately. Headings are
shown for fees and costs. The “Attn:” line is printed above the client’s name as recommended by the U.S. Postal Service. The
page number and statement number are excluded from the heading.
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Statement Example 9 - Progress Billing
 
 
 
 
 
 
 
 
 
 
 
 

Page: 1
John McBride 11/30/2016
Eastmont Towers Account No: 300-00Q
2920 Northwest Greenbriar Lane Statement No:  538
Lincoln  NE  68505

Management of Estate Trust

 Payments received after 11/30/2016 
 are not included on this statement.

 
 

Previous Balance $1,301.88

Fees

11/14/2016 PAM Telephone conference with client

11/14/2016 PAM Letter to client's trustee

11/21/2016 PAM Telephone conference with client's trustee

For Current Services Rendered 200.00
Sales Tax on Services 8.00

Expenses

Long distance telephone charges 7.55
Total Expenses 7.55

Total Current Work 215.55

Payments Received Thru 11/30/2016

11/11/2016 Payment -1,301.88

Balance Due $215.55

A T T O R N E Y S     A T     L A W

Michael L. Jensen
Paula A. Martin
Ronald P. Anderson
Robert O. Burns
Kendra I. Michaels

Street Address Mailing Address
P.O. Box 1128
Lincoln, NE  68512-1128

Phone
Fax
Web www.jmalaw.net

 

Jensen, Martin & Anderson, P.C.

1621 Cushman Drive
Lincoln, NE 68512

402-419-2200
402-419-2201

 
 

Template Settings
Fee Format Info Only
Date Yes
Tmkpr Initials Yes
Description Yes
Rate No
Total Non-bill Hrs n/a

Hours No Hours
Amount Totals Only
Paragraph No Paragraph
Subtotal No Subtotal

Fee Recap No Recap
Hours n/a
Total n/a

Level Desc n/a
Rate n/a

Expense Format Tcodes Subtotal Only

Advance Format n/a

Pymt Format Detail

Other Settings Summary
Progress billing client, Letterhead with
Columns Statement Designer custom page
layout, beginning template note.

Format Information
The statement shown above uses the “Info Only” Fee Format. This format is frequently used for progress billing and contingency
clients. This format code allows a range of fee transactions to print on the statement and not be billed. Costs can still be billed.
Headings are shown for fees, expenses and payments. The payment heading includes the “\E” date code to print the Payment
Cut-Off Date. A Beginning Template Note is shown. The firm name and address shown at the top of the statement are part of a
Statement Designer custom page layout.

Note: The $200.00 “For Current Services Rendered” amount is from the Type 6 (”progress billing”) transaction code as opposed
to the fee transactions displayed on the statement.
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Statement Example 10 - Progress Billing Reconciliation
 
 
 
 
 
 
 
 
 
 
 
 

Page: 1
John McBride 11/30/2016
Eastmont Towers Account No: 300-00Q
2920 Northwest Greenbriar Lane Statement No:  584
Lincoln  NE  68505

Management of Estate Trust
 
 

Previous Balance $1,301.88

Fees

Telephone conference with client, Letter to client's trustee
Telephone conference with client's trustee

For Current Services Rendered 1,254.55
Adjustment for Prior Billings -1,000.00
Sales Tax on Services 10.18

Expenses

Long distance telephone charges 7.55
Total Expenses 7.55

Total Current Work 272.28

Payments

11/11/2016 Payment -1,301.88

Balance Due $272.28

ATTORNEYS AND COUNSELORS AT LAW
FEDERAL TAX ID #

Lincoln Office Omaha Office

1621 Cushman Drive
Lincoln, Nebraska  68512

(402) 423-1440
Fax:  (402) 423-2561

10400 West Dodge Road
Omaha, Nebraska  68108

(402) 397-1440
Fax:  (402) 397-1441

12-3456789

 

Jensen, Martin & Anderson, P.C.

 
 

Template Settings
Fee Format Standard
Date No
Tmkpr Initials No
Description Yes
Rate No
Total Non-bill Hrs n/a

Hours No Hours
Amount Totals Only
Paragraph Total
Subtotal No Subtotal

Fee Recap No Recap
Hours n/a
Total n/a

Level Desc n/a
Rate n/a

Expense Format Tcodes Subtotal Only

Advance Format n/a

Pymt Format Detail

Other Settings Summary
Progress fee client reconciliation statement,
Two Offices Statement Designer custom
page layout.

Format Information
The statement shown above is a reconciliation statement for a progress fee client. Progressive billings of $1,000.00 have
previously been billed to the client. Therefore, they are credited back to the client on the “Adjustment for Prior Billings” line. The
Paragraph Format used combines all fee transactions into one paragraph regardless of date or timekeeper. Sales tax is assessed
on services. The firm name and address shown at the top of the statement are part of a Statement Designer custom page layout.
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Statement Example 11
 
 
 
 
 
 
 
 
 
 
 
 

Page: 1
Jefferson Insurance Co. November 30, 2016
American Charter Building Account No: 200-03M
9th & West 'O' Streets Statement No:  542
Suite 220
Lincoln  NE  68510-6330
 
Attn: Mike Johnson

Acquisition of Mid-State Insurance

 
 

Previous Balance $1,461.29

Hours
For Current Services Rendered 6.50 1,267.50
Total Non-billable Hours 0.50

Recapitulation
Timekeeper Hours  Rate  Total
Michael L. Jensen 3.50 $225.00 $787.50
Paula A. Martin     3.00 160.00 480.00

Sales Tax on Services 50.70

Total Expenses Thru 11/30/2016 70.52

Total Advances Thru 11/30/2016 90.00

Total Current Work 1,478.72

11/11/2016 Payment - thank you -500.00

Balance Due $2,440.01

Billing History
Fees Costs Advances Finance Charge

2,943.20 126.04 105.00 0.00 500.00
Write Off 221.58 12.65 0.00 0.00

A T T O R N E Y S     A T     L A W

Michael L. Jensen
Paula A. Martin
Ronald P. Anderson
Robert O. Burns
Kendra I. Michaels

Street Address Mailing Address
P.O. Box 1128
Lincoln, NE  68512-1128

Phone
Fax
Web www.jmalaw.net

 

Jensen, Martin & Anderson, P.C.

1621 Cushman Drive
Lincoln, NE 68512

402-419-2200
402-419-2201

 
 

Template Settings
Fee Format Standard
Date n/a
Tmkpr Initials No
Description n/a
Rate n/a
Total Non-bill Hrs Yes

Hours Totals Only
Amount Totals Only
Paragraph No Paragraph
Subtotal No Subtotal

Fee Recap Timekeeper
Hours Yes
Total Yes

Level Desc No
Rate Average Hourly

Expense Format Summary

Advance Format Summary

Pymt Format Detail

Other Settings Summary
Billing history without hours, Letterhead with
Columns Statement Designer custom page
layout.

Format Information
The Summary Fee Format bills fees but does not print individual transactions. Transactions with a Bill Code of 4 (billable, always
print) or a Type 4 transaction (“description only”) can be printed before the fee total if desired. Neither a Type 4 transaction nor
a transaction with a Bill Code of 4 is shown on this statement. The statement above charges sales tax on services. Non-billable
hours are totaled. A fee recap by timekeeper is included. The statement date is spelled out. The firm name and address shown at
the top of the statement are part of a Statement Designer custom page layout.
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Statement Example 12
Jensen, Martin & Anderson, P.C.

Lincoln Building, Suite 201
1621 Cushman Drive

Lincoln, NE 68512

Page: 1
Harold Richardson November 30, 2016
1548 West 57th Street Account No: 102-00M
Rochester  NY  14603-8409 Statement No:  654

Manage personal finances
 
 

Fees

Prepared for conference with client.

For Current Services Rendered 236.25
Sales Tax on Services 7.55

Expenses

Total Expenses Thru 11/30/2016 7.50
Sales Tax on Expenses 0.30

Total Current Work 251.60

Previous Balance $3,658.35

Balance Due $3,909.95

Past Due Amounts
0-30 31-60 61-90 91-120 121-180 181+

3,477.32 0.00 182.88 249.75 0.00 0.00

Template Settings
Fee Format Summary
Date n/a
Tmkpr Initials No
Description n/a
Rate n/a
Total Non-bill Hrs No

Hours No Hours
Amount Totals Only
Paragraph No Paragraph
Subtotal No Subtotal

Fee Recap No Recap
Hours n/a
Total n/a

Level Desc n/a
Rate n/a

Expense Format Summary

Advance Format n/a

Pymt Format n/al

Other Settings Summary
Firm heading from Statement Customization,
detail past due information, previous balance
after “Total Current Work”.

Format Information
Tabs3 allows you to specify a heading font in Statement Setup, which enables the firm’s heading to be printed using a different
font if desired. The statement above shows the heading in a bold and italics font. The Summary Fee Format allows each
transaction to be billed without the description printing. Transactions with a Bill Code of 4 (billable, always print) or a Type 4
(“description only”) transaction can be printed before the fee total if desired. Sales tax is assessed on both services and
expenses. The previous balance is printed after the “Total Current Work” line. The detail past due information is included at the
bottom of the statement. The statement date is spelled out.
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Statement Example 13
 
 
 
 
 
 
 
 
 
 
 
 

Page: 1
RJ's Engine Repair November 30, 2016
703 Cornhusker Highway Account No: 98CV904-RJMM
Lincoln  NE  68521 Statement No:  561
 
Attn: Rod Johnston

IRS Audit
 
 

Fees

Hours
Telephone conference with client 0.40 64.00

Research 1.30 208.00

Court appearance 0.90 144.00

For Current Services Rendered 2.60 416.00

Total Current Work 416.00

Balance Due $416.00

ATTORNEYS AND COUNSELORS AT LAW
FEDERAL TAX ID #

Lincoln Office Omaha Office

1621 Cushman Drive
Lincoln, Nebraska  68512

(402) 423-1440
Fax:  (402) 423-2561

10400 West Dodge Road
Omaha, Nebraska  68108

(402) 397-1440
Fax:  (402) 397-1441

12-3456789

 

Jensen, Martin & Anderson, P.C.

 
 

Template Settings
Fee Format Summary
Date n/a
Tmkpr Initials No
Description n/a
Rate n/a
Total Non-bill Hrs n/a

Hours Detail
Amount Detail
Paragraph No Paragraph
Subtotal Transaction Code

Fee Recap No Recap
Hours n/a
Total n/a

Level Desc n/a
Rate n/a

Expense Format No Expenses

Advance Format No Advances

Pymt Format n/al

Other Settings Summary
Fee subtotal by transaction code, Two Offices
Statement Designer custom page layout.

Format Information
The statement shown above uses a Summary Fee Format. The result is that only subtotals for each transaction code print rather
than the detail. Transactions with a Bill Code of 4 (billable, always print), Type 5 (miscellaneous) transactions and Type 4
(“description only”) transactions print before the fee total. The Client ID shown uses an Alpha Key Type.
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Statement Example 14

Attorneys at Law

RE:

Page No.

Statement Date:

Statement No.
Account No.

1621 Cushman Drive ° Lincoln, NE  68512 ° Fax°

 

Jensen, Martin & Anderson, P.C.

Harold Richardson
1548 West 57th Street
Rochester, NY   14603-8409

Manage personal finances

1

11/30/2016

656
102 00

402-423-1440 402-423-2561

Previous Balance before Adjustments $3,158.35

10/24/2016 The check we received on 9/24/2016 (check #7554)
was returned by the bank due to insufficient funds.
Accordingly, the $500.00 payment shown on the
10/31/2016 statement has been reversed. 500.00

Previous Balance $3,658.35

Fees

Rate Hours
11/02/2016 Letter to client's banker. 185.00 0.50 92.50

Office conference with Harold. 185.00 1.25 231.25
11/02/2016 1.75 323.75

11/21/2016 Prepared for conference with client. 115.00 1.25 143.75
11/21/2016 1.25 143.75

For Current Services Rendered 3.00 467.50

Recapitulation
Title Hours
Partner 1.75
Associate 1.25

Expenses

11/14/2016 Long distance telephone charges. 7.50
Long distance telephone charges 7.50

Total Expenses 7.50

Balance Due $4,133.35

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials No
Description Yes
Rate Yes
Total Non-bill Hrs n/a

Hours Detail
Amount Detail
Paragraph No Paragraph
Subtotal Date

Fee Recap Timekeeper Level
Hours Yes
Total No

Level Desc n/a
Rate No Date

Expense Format Tcodes Detail
with Subtotal

Advance Format No Advances

Pymt Format n/al

Other Settings Summary
Statement Designer custom page layout,
reversed payment.

Format Information
The statement shown above reflects a reversed payment. When a payment is reversed or refunded using the Payment
Adjustment program, the operator is given the opportunity to enter a Type 4 (“description only”) transaction. When this
transaction is included on a statement, the “Previous Balance before Adjustments” line is printed followed by the “description
only” transaction (which includes the amount of the reversal or refund), followed by the “Previous Balance” line. The “Previous
Balance before Adjustments” terminology can be changed on Line 4 of the Terminology tab in Statement Customization.

The fees and expenses shown above both use subtotal options. The individual fee transactions are printed and subtotaled by
transaction date. The individual expense transactions are printed and subtotaled by transaction code. The fee recap reflects the
number of hours for each timekeeper level. This statement was printed using a Statement Designer custom page layout with a
header, footer, and watermark image.
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Statement Example 15 - Task Based Billing
Page: 1

Federated Casualty, Ltd. 11/30/2016
2001 South 70th Street Account No: 550-00M
Suite 300 Statement No:  561
Lincoln  NE  68510
 
Attn: Samantha Kessler

Andrew C. Gilbert v. Federated Casualty
Federated Case # 98742-L
Policy Number: 92-365277-56

 
 

Fees

Rate Hours
11/07/2016 DHB L110 A103 Draft/revise response to complaint 175.00 0.50 87.50

DHB L110 A102 Research Hapton vs. Interstate
Insurance 175.00 1.00 175.00

11/14/2016 RJB L120 A106 Phone call with Sam Kessler 250.00 0.25 62.50
RJB L130 A108 Phone call with Tom Alberts of Alberts

Investigations regarding Gilbert v.
Federated to discuss previous
experience investigating arson,
testifying in court, and payment for
services.  (First report will be
completed by the end of the month.) 250.00 1.00 250.00

RJB L250 A103 Draft/revise motion for change of venue 250.00 1.00 250.00
For Current Services Rendered 3.75 825.00

Expenses

11/14/2016 L250 E101 Copying 6.75
Total Expenses 6.75

Advances

11/07/2016 L110 E106 Online research 60.00
Total Advances 60.00

Total Current Work 891.75

Balance Due $891.75

Task Code Summary

Fees Expenses
L110 Fact Investigation/Development 262.50 60.00
L120 Analysis/Strategy 62.50 0.00
L130 Experts/Consultants 250.00 0.00
L100 Case Assessment, Development and Administration 575.00 60.00

L250 Other Written Motions and Submissions 250.00 6.75
L200 Pre-Trial Pleadings and Motions 250.00 6.75

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials Yes
Description Yes
Rate Yes
Total Non-bill Hrs n/a

Hours Detail
Amount Detail
Paragraph No Paragraph
Subtotal No Subtotal

Fee Recap No Recap
Hours n/a
Total n/a

Level Desc n/a
Rate n/a

Expense Format Standard

Advance Format Standard

Pymt Format n/a

Other Settings Summary
Task Based Billing Client.

The Task Based Billing Information check
box on the Options tab of the Generate
Statements program is selected. This check
box controls whether the task codes and Task
Code Recapitulation are included on
statements for task based billing clients.

Format Information
The statement shown above includes phase/task codes and activity expense codes that are entered for Task Based Billing
Clients. When a client is designated as a Task Based Billing Client on the Setup tab of Client Information, the phase/task and
activity/expense codes are optionally printed on the client’s statement as well as a Task Code Summary that shows a breakdown
of all fee and cost expenses entered for each phase/task code. The format of the fees, expenses, advances, and payments is still
retrieved from the statement template assigned to the client on the Statement Options tab of Client Information.
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Statement Example 16 - Courtesy Discount

Page: 1
First National Bank 11/30/2016
Platte Valley Building Account No: 403-00M
13th & O Streets Statement No:  564
Lincoln  NE  68510
 
Attn: Lynn Traver

General File
 
 

Hours
11/14/2016 Attended First National Bank board meeting 2.25 315.00

Courtesy Discount -24.75
For Current Services Rendered 2.25 290.25
Sales Tax on Services 11.61

Total Current Work 301.86

Balance Due $301.86

Courtesy Discount Position - “After the last fee transaction”

Page: 1
First National Bank 11/30/2016
Platte Valley Building Account No: 403-00M
13th & O Streets Statement No:  564
Lincoln  NE  68510
 
Attn: Lynn Traver

General File
 
 

Hours
11/14/2016 Attended First National Bank board meeting 2.25 315.00

For Current Services Rendered 2.25 315.00
Courtesy Discount -24.75
Net Fees after Courtesy Discount 290.25
Sales Tax on Services 11.61

Total Current Work 301.86

Balance Due $301.86

Courtesy Discount Position -“After the Current Services rendered line”

Page: 1
First National Bank 11/30/2016
Platte Valley Building Account No: 403-00M
13th & O Streets Statement No:  564
Lincoln  NE  68510
 
Attn: Lynn Traver

General File
 
 

Hours
11/14/2016 Attended First National Bank board meeting 2.25 315.00

For Current Services Rendered 2.25 315.00
Sales Tax on Services 11.61

Total Current Work 326.61

Courtesy Discount -24.75

Balance Due $301.86

Courtesy Discount Position -“Just before the Balance Due”

Template Settings
Fee Format Standard
Date Yes
Tmkpr Initials No
Description Yes
Rate No
Total Non-bill Hrs n/a

Hours Detail
Amount Detail
Paragraph No Paragraph
Subtotal No Subtotal

Fee Recap No Recap
Hours n/a
Total n/a

Level Desc n/a
Rate n/a

Expense Format Standard

Advance Format Standard

Pymt Format n/a

Other Settings Summary
Courtesy discount options.

Format Information
The three statements shown above illustrate the three positions where the fee courtesy discount line can print on the statement.
The courtesy discount position is set on the Options tab of Statement Customization. The statement on the top left shows the
courtesy discount after the last fee transaction. The statement on the top right shows the courtesy discount after the “For
Current Services Rendered” line. The optional “Net Fees after Courtesy Discount” line is also shown. The bottom statement
shows the courtesy discount before the balance due. The Courtesy Discount is not reflected in the Total Current Work line when
using the last option.
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Statement Example 17 - Split Billing

Statement Date:
Statement No.

Account No.
Page:

 

JENSEN, MARTIN & ANDERSON, P.C.

October 31, 2016
7627

102.00

Andrew C. Gilbert
8974 Weatherby Road
Roswell, NM   88277

1621 Cushman Drive
Lincoln, NE 68512

402-423-1440

1

Auto AccidentRE:

Attn: Andrew C. Gilbert

Payments received after 10/31/2016 are not included on this statement.

Previous Balance $550.65

Fees

Hours
10/24/2016 RPA Communicate with Samantha Kessler regarding litigation. 1.00 160.00

10/25/2016 MLJ Phone call with Tom Alberts of Alberts Investigations regarding Gilbert v.
Federated to discuss previous experience investigating insurance fraud,
testifying in court, and payment for services.  (First report will be completed
by the end of the month.)

1.00 250.00

10/26/2016 MLJ Phone call with Sam Kessler. 2.00 500.00

10/27/2016 PAM Communicate (with client). 2.50 562.50

10/28/2016 RPA Research. 3.00 480.00

For Current Services Rendered 9.50 1,952.50

You are responsible for 50% of Fees 976.25

Expenses

10/25/2016 Photocopy charges. 6.75
10/25/2016 Postage 17.78

Total Expenses 24.53

You are responsible for 50% of Expenses 12.27

Total Current Work 1,977.03

Your portion of the Total Current Work 988.52

Balance Due $1,539.17

Statement Date:
Statement No.

Account No.
Page:

 

JENSEN, MARTIN & ANDERSON, P.C.

October 31, 2016
7627

102.00

Andrew C. Gilbert
8974 Weatherby Road
Roswell, NM   88277

1621 Cushman Drive
Lincoln, NE 68512

402-423-1440

1

Auto AccidentRE:

Attn: Andrew C. Gilbert

Payments received after 10/31/2016 are not included on this statement.

Previous Balance $550.65

Fees

Hours
10/24/2016 RPA Communicate with Samantha Kessler regarding litigation. 0.50 80.00

10/25/2016 MLJ Phone call with Tom Alberts of Alberts Investigations regarding Gilbert v.
Federated to discuss previous experience investigating insurance fraud,
testifying in court, and payment for services.  (First report will be completed
by the end of the month.)

0.50 125.00

10/26/2016 MLJ Phone call with Sam Kessler. 1.00 250.00

10/27/2016 PAM Communicate (with client). 1.25 281.25

10/28/2016 RPA Research. 1.50 240.00

For Current Services Rendered 4.75 976.25

Expenses

10/25/2016 Photocopy charges. 3.38
10/25/2016 Postage 8.89

Total Expenses 12.27

Total Current Work 988.52

Balance Due $1,539.17

Show pre-split values on statements selected Show pre-split values on statements not selected

Page No.
Statement No.

Statement Date:
Account No.

 

2
7627

10/31/2016

Auto Accident
102.00

Andrew C. Gilbert

RE:

Aged Due Amounts
0-30 31-60 61-90 91-120 121-180 181+

988.52 550.65 0.00 0.00 0.00 0.00

Split Billing Summary
Fees Expenses Advances Total

Gilbert/Andrew C. - Auto Accident 976.25 12.27 0.00 988.52
National Security Life Insurance - Andrew Gilbert Auto Accident      976.25 12.26 0.00 988.51

1,952.50 24.53 0.00 1,977.03

Billing History
Fees Expenses Advances Finance Charge Payments

1,463.25 38.42 37.50 0.00 0.00

A finance charge of 1% per month will be assessed on all accounts past due 30
days.

Total
Gilbert/Andrew C. - Auto Accident 988.52
National Security Life Insurance - Andrew Gilbert Auto Accident                                                                                              988.51

1,977.03

Billing History
Fees Expenses Advances Finance Charge Payments

1,463.25 38.42 37.50 0.00 0.00

A finance charge of 1% per month will be assessed on all accounts past due 30
days.

Page No.
Statement No.

Statement Date:
Account No.

 

2
7627

10/31/2016

Auto Accident
102.00

Andrew C. Gilbert

RE:

Aged Due Amounts
0-30 31-60 61-90 91-120 121-180 181+

988.52 550.65 0.00 0.00 0.00 0.00

Split Billing Summary

Detail Split Billing Summary Summary Split Billing Summary

The statements shown above were printed for a client set up for split billing. Client #102.00 is responsible for 50% of fees,
expenses, and advances. In the statement on the left, the client is configured to show pre-split values on statements and the
Split Billing Summary is set to Detail. In the statement on the right, the client is not configured to show pre-split values on
statements and the Split Billing Summary is set to Summary.

Split billing settings are configured at the client level. From the Client file (File | Open | Client), click the Split Billing tab and
select the client whose statement you want to configure. Click the Edit button and select the desired statement options. The
terminology used for split billing statements is configured in Statement Customization (Statements | Statement Customization
| Terminology).

- 92 -



Tabs3 Report Pack

Statement Example 18 - Combined Statement for Multiple Matters
Page: 1

Jefferson Insurance Co. November 30, 2016
American Charter Building Account No: 200-02C
9th & West 'O' Streets Statement No:  573
Suite 220
Lincoln  NE  68510-6330
 
Attn: Mark Allen

Hail Damage - Palmer farm
7255H-80-84833

 
 

Previous Balance $82.50

Fees

Hours
11/11/2016 Initial conference with Mike Johnson and Cindy Jacobson

regarding audit procedures 1.40 224.00
For Current Services Rendered 1.40 224.00

Recapitulation
Timekeeper  Total
Paula A. Madison $224.00

Expenses

11/14/2016 Long distance telephone charges 18.00
Total Expenses 18.00

Total Current Work 242.00

Balance Due $324.50

Account No: 200-03M
Statement No:  573

Acquisition of Mid-State Insurance

 
 

Previous Balance $1,461.29

Fees

Hours
11/21/2016 MLJ Put together proposal for Mid-State Insurance Company 3.50 787.50

PAM Office conference with Peter Smith, insurance salesman
for company. 1.75 280.00

11/22/2016 PAM Office conference with Sam Reader, Sally Farrows and John
Darrington. 1.25 200.00

PAM Telephone conference with President of Mid-State
Insurance Company 0.50 n/c
For Current Services Rendered 6.50 1,267.50
Total Non-billable Hours 0.50

Page: 2
Jefferson Insurance Co. November 30, 2016

Account No: 200-03M
Statement No:  573

Acquisition of Mid-State Insurance

 
 

Recapitulation
Timekeeper  Total
Michael L. Jensen $787.50
Paula A. Madison 480.00

Sales Tax on Services 50.70

Expenses

10/11/2016 Mileage to/from 30.00
10/11/2016 Filing fee 15.00
11/21/2016 Long distance telephone charges 25.52

Total Expenses 70.52

Advances

10/11/2016 Filing fee 75.00
11/21/2016 Filing fee 15.00

Total Advances 90.00

Total Current Work 1,478.72

Payments

11/11/2016 Payment - thank you -500.00

Finance Charge 14.54
Finance Charge is calculated based on $961.29

Balance Due $2,454.55

Your account is 60 days past due.

Total Balance Due $2,779.05

The 2-page statement shown above was printed using the CombineMatters option. A fee recap by timekeeper with totals is
shown for both matters. Note that fee sales tax is charged for client #200.03 but not for client #200.02. Non-billable hours are
printed and totaled for client 200.03. A Total Balance Due for both matters is shown at the bottom of the statement. The
following page shows both a detail and summary cover statement for these matters. The cover statement is optional.
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Statement Example 19 - Cover Statements
Page: 1

Jefferson Insurance Co. 11/30/2016
American Charter Building Account No:       200M
9th & West 'O' Streets
Suite 220
Lincoln  NE  68510-6330
 
Attn: Mike Johnson

Cover Statement

 
 

Previous Balance Fees Expenses Advances Payments Balance

Hail Damage - Palmer farm
7255H-80-84833

82.50 224.00 18.00 0.00 0.00 $324.50

Acquisition of Mid-State Insurance
1,461.29 1,318.20 70.52 90.00 -500.00

Finance Charge 14.54 $2,454.55

1,543.79 1,542.20 88.52 90.00 -500.00          
Finance Charge 14.54 $2,779.05

Page: 1
Jefferson Insurance Co. 11/30/2016
American Charter Building Account No:       200M
9th & West 'O' Streets
Suite 220
Lincoln  NE  68510-6330
 
Attn: Mike Johnson

Cover Statement

 
 

Hail Damage - Palmer farm
7255H-80-84833 $324.50

Acquisition of Mid-State Insurance $2,454.55

$2,779.05

A finance charge of 1% per month will be assessed
on all accounts past due 30 days.

Example of a Detail Cover Statement Example of a Summary Cover Statement

The detail and summary cover statements are shown above. The cover statement is optional and is generated after printing
statements for the desired files. The cover statements shown above summarize the statements shown on the previous page. The
“Cover Statement” text shown on the cover statement is a beginning statement note for the statement template (i.e., clear the
“Include Statement Notes for each File on Combined Statements” check box and select the “Include Statement Notes on a Cover
Statement” check box on the General tab of the Statement Templates program). A heading can also be specified on the Cover
Stmt tab of the Statement Customization program. The message about finance charge shown at the end of the cover statement
is an ending statement note for the statement template.

The terminology used for the cover statement can be changed on the Cover Stmt tab of Statement Customization. The Client ID
can optionally be printed next to the work description (not shown).

Cover statements can also be customized using the Statement Designer.
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Statement Example 20 - Client Funds
Page: 1

Natalie K. Sherman 11/30/2016
5334 Cherrywood Drive Account No: 900-00M
Lincoln  NE  68504 Statement No:  661

Divorce
Sherman ads. Sherman

 
 

Fees

Hours
11/11/2014 Open file/initial conference with client. n/c

11/14/2016 Letter to spouse's accountant requesting tax returns. 0.40 50.00
Letter to Smith London & O'Neill requesting financial net worth of spouse. 0.40 50.00
Letters to banks and brokerage firms requesting status of accounts. 1.00 125.00
For Current Services Rendered 1.80 225.00

Expenses

11/14/2016 Postage. 3.48
11/14/2016 Photocopy charges. 4.50

Total Expenses 7.98

Total Current Work 232.98

Payments

11/30/2016 Payment. -232.98

Balance Due $0.00

Client Funds

Beginning Client Funds Balance $0.00
11/07/2016 Initial deposit to client funds. 425.00
11/14/2016 Payment to Smith London & O'Neill for processing of financial documents. -100.00
11/30/2016 Payment. -232.98

Ending Client Funds Balance $92.02

Please Remit to Replenish Client Funds Balance $307.98

Total Amount to Remit $307.98

You have agreed to maintain a Client Funds balance of $400.00

Page: 1
Stewart Traver 11/30/2016
2590 South 2nd Street Account No: 910-00M
Lincoln  NE  68517 Statement No:  587

Estate

 
 

Client Funds

Ending Client Funds Balance $0.00

Please Remit Client Funds Balance Due $500.00

Page: 1
Roger Thomas 11/30/2016
700 Mission Circle Account No: 915-00M
Lincoln  NE  68521 Statement No:  520

Manage Personal Finances

 
 

Retainers

11/02/2016 Retainer deposit 200.00
11/14/2016 Consulting payment to Smith Consulting -45.00

Ending Retainer Balance $155.00

The statements shown above include examples of client funds activity. The statement on the top includes current work
performed as well as the client funds activity. The client funds activity includes a deposit, a payment to a third party and an
automatic payment to pay the client’s current work shown on the statement. An amount is shown to replenish the client funds
account balance. Ending Statement Notes from the Client file are used to make it clear to the client that the Total Amount to
Remit is to replenish the client funds balance.

The statement shown in the middle shows a client being billed a $500 retainer transaction. In this case, the One Time Retainer
check box has been selected on the A/R & Fund Balances tab of the Client file. Additionally, the Retainer Amount and Amount
to Bill in the client file are both set to $500.
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The statement shown on the bottom includes only client funds activity and no current work. In this example, the “Client Funds”
terminology has been changed to “Retainers” on Lines 59-64 of the Terminology tab of Statement Customization. The
“Beginning Client Funds Balance” has been suppressed by entering an asterisk in the first position of Line 61 of the Terminology
tab.

Statement Example 21 - Trust Account Information
Page: 1

Charles L. Dawson November 30, 2016
27550 Cottonwood Drive Account No: 100-00M
San Bernadino  CA  92408 Statement No:  657

Settlement of Grandfather's Estate
 
 

Previous Balance $324.00

Fees

11/01/2016 Preparation and filing of Federal Trust Tax Form. 250.00

11/21/2016 Office conference with Mr. Dawson. 150.00
For Current Services Rendered 400.00

Expenses

11/11/2016 Facsimile costs. 3.75
Total Expenses 3.75

Total Current Work 403.75

Payments

Total Payments thru 11/30/2016 -727.75

Balance Due $0.00

Your trust account balance is $53,162.00

Page: 1
Charles L. Dawson November 30, 2016
27550 Cottonwood Drive Account No: 100-00M
San Bernadino  CA  92408 Statement No:  657

Settlement of Grandfather's Estate
 
 

Previous Balance $324.00

Fees

11/01/2016 Preparation and filing of Federal Trust Tax Form. 250.00

11/21/2016 Office conference with Mr. Dawson. 150.00
For Current Services Rendered 400.00

Expenses

11/11/2016 Facsimile costs. 3.75
Total Expenses 3.75

Total Current Work 403.75

Payments

11/01/2016 Payment from trust. -443.75
11/02/2016 Expense payment. -75.00
11/21/2016 Fee payment. -209.00

Total Payments thru 11/30/2016 -727.75

Balance Due $0.00

Trust Account Activity

Opening Balance $52,000.00
10/11/2016 Expense money for Dawson

PAYEE: Dawson/Charles L. -1,200.00
11/01/2016 Sale of stocks 4,255.75
11/02/2016 Attorney fees

PAYEE: Jensen, Martin & Anderson, P.C.                                                   -443.75
11/11/2016 Real estate taxes

PAYEE: Lancaster County Treasurer -1,450.00
Closing Balance $53,162.00

Summary Trust Accounting Information Detail Trust Accounting Information

Page: 1
Charles L. Dawson November 30, 2016
27550 Cottonwood Drive Account No: 100-00M
San Bernadino  CA  92408 Statement No:  568

Settlement of Grandfather's Estate
 
 

Previous Balance $324.00

Fees

11/02/2016 Preparation and filing of Federal Trust Tax Form. 250.00

11/21/2016 Office conference with Mr. Dawson 150.00
For Current Services Rendered 400.00

Expenses

11/11/2016 Facsimile costs 3.75
Total Expenses 3.75

Total Current Work 403.75

Payments

Total Payments for 11/02/2016 -443.75
Total Payments for 11/03/2016 -75.00
Total Payments for 11/21/2016 -209.00
Total Payments thru 11/30/2016 -727.75

Balance Due $0.00

Your trust account balance is $53,162.00

Payment Totals by Date

The statements on this page are identical except for the trust accounting integration information and the payment section of
the statement. The statement on the top left uses the summary trust integration option and prints payment totals only whereas
the statement on the top right uses the detail trust integration option and lists each payment separately. The statement on the
bottom includes summary trust account information and shows payment totals by date.

The trust account information is retrieved from Tabs3 Trust Accounting Software (TAS). TAS is an optional add-on module.
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Statement Example 22- Trust Account Remittance Information
Page: 1

Arthur J. Carter 11/30/2016
4920 Everett Account No: 350-00M
Lincoln  NE  68503 Statement No:  658

Protection of New Wave Patent

Reminder:  We are meeting on December 11 at 2:00 p.m.

 
 

Fees

11/01/2016 Office conference with client regarding ownership of business.

For Current Services Rendered 825.00

Expenses

11/01/2016 Postage. 2.90
11/01/2016 Photocopy charges. 7.35

Total Expenses 10.25

Total Current Work 835.25

Payments

11/01/2016 Payment transferred from trust account. -835.25

Balance Due $0.00

Trust Account Activity

Opening Balance $0.00
11/01/2016 Initial deposit 3,000.00
11/02/2016 Fees

PAYEE: Jensen, Martin & Anderson, P.C.                                                    -835.25
Closing Balance $2,164.75

Please remit $835.25

Per our initial meeting, you have agreed to 
maintain a balance of $3,000 in your trust account.

Page: 1
Jack Maxwell 11/30/2016
1047 North 26th Street Account No: 916-00M
Lincoln  NE  68508 Statement No:  570

Manage Personal Finances

 
 

Your trust account #1 balance is $0.00
Please remit $1,000.00

Billing History
Fees Hours Expenses Advances Finance Charge Payments

4,092.50 20.40 76.83 160.00 0.00            4,092.50

The statements on this page are examples of the information that can be included from Tabs3 Trust Accounting Software (TAS).
The statement on the left includes detail trust activity. A payment from the client’s trust account is shown in the Trust Account
Activity section and is included in the Payments section of the client’s statement. The “Please remit” line prints when the trust
account’s Current Trust Balance is less than the Desired Minimum Balance. The amount to remit is included on this line, which is
the difference between the Tabs3 Target Balance and the Current Trust Balance. The Current Trust Balance, Desired Minimum
Balance and Tabs3 Target Balance fields are all found in the trust account file in TAS. The “Please remit” terminology can be
changed in the Bank Account File in TAS. Ending statement notes remind the client of the agreement to maintain a $3,000
balance. Beginning statement notes remind the client of an upcoming appointment. The section headings on the statement
shown on the left have been formatted to include bold, italic and underline attributes.

The trust account information shown on the statement on the right instructs the client to remit $1,000. The “Please remit” line
prints when the trust account’s Current Trust Balance is less than the Desired Minimum Balance. The amount to remit is included
on this line, which is the amount shown in the Tabs3 Amount to Bill field in the TAS trust account file. The “Please remit”
terminology can be changed in the Bank Account File in TAS.
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Statement Example 23 - Reminder Statements
 
 
 
 
 
 
 
 
 
 
 
 

Page: 1
Bradley Harrison 11/30/2016
834 Fox Hollow Account No: 751-00M
Toronto  ONT  M5J 4M2 Statement No:  660
Canada

Purchase of Real Estate
 
 

Previous Balance $1,250.93

Stmt Date Stmt # Billed Due
08/31/2016 279 1,500.51 1,200.51
09/30/2016 382 15.00 15.00
10/31/2016 394 35.42 35.42

1,250.93

Finance Charge 18.91

Balance Due $1,269.84

Billing History
Fees Hours Expenses Advances Finance Charge Payments

1,535.27 8.89 0.00 15.00 19.57 300.00

Payable in U.S. Dollars - Thank You.

A finance charge of 1% per month will be assessed
on all accounts past due 30 days.

A T T O R N E Y S     A T     L A W

Michael L. Jensen
Paula A. Martin
Ronald P. Anderson
Robert O. Burns
Kendra I. Michaels

Street Address Mailing Address
P.O. Box 1128
Lincoln, NE  68512-1128

Phone
Fax
Web www.jmalaw.net

 

Jensen, Martin & Anderson, P.C.

1621 Cushman Drive
Lincoln, NE 68512

402-419-2200
402-419-2201

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Page: 1
Bradley Harrison 11/30/2016
834 Fox Hollow Account No: 751-00M
Toronto  ONT  M5J 4M2 Statement No:  660

Purchase of Real Estate
 
 

Previous Balance $1,250.93

Finance Charge 18.91

Balance Due $1,269.84

Your account is 90 days past due.

Billing History
Fees Hours Expenses Advances Finance Charge Payments

1,535.27 8.89 0.00 15.00 19.57 300.00

Payable in U.S. Dollars - Thank You.

A finance charge of 1% per month will be assessed
on all accounts past due 30 days.

A T T O R N E Y S     A T     L A W

Michael L. Jensen
Paula A. Martin
Ronald P. Anderson
Robert O. Burns
Kendra I. Michaels

Street Address Mailing Address
P.O. Box 1128
Lincoln, NE  68512-1128

Phone
Fax
Web www.jmalaw.net

 

Jensen, Martin & Anderson, P.C.

1621 Cushman Drive
Lincoln, NE 68512

402-419-2200
402-419-2201

 
 

The statements shown above are examples of reminder statements. Reminder statements are generated by selecting the
Reminder Statement check box on the Options tab of the Statements window. When a reminder statement is printed, current
work is excluded from the statement.

You can select to print either a detail reminder statement or a summary reminder statement. A detail reminder statement
includes the statement date, statement number, billed amount and amounts due for each outstanding statement along with a
total balance due. The statement shown on the left is an example of a detail reminder statement. A summary reminder statement
includes only the total balance due. The statement shown on the right is an example of a summary reminder statement.

The statements shown also reflect ending client notes and ending template notes.

Statement Run Totals

Draft Statement Run Totals 10/31/2016

Statements Printed: 9
Hours: 122.85
Fees: 36,520.75
Expenses: 17.53
Advances: 75.00
Fee Sales Tax: 818.90
Exp Sales Tax: 0.06
Adv Sales Tax: 3.38
Finance Charge: 2.80

Rate Taxed Fees Fee Tax Taxed Exps Exp Tax Taxed Advs Adv Tax
(1) 4.0000 20,472.50 818.90
(2) 4.5000 1.25 0.06 75.00 3.38
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Statement run totals are optional and can be included when statements are run. The run totals page will print after all statements
have printed. Statement run totals are particularly useful for showing billed sales tax broken down by rate.

PDF Statement Summary

Date: 11/30/2016 Tabs3 PDF Statement Summary Page: 1
Jensen, Martin & Anderson, P.C.

User ID: CATHY
Statement Date: 11/30/2016
PDF Location: O:\DataSets\Tabs3\Statements\20161130

415.00 MegaConstruction Corporation
Corporate Merger - Megabuilders and BuilderCorp

James R. Tatiki, Sr. - jt@megaconcorp.com
415.00_Stmt_7576

PDF Statements Created: 1

The information shown above is an example of a PDF statement summary page. PDF Statement Summary pages are printed
when PDF statements are generated. The summary will print after all statements have printed. When PDF statements are output
to the E-mail Statements window or previewed, the PDF Statement Summary will be saved in the same location as the PDF
statements. The PDF Statement Summary is particularly useful for showing the PDF name, recipient, and e-mail address used in
the E-mail Statements window for each e-mail statement generated.

Statement Envelope

Tabs3 allows you to print envelopes when printing final statements. The Print Envelopes check box must be selected in the
Statement Setup section of the Print Setup program and the desired paper tray must be selected. Envelopes are then
automatically printed when final statements are run.
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Client Labels
Task Folder Reports | Client Reports | | Labels

The Tabs3 Client Labels program prints labels based on the Tabs3 client
information. You can print labels for select clients based on the
information in specified fields in the client file. For example, you can
select to print labels for clients whose names start with A thru L. You can
select to sort the labels so they print in a specified order, such as zip code
order or alphabetical order by client name.

You have the option to print labels in a one-across or two-across format.
You can also save the information in an ASCII export file format, a
Microsoft Word mail merge format or a WordPerfect mail merge format.

Pre-Update Statements Report

Date: 11/30/2016 Tabs3 Pre-Update Statements Report Page: 1

Jensen, Martin & Anderson, P.C.

Stmt # Client Name/Work Description Date Prev Bal Fees Expenses Advances Fin Chg Payments Bal Due

510 100.00 Dawson/Charles L. 11/30/2016 324.00 262.50 10.50 0.00 0.00 0.00 597.00 JPP
Settlement of Grandfather's Estate

511 101.00 Barrett/Karen 11/30/2016 1,085.32 43.75 0.00 0.00 0.00 0.00 1,129.07 DHB
Apartment Management

512 102.00 Richardson/Harold 11/30/2016 3,658.35 150.00 0.00 0.00 0.00 -1,700.00 2,108.35 RJB
Manage personal finances

513 200.01 Jefferson Insurance Co. 11/30/2016 1,117.00 0.00 0.00 0.00 0.00 0.00 1,117.00 RJB
Automobile Accident

513 200.02 Jefferson Insurance Co. 11/30/2016 82.50 0.00 0.00 0.00 0.00 0.00 82.50 RJB
Hail Damage - Palmer farm

514 200.03 Jefferson Insurance Co. 11/30/2016 2,086.62 832.00 4.50 0.00 0.00 -500.00 2,423.12 RJB
Acquisition of Mid-State Insurance

      200 Jefferson Insurance Co.                                                              3,286.12 832.00 4.50 0.00 0.00 -500.00 3,622.62

516 350.00 Carter/Arthur J. 11/30/2016 425.00 0.00 0.00 0.00 0.00 0.00 425.00 MLJ
Protection of New Wave Patent

Total 8,778.79 1,288.25 15.00 0.00 0.00 -2,200.00 7,882.04

Task Folder Statements | Pre-Update Stmts Report

The Pre-Update Statements Report shows the amounts that have been processed on final statements and are ready to be
updated by the Update Statements program. If multiple final statements were run for a client, the report will show only the
information that was on the last final statement that was displayed, printed or saved. The report shows the statement number
and statement date along with amounts for previous balance, fees, progress fees, expenses, advances, finance charge,
payments, and balance due. Totals are included at the end of the report.

Note: If the Print Zero Balance Payment Only Clients check box on the Options tab of the Generated Statements program is
cleared when running final statements, clients with no activity who have a payment equal to their previous balance will not
have a statement printed. However, a statement would have still been “processed” for the client and thus the client, along
with the zero balance statement, will be included on this report.
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Definitions for Pre-Update Statements Report
Date (heading) Used for reference and has no bearing on the report itself.

Stmt # Statement number that was shown on the final statement.

*1 (asterisk) An asterisk to the right of the Stmt # column indicates a critical field was changed after a final
statement was run. Another final statement needs to be run before the statement can be updated.

Client Client ID.

Name/Work Description Client name and work description. An asterisk before the work description indicates the work
description will not be printed on the client’s statement.1

Date Statement Date that was shown on the final statement.

Prev Bal Previous balance that was shown on the final statement.

Fees Total fees shown on the final statement. Fee sales tax and fee credits are included. Progress Fees
(Type 6 transactions) are shown separately.

Progress Total progress fees (Type 6 transactions) that were shown on the final statement.

Expenses Total expenses that were shown on the final statement. Expense sales tax and expense credits are
included.

Advances Total advances that were shown on the final statement. Advance sales tax and advance credits are
included.

Fin Chg Total finance charge that was shown on the final statement.

Payments Total payments that were shown on the final statement. Payments are not included on statements
when the Invoice format is used. However, the payments are still processed by Tabs3 and will be
included on this report. Automatic client funds payments are not included in this amount (because
these payments are not processed until final statements are updated). Automatic trust payments
that are in a Pending state will not be included on this report.

Bal Due Balance Due shown on the final statement.

(timekeeper) Primary timekeeper initials are shown next to the balance due if the report is not printed in
timekeeper order.

1Not shown on the sample report.

Update Statements Verification List
Date: 11/28/2016 Tabs3 Update Statements Verification List Page: 1

Jensen, Martin & Anderson, P.C.
User: CATHY Cathleen Trudore

Stmt # Client Name/Work Description Date Prev Bal Fees Expenses Advances Fin Chg Payments Bal Due

7613 415.00 MegaConstruction Corporation 11/30/2016 85,705.25 21,291.40 1.31 78.38 8.41 -80,000.00 27,084.75
Corporate Merger - Megabuilders and BuilderCorp

7616 101.00 Williams/John 10/31/2016 923.40 3,307.50 38.60 51.50 0.00 -1,617.65 2,703.35
State v. Williams

7617 102.00 Gilbert/Andrew C. 10/31/2016 0.00 0.00 76.83 75.00 0.00 0.00 151.83
Auto Accident

Grand Totals: 

86,628.65 24,598.90 116.74 204.88 8.41 -81617.65 29,939.93

Total Statement Count = 3

Task Folder Statements | Update Statements | Esc

The Update Statements Verification List list shows the amounts for each client that were updated by the Update Statements
program. For each statement that was updated, the report shows the statement number, Client ID, client name, work description,
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statement date, previous balance, fees, expenses, advances, finance charge, payments and balance due. Totals are shown at the
end of the list. A “totals only” list can optionally be printed.

Definitions for Update Statements Verification List
Date (heading) The date the list was printed.

Stmt # Statement number.

Client Client ID.

Name/Work Description Client name and work description. An asterisk before the work description indicates the work
description will not be included on the client’s statement.1

Date Statement date.

Prev Bal Previous balance shown on the statement.

Fees Total fees shown on the statement. Fee sales tax, fee credits and progress fees (Type 6 transactions)
are included.

Expenses Total expenses shown on the statement. Expense sales tax and expense credits are included.

Advances Total advances shown on the statement. Advance sales tax and advance credits are included.

Fin Chg Finance charge shown on the statement.

Payments Total payments shown on the statement.

Bal Due Balance due shown on the statement.

RB1 (Shown to the left of the work description.) This indicates that the client’s Bill On Demand check
box was selected when the Update Statements program was run. Because the client was set to “bill
on demand,” the Update Statements program cleared the Release To Bill check box. In order for the
client to have another statement processed, the Release To Bill check box must be selected.

CD1 (Shown to the left of the work description.) This indicates that the Change Discount Type to none
after statement updated check box was selected when the Update Statements program was run.
Because of this, the Update Statements program changed the Courtesy Discount Type to None. The
client will not receive another courtesy discount until the Courtesy Discount Type is changed back
to Percentage or Amount.

Total Statement Count The number of statements included on the list.

1Not shown on the sample report.

E-mail Statements Verification List
Date: 11/30/2016 E-mail Statements Verification List Page: 1

Jensen, Martin & Anderson, P.C.
User:  MLJ  Michael L. Jensen

Date Client ID Pri Tkr Contact E-mail Address PDF File Name Result User ID

11/30/2016 852.00 1-MLJ Jeff Turner jturner@rockwell.com 852.00_Stmt_7563.pdf         SentFailed  SALLYMLJ
11/30/2016 852.00 1-MLJ Jeff Turner jturner@rockwell.com 852.00_Stmt_7563.pdf                                        Sent    SALLY
11/30/2016  415.00                 2-PAM         James Takiti                                                jt@MegaConCorp.com                                                                            415.00_Stmt_7591.pdf                                        Deleted    KIM

Task Folder Statements | E-mail Statements | Esc

The E-mail Statements Verification List shows all changes performed in the E-mail Statements window, including which e-mails
were sent, failed to send, or were deleted without having been sent. You can select to print or save this report. Each e-mail
statement that has had a status change will be shown.
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Definitions for E-mail Statements Verification List
Date (heading) The date the list was printed.

Date The date the status of the e-mail changed.

Client ID Client ID.

Pri Tkr Primary Timekeeper number and initials assigned to the client.

Contact Full Name of the contact to whom the e-mail was addressed.

E-mail Address E-mail address in the To field of the e-mail.

PDF File Name File name of the statement that was attached to the e-mail. The PDF statement is saved in the
Statements folder within the current working directory, in a folder named for the statement date in
YYYYMMDD format.

Result Current status of the e-mail. This column will show one of three options: Sent, Failed, or Deleted.

User ID User ID of the user who changed the status of the e-mail.

Undo Update Statements Verification List

Date: 11/28/2016 Tabs3 Undo Updated Statements Verification List Page: 1
Jensen, Martin & Anderson, P.C.
User: CATHY Cathleen Trudore

Stmt # Client Name/Work Description Date Prev Bal Fees Expenses Advances Fin Chg Payments Bal Due

7616 101.00 Williams/John 10/31/2016 923.40 3,307.50 38.60 51.50 0.00 -1,617.65 2,703.35
State v. Williams

7617 102.00 Gilbert/Andrew C. 10/31/2016 0.00 0.00 76.83 75.00 0.00 0.00 151.83
Auto Accident

Grand Totals:                                                                                                      923.40 3,307.50 115.43 126.50 0.00 -1,617.65 2,855.18

Total Statement Count = 2

Task Folder Statements | Undo Single Updated Statement | Esc

The Undo Update Statements Verification List shows the statements that have been “un-updated” by the Undo Updated
Statement program. Each statement that has been un-updated will be shown along with a grand total. The definitions for this
report are identical to those for the Update Statements Verification List shown on the previous page.

Pre-Bill Tracking Report

Date: 11/28/2016 Pre-Bill Tracking Report Page: 1

Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 1 Robert J. Burns

Client Name Description Pre-Bill Hold Reviewed Final Batch

102.00M Richardson/Harold Manage personal finances 11/03/2016 R 11/30/2016 290
200.01M Jefferson Insurance Co. Automobile Accident 11/03/2016 R 11/30/2016 290
200.02C Jefferson Insurance Co. Hail Damage - Palmer farm 11/03/2016 R 11/30/2016 290
200.03M Jefferson Insurance Co. Acquisition of Mid-State Insurance 11/03/2016 R 11/30/2016 290
300.00Q McBride/John Management of Estate Trust 11/03/2016 290
550.00M Federated Casualty, Ltd. Andrew C. Gilbert v. Federated Casualty 11/03/2016 R 11/30/2016 290

Primary Timekeeper: 2 Michael L. Jensen

Client Name Description Pre-Bill Hold Reviewed Final Batch

350.00M Carter/Arthur J. Protection of New Wave Patent 11/03/2016 R 11/30/2016 290
600.00M Ace Manufacturing Company General Legal Counsel 11/03/2016 R 11/30/2016 290
600.01M Ace Manufacturing Company Workers' compensation claim 11/03/2016 R 11/30/2016 290
600.02M Ace Manufacturing Company Maintenance of insurance policies 11/03/2016 R 11/30/2016 290
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Date: 11/28/2016 Pre-Bill Tracking Report Page: 1

Jensen, Martin & Anderson, P.C.

Client Name Description Pre-Bill Hold Reviewed Final Batch Tkpr

100.00M Dawson/Charles L. Settlement of Grandfather's Estate 11/01/2016 H R 286 5
101.00M Barrett/Karen Apartment Management 11/01/2016 R 11/30/2016 286 4
102.00M Richardson/Harold Manage personal finances 11/01/2016 R 11/30/2016 286 1
200.01M Jefferson Insurance Co. Automobile Accident 11/01/2016 R 11/30/2016 286 1
200.02C Jefferson Insurance Co. Hail Damage - Palmer farm 11/01/2016 R 11/30/2016 286 1
200.03M Jefferson Insurance Co. Acquisition of Mid-State Insurance 11/01/2016 R 11/30/2016 286 1
300.00Q McBride/John Management of Estate Trust 11/01/2016 286 1
350.00M Carter/Arthur J. Protection of New Wave Patent 11/01/2016 R 11/30/2016 286 2
400.00R Lutz/Jody Manage trust account for Jody 11/01/2016 R 11/30/2016 286 5
402.00M Kiltzer/George Set up trust for children 11/01/2016 H R 286 4
500.00M Lyons/Mr. & Mrs. Art Audit of Federal Income Taxes 11/01/2016 286 4
550.00M Federated Casualty, Ltd. Andrew C. Gilbert v. Federated Casualty 11/01/2016 R 11/30/2016 286 1
600.00M Ace Manufacturing Company General Legal Counsel 11/01/2016 R 11/30/2016 286 2
600.01M Ace Manufacturing Company Workers' compensation claim 11/01/2016 R 11/30/2016 286 2
600.02M Ace Manufacturing Company Maintenance of insurance policies 11/01/2016 R 11/30/2016 286 2
750.00M Harrison Investments Purchase of Real Estate 11/01/2016 R 11/30/2016 286 4
751.00M Harrison/Bradley Purchase of Real Estate 11/01/2016 286 4
850.00H White/Kelly Divorce 11/01/2016 R 11/30/2016 286 4
900.00M Sherman/Natalie K. Divorce 11/01/2016 R 11/30/2016 286 4

Task Folder Statements | Pre-Bill Tracking | Print Report

The Pre-Bill Tracking Report includes the pre-bill tracking records that are displayed at the time the report is run. The report can
be sorted by Client ID, Client Name, Description, Timekeeper, Pre-Bill Date, Hold Status, Reviewed Status, Final Date, or Batch by
clicking the column header in the Pre-Bill Tracking window. Clicking the Options button in the Pre-Bill Tracking window lets
you specify which pre-bill tracking records you want shown. The Pre-Bill Tracking Report can be printed to show the statements
on hold, statements outstanding (not reviewed) or simply as an audit trail. The report can be printed for a range of primary,
secondary or originating timekeepers. The information for each timekeeper can begin on a new page if desired. The first report
shown is sorted by primary timekeeper. The second report shown is sorted by Client ID and therefore includes a Timekeeper
column.

Definitions for Pre-Bill Tracking Report
Date (heading) The date the list was printed.

Client Client ID. The letter following the Client ID represents the billing frequency.

Name Client name.

Description Client’s work description. An asterisk preceding the work description indicates the client’s work
description will not print on statements.1

Pre-Bill Date of the pre-bill run for the client (i.e., Report Date of Detail Work-In-Process Report or
Statement Date of draft statement).

Hold An “H” in the Hold column indicates that the statement has been marked as “on hold.”

Reviewed An “R” in the Reviewed column indicates that the statement has been marked as “reviewed.”

Final Date the final statement was run for the client via the Pre-Bill Tracking window.

Batch The batch number in which the pre-bill was included. Tabs3 automatically assigns a unique batch
number to each run of draft statements and each Detail Work-In-Process Report for use by the Pre-
Bill Tracking program.

Tkpr Number of primary, secondary, or originating timekeeper specified via the Pre-Bill Tracking Options.
This column is shown only when a sort order other than timekeeper is selected.

1Not shown on the sample report.
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Detail Accounts Receivable Report
Date: 11/28/2016 Tabs3 Detail Accounts Receivable Report Page: 1

Jensen, Martin & Anderson, P.C.

0-30 31-60 61-90 91-120 121-180 181+ Total WIP

100.00 M Dawson/Charles L.
RE: Settlement of Grandfather's Estate

Chuck Dawson  Last Statement: 11/17/2016 Fees 324.00 0.00 0.00 0.00 0.00 0.00 324.00 262.50
Last Payment: 11/03/2016Mobile: 714-884-7525                                                                                                             Expenses -75.00 0.00 0.00 0.00 0.00 0.00 -75.00 10.50

Amount: 75.00Home: 714-863-7184 Advances 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Open Date: 04/04/2015 Last Write Off: mm/dd/yyyy Fin Charge 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Primary: JPP Total 249.00 0.00 0.00 0.00 0.00 0.00 249.00 273.00
(12 Days)

101.00 M Barrett/Karen
RE: Apartment Management

Karen Barrett  Last Statement: 11/14/2016 Fees 0.00 1,070.86 0.00 0.00 0.00 0.00 1,070.86 43.75
Last Payment: 09/22/2016Business: 402-466-1234                                                                                                         Expenses 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Amount: 587.67Home: 402-472-9937 Advances 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
*Open Date: 05/02/2016 Last Write Off: 11/14/2016 Fin Charge 14.46 0.00 0.00 0.00 0.00 0.00 14.46 0.00

Primary: DHB Amount: 348.36 Total 14.46 1,070.86 0.00 0.00 0.00 0.00 1,085.32 43.75
(3 Days)

102.00 M Richardson/Harold
RE: Manage personal finances

Harold Richardson  Last Statement: 11/14/2016 Fees 1,958.35 0.00 0.00 0.00 0.00 0.00 1,958.35 150.00
Last Payment: 11/03/2016Mobile: 716-253-4510x210                                                                                                       Expenses 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Amount: 1,700.00Home: 716-862-7782 Advances 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
*Open Date: 05/10/2016 Last Write Off: mm/dd/yyyy Fin Charge 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Primary: RJB Total 1,958.35 0.00 0.00 0.00 0.00 0.00 1,958.35 150.00
(7 Days)

200.01 M Jefferson Insurance Co.
RE: Automobile Accident

Mike Johnson Last Statement: 11/14/2016 Fees 0.00 0.00 861.00 0.00 0.00 0.00 861.00 337.50
Last Payment: 11/03/2016Mobile: 402-464-2200                                                                                                             Expenses 3.00 3.00 0.00 0.00 0.00 0.00 6.00 0.00

Amount: 250.00Home: 402-464-2202 Advances 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Open Date: 06/01/2015 Last Write Off: mm/dd/yyyy Fin Charge 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Primary: RJB Total 3.00 3.00 861.00 0.00 0.00 0.00 867.00 337.50
(14 Days)

200.02 C Jefferson Insurance Co.
RE: Hail Damage - Palmer farm

Mark Allen Last Statement: 11/14/2016 Fees 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1,755.00
Last Payment: 11/05/2016Home: 402-464-2200 Expenses 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Amount: 250.00Mobile: 402-464-2202 Advances 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Open Date: 06/08/2016 Last Write Off: mm/dd/yyyy Fin Charge 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Primary: RJB Total 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1,755.00
Unapplied Payments: 167.50 -167.50 (24 Days)

200.03 M Jefferson Insurance Co.
RE: Acquisition of Mid-State Insurance

Mike Johnson Last Statement: 10/14/2016 Fees 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2,690.00
Last Payment: 11/06/2016Business: 402-464-2200                                                                                                          Expenses 0.00 0.00 0.00 0.00 0.00 0.00 0.00 26.00

Amount: 250.00Business Fax: 402-464-2202 Advances 0.00 0.00 0.00 0.00 0.00 0.00 0.00 89.00
Open Date: 07/04/2016 Last Write Off: mm/dd/yyyy Fin Charge 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Primary: RJB Total 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2,805.00
Unapplied Payments: 179.48 -179.48 (22 Days)

      200 Jefferson Insurance Co. Fees 0.00 0.00 861.00 0.00 0.00 0.00 861.00 4,782.50
Expenses 3.00 3.00 0.00 0.00 0.00 0.00 6.00 26.00
Advances 0.00 0.00 0.00 0.00 0.00 0.00 0.00 89.00

Fin Charge 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Total 3.00 3.00 861.00 0.00 0.00 0.00 867.00 4,897.50

Unapplied Payments: 346.98 520.02 (22 Days)

Totals Fees 2,282.35 1,070.86 861.00 0.00 0.00 0.00 4,214.21 5,238.75
Expenses -72.00 3.00 0.00 0.00 0.00 0.00 -69.00 36.50
Advances 0.00 0.00 0.00 0.00 0.00 0.00 0.00 89.00

Fin Charge 14.46 0.00 0.00 0.00 0.00 0.00 14.46 0.00
Total 2,224.81 1,073.86 861.00 0.00 0.00 0.00 4,159.67 5,364.25

Unapplied Payments: 346.98 3,812.69 (21 Days)
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Date: 11/28/2016 Tabs3 Detail Accounts Receivable Report Page: 1
Jensen, Martin & Anderson, P.C.

0-30 31-60 61-90 91-120 121+ Total

850.00 M White/Kelly
RE: Divorce

Kelly Ann White Fees 1,290.00 0.00 0.00 0.00 0.00 1,290.00
Business: 213-474-4336 1-MLJ 625.00 0.00 0.00 0.00 0.00 625.00
Business Fax: 2-PAM 450.00 0.00 0.00 0.00 0.00 450.00
E-mail: kelly_white_la@hushmail.com 5-KIM 215.00 0.00 0.00 0.00 0.00 215.00
Open Date: 10/04/2015 Expenses 0.00  0.00  0.00  0.00  0.00  0.00
Primary: KIM Advances 0.00 0.00 0.00 0.00 0.00 0.00

Fin Charge 0.00 0.00 0.00 0.00 0.00 0.00
Total 1,290.00 0.00 0.00 0.00 0.00 1,290.00

850.01 M White/Kelly
RE: Last Will & Testament

Kelly Ann White Fees 1,750.00 0.00 0.00 0.00 0.00 1,750.00
Business: 213-474-4336 1-MLJ 250.00 0.00 0.00 0.00 0.00 250.00
Business Fax: 5-KIM 1,500.00 0.00 0.00 0.00 0.00 1,500.00
E-mail: kelly@homeoffice.net Expenses 0.00 0.00 0.00 0.00 0.00 0.00
Open Date: 11/08/2015 Advances 0.00 0.00 95.00 0.00 0.00 95.00
Primary: KIM Filing Fees 0.00 0.00 10.00 0.00 0.00 10.00

Processor Fees 0.00 0.00 85.00 0.00 0.00 85.00
Fin Charge 0.00 0.00 0.00 0.00 0.00 0.00

Total 1,750.00 0.00 95.00 0.00 0.00 1,845.00

11/03/2016 09:50am CATHY Spoke to Kelly concerning past due balance. Discussed setting up a monthly payment schedule.  No more work will
be done until a good faith payment is made. Kelly agreed to send 100 in the next week.

Task Folder Reports | A/R Reports | Detail A/R Report

The Accounts Receivable Reports, both summary and detail, give you an aged breakdown of the balance due for each client.
They indicate how much of the balance for each client is in each of the aging periods defined on the Options tab in Tabs3
Customization. The Detail Accounts Receivable Report breaks down the balance due for each client by fees and costs and
provides totals for each period. The report date is used as a basis for calculating aging on the past due amounts. A “totals only”
report can also be printed.

All billed and updated statement amounts that are outstanding are included on the report regardless of the report date. Work-
in-process fee and cost totals are also shown on the report but use theWIP Cut-Off Date as a cut-off date. Additionally, the
Accounts Receivable Report includes unprocessed payments (excluding payments on hold) through theWIP Cut-Off Date. An
unprocessed payment is a payment that has been entered into work-in-process but has not been processed on a final statement
and updated.

The Options tab includes parameters that enable you to specify what type of information is included on the report (e.g., a WIP
cut-off date, include zero balance clients, a minimum balance due, etc.) The Format tab allows you to optionally include
information such as work-in-process, billing notes & instructions, and billing history, as well as choose portrait or landscape
orientation. Platinum users can also include a detailed breakdown of fees by timekeeper and costs by cost type.

Definitions for Detail Accounts Receivable Report
Date The report date is used as a basis for calculating aging of past due amounts.

(client) Client ID, client name, work description, contact name and first two phone numbers from the client
file. The letter following the Client ID represents the billing frequency. An asterisk immediately in
front of the work description indicates the work description will not print on the client’s statement.1

Open Date The date the client file was opened.

Primary Primary timekeeper initials are shown below the Open Date if the list is not printed in timekeeper
order.

Progress Bill Indicates the client is set up for Progress Billing.

Last Statement The date of the last updated statement.

Last Payment The date of the last payment, either processed or in work-in-process. TheWIP Cut-Off Date is used
in selecting which work-in-process payments are used in determining the last payment date;
however, all processed payments are used when determining the last payment date.

Amount Amount of the last payment. If multiple payments were entered on the last payment date, this
amount will be the total of the payments entered on that date.

Last Write Off Amount Date and amount of the last write off for the client.
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Fees / Expenses /
Advances / Fin Charge

The amounts owed for the corresponding aging period. Work-in-Process payments through the
WIP Cut-Off Date are applied to past due amounts. If you have the Platinum version, fee amounts
can be broken down by timekeeper and cost amounts can be broken down by cost type if the
Detail Information for Fees and Costs (Platinum Only) option is selected.

0-30 / 31-60 / 61-90 /
91-120 / 121-180 / 181+

The aging of all amounts owed is determined each time the Accounts Receivable Report is run. The
number of days between the report date and each statement date determines the aging of the past
due amount. Work-in-Process payments through theWIP Cut-Off Date are applied to past due
amounts.

Total (row) Fees + Expenses + Advances + Finance Charge for each aging period.

Total (column) (0-30) + (31-60) + (61-90) + (91-120) + (121-180) + (181+) for Fees, Expenses, Advances, and
Finance Charge. The client’s total balance due minus unapplied payments is shown at the end of
this column.

* Displayed in the Finance Charge row indicates the client will be assessed a finance charge on past
due amounts.

Unapplied Payments This figure includes unprocessed regular payments (Type “1”) through theWIP Cut-Off Date and
all processed regular payments that exceed the balance due. Unapplied payments are also included
in the client’s Total figures. Unapplied fee payments (Type 2) are shown as a credit amount in the 0-
30 column of the Fees row. Unapplied cost payments (Type 3) are shown as a credit amount in the
0-30 column of the Expenses or Advances row.

WIP Fees Total amount of fees in work-in-process through theWIP Cut-Off Date. Credit transactions are
included. Type 6 transactions and non-billable transactions are not included. Transactions on hold
are included.

WIP Expenses Total amount of expenses in work-in-process through theWIP Cut-Off Date. Credit transactions
are included. Non-billable transactions are not included. Transactions on hold are included.

WIP Advances Total amount of advances in work-in-process through theWIP Cut-Off Date. Credit transactions
are included. Non-billable transactions are not included. Transactions on hold are included.

WIP Total Total work-in-process fees, expenses, and advances.

(Age) Days Displayed in the WIP column. Average age of work-in-process fees, expenses, and advances based
on the age of each entry multiplied by the amount of each entry divided by the total WIP amount
(weighted average).

Billing Notes &
Instructions

Billing notes and instructions can optionally be entered on the Billing Preferences tab of the Client
file. If the Billing Notes & Instructions check box is selected for the report, billing notes and
instructions will be included in a separate column to the right of the report.
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Summary Accounts Receivable Report

Date: 11/28/2016 Tabs3 Summary Accounts Receivable Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 1 Michael L. Jensen
0-30 31-60 61-90 91-120 121-180 181+ Bal Due

121.01 M Phillips/Marcus 4,506.35 1,167.50 0.00 0.00 0.00 0.00 5,673.85

200.01 M Peterson Insurance Co. 660.35 0.00 0.00 0.00 0.00 0.00 660.35

Totals 5,166.70 1,167.50 0.00 0.00 0.00 0.00 6,334.20

Task Folder Reports | A/R Reports | Summary A/R Report

The Summary Accounts Receivable Report gives you an aged breakdown of the balance due for each client. It indicates how
much of the balance for each client is in each of the aging periods defined on the Options tab in Tabs3 Customization. The
report date is used as a basis for calculating aging on the past due amounts. All billed and updated statement amounts that are
outstanding are included on the report regardless of the report date. The Summary Accounts Receivable Report includes
unprocessed payments (excluding payments on hold) through the specifiedWIP Cut-Off Date. An unprocessed payment is a
payment that has been entered into work-in-process but has not been processed on a final statement and updated. The report
above includes subtotals by client.

The Options tab includes parameters that enable you to specify what type of information is included on the report (e.g., a WIP
cut-off date, include zero balance clients, a minimum balance due, etc.) The Format tab allows you to optionally include
information such as work description, client name, billing notes & instructions, contact & billing information, as well as choose
portrait or landscape orientation.

Definitions for Summary Accounts Receivable Report
Date The report date is used as a basis for calculating aging on the past due amounts.

Client Client ID. The letter after the Client ID represents the billing frequency.

Name Client name and/or work description will be printed depending if the Client Name andWork
Description options are selected on the Format tab. When the Contact & Billing Information
option is selected, the contact name, first two phone numbers with information, and primary
timekeeper initials will print. (Note: The timekeeper initials will only print if the list is not printed in
timekeeper order.) Progress Bill indicates the client is set up for progress billing. Fin. Chg. indicates
the client will be assessed a finance charge on past due amounts. The report shown includes the
client name only.

0-30, 31-60, 61-90, 91-
120, 121-180, 181+

Each aging column includes fees, expenses, advances, fee/expense/advance tax and finance
charge. The aging of amounts is determined by the report date specified. The number of days
between the Report date and each statement date determines the aging period of each past due
amount. Work-In-Process payments through theWIP Cut-Off Date are applied to past due
amounts.

Bal Due (0-30) + (31-60) + (61-90) + (91-120) + (121-180) + (181+) = Bal Due.

Unapplied Payments This figure includes unprocessed regular payments (Type “1”) through the WIP Cut-Off Date and all
processed regular payments that exceed the Balance Due. Unapplied payments are also included in
the client Balance Due figure. Unapplied fee and cost payments (Types 2 and 3) are shown as a
credit amount in the 0-30 bracket.

(Bal Due) Client’s Bal Due minus Unapplied Payments.

Billing Notes &
Instructions

Billing notes and instructions can optionally be entered on the Billing Preferences tab of the Client
file. If the Billing Notes & Instructions check box on the Format tab is selected for the report,
billing notes and instructions will be included on the report.
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Accounts Receivable by Invoice Report

Date: 11/28/2016 Tabs3 Accounts Receivable by Invoice Report Page: 1
Jensen, Martin & Anderson, P.C.

Thru 10/31/2016

B I L L E D D U E
Date Fees Expenses Advances Fin Chg Total Fees Expenses Advances Fin Chg Total Ref # Stmt #

200.02M  Peterson Insurance Co. (continued)
09/27/2016 91.00 40.00 131.00 40.00 40.00 2 7590

6 DHB 91.00
Adv 0 Miscellaneous 40.00

Last Applied Pymt: 91.00 11/28/2016

10/28/2016 1,584.50 215.25 150.00 1,949.75 224.50 215.25 150.00 589.75 3 7594
1 MLJ 1,000.00
7 CB 84.50
8 JAN 500.00

Exp 0 Miscellaneous 96.00
Exp 1 Phone 81.00
Exp 2 Photocopies/Faxes 38.25
Adv 0 Miscellaneous 150.00

Last Applied Pymt: 1,360.00 11/28/2016

Subtotal 1,675.50 215.25 265.00 2,155.75 224.50 215.25 265.00 704.75
1 MLJ 1,000.00
6 DHB 91.00
7 CB 84.50
8 JAN 500.00

Exp 0 Miscellaneous 96.00
Exp 1 Phone 81.00
Exp 2 Photocopies/Faxes 38.25
Adv 0 Miscellaneous 190.00
Adv 1 Filing Fees 75.00

Balance Due: 704.75

415.00M  MegaConstruction Corporation
RE: Corporate Merger - Megabuilders and BuilderCorp

10/28/2016 40,547.50 22.26 40,569.76 5,682.99 22.26 5,705.25 24 7593
1 MLJ 12,625.00
2 PAM 10,125.00
4 ROB 13,650.00
6 DHB 540.00
7 CB 2,295.00
8 JAN 1,312.50

Last Applied Pymt: 34,864.51 11/22/2016

Balance Due: 5,705.25

850.00M  White/Kelly
RE: Divorce

10/28/2016 840.00 150.00 990.00 715.00 150.00 865.00 1 7596
1 MLJ 750.00
5 KIM 90.00

Adv 1 Filing Fees 150.00
Last Applied Pymt: 125.00 11/22/2016

Balance Due: 865.00

Totals

54,220.10 404.69 691.50 22.26 55,338.55 13,615.00 376.44 666.50 22.26 14,680.20
1 MLJ 19,719.10
2 PAM 13,928.75
3 RPA 1,746.25
4 ROB 13,650.00
5 KIM 125.00
6 DHB 631.00
7 CB 2,392.50
8 JAN 1,892.50
9 JIM 135.00

Exp 0 Miscellaneous 161.44
Exp 1 Phone 141.25
Exp 2 Photocopies/Faxes 102.00
Adv 0 Miscellaneous 209.00
Adv 1 Filing Fees 300.00
Adv 2 Processor Fees 182.50

Balance Due: 14,680.20

Task Folder Reports | A/R Reports | A/R by Invoice Report

The Accounts Receivable by Invoice Report shows how much was billed and how much is still due by invoice for each client.
Billed and due amounts are broken down into fees, expenses, advances, finance charge, and totals. Detailed billed information
that shows amounts billed by timekeeper and Cost Type can optionally be included for each statement and/or subtotal. The
amount and date of the payment that was most recently applied to each statement can also be printed on the report. Payments
on hold are not included.
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The Options tab includes parameters that enable you to select a date range of information to include, select a cut-off date for
WIP payments, include zero balance statements, include the last applied payment date and amount, print detailed billed
information for each statement, print detailed billed information for each subtotal, and start each client on a new page.

Definitions for Accounts Receivable by Invoice Report
Date (heading)6 Used for reference only.

Date Range (heading)1 Shows the date range selected for the report. A date range will not print if a beginning and ending
date range of mm/dd/yyyy is used.

(client) Client ID, name and work description. The letter after the Client ID represents the billing frequency.
An asterisk preceding the work description indicates the work description will not print on the
client’s statement.1

Balance Forward1 This figure is shown if the client had a balance due prior to the beginning date selected for the
report.

Date Statement date.

Billed Billed information from the client ledger file. Detailed billed information that shows amounts billed
by timekeeper and Cost Type can optionally be included for each statement.

P1 Following a fee amount represents a progress billing amount (Type 6 transactions).

Due Due information from the client ledger file.

Total Fees + Expenses + Advances + Finance Charge Due.

Ref # Reference number of the client ledger record.

Stmt # Statement number.

Subtotal Subtotals for each client. If only one invoice is printed for the client, a client subtotal will not print.
Detailed billed information that shows amounts billed by timekeeper and Cost Type can optionally
be included for each subtotal.

Last Applied Pymt This field is optionally included on the report, and represents the amount and date of the last
payment (either processed or WIP) that was applied to the statement. It shows only when a portion
of the statement has been paid. A negative figure for the payment amount indicates that the last
payment record in the client ledger file is a payment reversal record.

Unapplied Payments Consists of both processed and unprocessed payments. This field is displayed whenever payments
exceed billed amounts. The Unapplied Payments figure includes Type 1 (regular), 2 (fee), and 3
(cost) payments.

Balance Due The Balance Due information is calculated and is not stored in the client ledger file.

Total Total Billed, Due and Balance Due for all clients shown.

1Not shown on the sample report.
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Accounts Receivable by Timekeeper Report (Platinum Only)
Date: 11/28/2016 Tabs3 Accounts Receivable by Timekeeper Report Page: 1

Jensen, Martin & Anderson, P.C.

Working Timekeeper: 1 Michael L. Jensen
Total

0-30 31-60 61-90 91-120 121-180 181+ Fees Due Balance Due

121.01 Phillips/Marcus 0.00 0.00 0.00 0.00 0.00 4,871.60 4,871.60 5,123.85
RE: Real Estate Acquisition

200.01 Peterson Insurance Co. 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
RE: General Legal Counsel Unapplied Payments: 2,327.65 -2,327.65

Totals 0.00 0.00 0.00 0.00 0.00 4,871.60 4,871.60 2,796.20

Working Timekeeper: 2 Paula Ann Martin
Total

0-30 31-60 61-90 91-120 121-180 181+ Fees Due Balance Due

101.00 Williams/John 0.00 0.00 0.00 0.00 0.00 1,015.25 1,015.25 1,015.25
RE: State v. Williams

Totals 0.00 0.00 0.00 0.00 0.00 1,015.25 1,015.25 1,015.25

Working Timekeeper: 3 Ronald P. Anderson
Total

0-30 31-60 61-90 91-120 121-180 181+ Fees Due Balance Due

200.02 Peterson Insurance Co. 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
RE: Maintenance of Insurance Policies Unapplied Payments: 290.97 -290.97

415.00 MegaConstruction Corporation 0.00 0.00 0.00 0.00 0.00 65,477.06 65,477.06 65,499.22
RE: Corporate Merger - Megabuilders and BuilderCorp

Totals 0.00 0.00 0.00 0.00 0.00 65,477.06 65,477.06 65,208.25

Working Timekeeper: 5 Kendra I. Michaels
Total

0-30 31-60 61-90 91-120 121-180 181+ Fees Due Balance Due

850.00 White/Kelly 0.00 0.00 0.00 0.00 0.00 125.00 125.00 150.00
RE: Divorce

850.01 White/Kelly 0.00 0.00 0.00 0.00 0.00 1,500.00 1,500.00 1,500.00
RE: Last Will & Testament

Totals 0.00 0.00 0.00 0.00 0.00 1,625.00 1,625.00 1,650.00

Note:  Aging figures are shown for Receipt Allocation by Invoice clients only.

Note:  Aging figures are shown for Receipt Allocation by Invoice clients only.

Note:  Aging figures are shown for Receipt Allocation by Invoice clients only.

Date: 11/28/2016 Tabs3 Accounts Receivable by Timekeeper Report Page: 1
Jensen, Martin & Anderson, P.C.

Working Timekeeper: 1 Michael L. Jensen
Fees Due

101.00 Williams/John 1,812.50

121.01 Phillips/Marcus 7,759.10

200.01 Peterson Insurance Co. 7,608.00

200.02 Peterson Insurance Co. 1,175.00

415.00 MegaConstruction Corporation 8,475.00

Totals 26,829.60
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Date: 11/28/2016 Tabs3 Accounts Receivable by Timekeeper Report Page: 1
Jensen, Martin & Anderson, P.C.

Total % Total Total
0-30 31-60 61-90 91-120 121+ Fees Due WIP Fees Fees Due Fees Due Balance Due

Totals for Michael L. Jensen 24,720.85 1,983.75 0.00 0.00 125.00 26,829.60 625.00 111,129.44 24.14% 111,888.67

Totals for Paula Ann Martin 8,327.75 0.00 0.00 0.00 0.00 8,327.75 1,237.50 101,210.31 8.23% 101,717.29

Totals for Ronald P. Anderson 41,352.53 24,929.56 0.00 0.00 0.00 66,282.09 0.00 92,484.59 71.67% 92,777.22

Totals for Robert O. Burns 5,250.00 0.00 0.00 0.00 0.00 5,250.00 0.00 90,324.56 5.81% 90,617.19

GRAND TOTALS 79,651.13 26,913.31 0.00 0.00 125.00 106,689.44 1,862.50

Note:  Matters not configured for Receipt Allocation by Invoice have been excluded.

Task Folder Reports | A/R Reports | A/R by Timekeeper Report

The Accounts Receivable by Timekeeper Report shows you fees due for each working timekeeper. This report includes only
clients that the timekeeper has worked on, and can be run for all working timekeepers or for a range of timekeepers. The
Accounts Receivable by Timekeeper Report is only available in the Platinum version of the software.

A breakdown by aging period can be included for each of the aging periods defined on the Options tab in Tabs3 Customization.
All billed and updated statement amounts that are outstanding are included on the report regardless of the report date. The
Accounts Receivable by Timekeeper Report includes unprocessed payments (excluding payments on hold) through the
specified WIP Payment Cut-Off Date. An unprocessed payment is a payment that has been entered into work-in-process but has
not been processed on a final statement and updated.

The Options tab includes parameters that enable you to specify what type of information is included on the report (e.g., a WIP
Payment cut-off date, working timekeeper range, a minimum past due fee amount, etc.). The Format tab allows you to
optionally include information such as work description, aging breakdown, WIP fees, total fees due, and total balance due. The
Sort tab allows you to change the sort order within a working search or fees due.

Receipt Allocation by Invoice Notes: Only clients that are configured for Receipt Allocation by Invoice can display an aging
breakdown. The aging columns will be blank for clients that have Receipt Allocation by Invoice disabled. These columns may
also be blank for clients that were converted from other software.

When running the report for a range of clients, both clients with Receipt Allocation by Invoice enabled and clients with
Receipt Allocation by Invoice disabled can be included. If this occurs, and a timekeeper’s accounts receivable totals include
one or more clients for whom Receipt Allocation by Invoice is disabled, the following note will appear in the Totals section for
that timekeeper: Note: Aging figures are shown for Receipt Allocation by Invoice clients only.

Additionally, if the Include Clients whose timekeeper’s fees aremore than ### days past due option is set to anything other
than 0, and there are clients included in the Client ID range for whom Receipt Allocation by Invoice is disabled, this following
note will be displayed: Note: Matters not configured for Receipt Allocation by Invoice have been excluded. This note will
appear after every Working Timekeeper’s Totals regardless of whether or not they have accounts receivable amounts for these
clients.

Definitions for Accounts Receivable by Timekeeper Report (Platinum Only)
Date The report date is used as a basis for calculating aging on the past due amounts.

Client Client ID.

Name Client name. The client’s work description will be printed if theWork Description check box is
selected on the Format tab.

0-30, 31-60, 61-90, 91-
120, 121-180, 181+

Each aging column includes the amount of fees due to the working timekeeper. Aging periods will
be printed if the Aging Breakdown option is selected on the Format tab. The aging of fees due is
determined each time the report is run. The number of days between the report date and each
statement date determines the aging period of each past due amount. Work-In-Process payments
through theWIP Cut-Off Date are applied to past due amounts. Only clients that are configured
for Receipt Allocation by Invoice can display an aging breakdown.

Fees Due Total of fees due for the working timekeeper. This value is displayed regardless of whether the client
is configured for Receipt Allocation by Invoice. As a result, totals or grand totals of the Fees Due will
only match the sum of the aging period totals or grand totals if all of the clients on the report are
configured for Receipt Allocation by Invoice.
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WIP Fees Amount of fees for the working timekeeper that are in Work-In-Process through theWIP Payment
Cut-Off Date. Type 6 transactions and nonbillable transactions are not included. The WIP Fees
column is included if theWork-In-Process Fees check box is selected in the Format tab.

Total Fees Due Total of all fees due for all timekeepers who worked on the matter. The Total Fees Due column is
included if the Total Fees Due check box is selected on the Format tab.

%Total Fees Due Percentage of Total Fees Due that is owed to the working timekeeper (Fees Due divided by Total
Fees Due). The % Total Fees Due column is included if the Total Fees Due and%Total Fees Due
check boxes are selected in the Format tab.

Total Balance Due Total Balance Due for the matter, including all fees for all timekeepers, expenses, advances, and
finance charges, minus any unapplied payments. The Total Balance Due column is included if the
Total Balance Due check box is selected in the Format tab.

Unapplied Payments This figure includes unprocessed regular payments (Type “1”) through theWIP Payment Cut-Off
Date and all processed regular payments that exceed the balance due. Unapplied payments are also
included as a credit in the client’s Total figures. Unapplied payments are shown below the aging
breakdown.

Summary Collections Report

Date: 11/28/2016 Tabs3 Summary Collections Report Page: 1
Jensen, Martin & Anderson, P.C.

Average Amount Amount
Age Billed Paid % Paid Amount Due

101.00 M Williams/John 48 4,514.45 1,462.40 32.39% 3,052.05
RE: State v. Williams

Contact: Johnny Williams Last Payment: 10/24/2016 579.90 35 days
Home:            402-598-2354

200.01 M Peterson Insurance Co. 48 3,154.75 682.84 21.64% 2,471.91
RE: *General Legal Counsel

Contact: Paul Franklin Last Payment: 10/10/2016 959.75 45 days
Business:       402-435-1739 Ext. 512

102.00 M Federated Casualty, Ltd. 104 1,672.29 272.18 16.28% 1,400.11
RE: Andrew C. Gilbert v. Federated Casualty

Contact: Samantha Kessler Last Payment: 08/29/2016 100.00 93 days
Mobile:           402-421-2850 Ext. 210

200.02 M Peterson Insurance Co. 0 0.00 0.00 0.00% 0.00
Unapplied Payments: 279.12 -279.12

RE: Maintenance of Insurance Policies
Contact: Paul Franklin Last Payment: 10/31/2016 500.00 30 days
Business:       402-435-1739 Ext. 512

Amount Amount
Billed Paid % Paid Amount Due

Totals 9,341.49 2,417.42 25.88% 6,924.07
Unapplied Payments: 279.12 6,644.95

Task Folder Reports | A/R Reports | Collections Report

The Collections Reports can be used to assist with the collection of receivables. A Summary Collections Report helps identify
which clients may require additional collection efforts and includes the total amount billed, amount paid, percentage paid, and
amount due for all outstanding invoices. The date and amount of the last payment is shown on both Detail and Summary
Collections Reports along with the number of days since the last payment. The client address can be optionally included on
both reports.

You have a great deal of flexibility in determining exactly which clients you want included on the report. You can select which
clients you want included on the report based on a number of days past due, a minimum amount past due in a specified
number of days past due, total balance due, or you can specify to include only clients that have no payments in a specified
number of days. Clients can be sorted by name, Client ID, descending balance due, or descending last payment date.
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Work-in-process payments thru the WIP Payment Cut-Off Date specified are applied to invoices with a balance due. Work-in-
process payments on Hold are not included.

Definitions for Summary Collections Report
Date (heading) The report date is used as a basis for calculating the age of payments and the average age of

outstanding invoices.

(client) Client ID, client name and work description. The letter following the Client ID represents the billing
frequency. The contact name and primary phone are always shown on the report. If the primary
phone is not selected, the next available phone number is printed. The client’s primary address is
shown under the contact information when including the optional client address. If the client is set
up to receive statements using only an Additional Bill To record, the Bill To Name and Bill To
Address will print instead of the client’s primary address.

Average Age A calculated average number of days old for all invoices that have an amount due. The number of
days old is based on the specified report date. This figure is a simple average and is not weighted.
For example, if there are 2 invoices, one past due 60 days and another past due 90 days, the Average
Age will be 75 days.

Amount Billed Total amount billed to the client for all invoices that have an amount due. It is important to note
that this figure does not include invoices that have been paid in full.

Amount Paid This figure represents the total amount paid on all of the invoices included in the Amount Billed
figure. Work-in-process payments thru the WIP Pymt Cut-Off Date specified are applied to invoices
with a balance due.

%Paid Percentage of Amount Billed that has been paid (Amount Paid divided by Amount Billed).

Amount Due Amount Billed minus Amount Paid.

Unapplied Payments Consists of processed payments and work-in-process payments thru the WIP Pymt Cut-Off Date
specified. This field is displayed whenever payments exceed billed amounts. The Unapplied
Payments figure includes Type 1 (regular), 2 (fee), and 3 (cost) payments. If unapplied payments are
shown on the report, the Amount Due minus Unapplied Payments is shown under the Amount Due
figure.

Last Payment On the summary report, the date of the last payment, amount, and the number of days between the
last payment and report date are shown. The last payment is determined based on the payment date
as opposed to the date of entry. If there are multiple payments with the same date for the last
payment, the amounts are combined. The Last Payment can be a processed payment or a work-in-
process payment.
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Detail Collections Report

Date: 11/30/2016 Tabs3 Detail Collections Report Page: 1
Jensen, Martin & Anderson, P.C.

200.01 M Peterson Insurance Co. Statement Statement Amount Amount

RE: *General Legal Counsel Date Number Age Billed Paid % Paid Amount Due

Contact: Paul Franklin  04/27/2016 599  217  125.00  60.00  48.00%  65.00
Address: 5th & Turner  07/29/2016 7503  124  239.00  125.00  52.30%  114.00

Malcolm, NE 68633 09/01/2016 7511  90  10.41  0.00  0.00%  10.41
Business: 402-435-1739x512  Prim:  MLJ  09/30/2016 7517 61 859.75 0.00 0.00% 859.75
Business Fax: 402-421-2855  Sec:  RPA  10/31/2016 7520 30 1,563.19 0.00 0.00% 1,563.19
Home: 402-421-4677  Orig:  PAM  11/30/2016 7577 0 5,600.00 0.00 0.00% 5,600.00

Mobile: 402-474-8605 87 8,397.35 185.00 2.20% 8,212.35
E-mail: pfranklin@petersoninsurance.com

 

Trust Balance: 500.00 Work-In-Process & Billing History Total To-Date

Client Funds: 150.00 WIP Amount Due WIP + Due Billed

 Fees: 5,600.00 7,998.00 13,598.00 13,841.75
Billing Notes & Instructions: Expenses: 0.00 75.35 75.35 150.35
10/12/2016 11:04am RON Called Ms. Kessler (bookkeeper) who said that check Advances: 0.00 139.00 139.00 339.00
#8756 was sent on 10/07/2016. Finance Charge: 0.00 0.00 0.00

Total: 5,600.00 8,212.35 13,812.35 14,331.10
10/14/2016 11:35am RON Check was not received. Called Ms. Kessler. She Average Age: 33    33 days
said check was mailed on 10/07/2016 and that we should have already received
it. She will stop payment on that check and issue another check.

Last 5 Write Offs within All Months & Last 5 Payments within All Months
Write Offs Payments

09/16/2016 60.00 11/26/2016 812.50
01/20/2016 506.25
03/16/2016 4,465.00
10/17/2016 275.00

Total: Total:60.00 6,058.75

Last Payment Date:  10/17/2016 Average Days Between Payments: 108 days

Last Payment Amount: 275.00 Days Since Last Payment: 44 days

Amount Amount
Billed Paid % Paid Amount Due

Totals 8,397.35 185.00 2.20% 8,212.35

The Detail Collections Report shows more detail for determining how to proceed with collections efforts. A Detail Collections
Report provides additional contact information, detail for each outstanding invoice, optional work-in-process and billing
history information, optional write off and payment history, and optional billing notes and instructions.

When including a payment history, the average number of days between payments is calculated and shown making it easy to
determine if a client’s last payment is within their normal average number of days. Work-in-process payments thru the WIP
Payment Cut-Off Date specified are applied to invoices with a balance due. Work-in-process payments on Hold are not
included.

Like the Summary Collections Report, you have a great deal of flexibility in determining exactly which clients you want included
on the report. You can select which clients you want included on the report based on a number of days past due, a minimum
amount past due in a specified number of days past due, total balance due, or you can specify to include only clients that have
no payments in a specified number of days. Clients can be sorted by name, Client ID, descending balance due, or descending
last payment date.

It is important to note that the Collections reports do not include invoices that have been paid in full (with the exception of the
To-Date Billed figures in the optional Work-In-Process & Billing History section).

Definitions for Detail Collections Report
Date (heading) The report date is used as a basis for determining the age of unpaid statements, the age of the last

payment, and the average age of work-in-process transactions. It is also used for defining the time
frame when including payment items or write off items.

(client) Client ID, client name and work description. The letter following the Client ID represents the billing
frequency. The contact name and primary phone are always shown on the report. The client’s
primary address is shown under the contact name when including the optional client address. All
other selected phone numbers, the primary e-mail address, and timekeeper assignments are
included on a detail report. If the client is set up to receive statements using only an Additional Bill
To record, the Bill To Name and Bill To Address will print instead of the client’s primary address.

Trust Balance Only shown on the detail report. Includes a combined balance for all bank accounts for the client.
Includes all trust transactions regardless of the date.
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Client Funds Only shown on the detail report. Reflects the current balance of the client funds account including
any work-in-process client funds transactions regardless of the date.

Progress Billing1 Progress WIP: Total amount of Type 6 (progress fee) transactions in work-in-process regardless of
date.
Progress Billed: Total amount of Type 6 progress fees billed since the last time the client was
“reconciled” (from the Progress Billed field on the A/R & Fund Balances tab in the Client file).
Progress WIP Tax is not included.
Progress Paid: Progress Billed minus Fees Due (from the A/R & Fund Balances tab in the Client file).

Billing Notes &
Instructions

Billing Notes & Instructions from the Billing Preferences tab in the client file. This information is
optional and is included only when the Billing Notes & Instructions check box on the Format tab
is selected.

Statement Date Date of the updated statement that has an amount due. Only statements that have current charges
will be included.

Statement Number Statement Number of the updated statement that has an amount due.

Age Age of statement in days based on the specified Report Date. The total Age figure is the calculated
average number of days old of each invoice with an amount due. This figure is a simple average and
is not weighted. For example, if there are 2 invoices, one past due 60 days and another past due 90
days, the Average Age will be 75 days regardless of the amount due for each invoice.

Amount Billed Amount billed for the updated statement that has an amount due.

Amount Paid Amount paid for the updated statement that has an amount due. Work-in-process payments thru
the WIP Pymt Cut-Off Date specified are applied to invoices with a balance due.

%Paid Percentage of Amount Billed that has been paid (Amount Paid divided by Amount Billed).

Amount Due Amount Billed minus Amount Paid.

Unapplied Payments1 Consists of processed payments and work-in-process payments thru the WIP Pymt Cut-Off Date
specified. This field is displayed whenever payments exceed billed amounts. The Unapplied
Payments figure includes Type 1 (regular), 2 (fee), and 3 (cost) payments. If unapplied payments are
shown on the report, the Amount Due minus Unapplied Payments is shown under the Amount Due
figure.

Work-In-Process & Billing History
This section is shown only when the IncludeWork-In-Process & Billing History check box on the Format tab is selected.

WIP Amount of fee, expense, and advance transactions in work-in-process for the client. All work-in-
process transactions are included in these figures regardless of the date of the transactions.
Transactions on hold are included. Progress fees are not included.

Amount Due Amount due for fees, expenses, advances, and finance charge for the client. The Total Amount Due
in this section will match the Total Amount Due in the section that itemizes the detailed statements
(i.e., above the Work-In-Process & Billing History section).

Total WIP + DueWIP
plus Amount Due.

To-Date Billed To-Date Billed amounts for fees, expenses, advances, finance charge and a grand
total of all statements that have been billed, including statements that have been paid in full. These
figures make it easy to see how much business the firm has done with the client.

Average Age Average age of work-in-process fees, expenses, and advances based on the age of each entry
multiplied by the amount of each entry divided by the total WIP amount (weighted average).

Write Off History & Payment History
This section is shown only when the Payment Items orWrite Off Items check boxes on the Format tab are selected. If the
check boxes are selected and no write offs or payments are available, the section heading will not be printed. The number of
items selected and time frame selected are included in the heading.

Write Offs Lists write off amounts within the number of items and time frame specified along with the date of
the write off. A total for write off amounts listed is included.
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Payments Lists all processed and unprocessed payment amounts within the number of items and time frame
specified along with the payment date. The label “WIP” is shown next to any unprocessed payments
(i.e., payments still in work-in-process). A total for payment amounts listed is included. Payments
on the same date are combined.

Average Days Between
Payments

The number of days between each payment in the Payments list is averaged. This figure can be
useful when comparing to the number of days since the last payment to determine if the client is
paying later than usual. This figure can change when additional payments are shown on the report.
This figure prints only when the average is greater than zero.

Last Payment Information
The last payment information is always shown regardless of whether the payment history is included. This information is the
same information presented on the summary report; however, full labels are included on the detail report. The last payment is
determined based on the payment date as opposed to the date of entry. If there are multiple payments with the same date for
the last payment, the amounts are combined. The Last Payment can be a processed payment or a work-in-process payment.

Last Payment Date Date of the last payment.

Last Payment Amount Amount of the last payment.

Days Since Last Payment Number of days between the last payment and the report date.

1Not shown on the sample report.
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Allocated Payments Report
Date: 11/28/2016 Tabs3 Detail Allocated Payments Report Page: 1

Jensen, Martin & Anderson, P.C.

Payments Allocated From 09/01/2016 Thru 09/30/2016

Pymt Date Ref # Stmt # Pymt Amt Allocated Exp Tax Expenses Adv Tax Advances Fin Chg Fee Tax Fees

100.00M  Phillips/Marcus
1 MLJ RE: Real Estate Acquisition

09/08/2016 ARCH 72 750.00F 750.00 0.00 0.00 0.00 0.00 0.00 28.84 721.16
149.59001 Michael L. Jensen
427.18002 Jennifer A. Martin
144.39003 Ronald P. Anderson

09/12/2016 ARCH 92 75.00A 75.00  0.00 0.00 0.00 75.00  0.00 0.00 0.00
Miscellaneous 4.69

Filing Fees 23.44
Processor Fees 18.75

Witness Fees 28.12

09/15/2016 ARCH 92  9.00E 9.00  0.00  9.00  0.00  0.00  0.00  0.00  0.00
Miscellaneous 2.90

Phone 1.61
Photocopies 4.49

Subtotal                                                                           834.00                    834.00 0.00 9.00 0.00                     775.00 0.00 28.84                 721.16
Miscellaneous 2.90 Miscellaneous 4.69 149.59001 Michael L. Jensen

Phone 1.61 Filing Fees 23.44 427.18002 Jennifer A. Martin
Photocopies 4.49 Processor Fees 18.75 144.39003 Ronald P. Anderson

Witness Fees 28.12

120.00M  Berger/Randall
1 MLJ RE: Real Estate Investment

09/01/2016 ARCH 101 1,000.00 92.75 0.00 20.00 0.00 0.00 0.00 0.00 72.75
Allocated Out of Date Range: 907.25 Miscellaneous  20.00 72.75004 Nicole Sampson

09/07/2016 ARCH 103 150.00F 127.25 0.00 0.00 0.00 0.00 0.00 0.00 127.25
Remaining Amount to Allocate: 22.75 127.25004 Nicole Sampson

09/12/2016 9 WIP  300.00 40.00 * 0.00 0.00 0.00 0.00 0.00 0.00 40.00
Remaining Amount to Allocate: 260.00 40.00003 Ronald P. Anderson

09/23/2016 16 WIP  75.00 35.00 * 0.00 0.00 0.00 0.00 0.00 0.00 35.00
Remaining Amount to Allocate: 40.00 35.00003 Ronald P. Anderson

Subtotal 1,525.00 295.00 0.00 20.00 0.00 0.00 0.00 0.00 275.00
Allocated Out of Date Range: 907.25 Miscellaneous 20.00 75.00003 Ronald P. Anderson

Remaining Amount to Allocate: 322.75 200.00004 Nicole Sampson
Unallocated Payments: 325.00

Total Unallocated: 647.75

Grand Totals 2,359.00  1,129.00  0.00 29.00  0.00                     75.00  0.00 28.84                 996.16
Allocated Out of Date Range: 907.25 Miscellaneous  22.90 Miscellaneous  4.69 149.59001 Michael L. Jensen

Remaining Amount to Allocate: 322.75 Phone 1.61 Filing Fees 23.44 427.18002 Jennifer A. Martin
Unallocated Payments: 325.00 Photocopies 4.49 Processor Fees 18.75 219.39003 Ronald P. Anderson

Total Unallocated: 647.75 Witness Fees 28.12 200.00004 Nicole Sampson

Task Folder Reports | Management Reports | Allocated Payments Report

The Allocated Payments Report shows how payments were allocated to fees, expenses, advances, sales tax and finance charge.
Only those payments that include allocated amounts are included in the body of the report. Amounts allocated to individual
timekeepers and cost types are included on a Detail report. This report is based on the payment allocation date, which may or
may not be the same as the payment transaction date, depending on when the payment was allocated.

The Options tab allows you to select a payment allocation date range of payments to include and select if the report will be a
detail or summary type. If the Detail option is selected, you can optionally include fee compensation amounts on the report.
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Date: 11/28/2016 Tabs3 Summary Allocated Payments Report Page: 1
Jensen, Martin & Anderson, P.C.

Payments Allocated From 09/01/2016 Thru 10/31/2016

Pymt Date Ref # Stmt # Pymt Amt Allocated Exp Tax Expenses Adv Tax Advances Fin Chg Fee Tax Fees

100.00M  Phillips/Marcus
1 MLJ RE: Real Estate Acquisition

09/08/2016 ARCH 72 750.00F 750.00 0.00 0.00 0.00 0.00 0.00                      28.84 721.16
09/12/2016 ARCH 92                     75.00A 75.00 0.00 0.00 0.00 75.00 0.00                        0.00                     0.00
09/15/2016 ARCH 92                       9.00E                     0.00                        0.00                        9.00                        0.00                       0.00                       0.00                        0.00                     0.00

Subtotal     834.00                   834.00 0.00 9.00 0.00                      75.00 0.00 28.84                 721.16

120.00M  Berger/Randall
1 MLJ RE: Real Estate Investment

09/01/2016 ARCH 101 1,000.00 92.75 0.00 20.00 0.00 0.00 0.00 0.00 72.75
Allocated Out of Date Range: 907.25

09/07/2016 ARCH 103 150.00F 127.25 0.00 0.00 0.00 0.00 0.00 0.00 127.25
Remaining Amount to Allocate: 22.75

09/12/2016 9 WIP  300.00 40.00 * 0.00 0.00 0.00 0.00 0.00 0.00 40.00
Remaining Amount to Allocate: 260.00

09/23/2016 16 WIP  75.00 35.00 * 0.00 0.00 0.00 0.00 0.00 0.00 35.00
Remaining Amount to Allocate: 40.00

Subtotal 1,525.00 295.00 0.00 20.00 0.00 0.00 0.00 0.00 275.00
Allocated Out of Date Range: 907.25

Remaining Amount to Allocate: 322.75
Unallocated Payments: 325.00

Total Unallocated: 647.75

Grand Totals 2,359.00 1,129.00 0.00 29.00 0.00                      75.00 0.00 28.84                  996.16
Allocated Out of Date Range: 907.25

Remaining Amount to Allocate: 322.75
Unallocated Payments: 325.00

Total Unallocated: 647.75

Definitions for Allocated Payments Report
Date (heading) Used for reference only and has no bearing on the report.

Payments Allocated From
(heading)

Shows the date range selected for the report. A date range will not print if a beginning and ending
date range for payment allocation of mm/dd/yyyy is used. This report is based on the payment
allocation date, which may or may not be the same as the payment transaction date, depending on
when the payment was allocated.

(client) Client ID, name, work description, and the client’s primary report order timekeeper number and
initials. The letter following the Client ID represents the billing frequency. An asterisk preceding the
work description indicates the work description will not print on the client’s statement.1

Pymt Date The payment transaction date.

Ref # Reference number of the payment transactions. “ARCH” indicates the payment transaction has
already been included on an updated statement.

Stmt # The number of the statement on which the payment was processed. “WIP” indicates the payment
has not yet been included on an updated statement.

Pymt Amt The amount of the payment. The letter after the payment amount represents the payment type. “F”
indicates a fee payment (Type “2”), “E” indicates an expense payment (Type “3”), “A” indicates an
advance payment (Type “3”). No letter is shown for regular payments (Type “1”).

Allocated The amount of the payment that is allocated. An asterisk following this amount indicates the
payment was manually allocated.

Exp Tax The amount of the payment allocated to expense tax.

Expenses The amount of the payment allocated to expenses.

Adv Tax The amount of the payment allocated to advance tax.

Advances The amount of the payment allocated to advances.

Fin Chg The amount of the payment applied to finance charge.

Fee Tax The amount of the payment allocated to fee tax.
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Fees The amount of the payment allocated to fees.

Allocated Out of Date
Range

Shows only when a portion of the payment has been allocated outside of the specified allocation
date range.

Payment Adjustments Shows only when amounts have been refunded.1

Remaining Amount to
Allocate

Shows only when a portion of the payment included in the body of the report has unallocated
amounts.

Unallocated Payments Shows only when there are unallocated payments for a client that is included on the report. Only
those clients with allocated amounts will be included on this report. Includes all unallocated
payments for those clients regardless of the specified allocation date range. Consists of payments
that have no allocated amounts as well as portions of payments not on the report that are
unallocated.

Total Unallocated The sum of the Remaining Amount to Allocate and the Unallocated Payments.

Progress Paid Shows only when there are payments allocated to progress fees. Includes all payments allocated to
progress fees within the specified allocation date range.1

1Not shown on the sample report.
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Unallocated Payments Report

Date: 11/28/2016 Tabs3 Unallocated Payments Report Page: 1
Jensen, Martin & Anderson, P.C.

Pymt Date Ref # Stmt # Pymt Amt Allocated Unallocated

101.00M  Williams/John
2 PAM RE: State v. Williams 10/31/2016 6 WIP 1,617.65 923.40 694.25

415.00M  MegaConstruction Corporation
3 RPA RE: Corporate Merger - Megabuilders and BuilderCorp 11/28/2016 13 WIP 30,000.00 20,929.26 9,070.74

Grand Totals 31,617.65 21,852.66 9,764.99

Task Folder Reports | Management Reports | Unallocated Payments Report

The report shown above is an example of the Unallocated Payments Report. The Unallocated Payments Report shows payments
with unallocated amounts, including the payment date, reference number of the payment transaction, the statement number
the payment was included on, the amount of the payment, and the portion allocated and left unallocated. The report can also
display totals for the client, timekeeper or category used as the sort order.

The Options tab includes parameters that enable you to limit what date range of unallocated payments to include.

Definitions for Unallocated Payments Report
Date (heading) Used for reference only and has no bearing on the report.

(client) Client ID, billing frequency, name and work description. The letter following the Client ID represents
the billing frequency. An asterisk before the work description indicates that the work description
will not be included on the client’s statement.1

Pymt Date Date of the payment transaction.

Ref # Reference number identifying the payment record in the payment file for editing purposes. “ARCH”
indicates the payment transaction has already been included on an updated statement.

Stmt # The number of the statement on which the payment was processed. “WIP” indicates the payment is
still in work-in-process and has not yet been included on an updated statement. “HOLD” indicates
the work-in-process payment that has not been allocated because its Status field has been
changed to “H - Hold”.1

Pymt Amt Payment amount. The letter after the payment amount represents the payment type. “F” indicates a
fee payment (Type “2”), “E” indicates an expense payment (Type “3”), “A” indicates an advance
payment (Type “3”). No letter is shown for regular payments (Type “1”).

Allocated Amount of the payment that has been allocated. This figure is the difference between the Payment
Amount and the Unapplied Amount, which can be found on the payment record in the client ledger
file. This figure may not match the Pymt Amt if the payment has not applied to any amounts or if
the payment allocation has been edited. An asterisk following this amount indicates the payment
was manually allocated.

Unallocated The amount of the payment that is unallocated.

Payment Adjustments Shows only when amounts have been refunded.1

1Not shown on the sample report.
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Client Funds Report

Date: 11/30/2016 Tabs3 Client Funds Report Page: 1
Jensen, Martin & Anderson, P.C.

Date Type Description Amount Balance

900.00 Sherman/Natalie K.
Divorce

Opening Fund Balance: 0.00
11/03/2016  Credit Card Initial Deposit. 5,000.00  5,000.00
11/10/2016  Withdrawal  Payment to Alberts Investigations. 100.00  4,900.00
11/17/2016  Manual Fee Payment Payment for outstanding fees. 1,015.00  3,885.00
11/17/2016  Manual WIP Payment Payment for current work. 2,000.00  1,885.00
11/28/2016  Auto All Payment Payment  1,150.00  735.00

Minimum Balance: 0.00 Total Credit Cards: 5,000.00
Target Balance: 0.00 Total Payments: 4,165.00

Total Withdrawals: 100.00

850.01 White/Kelly
Divorce

Opening Fund Balance: 0.00

Retainer Amount: 500.00
Amount to Bill: 500.00
One Time

Closing Fund Balance: 0.00

Total Credit Cards: 5,000.00
Total Deposits: 0.00
Total Payments: 4,165.00
Total Withdrawals: 100.00

Total Fund Balance: 735.00

Closing Fund Balance: 735.00
Current Fund Balance: 1,000.00

Discrepancy:                                                                                                -265.00

 

Date: 11/28/2016 Tabs3 Client Funds Report Page: 1
Jensen, Martin & Anderson, P.C.

Client Name and Work Description Fund Balance

900.00 Sherman/Natalie K. 735.00
Divorce

850.01 White/Kelly 0.00
Divorce

Total Fund Balance: 735.00

Task Folder Reports | Client Reports | Client Funds Report

The Client Funds Report shows the client funds activity within a given date range. The detail report (top) shows credit card
deposits, withdrawals, and payments to the firm for each client funds account along with a running client funds balance. The
summary report (bottom) simply shows the balance for each client funds account.

The Options tab includes parameters that enable you to print a detail or summary report, select a date range of information to
include, print transaction descriptions, print billing amounts, print General Ledger Software (GLS) journal entry information,
include one time retainer clients only, include clients with activity only, exclude clients with a fund balance of zero, and start
each client on a new page.

Definitions for Client Funds Report
Date (heading) Used for reference only.

- 122 -



Tabs3 Report Pack

(client) Client ID, name and work description. The letter after the Client ID represents the billing frequency.
An asterisk preceding the work description indicates the work description will not print on the
client’s statement.1

Opening Fund Balance This figure is a calculated amount: Closing Balance + Payments + Withdrawals - Deposits =
Opening Balance.

Date Transaction date.

Type Transaction Type. Available types include “Credit Card,” “Deposit,” “Withdrawal,” “Manual All
Payment,” “Manual Fee Payment,” “Manual Cost Payment,” “Manual Exp Payment,” “Manual Adv
Payment,” “Manual WIP Payment,” “Auto All Payment,” “Auto Fee Payment,” “Auto Cost Payment,”
“Auto Exp Payment,” “Auto Adv Payment.” An asterisk in front of the Type indicates that the
transaction is on hold.1

Description Transaction description.

Amount Transaction amount.

Totals Total credit cards, deposits, payments, and withdrawals within the date range specified.

Closing Fund Balance
(Detail Report)

This figure is a calculated amount. The Fund Balance from the A/R & Fund Balances tab of the
Client file is retrieved. This figure is used if no Ending Date was specified for the report. However, if
an Ending Date was specified, all credit cards and deposits after the Ending Date are deducted from
the client funds balance and all payments and withdrawals after the Ending Date are added to the
client funds balance.

Current Fund Balance
(Detail Report)

The Fund Balance from the A/R & Fund Balances tab of the Client file. This figure is only displayed
if the Current Fund Balance differs from the Closing Fund Balance. To correct a discrepancy, run the
Data File Integrity Check (DFIC) without the Read Only check box selected. Running the DFIC in this
scenario will report an error 186. For more information, see Knowledge Base Article R11658, "DFIC
Error 186 - Balance Mismatch".

Fund Balance (Summary
Report)

This figure is a calculated amount. The Fund Balance from the A/R & Fund Balances tab of the
Client file is retrieved. This figure is used if no Ending Date was specified for the report. However, if
an Ending Date was specified, all credit cards and deposits after the Ending Date are deducted from
the client funds balance and all payments and withdrawals after the Ending Date are added to the
client funds balance.

Minimum Balance Amount entered in the Minimum Balance field on the A/R & Fund Balances tab of the Client file.
This represents the minimum amount you want the client to maintain in the client funds account.

Target Balance Amount entered in the Target Balance field on the A/R & Fund Balances tab of the Client file. This
represents the target amount you want the client to maintain in the client funds account. If the
client fund balance falls below the Minimum Balance, Tabs3 can bill a client funds amount equal to
the Target Balance minus the current balance.

One Time Indicates the client is a one-time retainer client (i.e., the One Time Retainer check box is selected
on the A/R & Fund Balances tab of the Client file).

Retainer Amount Amount entered in the Retainer Amount field on the A/R & Fund Balances tab of the Client file.
The amount represents the full amount of the retainer being billed and is only shown for one time
retainer clients.

Amount to Bill Amount entered in the Amount to Bill field on the A/R & Fund Balances tab of the Client file.
When the One Time Retainer check box is selected for a client, a line will print at the end of the
Client Funds section of the statement asking the client to remit the amount shown in the Amount
to Bill field.

Total Fund Balance Grand total of all Ending Fund Balances shown on the report.

1Not shown on the sample report.
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Client Productivity Report
Date: 11/28/2016 Tabs3 Client Productivity Report Page: 1

Jensen, Martin & Anderson, P.C.

Thru 11/28/2016

Hours Fees Exps Advs Total Write-Up Write-Dn Rate

100.00 M Dawson/Charles L.
Settlement of Grandfather's Estate

5 JPP 14.00 2,875.00 50.00 0.00 2,925.00 625.00 0.00 205.36
NB: 1.00 175.00 0.00 0.00 175.00

WIP: 273.00 Age: 12
101.00 M Barrett/Karen
Apartment Management

4 DHB 11.00 1,865.00 43.88 0.00 1,908.88 0.00 0.00 169.55
Write Off: -848.36 0.00 0.00 -848.36 92.42
NB: 0.75 131.25 0.00 0.00 131.25

102.00 M Richardson/Harold
Manage personal finances

1 RJB 18.30 3,431.00 81.50 0.00 3,512.50 0.00 0.00 187.49
200.01 M Jefferson Insurance Co.
Automobile Accident

1 RJB 9.50 2,275.00 15.00 90.00 2,380.00 162.50 0.00 239.47
200.02 C Jefferson Insurance Co.
Hail Damage - Palmer farm

1 RJB 9.00 2,000.00 67.50 15.00 2,082.50 245.00 0.00 222.22
NB: 3.25 675.00 0.00 0.00 675.00

200.03 M Jefferson Insurance Co.
Acquisition of Mid-State Insurance

1 RJB 13.50 3,000.00 55.52 15.00 3,070.52 217.81 45.31 222.22
NB: 0.00 37.50 0.00 0.00 37.50

WIP: 115.00 Age: 36
200  Jefferson Insurance Co.

32.00 7,275.00 138.02 120.00 7,533.02 625.31 45.31 227.34
NB: 3.25 712.50 0.00 0.00 712.50

WIP: 115.00 Age: 36
300.00 Q McBride/John
Management of Estate Trust

1 RJB 9.00 2,250.00 0.00 0.00 2,250.00 0.00 0.00 250.00
NB: 1.75 437.50 0.00 0.00 437.50

WIP: 82.50 Age: 15
Progress Billed: 1,000.00

350.00 M Carter/Arthur J.
Protection of New Wave Patent

2 MLJ 6.00 1,350.00 10.25 0.00 1,360.25 0.00 0.00 225.00
Write Off: -100.00 0.00 0.00 -100.00 208.33

Totals
90.30 19,046.00 323.65 120.00 19,489.65 1,250.31 45.31 210.92

Write Off: -948.36 0.00 0.00 -948.36 200.42
NB: 6.75 1,456.25 0.00 0.00 1,456.25

WIP: 470.50 Age: 18
Progress Billed: 1,000.00

Date: 11/28/2016 Tabs3 Client Productivity Report Page: 1
Jensen, Martin & Anderson, P.C.

Hours Fees Exps Advs Total Write-Up Write-Dn Rate

101.00 M Barrett/Karen
Apartment Management

4 DHB 11.00 1,865.00 43.88 0.00 1,908.88 0.00 0.00 169.55
Write Off: -348.36 0.00 0.00 -348.36 137.88
NB: 0.75 131.25 0.00 0.00 131.25

WIP: 43.75 Age: 3

350.00 M Carter/Arthur J.
Protection of New Wave Patent

2 MLJ 6.00 1,350.00 10.25 0.00 1,360.25 0.00 0.00 225.00
Write Off: -100.00 0.00 0.00 -100.00 208.33

Totals
17.00 3,215.00 54.13 0.00 3,269.13 0.00 0.00 189.12

Write Off: -448.36 0.00 0.00 -448.36 162.74
NB: 0.75 131.25 0.00 0.00 131.25

WIP: 43.75 Age: 3

This report includes only clients with write offs.

Task Folder Reports | Productivity Reports | Client Productivity

The report shown above is a Client Productivity Report. This report shows the billed fees and costs for each client for a given
date range and optionally includes work-in-process through the report’s cut-off date. Finance charge is not shown on this
report. The report shown on the left reflects all activity within the specified date range. The report on the right shows only
clients with write offs.

The Options tab includes parameters that enable you to select a date range for information, include work-in-process totals for
each client and include write off clients only.

Definitions for Client Productivity Report
Date Used for work-in-process aging.

Date Range1 Only updated statements within the selected date range will be included on this report.

(client) Client ID, name and work description. The letter after the Client ID represents the billing frequency.
An asterisk preceding the work description indicates that the work description will not print on the
client’s statement.1

(timekeeper) Primary timekeeper number and initials are shown below the Client ID if the report is not printed in
timekeeper order.

Hours / Fees / Exps /
Advs

Total billed hours, fees, expenses, and advances for the client. WIP amounts are not included. Write-
ups/write-downs are included. Progress fees are not included in the Fees figure—they are noted in
the Progress Billed figure.

Totals Fees + Expenses + Advances. Write-ups and write-downs are included in the fee, expenses and
advance figures.

Write-Up Total fees, expenses and advances written up. The fee write-up also includes the value of hours
written up. Write-ups are also included in the Fees, Exps, Advs and Total figures.
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Write-Down Total fees, expenses and advances written down. The fee write-down also includes the value of
hours written down and any courtesy discount. Write-downs are shown as a positive amount.
Write-downs are also included in the Fees, Exps, Advs and Total figures.

Rate Total fees divided by total hours.

Write Off Amount of fees, expenses and advances written off by the Write Off Client program.

Write Off Rate Total fees less fee write off divided by total hours.

NB: Non-billable Hours, Fees, Expenses, Advances, and Total (Fees + Exps + Advs). This line prints only
if non-billable hours or amounts were billed.

WIP Total work-in-process fees and costs through the ending date of the report’s date range. Including
the WIP total for each client is optional.

Age Average age of work-in-process fees and costs based on the age of each entry times the amount of
each entry divided by the total WIP amount (weighted average).

Progress Billed Total amount of Type 6 progress fees billed since the last time the client was “reconciled.” This
amount is the same as the Progress Billed field on the A/R & Fund Balances tab in the Client file.

1Not shown on the sample report.
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Client Ledger Report

Date: 11/28/2016 Tabs3 Client Ledger Report Page: 1
Jensen, Martin & Anderson, P.C.

From 08/01/2016 Thru 11/28/2016

Fee Expense Advance Payment Apply to
Date Ref # Stmt # Amount Hours Amount Amount Amount Stmt # Bill Total Balance Due

100.00M  Dawson/Charles L. 650.00Balance Forward:
RE: Settlement of Grandfather's Estate

08/15/2016 4.50900.00 6.25 906.25 1,556.25425    1
09/15/2016 443.75R 1,112.50478    3
09/29/2016 -75.00R 1,187.50490    8
09/29/2016 380.00R 807.50478    2
10/03/2016 300.00F 507.50490    6
10/03/2016 -300.00F 807.50490   12
10/17/2016 5.50750.00 43.75 823.75 1,631.25478    4
10/17/2016 75.00R 1,556.25490    5
11/03/2016 75.00E 1,481.25WIP
11/14/2016 4.00600.00 624.00 2,105.25490    7

Subtotal 898.7514.002,250.00 50.00 2,354.00 2,105.25

101.00M  Barrett/Karen
RE: Apartment Management

09/22/2016 587.67R -587.67391    1
10/17/2016 11.001,865.00 43.88 2,006.89 1,419.22391    2
10/31/2016Write Off: 391500.00 -500.00 919.22    5
11/14/2016 14.46 933.68473    3

Subtotal 587.6711.001,865.00 43.88 2,021.35 933.68
Write Off: 500.00 -500.00

300.00Q  McBride/John
RE: Management of Estate Trust

09/29/2016 -500.00R 500.00491   13
10/06/2016 208.00R 292.00449    1
10/17/2016 9.002,250.00 2,340.00 2,632.00488    5
10/24/2016 500.00R 2,132.00491    6
11/07/2016 500.00R 1,632.00495    8
11/07/2016 1,000.00R 632.00WIP
11/14/2016 1,000.00P 1,040.00 1,672.00491    7

Subtotal 1,708.009.002,250.00 2,380.00 1,672.00
Progress Billed: 1,000.00 1,000.00

Total 650.00Balance Forward:
3,194.4234.006,365.00 93.88 6,755.35 4,710.93

Write Off: 500.00 -500.00
Progress Billed: 1,000.00 1,000.00

Date: 11/28/2016 Tabs3 Client Ledger Report Page: 1
Jensen, Martin & Anderson, P.C.

From 08/01/2016 Thru 11/28/2016

Fee Expense Advance Payment
Date Ref # Stmt # Timekeeper Amount Expense Type Amount Advance Type Amount Amount Bill Total

100.00M  Dawson/Charles L.
RE: Settlement of Grandfather's Estate

08/15/2016 900.00 6.25 906.25425    1
09/15/2016 443.75R478    3
09/29/2016 -75.00R490    8
09/29/2016 380.00R478    2
10/03/2016 300.00F490    6
10/03/2016 -300.00F490   12
10/17/2016 750.00 43.75 823.75478    4

1 RJB: 300.00 0 Miscellaneous 43.75
5 JPP: 450.00

10/17/2016 75.00R490    5
11/02/2016 75.00EWIP
11/15/2016 600.00 624.00490    7

5 JPP: 600.00

Subtotal 898.752,250.00 50.00 2,354.00
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Date: 11/28/2016 Tabs3 Client Ledger Report Page: 1
Jensen, Martin & Anderson, P.C.

From 08/01/2016 Thru 11/28/2016

Fee Expense Advance Finance Payment Apply to
Date Stmt # Timekeeper Amount Hours Expense Type Amount Advance Type Amount Charge Amount Stmt # Bill Total Balance Due

121.01M  Phillips/Marcus 267.00Balance Forward:
RE: Real Estate Acquisition

08/23/2016 267.00R 0.007587
08/28/2016 1.25167.50 2.90 170.40 170.407587

1 MLJ: 120.00 0 Miscellaneous 2.90
3 RPA: 47.50

09/27/2016 8.001,267.50 132.03 35.00 1,434.53 1,604.937591
1 MLJ: 445.00 0 Miscellaneous 104.15 1 Filing Fees 15.00
2 PAM: 62.50 1 Phone 12.88 2 Processor Fees 20.00
3 RPA: 760.00 2 Photocopies/Faxes 15.00

09/27/2016 167.50R 1,437.437591
10/28/2016 20.834,254.10 52.25 200.00 4,506.35 5,943.787595

1 MLJ: 1,606.60 0 Miscellaneous 24.75 0 Miscellaneous 15.00
2 PAM: 2,375.00 1 Phone 27.50 1 Filing Fees 75.00
3 RPA: 237.50 2 Processor Fees 110.00
5 KIM: 35.00

10/28/2016 269.93R 5,673.857595
11/09/2016 5,000.00R 673.857613
11/28/2016 8.502,425.00 2,425.00 3,098.857613

1 MLJ: 2,425.00

Subtotal 5,704.4338.588,114.10 187.18 235.00 8,536.28 3,098.85
1 MLJ: 4,596.60 0 Miscellaneous 131.80 0 Miscellaneous 15.00
2 PAM: 2,437.50 1 Phone 40.38 1 Filing Fees 90.00
3 RPA: 1,045.00 2 Photocopies/Faxes 15.00 2 Processor Fees 130.00
5 KIM: 35.00

Total 267.00Balance Forward:
5,704.4338.588,114.10 187.18 235.00 8,536.28 3,098.85

1 MLJ: 4,596.60 0 Miscellaneous 131.80 0 Miscellaneous 15.00
2 PAM: 2,437.50 1 Phone 40.38 1 Filing Fees 90.00
3 RPA: 1,045.00 2 Photocopies/Faxes 15.00 2 Processor Fees 130.00
5 KIM: 35.00

Task Folder Reports | Management Reports | Client Ledger Report

A detail Client Ledger Report reflects all statements and payments (excluding payments “on hold”) by client for a range of dates.
A summary report includes the total billed and paid amounts for each client. A “totals only” report includes totals for all clients
in the selected range. The information for the Client Ledger Report is retrieved from the client ledger file.

The Client Ledger Report shows the amount of payments, fees, expenses, advances, finance charge, fee sales tax, expense sales
tax, advance sales tax and balance due for each statement. Payment activity (including payment reversals), write offs and
balance due information are also included. Detailed billed information that shows amounts billed by timekeeper and Cost Type
can optionally be included on the detail reports. A report showing only write offs can be generated.

The Options tab includes parameters that enable you to print a detail or summary report as well as specify what type of
information is included on the report (e.g., include zero balance clients, detail information for each statement, write offs only,
etc.). The Format tab allows you to optionally include information such as reference numbers, hours, bill total, and balance due
as well as specify whether the report will print portrait or landscape.

Definitions for Client Ledger Report
Date (heading) Used for reference only.

date range (heading) Client ledger records as well as WIP payments (excluding payments on hold) within the date range
will be included on this report. Shows the beginning and ending dates used for the report (if a
range was specified).

(client) Client ID, name and work description. The letter after the Client ID represents the billing frequency.
An asterisk preceding the work description indicates that the work description will not print on the
client’s statement.1

Balance Forward This amount is shown if the client had a balance due prior to the beginning date selected for the
report.

Date Statement/payment date.

Ref # Optional column. Client Ledger reference number. “WIP” indicates the payment is still in work-in-
process.

Stmt # Optional column. Statement number.

Fee Amount,
Expense Amount,
Advance Amount,
Finance Charge, Fee Tax,
Expense Tax, Advance
Tax

Total fees, expenses, advances, finance charge, fee tax, expense tax and advance tax shown on the
statement. As an option, the Finance Charge, Fee Tax, Expense Tax and Advance Tax columns can
be excluded from the report.
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P A “P” following a fee amount represents a progress billing amount (Type 6).

Hours Optional column. The total number of Hours to Bill for fees on each statement.

Payment Amount Amount of the payment. The letter following the payment amount indicates the payment type. “R”
indicates a regular payment (Type “1”), “F” indicates a fee payment (Type “2”), “E” indicates an
expense payment (Type “3”), “A” indicates an advance payment (Type “3”). A negative payment
amount indicates a payment reversal or refund.

Apply to Stmt # Optional column. Statement number to which the payment was applied. If a specific statement
number was not selected when the payment was entered, this column will be blank.

Bill Total Optional column. Includes the total amount billed on the statement (fees + expenses + advances +
finance charge + fee tax + advance tax + expense tax). Any billed finance charge and tax amounts
are included even if those columns are excluded from the report. Payments and Previous Balance
are not included in this figure.

Balance Due Optional column. Balance Due. The Balance Due information is calculated and is not stored in the
client ledger file. Balance Due = (Fees + Expenses + Advances + Finance Charge + Fee Tax +
Expense Tax + Advance Tax) minus Payment Amount.

Non-billable Optional non-billable information. Totals for non-billable transactions appearing on the statement.
Includes the total amount for non-billable fees in the Fees column, the total for non-billable
expenses in the Expenses column, and the total non-billable advances in the Advances column.
Also includes the total number of non-billable hours for fees in the Hours column.

Write-Up1
Write-Down

Including the optional Non-billable information will also include aWrite-Up orWrite-Down row
on the report if transactions were adjusted. When the Hours column is included on the report, the
value of the hours written up is included in the Write-Up amount and the value of the hours written
down is included in the Write-Down amount. Courtesy discount is always included in the Write-
Down amount.

Write Off Write off. Write off amounts are included based on the write off transaction date.

Billed Timekeeper & Cost
Type Information

Optional detailed billed information. Selecting the Detail Information for each Statement check
box on the Options tab shows the amounts billed by timekeeper and Cost Type.

Total Progress fees (Type 6) are not included in the Fee Subtotal and Total lines—they are totaled in the
Progress Billed line. Write Offs are not included in the total figures but are included in the Balance
Due.

Progress Total progress billings on the report.

1Not shown on the sample report.
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Receipt Allocation Report
Date: 11/28/2016 Tabs3 Detail Receipt Allocation Report Page: 1

Jensen, Martin & Anderson, P.C.

10/01/2016 to 10/31/2016 09/01/2016 to 09/30/2016

Billed Billed Effect. Billed Billed Effect.
Hours Amount Receipts Rate Hours Diff. % Chg. Amount Diff. % Chg. Receipts Diff. % Chg. Rate Diff. % Chg.

100.00 M Phillips/Marcus
Real Estate Acquisition

1 Michael L. Jensen 39.60 5,447.00 6,168.19 132.92 51.25 -11.65  -22.73% 6,827.50 -1,380.50  -20.00% 6,477.11 -308.92   -5.00% 125.97 6.95    5.52%
2 Jennifer A. Martin 33.25 8,312.50 9,305.99 243.73 39.25 -6.00  -15.29% 7,443.75 868.75   12.00% 7,308.48 1,997.51   27.00% 189.65 54.08   28.52%
3 Ronald P. Anderson 20.00 3,667.50 4,957.00 175.46 34.00 -14.00  -41.18% 6,460.00 -2,792.50  -43.00% 5,889.75 -932.75  -16.00% 190.00 -14.54   -7.65%
Total Fees 92.85 17,427.00 20,431.18 181.77 124.50 -31.65  -25.42% 20,731.25 -3,304.25  -16.00% 19,675.34 755.84    4.00% 163.53 18.24   11.15%

0 Miscellaneous 24.75 48.20 82.30 -57.55  -70.00% 82.30 -34.10  -41.00%
1 Phone 13.75 36.48 147.88 -134.13  -91.00% 72.88 -36.40  -50.00%
2 Photocopies 38.40 22.42 167.40 -129.00  -77.00% 18.00 4.42   25.00%
Total Expenses 76.90 107.10 397.58 -320.68  -81.00% 173.18 -66.08  -38.00%

0 Miscellaneous 15.00 189.10 25.00 -10.00  -40.00% 25.00 164.10  656.00%
1 Filing Fees 75.00 75.00 230.00 -155.00  -67.00% 105.00 -30.00  -29.00%
2 Processor Fees 60.00 115.58 110.00 -50.00  -45.00% 20.00 95.58  478.00%
3 Outside Services 90.00 495.98 0.00 90.00    0.00% 0.00 495.98    0.00%
Total Advances 240.00 875.66 365.00 -125.00  -34.00% 150.00 725.66  484.00%

Fee Tax 642.08 0.00 724.25 -82.17  -11.00% 0.00 0.00    0.00%
Totals 92.85 18,385.98 21,413.94 181.77 124.50 -31.65  -25.42% 22,218.08 -3,832.10  -17.00% 19,998.52 1,415.42    7.00% 163.53 18.24   11.15%

101.00 M Williams/John
State v. Williams

1 Michael L. Jensen 15.75 3,937.50 6,047.29 250.00 14.25 1.50   10.53% 3,562.50 375.00   11.00% 2,202.71 3,844.58  175.00% 250.00 0.00    0.00%
2 Jennifer A. Martin 11.25 2,531.25 7,669.16 225.00 4.00 7.25  181.25% 900.00 1,631.25  181.00% 1,162.09 6,507.07  560.00% 225.00 0.00    0.00%
3 Ronald P. Anderson 11.25 1,800.00 24,609.50 160.00 0.00 11.25    0.00% 0.00 1,800.00    0.00% 750.50 23,859.00 3179.00% 0.00 160.00    0.00%
Total Fees 38.25 8,268.75 38,325.95 216.18 18.25 20.00  109.59% 4,462.50 3,806.25   85.00% 4,115.30 34,210.65  831.00% 244.52 -28.34  -11.59%

0 Miscellaneous 0.00 87.16 58.15 -58.15 -100.00% 1.25 85.91 6873.00%
1 Phone 0.00 75.78 30.55 -30.55 -100.00% 0.00 75.78    0.00%
2 Photocopies 37.35 53.60 16.25 21.10  130.00% 0.00 53.60    0.00%
Total Expenses 37.35 216.54 104.95 -67.60  -64.00% 1.25 215.2917223.00%

0 Miscellaneous 0.00 253.00 253.00 -253.00 -100.00% 4.00 249.00 6225.00%
1 Filing Fees 75.00 150.00 0.00 75.00    0.00% 0.00 150.00    0.00%
2 Processor Fees 14.50 14.50 0.00 14.50    0.00% 0.00 14.50    0.00%
4 Medical Records 0.00 150.00 0.00 0.00    0.00% 0.00 150.00    0.00%
Total Advances 89.50 567.50 253.00 -163.50  -65.00% 4.00 563.5014088.00%

Totals 38.25 8,395.60 39,109.99 216.18 18.25 20.00  109.59% 4,820.45 3,575.15   74.00% 4,120.55 34,989.44  849.00% 244.52 -28.34  -11.59%
Unallocated Payments 217.76

GRAND TOTALS
1 Michael L. Jensen 55.35 9,384.50 12,215.48 166.24 65.50 -10.15  -15.50% 10,390.00 -1,005.50  -10.00% 8,679.82 3,535.66   41.00% 152.96 13.28    8.68%
2 Jennifer A. Martin 44.50 10,843.75 16,975.15 239.00 43.25 1.25    2.89% 8,343.75 2,500.00   30.00% 8,470.57 8,504.58  100.00% 192.92 46.08   23.89%
3 Ronald P. Anderson 31.25 5,467.50 29,566.50 169.89 34.00 -2.75   -8.09% 6,460.00 -992.50  -15.00% 6,640.25 22,926.25  345.00% 190.00 -20.11  -10.58%
Total Fees 131.10 25,695.75 58,757.13 191.81 142.75 -11.65   -8.16% 25,193.75 502.00    2.00% 23,790.64 34,966.49  147.00% 173.89 17.92   10.31%

0 Miscellaneous 24.75 135.36 140.45 -115.70  -82.00% 83.55 51.81   62.00%
1 Phone 13.75 112.26 178.43 -164.68  -92.00% 72.88 39.38   54.00%
2 Photocopies 75.75 76.02 183.65 -107.90  -59.00% 18.00 58.02  322.00%
Total Expenses 114.25 323.64 502.53 -388.28  -77.00% 174.43 149.21   86.00%

0 Miscellaneous 15.00 442.10 278.00 -263.00  -95.00% 29.00 413.10 1424.00%
1 Filing Fees 150.00 225.00 230.00 -80.00  -35.00% 105.00 120.00  114.00%
2 Processor Fees 74.50 130.08 110.00 -35.50  -32.00% 20.00 110.08  550.00%
3 Outside Services 90.00 495.98 0.00 90.00    0.00% 0.00 495.98    0.00%
4 Medical Records 0.00 150.00 0.00 0.00    0.00% 0.00 150.00    0.00%
Total Advances 329.50 1,443.16 618.00 -288.50  -47.00% 154.00 1,289.16  837.00%

Fee Tax 642.08 0.00 724.25 -82.17  -11.00% 0.00 0.00    0.00%
Totals 131.10 26,781.58 60,523.93 191.81 142.75 -11.65   -8.16% 27,038.53 -256.95   -1.00% 24,119.07 36,404.86  151.00% 173.89 17.92   10.31%
Unallocated Payments 217.76
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Date: 11/28/2016 Tabs3 Summary Receipt Allocation Report Page: 1
Jensen, Martin & Anderson, P.C.

10/01/2016 to 10/31/2016 07/01/2016 to 09/30/2016

Billed Billed Billed Billed Current
Hours Amount Write Offs Receipts Hours Amount Write Offs Receipts Amount Due

100.00 M Phillips/Marcus
Real Estate Acquisition

Total Fees 92.85 17,427.00 550.00 20,431.18 146.63 24,426.87 371.39 19,675.34 9,244.06

Total Expenses 76.90 75.00 107.10 459.78 0.00 173.18 150.15

Total Advances 240.00 58.00 875.66 495.58 0.00 150.00 232.00

Fee Tax 642.08 0.00 0.00 791.30 7.13 0.00 391.76
Totals 92.85 18,385.98 683.00 21,413.94 146.63 26,173.53 378.52 19,998.52 10,017.97

251.00 M Stevenson/Thomas
Divorce

Total Fees 0.01 2.49 125.75 2.49 355.72 72,360.00 0.00 68,289.75 18,667.24

Total Expenses 0.00 0.00 0.00 217.34 0.00 217.34 217.34

Total Advances 0.00 0.00 0.00 304.91 0.00 304.91 304.91

Totals 0.01 2.49 125.75 2.49 355.72 72,882.25 0.00 68,812.00 19,189.49

253.00 M Jones/Steven
General Litigation

Total Expenses 70.21 0.00 53.15 53.15 0.00 0.00 70.21

Total Advances 160.00 0.00 238.70 238.70 0.00 0.00 160.00

Totals 0.00 230.21 0.00 291.85 0.00 291.85 0.00 0.00 230.21
Progress Billing 4,324.25 1,506.25 6,060.71

GRAND TOTALS
Total Fees 92.86 17,429.49 675.75 20,433.67 502.35 96,786.87 371.39 87,965.09 27,911.30

Total Expenses 147.11 75.00 160.25 730.27 0.00 390.52 437.70

Total Advances 400.00 58.00 1,114.36 1,039.19 0.00 454.91 696.91

Fee Tax 642.08 0.00 0.00 791.30 7.13 0.00 391.76
Totals 92.86 18,618.68 808.75 21,708.28 502.35 99,347.63 378.52 88,810.52 29,437.67
Progress Billing 4,324.25 1,506.25 35,268.17
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Date: 11/28/2016 Tabs3 Detail Receipt Allocation Report Page: 1
Jensen, Martin & Anderson, P.C.

10/01/2016 to 10/31/2016 01/01/2016 to 10/31/2016

Billed Billed Billed Billed Current
Hours Amount Write Offs Receipts Hours Amount Write Offs Receipts Amount Due

100.00 M Phillips/Marcus
Real Estate Acquisition

1 Michael L. Jensen 39.60 5,447.00 183.34 5,223.99 985.60 208,403.25 554.73 36,085.56 3,081.35
2 Jennifer A. Martin 33.25 8,312.50 208.33 7,882.38 965.13 238,608.75 208.33 42,831.10 3,501.54
3 Ronald P. Anderson 20.00 3,667.50 158.33 4,185.14 947.00 179,429.37 158.33 30,959.51 2,661.17

Pri 001 MLJ 1,668.23 3,664.64
Org 001 MLJ 374.90 9,485.20
Org 002 JAM 74.98 1,897.04
Org 007 JMF 1,021.56 6,574.91

Total Fees 92.85 17,427.00 550.00 20,431.18 2,897.73 626,441.37 921.39 131,497.96 9,244.06

0 Miscellaneous 24.75 0.00 48.20 546.25 0.00 385.95 0.00
1 Phone 13.75 24.98 36.48 1,542.08 24.98 261.36 50.02
2 Photocopies 38.40 50.02 22.42 706.55 50.02 265.42 100.13
Total Expenses 76.90 75.00 107.10 2,794.88 75.00 912.73 150.15

0 Miscellaneous 15.00 0.00 189.10 505.00 0.00 214.10 0.00
1 Filing Fees 75.00 40.00 75.00 455.00 40.00 255.00 160.00
2 Processor Fees 60.00 18.00 115.58 375.58 18.00 285.58 72.00
3 Outside Services 90.00 0.00 495.98 1,144.45 0.00 591.43 0.00
Total Advances 240.00 58.00 875.66 2,480.03 58.00 1,346.11 232.00

Fee Tax 642.08 0.00 0.00 24,816.88 7.13 0.00 391.76
Totals 92.85 18,385.98 683.00 21,413.94 2,897.73 656,533.16 1,061.52 133,756.80 10,017.97

GRAND TOTALS
1 Michael L. Jensen 39.60 5,447.00 183.34 5,223.99 985.60 208,403.25 554.73 36,085.56 3,081.35
2 Jennifer A. Martin 33.25 8,312.50 208.33 7,882.38 965.13 238,608.75 208.33 42,831.10 3,501.54
3 Ronald P. Anderson 20.00 3,667.50 158.33 4,185.14 947.00 179,429.37 158.33 30,959.51 2,661.17

Pri 001 MLJ 1,668.23 3,664.64
Org 001 MLJ 374.90 9,485.20
Org 002 JAM 74.98 1,897.04
Org 007 JMF 1,021.56 6,574.91

Total Fees 92.85 17,427.00 550.00 20,431.18 2,897.73 626,441.37 921.39 131,497.96 9,244.06

0 Miscellaneous 24.75 0.00 48.20 546.25 0.00 385.95 0.00
1 Phone 13.75 24.98 36.48 1,542.08 24.98 261.36 50.02
2 Photocopies 38.40 50.02 22.42 706.55 50.02 265.42 100.13
Total Expenses 76.90 75.00 107.10 2,794.88 75.00 912.73 150.15

0 Miscellaneous 15.00 0.00 189.10 505.00 0.00 214.10 0.00
1 Filing Fees 75.00 40.00 75.00 455.00 40.00 255.00 160.00
2 Processor Fees 60.00 18.00 115.58 375.58 18.00 285.58 72.00
3 Outside Services 90.00 0.00 495.98 1,144.45 0.00 591.43 0.00
Total Advances 240.00 58.00 875.66 2,480.03 58.00 1,346.11 232.00

Fee Tax 642.08 0.00 0.00 24,816.88 7.13 0.00 391.76
Totals 92.85 18,385.98 683.00 21,413.94 2,897.73 656,533.16 1,061.52 133,756.80 10,017.97

Task Folder Reports | Management Reports | Receipt Allocation Report

The reports shown on pages 129 through 131 are examples of Receipt Allocation Reports. The Receipt Allocation Report shows
billed information as well as receipts (both processed and unprocessed payments) from clients as allocated to individual
working timekeepers, primary, secondary and originating timekeepers, expenses (by Expense Type), advances (by Advance
Type), fee, expense and advance sales tax, and finance charge. The report can be printed by primary, secondary, originating or
working timekeeper, or by category for up to two time periods. A detail report includes each timekeeper who did work for the
client as well as amounts billed and paid by individual Cost Types. A summary report shows totals for each client.

The Options tab includes parameters that enable you to print a detail or summary report; define two reporting periods to
compare; select a range of working timekeepers; include all amounts for each working timekeeper; include only clients with
receipts; include unallocated payments; or print only unallocated payments. The Format tab allows you to select optional
information to include.

Definitions for Receipt Allocation Report
Date (heading) Used for reference only.

Sorted by (heading) Displays the Secondary sort order unless Client ID or Name Search is selected.

(Date Range) Two date ranges can be included. These date ranges are used to select what transactions will appear
on the report. For billed transactions, the statement date is used. Receipts use the allocation date.
Write Offs use the write off date.

(Timekeeper) The number and name of the timekeeper who did the work. If fee compensation information is
included, will instead list Pri, Sec or Ori, and the number and initials of the timekeeper.

Billed Hours The fee hours billed during the period.

Billed Amount The fee, expense or advance amount billed during the period.
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Write Offs Write off amounts during the period. Write off amounts are included based on the write off
transaction date. There can be a write off amount for each working timekeeper, expense type,
advance type, fee tax, expense tax, advance tax and finance charge.

Receipts Payments allocated during the period.

Effect Rate The effective rate for the specified period. (Billed Amount - Write Offs) / Billed Hours.

Diff. The difference between the two date ranges. Can be shown for Billed Hours, Billed Amounts, Write
Offs, Receipts, and Effective Rates.

%Chg. Displays the percentage of change between the two date ranges. Can be included for Billed Hours,
Billed Amounts, Write Offs, Receipts, and Effective Rates.

Current Amount Due The Current Amount Due figure shows what is currently due at the time the report is run. It is
important to note that the Periods specified do NOT affect this amount. This figure includes the
total amount billed (from the Client Ledger) minus all payments allocated minus any Write Off (i.e.,
Billed minus Paid minus Write Off).

If the Print Unallocated Payments check box is selected, the total unallocated payment amount will
be subtracted from the Current Amount Due figure. The total unallocated payment amount includes
ALL unallocated payments, even those that are excluded from the Unallocated Payments figure
because the payment transaction date falls outside of the specified period. This adjusted amount
due will print directly below the Current Amount Due figure.

If the client is a Progress Billing client, a separate line on the report called Progress Billing will be
printed below the Totals line on the report. This line will include any Type 6 progress fees billed
since the last time the client was “reconciled” as well as any payments towards the progress billed
amounts. An adjusted amount due will print on the Progress Billing line under the Current Amount
Due column. This adjusted amount due is calculated as: Current Amount Due plus Progress Billed
minus Progress Paid.

Other Payments1 This line is used only in data sets that were converted from versions prior to Version 14 and can only
be shown when the Current Amount Due column is included. In some instances, payments may
have been converted without the payment allocation records due to incomplete information. This
will cause a discrepancy in the Current Amount Due on the Receipt Allocation Report when
compared with Accounts Receivable Reports and is therefore provided so the reports will match.
This amount is always shown as a negative figure.

Unallocated Payments Unallocated payments during the period. Unallocated payments are included based on the payment
transaction date. Optionally shown at the client level and in totals. An unallocated payment is a
payment that has been entered but cannot be applied because there are no amounts due.
Unallocated payments can be processed (i.e., billed and updated) or unprocessed. (Note: It is
possible to have an amount in the Unallocated Payments field and also have amounts showing as
due. For example, a fee payment will show as an unallocated payment if you only have costs due.)
See also the explanation of Current Amount Due above.

Progress Billing Total amount of Type 6 progress fees billed since the last time the client was “reconciled.” Payments
cannot be allocated to Progress Billed. However, they can apply to Progress Billed on the Client
Ledger Report. You could have a situation where a payment shows as applied to progress fees on
the Client Ledger Report but shows as unallocated on the Receipt Allocation Report. See also the
explanation of Current Amount Due above.

Total Primary, Total
Secondary, Total
Originating

Total allocations for all primary timekeepers, secondary timekeepers and originating timekeepers.

Uncollected1 The Uncollected column is a calculated amount: Billed Amount minus Write Offs minus Receipts.

1Not shown on the sample reports.

- 132 -



Tabs3 Report Pack

Client Analysis Report

Date: 11/28/2016 Tabs3 Client Analysis Report Page: 1

August 2016 Thru October 2016

Non-Bill Non-Bill Billed Original Hours Hours Billed Fees Write-Up/ Courtesy
Hours Amount Hours Hours Diff. Ratio Rate Billed Down Discount

101.00M Williams/John
State v. Williams

August 0.30 75.00 1.25 1.25 0.00 100.00% 160.00 200.00 0.00 0.00
September 0.00 0.00 2.75 2.75 0.00 100.00% 250.00 687.50 0.00 0.00
October 0.50 112.50 14.55 14.55 0.00 100.00% 210.14 3,057.50 0.00 0.00

Subtotal 0.80 187.50 18.55 18.55 0.00 100.00% 212.67 3,945.00 0.00 0.00

121.01M Phillips/Marcus
Real Estate Acquisition

August 0.00 0.00 1.25 1.25 0.00 100.00% 134.00 167.50 0.00 0.00
September 0.00 0.00 8.00 8.00 0.00 100.00% 158.44 1,267.50 -37.50 0.00
October 1.00 272.50 20.83 20.83 0.00 100.00% 240.04 5,000.00 208.40 0.00

Subtotal 1.00 272.50 30.08 30.08 0.00 100.00% 213.93 6,435.00 170.90 0.00

200.01M Peterson Insurance Co.
General Legal Counsel

August 1.00 150.00 0.00 0.00 0.00 0.00% 0.00 0.00 0.00 0.00
September 0.00 0.00 8.05 8.05 0.00 100.00% 179.04 1,441.25 0.00 0.00
October 0.20 50.00 7.55 7.55 0.00 100.00% 200.89 1,516.75 0.00 0.00

Subtotal 1.20 200.00 15.60 15.60 0.00 100.00% 189.62 2,958.00 0.00 0.00

200.02M Peterson Insurance Co.
Maintenance of Insurance Policies

August 0.00 0.00 0.00 0.00 0.00 0.00% 0.00 0.00 0.00 0.00
September 0.00 0.00 1.30 1.30 0.00 100.00% 70.00 91.00 0.00 0.00
October 0.00 0.00 9.10 9.10 0.00 100.00% 174.12 1,584.50 0.00 0.00

Subtotal 0.00 0.00 10.40 10.40 0.00 100.00% 161.11 1,675.50 0.00 0.00

200 Peterson Insurance Co.
August 1.00 150.00 0.00 0.00 0.00 0.00% 0.00 0.00 0.00 0.00
September 0.00 0.00 9.35 9.35 0.00 100.00% 163.88 1,532.25 0.00 0.00
October 0.20 50.00 16.65 16.65 0.00 100.00% 186.26 3,101.25 0.00 0.00

Subtotal 1.20 200.00 26.00 26.00 0.00 100.00% 178.21 4,633.50 0.00 0.00
GRAND TOTALS

August 1.30 225.00 2.50 2.50 0.00 100.00% 147.00 367.50 0.00 0.00
September 0.00 0.00 20.10 20.10 0.00 100.00% 173.50 3,487.25 -37.50 0.00
October 1.70 435.00 52.03 52.03 0.00 100.00% 214.47 11,158.75 208.40 0.00

Totals 3.00 660.00 74.63 74.63 0.00 100.00% 201.17 15,013.50 170.90 0.00
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Date: 11/28/2016 Tabs3 Client Analysis Report Page: 1

August 2016 Thru October 2016

Billed Billed Fees Expenses Advances Total Payment Effect.
Hours Rate Billed Billed Billed Billed Payments Ratio Rate

101.00M Williams/John
State v. Williams

August 1.25 160.00 200.00 0.00 0.00 200.00 0.00
September 2.75 250.00 687.50 35.90 0.00 723.40 0.00
October 14.55 210.14 3,057.50 38.60 51.50 3,147.60 1,617.65

Subtotal 18.55 212.67 3,945.00 74.50 51.50 4,071.00 1,617.65 40.00% 212.67

121.01M Phillips/Marcus
Real Estate Acquisition

August 1.25 134.00 167.50 2.90 0.00 170.40 267.00
September 8.00 158.44 1,267.50 132.03 35.00 1,434.53 167.50
October 20.83 240.04 5,000.00 52.25 200.00 5,252.25 269.93

Subtotal 30.08 213.93 6,435.00 187.18 235.00 6,857.18 704.43 10.00% 213.93

200.01M Peterson Insurance Co.
General Legal Counsel

August 0.00 0.00 0.00 0.66 0.00 0.66 0.00
September 8.05 179.04 1,441.25 28.25 25.00 1,494.50 0.00
October 7.55 200.89 1,516.75 34.44 0.00 1,551.19 275.00

Subtotal 15.60 189.62 2,958.00 63.35 25.00 3,046.35 275.00 9.00% 189.62

200.02M Peterson Insurance Co.
Maintenance of Insurance Policies

August 0.00 0.00 0.00 0.00 75.00 75.00 0.00
September 1.30 70.00 91.00 0.00 40.00 131.00 0.00
October 9.10 174.12 1,584.50 215.25 150.00 1,949.75 0.00

Subtotal 10.40 161.11 1,675.50 215.25 265.00 2,155.75 0.00 0.00% 161.11

200 Peterson Insurance Co.
August 0.00 0.00 0.00 0.66 75.00 75.66 0.00
September 9.35 163.88 1,532.25 28.25 65.00 1,625.50 0.00
October 16.65 186.26 3,101.25 249.69 150.00 3,500.94 275.00

Subtotal 26.00 178.21 4,633.50 278.60 290.00 5,202.10 275.00 5.00% 178.21
GRAND TOTALS

August 2.50 147.00 367.50 3.56 75.00 446.06 267.00
September 20.10 173.50 3,487.25 196.18 100.00 3,783.43 167.50
October 52.03 214.47 11,158.75 340.54 401.50 11,900.79 2,162.58

Totals 74.63 201.17 15,013.50 540.28 576.50 16,130.28 2,597.08 16.00% 201.17

Task Folder Reports | Productivity Reports | Client Analysis Report

The Client Analysis Report is a date-based report that provides monthly comparisons of billed hours, amounts, and payments by
client. It includes Billed Hours, Original Hours, Billed Amounts, and Payments for clients for an individual month or range of
months. The columns included on the report are fully customizable, allowing you to select what information the report will
display. The format makes it easy to see month-by-month figures for each client. The report includes Hours and Payment Ratios
as well as Billed and Effective Rate information. Non-billable Hours and Amounts can be included as well as Write Offs and net
Write-Ups/Write-Downs. Courtesy Discounts can be included as a separate column or can be combined with the Write-
Up/Write-Down column.

The Options tab includes parameters that enable you to select a range of months to include on the report. The Format tab
allows you to select what optional fields are included.

Definitions for Client Analysis Report
Date (heading) Used for reference only.

Date Range The range of months for which the report includes information.

(Client) Client ID, name and work description. The letter after the Client ID represents the billing frequency.
An asterisk preceding the work description indicates that the work description will not print on the
client’s statement.1

(Month) Each month included on the report.

Non-Bill Hours Total non-billable hours accumulated during the specified time frame.

Non-Bill Amount Total non-billable amount accumulated during the specified time frame. This amount includes both
the non-billable fee and cost amount.
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Billed Hours Total billable hours billed during the specified time frame. Billed figures are accumulated based on
the statement date. Includes the Write-Up Hours and Write-Down Hours.

Original Hours Total hours worked for transactions billed during the specified time frame. Any write-up/write-
down of hours will not affect this figure.

Hours Diff Billed Hours minus Original Hours.

Hours Ratio Billed Hours divided by Original Hours

Billed Rate Hourly billing rate based on billed hours. Fees Billed divided by Billed Hours.

Fees Billed Total billable fees billed during the specified time frame. Includes any Fee Tax amounts billed.
Progress billed fee transactions (i.e., Type 6 transactions) and Progress Fee Tax are included in this
amount.

Expenses Billed Total billable expenses billed during the specified time frame. Includes any Expense Tax amounts
billed.

Advances Billed Total billable advances billed during the specified time frame. Includes any Advance Tax amounts
billed.

Total Billed Total billable amount billed during the specified time frame. This amount includes total fees,
expenses and advances billed. Includes any Sales Tax and Finance Charges billed.

Write-Up/Down Total net write-up/down amount billed during the specified time frame. This amount includes write-
up/down amounts for fees, expenses and advances.

Courtesy Discount Total courtesy discount amount billed during the specified time frame. When IncludeWrite-
Up/Down is selected, the courtesy discount amount will be included in the Write-Up/Down
column.

Write Offs Total write offs during the specified time frame. Write off figures are accumulated based on the
write off transaction date.

Payments Payments with a payment transaction date during the specified time frame. Payments include both
work-in-process and archived payments. Unapplied payments are included; however, any payments
on hold are excluded.

Payment Ratio Payments divided by Billed Amount.

Effective Rate Hourly billing rate based on original hours. (Fees Billed minus Fee Write Offs) divided by Original
Hours.

1Not shown on the sample report.
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Client Realization Report
Date: 11/28/2016 Tabs3 Detail Client Realization Report Page: 1

Jensen, Martin & Anderson, P.C.

Original Billed Realization Original Billed Billing Collection Collection
Hours Hours Rate Value Amount Realization Amount Realization

100.00M Phillips/Marcus
Real Estate Acquisition

1 Michael L. Jensen 96.85 96.85 163.97 13,014.49 15,880.25 122.02% 11,874.06 74.77%
2 Jennifer A. Martin 75.25 75.25 218.52 16,443.75 16,443.75 100.00% 15,339.80 93.29%
3 Ronald P. Anderson 54.25 54.25 187.56 10,175.00 10,175.00 100.00% 9,432.11 92.70%
Fee Tax 1,458.93 767.62 52.62%

Fees 226.35 226.35 194.20 39,633.24 43,957.93 110.91% 37,413.59 85.11%

0 Miscellaneous 107.05 96.75 90.38%
1 Phone 86.63 80.91 93.40%
2 Photocopies 56.40 40.42 71.67%

Expenses 250.08 218.08 87.20%

0 Miscellaneous 40.00 40.00 100.00%
1 Filing Fees 180.00 180.00 100.00%
2 Processor Fees 80.00 80.00 100.00%
3 Witness Fees 90.00 90.00 100.00%

Advances 390.00 390.00 100.00%

Subtotal 44,598.01 38,021.67 85.25%

120.00M Berger/Randall
Real Estate Investment

Progress Billing 5,637.50 0.00 0.00%

Fees 0.00 0.00 0.00 0.00 5,637.50 0.00% 0.00 0.00%

0 Miscellaneous 646.25 570.44 88.27%
1 Phone 300.00 264.81 88.27%

Expenses 946.25 835.25 88.27%

0 Miscellaneous 12.00 12.00 100.00%
1 Filing Fees 150.00 150.00 100.00%
2 Processor Fees 65.00 65.00 100.00%
3 Witness Fees 80.00 80.00 100.00%

Advances 307.00 307.00 100.00%

Subtotal 6,890.75 1,142.25 16.58%

200.01M Peterson Insurance Co.
General Legal Counsel

1 Michael L. Jensen 20.50 20.50 250.00 5,125.00 5,125.00 100.00% 5,125.00 100.00%
2 Jennifer A. Martin 18.00 18.00 160.00 2,880.00 2,880.00 100.00% 2,880.00 100.00%
3 Ronald P. Anderson 6.25 6.25 125.00 781.25 781.25 100.00% 781.25 100.00%

Fees 44.75 44.75 196.34 8,786.25 8,786.25 100.00% 8,786.25 100.00%

0 Miscellaneous 21.34 21.34 100.00%
1 Phone 9.75 9.75 100.00%
2 Photocopies 9.30 9.30 100.00%

Expenses 40.39 40.39 100.00%

0 Miscellaneous 4.00 4.00 100.00%
1 Filing Fees 75.00 75.00 100.00%
2 Processor Fees 25.00 25.00 100.00%

Advances 104.00 104.00 100.00%

Subtotal 8,930.64 8,930.64 100.00%
TOTALS

1 Michael L. Jensen 117.35 117.35 179.00 18,139.49 21,005.25 115.80% 16,999.06 80.93%
2 Jennifer A. Martin 93.25 93.25 207.23 19,323.75 19,323.75 100.00% 18,219.80 94.29%
3 Ronald P. Anderson 60.50 60.50 181.10 10,956.25 10,956.25 100.00% 10,213.36 93.22%
Fee Tax 1,458.93 767.62 52.62%
Progress Billing 5,637.50 0.00 0.00%

Fees 271.10 271.10 215.35 48,419.49 58,381.68 120.57% 46,199.84 79.13%

0 Miscellaneous 774.64 688.53 88.88%
1 Phone 396.38 355.47 89.68%
2 Photocopies 65.70 49.72 75.68%

Expenses 1,236.72 1,093.72 88.44%

0 Miscellaneous 56.00 56.00 100.00%
1 Filing Fees 405.00 405.00 100.00%
2 Processor Fees 170.00 170.00 100.00%
3 Witness Fees 170.00 170.00 100.00%

Advances 801.00 801.00 100.00%

Totals 60,419.40 48,094.56 79.60%
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Date: 11/28/2016 Tabs3 Summary Client Realization Report Page: 1
Jensen, Martin & Anderson, P.C.

Original Billed Realization Original Billed Billing Est. Hours Collection Collection
Hours Hours Rate Value Amount Realization Collected Amount Realization Write Offs Uncollected

100.00M Phillips/Marcus
Real Estate Acquisition

Fees 242.73 242.73 180.42 43,150.74 43,794.25 101.49% 207.37 37,413.59 85.43% 2,578.52 3,802.14
Expenses 312.28 218.08 69.83% 32.00 62.20
Advances 520.58 390.00 74.92% 0.00 130.58

Subtotal 44,627.11 38,021.67 85.20% 2,610.52 3,994.92

210.01M Peterson Insurance Co.
General Legal Counsel

Fees  44.75  44.75 196.34  8,786.25  8,786.25 100.00%  44.75  8,786.25 100.00%  0.00 0.00
Expenses  40.39  40.39 100.00% 0.00 0.00
Advances 104.00 104.00 100.00% 0.00 0.00

Subtotal  8,930.64  8,930.64 100.00%  0.00 0.00

TOTALS

Fees 598.66 596.96 193.40 118,346.99 115,781.74 97.83% 560.70 108,749.58 93.93% 3,230.02 3,802.14
Expenses 529.62 435.42 82.21% 32.00 62.20
Advances 825.49 694.91 84.18% 0.00 130.58

Totals 117,136.85 109,879.91 93.80% 3,262.02 3,994.92

Task Folder Reports | Management Reports | Client Realization Report

Billing realization is the percentage of professional work performed that is billed to clients. The Client Realization Report shows
billed information for a specified date range, the realized value compared to actual time spent, and the collections applied to the
billed information. The Client Realization Report helps you evaluate the profitability of individual clients by showing the
amounts collected on specific billings.

On the Detail Client Realization Report, the fees billed and collected print for each working timekeeper who did work for the
client, and the expenses and advances billed and collected are broken down by Cost Type along with sales tax. Finance charge
billed and collected will print on a separate row. The Summary Client Realization Report includes only a separate line for total
billed and collected amounts for fees, expenses, advances, and finance charge for each client.

The Options tab includes parameters that enable you to select a range of dates to include on the report and restrict what
transaction information is included. The Format tab allows you to select what optional fields are included.

Definitions for Client Realization Report
Date (heading) Used for reference only.

(Client) Client ID, name and work description. The letter after the Client ID represents the billing frequency.
An asterisk preceding the work description indicates that the work description will not print on the
client’s statement.1

Original Hours Total hours worked for transactions billed and updated for the specified period. Any write-up/write-
down of hours will not affect this figure.

Billed Hours Total billable hours billed and updated for the specified period. Billed figures are accumulated
based on the statement date. Includes the Write-Up Hours and Write-Down Hours.

Realization Rate Billed Amount divided by Original Hours.

Original Value Total billable amount billed and updated for the specified period prior to any write-up/write-down
amounts.

Billed Amount Total billable amount billed and updated for the specified period. This amount includes total fees,
expenses and advances billed. Progress billed fee transactions (i.e., Type 6 transactions) are shown
as a separate line item. The Total Billed amount includes Sales Tax, Finance Charges, Write-Up, and
Write-Down amounts.

Billing Realization The percentage of professional work performed that is actually billed to clients. Billed Amount
divided by Original Value.

Est. Hours Collected Collection Realization multiplied by Billed Hours.

Collection Amount The total amount of payments applied to updated statements with a statement date within the
specified period (i.e., not the payment transaction date).

Collection Realization The percentage of work billed and updated that is actually collected. Collection Amount divided by
Billed Amount.
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Write Offs Total write offs for statements billed and updated for the specified period. Write off figures are
accumulated for the billing period for which the write off was performed (i.e., not the write off
date).

Uncollected Billed Amount minus Collection Amount minus Write Offs.

1Not shown on the sample report.

Timekeeper Analysis Report

Date: 11/28/2016 Tabs3 Timekeeper Analysis Report Page: 1
Jensen, Martin & Anderson, P.C.

September 2016 Thru November 2016

Billed Billed Fee Effective
Hours Amount Write Offs Receipts Rate

001 Michael L. Jensen
September 41.25 17,632.50 0.00 24,883.04 427.45
October 50.83 18,156.60 1,916.03 15,038.37 357.20
November 12.70 6,350.00 0.00 23,098.49 500.00

Subtotal 104.78 42,139.10 1,916.03 63,019.90 402.17

002 Paula Ann Martin
September 40.75 17,736.25 0.00 27,067.12 435.25
October 37.30 13,692.50 1,525.54 19,917.00 367.09
November 10.25 4,612.50 0.00 21,411.13 450.00

Subtotal 88.30 36,041.25 1,525.54 68,395.25 408.17

003 Ronald P. Anderson
September 20.00 7,310.00 0.00 5,411.98 365.50
October 8.25 1,296.25 0.00 5,312.04 157.12
November 0.00 0.00 0.00 4,710.44 0.00

Subtotal 28.25 8,606.25 0.00 15,434.46 304.65

GRAND TOTALS
September 102.00 42,678.75 0.00 57,362.14 418.42
October 96.38 33,145.35 3,441.57 40,267.41 343.90
November 22.95 10,962.50 0.00 49,220.06 477.67

Totals 221.33 86,786.60 3,441.57 146,849.61 392.11
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Date: 11/28/2016 Tabs3 Timekeeper Analysis Report by Month Page: 1
Jensen, Martin & Anderson, P.C.

September 2016 Thru November 2016

Billed Original Hours Hours Billed Original Amount Amount Fee Receipt Billed Effective
Hours Hours Diff. Ratio Amount Value Difference Ratio Write Offs Receipts Ratio Rate Rate

September

001 Michael L. Jensen 41.25 41.25 0.00 100.00% 17,632.50 17,670.00 -37.50 99.79% 0.00 24,883.04 141.12% 427.45 427.45
002 Paula Ann Martin 40.75 40.75 0.00 100.00% 17,736.25 17,736.25 0.00 100.00% 0.00 27,067.12 152.61% 435.25 435.25
003 Ronald P. Anderson 20.00 20.00 0.00 100.00% 7,310.00 7,310.00 0.00 100.00% 0.00 5,411.98 74.04% 365.50 365.50

Subtotal 102.00 102.00 0.00 100.00% 42,678.75 42,716.25 -37.50 99.91% 0.00 57,362.14 134.40% 418.42 418.42

October

001 Michael L. Jensen 50.83 50.83 0.00 100.00% 18,156.60 18,694.10 -537.50 97.12% 1,916.03 15,038.37 82.83% 357.20 357.20
002 Paula Ann Martin 37.30 37.30 0.00 100.00% 13,692.50 13,692.50 0.00 100.00% 1,525.54 19,917.00 145.46% 367.09 367.09
003 Ronald P. Anderson 8.25 8.25 0.00 100.00% 1,296.25 1,296.25 0.00 100.00% 0.00 5,312.04 409.80% 157.12 157.12

Subtotal 96.38 96.38 0.00 100.00% 33,145.35 33,682.85 -537.50 98.40% 3,441.57 40,267.41 121.49% 343.90 343.90

November

001 Michael L. Jensen 12.70 12.70 0.00 100.00% 6,350.00 6,350.00 0.00 100.00% 0.00 23,098.49 363.76% 500.00 500.00
002 Paula Ann Martin 10.25 10.25 0.00 100.00% 4,612.50 4,612.50 0.00 100.00% 0.00 21,411.13 464.20% 450.00 450.00
003 Ronald P. Anderson 0.00 0.00 0.00 0.00% 0.00 0.00 0.00 0.00% 0.00 4,710.44 0.00% 0.00 0.00

Subtotal 22.95 22.95 0.00 100.00% 10,962.50 10,962.50 0.00 100.00% 0.00 49,220.06 448.99% 477.67 477.67

GRAND TOTALS
001 Michael L. Jensen 104.78 104.78 0.00 100.00% 42,139.10 42,714.10 -575.00 98.65% 1,916.03 63,019.90 149.55% 402.17 402.17
002 Paula Ann Martin 88.30 88.30 0.00 100.00% 36,041.25 36,041.25 0.00 100.00% 1,525.54 68,395.25 189.77% 408.17 408.17
003 Ronald P. Anderson 28.25 28.25 0.00 100.00% 8,606.25 8,606.25 0.00 100.00% 0.00 15,434.46 179.34% 304.65 304.65

Totals 221.33 221.33 0.00 100.00% 86,786.60 87,361.60 -575.00 99.34% 3,441.57 146,849.61 169.21% 392.11 392.11

Task Folder Reports | Productivity Reports | Timekeeper Analysis Report

The Timekeeper Analysis Report provides an analysis of Billed Hours, Original Hours, Billed Amounts and gross receipts by
working timekeeper for a date range, thus allowing you to analyze the information included on the report by month for each
timekeeper, or to compare each timekeeper.

As shown in the above reports, the Timekeeper Analysis Report can be sorted by Timekeeper or by Month. Optional columns
can be included for a more detailed report.

The Options tab includes parameters that enable you to select a range of months to include on the report, restrict what working
timekeeper information is included, and to group results by month or by timekeepers. The Format tab allows you to select what
optional fields are included.

Definitions for Timekeeper Analysis Report
Date (heading) Used for reference only.

Billed Hours Total billable hours billed and updated during the specified time frame. Billed figures are
accumulated based on the statement date. (Note: The Billed Hours includes the Write-Up Hours and
Write-Down Hours.)

Original Hours Total hours worked for transactions billed during the specified time frame. Any write-up/write-
down of hours will not affect this figure.

Hours Difference Billed Hours minus Original Hours.

Hours Ratio Billed Hours divided by Original Hours.

Billed Amount Total billable fees billed and updated during the specified time frame including write-up and write-
down amounts. Billed figures are accumulated based on the statement date. Progress billed fee
transactions (i.e., Type 6 transactions) are not included in this amount.

Original Value A calculated amount for all transactions billed during the specified time frame based on Original
Hours multiplied by Rate.

Amount Difference Billed Amount minus Original Value.

Amount Ratio Billed Amount divided by Original Value.

Write Offs Total write offs during the specified time frame. Write off figures are accumulated based on the
write off transaction date.

Fee Receipts Receipts allocated during the specified time frame. The receipt information is accumulated based on
the payment allocation date and can include both work-in-process and archived payment entries.
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The receipt amounts represent the gross working timekeeper amounts and exclude payments on
hold. Unapplied payments are not included.

Receipts Ratio Fee Receipts divided by Billed Amount.

Billed Rate Hourly billing rate based on billed hours (Billed Amount divided by Billed Hours).

Effective Rate Hourly billing rate based on original hours (Billed Amount divided by Original Hours).

Timekeeper Realization Report
Date: 11/28/2016 Tabs3 Timekeeper Realization Report Page: 1

Jensen, Martin & Anderson, P.C.

July 1, 2016 thru September 30, 2016

Original Billed Realization Original Billed Billing Est. Hours Collection Collection
Timekeeper Hours Hours Rate Value Amount Realization Collected Amount Realization Write Offs Uncollected

1 Michael L. Jensen 74.25 74.25 454.58 33,790.00 33,752.50 99.89% 72.77 33,079.12 98.00% 0.00 673.38
2 Paula Ann Martin 86.00 86.00 440.68 37,898.75 37,898.75 100.00% 85.59 37,716.94 99.52% 0.00 181.81
3 Ronald P. Anderson 27.50 27.50 373.00 10,257.50 10,257.50 100.00% 26.98 10,065.10 98.12% 0.00 192.40
4 Robert O. Burns 35.25 35.25 750.00 26,437.50 26,437.50 100.00% 35.25 26,437.50 100.00% 0.00 0.00
5 Kendra I. Michaels 11.25 11.25 350.00 3,937.50 3,937.50 100.00% 11.25 3,937.50 100.00% 0.00 0.00

Totals 234.25 234.25 479.33 112,321.25 112,283.75 99.97% 232.06 111,236.16 99.07% 0.00 1,047.59

Date: 11/28/2016 Tabs3 Timekeeper Realization Report Page: 1
Jensen, Martin & Anderson, P.C.

July 1, 2016 thru September 30, 2016

Original Billed Realization Original Billed Billing Collection Collection
Timekeeper Hours Hours Rate Value Amount Realization Amount Realization

1 Michael L. Jensen 74.25 74.25 454.58 33,790.00 33,752.50 99.89% 33,079.12 98.00%
2 Paula Ann Martin 86.00 86.00 440.68 37,898.75 37,898.75 100.00% 37,716.94 99.52%
3 Ronald P. Anderson 27.50 27.50 373.00 10,257.50 10,257.50 100.00% 10,065.10 98.12%
4 Robert O. Burns 35.25 35.25 750.00 26,437.50 26,437.50 100.00% 26,437.50 100.00%
5 Kendra I. Michaels 11.25 11.25 350.00 3,937.50 3,937.50 100.00% 3,937.50 100.00%

Totals 234.25 234.25 479.33 112,321.25 112,283.75 99.97% 111,236.16 99.07%

Task Folder Reports | Management Reports | Timekeeper Realization Report

Billing Realization is the percentage of professional work performed that is billed to clients. The Timekeeper Realization Report
shows billed information for a specified date range, the realized value (i.e. percentage of professional work performed that is
actually billed to clients) compared to actual time spent, and the collections applied to the billed information. The report helps
you evaluate the profitability of individual working timekeepers by showing the amounts collected on specific billings.

The Options tab includes parameters that enable you to select a range of months to include on the report and to limit what
timekeeper’s work will appear. The Format tab allows you to select what optional fields are included.

Definitions for Timekeeper Realization Report
Date (heading) Used for reference only.

(date range) The time period of billed transactions that the report includes. Can be a predetermined time period
(i.e., Current Reporting Month), or any date range specified when the report is generated.

(timekeeper) Working timekeeper number and name.

Original Hours Total hours worked for transactions billed and updated for the specified period. Any write-up/write-
down of hours will not affect this figure.

Billed Hours Total billable hours billed and updated for the specified period. Billed figures are accumulated
based on the statement date. Includes the Write-Up Hours and Write-Down Hours.

Realization Rate Billed Amount divided by Original Hours.

Original Value Total billable amount billed and updated for the specified period prior to any write-up/write-down
amounts.
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Billed Amount Total billable fees billed and updated for the specified period including write-ups, write-downs, and
courtesy discount amounts. Progress billed fee transactions (i.e., Type 6 transactions) are not
included in this amount.

Billing Realization The percentage of professional work performed that is actually billed to clients. Billed Amount
divided by Original Value.

Est. Hours Collected Collection Realization multiplied by Billed Hours.

Collection Amount The total amount of work-in-process payments and updated payments applied to fees on updated
statements with a statement date within the specified period (i.e., not the payment transaction date
or payment allocation date).

Collection Realization The percentage of work billed and updated that is actually collected. Collection Amount divided by
Billed Amount.

Write Offs Total write offs for statements billed and updated for the specified period. Write off figures are
accumulated for the billing period for which the write off was performed (i.e., not the write off
date).

Uncollected Billed Amount minus Collection Amount minus Write Offs.
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Timekeeper Productivity Report

Date: 11/28/2016 Tabs3 Timekeeper Productivity Report Page: 1
Jensen, Martin & Anderson, P.C.

Sep 2016 Oct 2016 Total YTD Total

Billed
Hours Worked 37.60 42.25 79.85 79.85
Billed Hours 39.67 42.41 82.08 82.08
Write-Up Hours 3.07 0.16 3.23 3.23
Write-Down Hours 1.00 0.00 1.00 1.00

Worked Value 8,952.50 9,887.50 18,840.00 18,840.00
Write-Up Hours Value 617.50 40.00 657.50 657.50
Write-Down Hours Value 200.00 0.00 200.00 200.00
Billed Amount 9,338.24 9,716.39 19,054.63 19,054.63
Write-Up Amount 0.00 0.00 0.00 0.00
Write-Down Amount 31.76 73.29 105.05 105.05
Courtesy Discount 0.00 137.82 137.82 137.82
Total Write-Up 617.50 40.00 657.50 657.50
Total Write-Down 231.76 211.11 442.87 442.87

Worked Rate 248.36 229.97 238.63 238.63
Billed Rate 235.40 229.11 232.15 232.15
Write Offs 0.00 0.00 0.00 0.00
Effective Rate 235.40 229.11 232.15 232.15

Worked
Billable Hours Worked 37.60 42.25 79.85 146.50
Non-billable Hours Worked 0.00 0.00 0.00 1.50

Hours to Bill 39.67 42.41 82.08 148.89

Worked Value 8,952.50 9,887.50 18,840.00 34,427.50
Non-billable Amount 37.50 0.00 37.50 440.00

Amount to Bill 9,338.24 9,716.39 19,054.63 34,682.13

Total Hours 37.60 42.25 79.85 148.00
Total Amount 8,990.00 9,887.50 18,877.50 34,867.50

1 Michael L. Jensen

You can pick and choose which values you want included on the report.
The reports on page 142 and page 143 are the same except that the report on page 142 includes

rows for Write-Up Hours Value and Write-Down Hours Value whereas
the report on page 143 does not. Billed and Worked Percentages are not

included on these reports and neither is Cumulative WIP.
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Date: 11/28/2016 Tabs3 Timekeeper Productivity Report Page: 1
Jensen, Martin & Anderson, P.C.

Sep 2016 Oct 2016 Total YTD Total

Billed
Hours Worked 37.60 42.25 79.85 79.85
Billed Hours 39.67 42.41 82.08 82.08
Write-Up Hours 3.07 0.16 3.23 3.23
Write-Down Hours 1.00 0.00 1.00 1.00

Worked Value 8,952.50 9,887.50 18,840.00 18,840.00
Billed Amount 9,338.24 9,716.39 19,054.63 19,054.63
Write-Up Amount 0.00 0.00 0.00 0.00
Write-Down Amount 31.76 73.29 105.05 105.05
Courtesy Discount 0.00 137.82 137.82 137.82
Total Write-Up 617.50 40.00 657.50 657.50
Total Write-Down 231.76 211.11 442.87 442.87

Worked Rate 248.36 229.97 238.63 238.63
Billed Rate 235.40 229.11 232.15 232.15
Write Offs 0.00 0.00 0.00 0.00
Effective Rate 235.40 229.11 232.15 232.15

Worked
Billable Hours Worked 37.60 42.25 79.85 146.50
Non-billable Hours Worked 0.00 0.00 0.00 1.50

Hours to Bill 39.67 42.41 82.08 148.89

Worked Value 8,952.50 9,887.50 18,840.00 34,427.50
Non-billable Amount 37.50 0.00 37.50 440.00

Amount to Bill 9,338.24 9,716.39 19,054.63 34,682.13

Total Hours 37.60 42.25 79.85 148.00
Total Amount 8,990.00 9,887.50 18,877.50 34,867.50

1 Michael L. Jensen
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Date: 11/28/2016 Tabs3 Timekeeper Productivity Report Page: 1
Jensen, Martin & Anderson, P.C.

Sep 2016 Oct 2016 Total YTD Total

Billed
Billed Hours 39.67 42.41 82.08 82.08

Billed Amount 9,338.24 9,716.39 19,054.63 19,054.63

Billed Rate 235.40 229.11 232.15 232.15

2  Paula A. Martin
Billed

Billed Hours 4.00 1.75 5.75 5.75

Billed Amount 1,100.00 425.32 1,525.32 1,525.32

Billed Rate 275.00 243.04 265.27 265.27

Billed
Billed Hours 6.08 1.46 7.54 7.54

Billed Amount 861.25 215.48 1,076.73 1,076.73

Billed Rate 141.65 147.59 142.80 142.80

Billed Amount 1,181.25 513.35 1,694.60 1,694.60

Billed Rate 175.00 167.21 172.57 172.57

Billed Amount 600.00 0.00 600.00 600.00

Billed Rate 150.00 0.00 150.00 150.00

GRAND TOTALS

Billed
Billed Hours 60.50 48.69 109.19 109.19

Billed Amount 13,080.74 10,870.54 23,951.28 23,951.28

Billed Rate 216.21 223.26 219.35 219.35

1 Michael L. Jensen

3  Ron P. Anderson

4  Ronald O. Burns
Billed

Billed Hours 6.75 3.07 9.82 9.82

5  Kendra I. Michaels
Billed

Billed Hours 4.00 0.00 4.00 4.00

Sep 2016 Oct 2016 Total YTD Total

Date: 11/28/2016 Tabs3 Timekeeper Productivity Report Page: 1
Jensen, Martin & Anderson, P.C.

Sep 2016 Oct 2016 Total YTD Total

Worked Value 8,952.50 9,887.50 18,840.00 18,840.00
(WV / Grand Total WV) 71.0% 89.3% 79.6% 79.6%
Billed Amount 9,338.24 9,716.39 19,054.63 19,054.63
(BA / Grand Total BA) 71.4% 89.4% 79.6% 79.6%
Total Write-Up 617.50 40.00 657.50 657.50
(TWU / Worked Value) 7.0% 0.0% 3.0% 3.0%
Total Write-Down 231.76 211.11 442.87 442.87
(TWD / Worked Value) 3.0% 2.0% 2.0% 2.0%

Worked Rate 248.36 229.97 238.63 238.63
Billed Rate 235.40 229.11 232.15 232.15
Write Offs 0.00 57.75 57.75 57.75
Effective Rate 235.40 227.74 231.44 231.44

Worked
Billable Hours Worked 37.60 42.25 79.85 146.50
(BHW / Total Hours) 100.0% 100.0% 100.0% 99.0%
Non-billable Hours Worked 0.00 0.00 0.00 1.50
(NHW / Total Hours) 0.0% 0.0% 0.0% 1.0%

Hours to Bill 39.67 42.41 82.08 148.89
(HB / Total Hours) 105.5% 100.4% 102.8% 100.6%

Worked Value 8,952.50 9,887.50 18,840.00 34,427.50
(WV / Total Amount) 99.6% 100.0% 99.8% 98.7%
Non-billable Amount 37.50 0.00 37.50 440.00
(NA / Total Amount) 0.4% 0.0% 0.2% 1.3%

Amount to Bill 9,338.24 9,716.39 19,054.63 34,682.13
(AB / Total Amount) 103.9% 98.3% 100.9% 99.5%

Total Hours 37.60 42.25 79.85 148.00
(TH / Grand Total Hours) 62.0% 87.3% 73.3% 59.0%
Total Amount 8,990.00 9,887.50 18,877.50 34,867.50
(TA / Grand Total Amount) 69.3% 88.8% 78.3% 64.2%

WIP Hours to Bill 66.81
WIP Amount: 15,332.22
Average Age: 180 Days

1  Michael L. Jensen
Billed

Hours Worked 37.60 42.25 79.85 79.85
(HW / Grand Total HW) 64.4% 87.3% 74.8% 74.8%
Billed Hours 39.67 42.41 82.08 82.08
(BH / Grand Total BH) 65.6% 87.1% 75.2% 75.2%
Write-Up Hours 3.07 0.16 3.23 3.23
(WUH / Hours Worked) 8.2% 0.4% 4.0% 4.0%
Write-Down Hours 1.00 0.00 1.00 1.00
(WDH / Hours Worked) 2.7% 0.0% 1.3% 1.3%

This report only includes Billed Hours,
Billed Amount, and Billed Rate.

This report includes percentages.
The Compare to Recommended
Hours option was not selected.

Task Folder Reports | Productivity Reports | Timekeeper Productivity

The Timekeeper Productivity Report shows billed information, worked information or a combination of both for a range of
timekeepers and timekeeper levels. You can select exactly which items you want included on the reports and optionally include
percentages. Any range of months during the current reporting year can be included on the report. Totals are shown for all
months selected on the report as well as year-to-date totals, which include the figures from the first month of the reporting year
thru the Ending Reporting Month specified on the Options tab. Optional information is selected on the Format tab, as well as
the option to print in portrait or landscape format.

For example, assume your current reporting month is October and your fiscal year runs from January through December. If you
were to run the report for August through October, the Total figures would include August through October amounts and the
YTD Total figures would include January through October amounts. You have the option to print one timekeeper per page and
to print zero activity timekeepers. Various figures from this report can optionally be generated in a graphical format (page 166).

Billed Portion Definitions
The Billed section of the report includes hours and amounts based on the statement date of the updated statement. When the
Billed Information check box is selected on the Options tab, the following items can be included or excluded from the report
via the Format tab.

Hours Worked Total hours worked for transactions billed during the month.

% Percentage comparison to the Grand Total Hours Worked in the same column on the report.

Billed Hours Total billable hours billed during the month based on Statement Date. (Note: The Billed Hours
includes the Write-Up Hours and Write-Down Hours.)

% Percentage comparison to the Grand Total Billed Hours in the same column on the report.

Write-Up Hours Total write-up for hours billed during the month. This figure is calculated based on the total Hours
to Bill for transactions billed for the month minus the total Hours Worked for the same transactions.

% Percentage comparison to the Grand Total Write-Up Hours in the same column on the report.
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Write-Down Hours Total write-down for hours billed during the month. This figure is calculated based on the total
Worked Hours for transactions billed for the month minus the total Hours to Bill for the same
transactions.

% Percentage comparison to the Grand Total Write-Down Hours in the same column on the report.

Worked Value A calculated amount for all transactions billed during the month based on Hours Worked multiplied
by Rate.

% Percentage comparison to the Grand Total Worked Value in the same column on the report.

Write-Up Hours Value A calculated amount for all transactions billed during the month based on (Billed Hours - Hours
Worked) multiplied by rate.

% Write-Up Hours Value divided by Worked Value.

Write-Down Hours Value A calculated amount for all transactions billed during the month based on (Hours Worked - Billed
Hours) multiplied by rate.

% Write-Down Hours Value divided by Worked Value.

Billed Amount Total billable fees billed during that month. (Note: The Billed Amount includes the Write-Up
Amount and Write-Down Amount but does not include the Write Offs).

% Percentage comparison to the Grand Total Billed Amt in the same column on the report.

Write-Up Amount Total write-up for fees billed during the month.

% Write-up percentage [Write-Up divided by (Billed Amt - Write-Up +Write-Down)].

Write-Down Amount Total write-downs for fees billed during the month.

% Write-down percentage [Write-Down divided by (Billed Amt - Write-Up +Write-Down)].

Courtesy Discount Dollar value of any billed and updated courtesy discounts.

% Courtesy Discount divided by Worked Value.

Total Write-Up Write-Up Hours Value plus Write-Up Amount.

% Total Write-Up divided by Worked Value.

Total Write-Down Write-Down Hours Value plus Write-Down plus Courtesy Discount.

% Total Write-Down divided by Worked Value.

Worked Rate Hourly worked rate (Billed Amount divided by Hours Worked).

Billed Rate Hourly billing rate (Billed Amt divided by Hours).

Write Offs Write offs for that month by working timekeeper. Write off figures are accumulated for the billing
period in which the write off was performed (i.e., not the write off date). A report of write offs for a
specified range of write off dates can be generated using the Client Ledger Report for Write Offs
Only.

Effective Rate Effective hourly billing rate [(Billed Amt minus Write Offs) divided by Billed Hours].

Worked Portion Definitions
Information in the Worked section is based on transaction dates in the current reporting period. There is no distinction made as
to whether or not the billable worked hours and amounts have been billed. Fee transactions entered with a previous month’s
date will be included in the month of the fee transaction’s date. When theWorked Information check box is selected on the
Options tab, the following items can be included or excluded from the report via the Format tab.

Billable Hours Worked Total billable hours worked during the month including hours on hold.
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% Percentage comparison to timekeeper’s Total Billable and Non-billable Hours (Billable Hours
Worked divided by Total Hours).

Non-billable Hours
Worked

Total non-billable hours worked during the month including hours on hold.

% Percentage comparison to timekeeper’s Total Billable and Non-billable Hours (Non-billable Hours
Worked divided by Total Hours).

Hours to Bill Total billable hours to bill during the month including hours on hold.

% Percentage comparison to timekeeper’s Total Hours (Hours to Bill divided by Total Hours).

Worked Value A calculated amount for all transactions during the month based on Billable Hours Worked
multiplied by rate of transactions. Transactions on hold are included. Does not include write-up or
write-down.

% Percentage comparison to timekeeper’s Total Amount (Worked Value divided by Total Amount).

Non-billable Amount Total non-billable fee amount for transactions entered during the month. Transactions on hold are
included.

%
Percentage comparison to timekeeper’s Total Amount (Non-billable Amount divided by Total
Amount).

Amount to Bill Total billable fee amount for transactions entered during the month. Includes write-up and write-
down.

% Percentage comparison to timekeeper’s Total Amount (Amount to Bill divided by Total Amount).

Total Hours Billable Hours Worked + Non-billable Hours Worked.

% The calculations for these percentages depend on whether the “Compare to Recommended Hours”
check box was selected.

“Compare to Recommended Hours” Check Box Cleared

Total When the “Compare to Recommended Hours” check box is cleared, the
percentage for the timekeeper’s worked hours in the Total column uses the
following formula: timekeeper’s Total Hrs in the Total column divided by the
Total Hours in the Grand Totals section.

YTD Total The percentage for the timekeepers worked hours in the YTD Total column uses
the following formula: timekeeper’s Total Hrs in the YTD Total column divided by
the YTD Total Hours in the Grand Totals section.

(Note: A Total Hours percentage comparison will not be included in the Grand
Totals section unless you are comparing figures to recommended hours.)
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“Compare to Recommended Hours” Check Box Selected

Total When the “Compare to Recommended Hours” check box is selected, the
percentage for the timekeeper’s worked hours in the Total column is compared
to the hours specified in the Recommended Hours per Month field by using the
following formula: timekeeper’s Total Hours in the Total column divided by (the
number of months on the report multiplied by the Recommended Hours).

YTD Total The percentage for the timekeeper’s worked hours in the YTD Total column is
compared to the hours specified in the Recommended Hours per Month field
by using the following formula: timekeeper’s Total Hours in the YTD Total
column divided by (the number of months in the YTDmultiplied by the
Recommended Hours).

Total in
Grand Totals

If more than one timekeeper is used in the report, percentages in the Grand
Totals Worked section are calculated using the following. The percentage for the
grand total worked hours in the Total column is compared to the hours specified
in the Recommended Hours per Month field by using the following formula:
Total Hours in the Total Column divided by (the number of timekeepers on the
report multiplied by the number of months on the report multiplied by the
Recommended Hours).

YTD Total in
Grand Totals

The percentage for the Grand Total worked hours in the YTD Total column is
compared to the hours specified in the Recommended Hours per Month field
by using the following formula: Total Hours in the YTD Total column divided by
(the number of timekeepers on the report multiplied by the number of months in
the YTDmultiplied by the Recommended Hours).

Total Amount Worked Value + Non-billable Amount.

% Percentage comparison to Grand Total Amount.

WIP Hours to Bill Accumulative billable work-in-process hours to bill through the ending reporting month selected
(including credits and excluding non-billable hours).

WIP Amount Accumulative billable work-in-process amounts through the ending reporting month selected
(includes credits, write-ups and write-downs, and excluding non-billable hours).

Average Age Average age of billable work-in-process fees based on the age of each transaction times the
amount of each transaction divided by the total work-in-process (weighted average). [Tip: If this
number is negative or seems excessively large, you can run a Transaction File List for fee work-in-
process transactions using mm/dd/yyyy for the beginning and ending date and subtotal by
transaction date in order to identify which transaction(s) is skewing this calculated figure.]
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Category Productivity Report
Date: 11/28/2016 Tabs3 Category Productivity Report Page: 1

Jensen, Martin & Anderson, P.C.

Sep 2016 Oct 2016 Total YTD Total

1  Business Consulting
Billed

Hours Worked 3.50 6.65 10.15 10.15
Billed Hours 3.65 6.94 10.59 10.59

Worked Value 605.00 1,405.25 2,010.25 2,010.25
Billed Amount 581.99 1,201.79 1,783.78 1,783.78

Billed Rate 159.45 173.17 168.44 168.44

5  Other Consulting
Billed

Hours Worked 40.85 35.25 76.10 76.10
Billed Hours 42.85 35.25 78.10 78.10

Worked Value 9,393.75 8,043.75 17,437.50 17,437.50
Billed Amount 9,893.75 7,893.75 17,787.50 17,787.50

Billed Rate 230.89 223.94 227.75 227.75

15  Business Tax
Billed

Hours Worked 1.00 6.50 7.50 7.50
Billed Hours 1.00 6.50 7.50 7.50

Worked Value 250.00 1,625.00 1,875.00 1,875.00
Billed Amount 250.00 1,625.00 1,875.00 1,875.00

Billed Rate 250.00 250.00 250.00 250.00

20  Real Estate
Billed

Hours Worked 8.25 0.00 8.25 8.25
Billed Hours 8.25 0.00 8.25 8.25

Worked Value 1,590.00 0.00 1,590.00 1,590.00
Billed Amount 1,590.00 0.00 1,590.00 1,590.00

Billed Rate 192.73 0.00 192.73 192.73

Sep 2016 Oct 2016 Total YTD Total

Hours Worked 53.60 48.40 102.00 102.00
Billed Hours 55.75 48.69 104.44 104.44

Worked Value 11,838.75 11,074.00 22,912.75 22,912.75
Billed Amount 12,315.74 10,720.54 23,036.28 23,036.28

Billed Rate 220.91 220.18 220.57 220.57

GRAND TOTALS

Date: 11/28/2016 Tabs3 Category Productivity Report Page: 1
Jensen, Martin & Anderson, P.C.

Sep 2016 Oct 2016 Total YTD Total

1  Business Consulting
Billed

Hours Worked 3.50 6.65 10.15 10.15
(HW / Grand Total HW) 100.0% 100.0% 100.0% 100.0%
Billed Hours 3.65 6.94 10.59 10.59
(BH / Grand Total BH) 100.0% 100.0% 100.0% 100.0%
Write-Up Hours 0.15 0.29 0.44 0.44
(WUH / Hours Worked) 4.3% 4.4% 4.3% 4.3%
Write-Down Hours 0.00 0.00 0.00 0.00
(WDH / Hours Worked) 0.0% 0.0% 0.0% 0.0%

Worked Value 605.00 1,405.25 2,010.25 2,010.25
(WV / Grand Total WV) 100.0% 100.0% 100.0% 100.0%
Write-Up Hours Value 26.70 61.85 88.55 88.55
(WUHV / Worked Value) 4.4% 4.4% 4.4% 4.4%
Write-Down Hours Value 0.00 0.00 0.00 0.00
(WDHV / Worked Value) 0.0% 0.0% 0.0% 0.0%
Billed Amount 581.99 1,201.79 1,783.78 1,783.78
(BA / Grand Total BA) 100.0% 100.0% 100.0% 100.0%
Write-Up Amount 0.00 0.00 0.00 0.00
(WUA / Worked Value) 0.0% 0.0% 0.0% 0.0%
Write-Down Amount 49.71 115.31 165.02 165.02
(WDA / Worked Value) 8.2% 8.2% 8.2% 8.2%
Courtesy Discount 0.00 150.00 150.00 150.00
(CD / Worked Value) 0.0% 10.7% 7.5% 7.5%
Total Write-Up 26.70 61.85 88.55 88.55
(TWU / Worked Value) 4.0% 4.0% 4.0% 4.0%
Total Write-Down 49.71 265.31 315.02 315.02
(TWD / Worked Value) 8.0% 19.0% 16.0% 16.0%

Worked Rate 166.28 180.72 175.74 175.74
Billed Rate 159.45 173.17 168.44 168.44
Write Offs 0.00 0.00 0.00 0.00
Effective Rate 159.45 173.17 168.44 168.44

Worked
Billable Hours Worked 3.50 6.65 10.15 45.15
(BHW / Total Hours) 100.0% 100.0% 100.0% 97.8%
Non-billable Hours Worked 0.00 0.00 0.00 1.00
(NHW / Total Hours) 0.0% 0.0% 0.0% 2.2%

Hours to Bill 3.65 6.94 10.59 45.75
(HB / Total Hours) 104.3% 104.4% 104.3% 99.1%

Worked Value 605.00 1,405.25 2,010.25 10,004.00
(WV / Total Amount) 94.2% 96.2% 95.6% 96.8%
Non-billable Amount 37.50 55.00 92.50 327.50
(NA / Total Amount) 5.8% 3.8% 4.4% 3.2%

Amount to Bill 581.99 1,201.79 1,783.78 9,817.53
(AB / Total Amount) 90.6% 82.3% 84.8% 95.0%

Total Hours 3.50 6.65 10.15 46.15
(TH / Grand Total Hours) 100.0% 100.0% 100.0% 100.0%
Total Amount 642.50 1,460.25 2,102.75 10,331.50
(TA / Grand Total Amount) 100.0% 100.0% 100.0% 100.0%

Task Folder Reports | Productivity Reports | Category Productivity

The reports shown above are Category Productivity Reports. This report can be run for billed information, worked information or
both for a range of categories. The report can be run for any number of consecutive months during the current year. The figures
in the Total column are totals of all months on the report. The figures in the YTD Total column are year-to-date totals.

For example, assume your current reporting month is October and your fiscal year runs from January through December. If you
were to run the report for August through October, the Total figures would include August through October amounts and the
YTD Total figures would include January through October amounts. You have the option to print one category per page and to
print zero activity categories, as well as to print in portrait or landscape orientation. Various figures from this report can
optionally be generated in a graphical format (page 166).

Billed Portion Definitions
The Billed section of the report includes hours and amounts based on the statement date of the updated statement. When the
Billed Information check box is selected on the Options tab, the following items can be included or excluded from the report
via the Format tab.

Hours Worked Total hours worked for transactions billed during the month.

% Percentage comparison to the Grand Total Hours Worked in the same column on the report.

Billed Hours Total billable hours billed during the month based on Statement Date. (Note: The Billed Hours
includes the Write-Up Hours and Write-Down Hours.)

% Percentage comparison to the Grand Total Billed Hours in the same column on the report.

Write-Up Hours Total write-up for hours billed during the month. This figure is calculated based on the total Hours
to Bill for transactions billed for the month minus the total Hours Worked for the same transactions.

% Percentage comparison to the Grand Total Write-Up Hours in the same column on the report.
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Write-Down Hours Total write-down for hours billed during the month. This figure is calculated based on the total
Worked Hours for transactions billed for the month minus the total Hours to Bill for the same
transactions.

% Percentage comparison to the Grand Total Write-Down Hours in the same column on the report.

Worked Value A calculated amount for all transactions billed during the month based on Hours Worked multiplied
by Rate.

% Percentage comparison to the Grand Total Worked Value in the same column on the report.

Write-Up Hours Value A calculated amount for all transactions billed during the month based on (Billed Hours - Hours
Worked) multiplied by rate.

% Write-Up Hours Value divided by Worked Value.

Write-Down Hours Value A calculated amount for all transactions billed during the month based on (Hours Worked - Billed
Hours) multiplied by rate.

% Write-Down Hours Value divided by Worked Value.

Billed Amount Total billable fees billed during that month. (Note: The Billed Amount includes the Write-Up Amount
and Write-Down Amount but does not include the Write Offs).

% Percentage comparison to the Grand Total Billed Amt in the same column on the report.

Write-Up Amount Total write-up for fees billed during the month.

% Write-up percentage [Write-Up divided by (Billed Amt - Write-Up +Write-Down)].

Write-Down Amount Total write-downs for fees billed during the month.

% Write-down percentage [Write-Down divided by (Billed Amt - Write-Up +Write-Down)].

Courtesy Discount Dollar value of any billed and updated courtesy discounts.

% Courtesy Discount divided by Worked Value.

Total Write-Up Write-Up Hours Value plus Write-Up Amount.

% Total Write-Up divided by Worked Value.

Total Write-Down Write-Down Hours Value plus Write-Down plus Courtesy Discount.

% Total Write-Down divided by Worked Value.

Worked Rate Hourly worked rate (Billed Amount divided by Hours Worked).

Billed Rate Hourly billing rate (Billed Amt divided by Hours).

Write Offs Write offs for that month by category. Write off figures are accumulated based on the write off date.
A report of write offs for a specified range of write off dates can be generated using the Client
Ledger Report for Write Offs Only.

Effective Rate Effective hourly billing rate [(Billed Amt minus Write Offs) divided by Billed Hours].

Worked Portion Definitions
Information in the Worked section is based on transaction dates in the current reporting period. There is no distinction made as
to whether or not the billable worked hours and amounts have been billed. Fee transactions entered with a previous month’s
date will be included in the month of the fee transaction’s date. When theWorked Information check box is selected on the
Options tab, the following items can be included or excluded from the report via the Format tab.

Billable Hours Worked Total billable hours worked during the month including hours on hold.
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% Percentage comparison to category’s Total Billable and Non-billable Hours (Billable Hours Worked
divided by Total Hours).

Non-billable Hours
Worked

Total non-billable hours worked during the month including hours on hold.

% Percentage comparison to category’s Total Billable and Non-billable Hours (Non-billable Hours
Worked divided by Total Hours).

Hours to Bill Total billable hours to bill during the month including hours on hold.

% Percentage comparison to category’s Total Hours (Hours to Bill divided by Total Hours).

Worked Value A calculated amount for all transactions during the month based on Billable Hours Worked
multiplied by rate of transactions. Transactions on hold are included. Does not include write-up or
write-down.

% Percentage comparison to category’s Total Amount (Worked Value divided by Total Amount).

Non-billable Amount Total non-billable fee amount for transactions entered during the month. Transactions on hold are
included.

% Percentage comparison to category’s Total Amount (Non-billable Amount divided by Total
Amount).

Amount to Bill Total billable fee amount for transactions entered during the month. Includes write-up and write-
down.

% Percentage comparison to category’s Total Amount (Amount to Bill divided by Total Amount).

Total Hours Billable Hours Worked + Non-billable Hours Worked.

% Percentage comparison to Grand Total Hours.

Total Amount Worked Value + Non-billable Amount.

% Percentage comparison to Grand Total Amount.

WIP Hours to Bill Accumulative billable work-in-process hours to bill through the ending reporting month selected
(including credits and excluding non-billable hours).

WIP Amount Accumulative billable work-in-process amounts through the ending reporting month selected
(includes credits, write-ups and write-downs, and excluding non-billable hours).

Average Age Average age of billable work-in-process fees based on the age of each transaction times the
amount of each transaction divided by the total work-in-process (weighted average). [Tip: If this
number is negative or seems excessively large, you can run a Transaction File List for fee work-in-
process transactions using mm/dd/yyyy for the beginning and ending date and subtotal by
transaction date in order to identify which transaction(s) is skewing this calculated figure.]
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Timekeeper Profitability Report

Date: 11/28/2016 Tabs3 Timekeeper Profitability Report Page: 1
Jensen, Martin & Anderson, P.C.

Aug 2016 Sep 2016 Oct 2016 Total

  1   Michael L. Jensen
Billed Fees                                           15000 17633 16907 43285
Overhead                                              10000 10000 10000 30000

Fee % of Overhead                             150 % 176%               169 % 144 %
Net Profit 50005000                7633 6907 13285

  2   Paula Ann Martin
Billed Fees 12938 15271 12725 41037
Overhead 10000 10000 10000 30000

Fee % of Overhead 129 % 153% 127 % 137%
Net Profit 2938 5271 2725 11037

  3   Ronald P. Anderson
Billed Fees                                           13000              17310             10456 40766
Overhead 10000 10000 10000 30000

Fee % of Overhead                               130 %             173%               105 %                136 %
Net Profit                                               3000              7310                456              10766

GRAND TOTALS

Billed Fees                                            40938 50214 40088             125088
Overhead 30000 30000 30000 90000

Fee % of Overhead                              137 % 167% 134 % 139 %
Net Profit                                            110938              20214              10088               35088

Task Folder Reports | Management Reports | Timekeeper Profitability Report

The report shown above is a Timekeeper Profitability Report. This report shows billed amounts and overhead amounts for each
timekeeper for any range of months in the current fiscal year. Net profits are calculated as well as a percentage of overhead.
Before using this report, monthly overhead figures must be provided by the user and entered via the Profitability button in the
Timekeeper program. Only managers can print a Timekeeper Profitability Report. This report can optionally be generated in a
graphical format (page 166).

This report can be run for a range of timekeepers and a range of months in the current reporting year. You can optionally
include timekeepers with no billed fees and start each timekeeper on a new page.

Note: The Timekeeper Profitability Report displays dollar amounts without cents. As a result, some amounts may be rounded,
and minor differences may exist between the amounts on this report and other reports that include cents.

Definitions for Timekeeper Profitability Report
Date (heading) Used for reference only.

(Timekeeper) Timekeeper number and name.

Billed Fees Amounts Billed by this timekeeper in the specified reporting month. This amount is based on the
statement date of the updated statement (similar to the Billed Amount on the Timekeeper
Productivity Report).

Overhead Overhead amount for the month. Overhead amounts are entered in the Timekeeper Profitability
Amounts window which is accessed via the Profitability button in the Timekeeper program.

%of Billed Fees This figure is calculated by dividing the Billed Fees amount by the Overhead amount.
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Net Profit This figure is calculated by subtracting the Overhead amount from the Billed Fees amount.

Totals Total amounts for the months included on the report.

Timekeeper Status Report

Date: 11/28/2016 Tabs3 Detail Timekeeper Status Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary WIP Accounts Receivable Total
Timekeeper Hours Amount 0-30 31-60 61-90 91-120 121-180 181+ Balance WIP + A/R

1 Michael L. Jensen
Fees: 44.55 10,997.25 0.00 5,770.85 2,276.66 0.00 0.00 0.00 8,047.51 19,044.76

Expenses: 12.00 0.00 86.69 0.00 0.00 0.00 0.00 86.69 98.69
Advances: 0.00 0.00 200.00 0.00 0.00 0.00 0.00 200.00 200.00
Fin. Chrg: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Total: 11,009.25 0.00 6,057.54 2,276.66 0.00 0.00 0.00 8,334.20 19,343.45

2 Paula Ann Martin
Fees: 39.70 8,800.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 8,800.00

Expenses: 115.43 0.00 0.00 0.00 0.00 0.00 0.00 0.00 115.43
Advances: 211.50 0.00 0.00 0.00 0.00 0.00 0.00 0.00 211.50
Fin. Chrg: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Total: 9,126.93 0.00 0.00 0.00 0.00 0.00 0.00 0.00 9,126.93

Unapplied Payments: 694.25 Balance Due: -694.25

3 Ronald P. Anderson
Fees: 14.00 2,838.00 20,818.90 1,584.50 91.00 0.00 0.00 0.00 22,494.40 25,332.40

Expenses: 4.28 1.31 215.25 0.00 0.00 0.00 0.00 216.56 220.84
Advances: 0.00 78.38 150.00 40.00 75.00 0.00 0.00 343.38 343.38
Fin. Chrg: 8.41 22.26 0.00 0.00 0.00 0.00 30.67 30.67

Total: 2,842.28 20,907.00 1,972.01 131.00 75.00 0.00 0.00 23,085.01 25,927.29

5 Kendra I. Michaels
Fees: 13.00 2,200.00 0.00 840.00 0.00 0.00 0.00 0.00 840.00 3,040.00

Expenses: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Advances: 0.00 0.00 150.00 0.00 0.00 0.00 0.00 150.00 150.00
Fin. Chrg: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Total: 2,200.00 0.00 990.00 0.00 0.00 0.00 0.00 990.00 3,190.00

GRAND TOTALS
Fees: 111.25 24,835.25 20,818.90 8,195.35 2,367.66 0.00 0.00 0.00 31,381.91 56,217.16

Expenses: 131.71 1.31 301.94 0.00 0.00 0.00 0.00 303.25 434.96
Advances: 211.50 78.38 500.00 40.00 75.00 0.00 0.00 693.38 904.88
Fin. Chrg: 8.41 22.26 0.00 0.00 0.00 0.00 30.67 30.67

Total: 25,178.46 20,907.00 9,019.55 2,407.66 75.00 0.00 0.00 32,409.21 57,587.67

Unapplied Payments: 694.25 Balance Due: 31,714.96

Task Folder Reports | Management Reports | Timekeeper Status Report

The Timekeeper Status Report is a report that can be printed by primary, secondary or originating reporting timekeeper and
combines work-in-process with accounts receivable information. Progress billing information is also shown on this report. The
data for the accounts receivable figures is retrieved from the client ledger file. The work-in-process information is retrieved from
the fee and cost transaction files. The report includes all processed payments regardless of report date and unprocessed
payments (excluding payments on hold) through theWIP Pymt Cut-Off Date specified. Timekeepers with zero amounts will
not be included in the report. You can run this report in a detail or summary format. The detail report breaks down the amounts
by fees, expenses, advances, finance charge, and totals, whereas the summary report prints totals only for each timekeeper.

Definitions for Timekeeper Status Report
Date Used as a basis for calculating the aging of accounts receivable. The WIP Pymt Cut-Off Date

specified is used as a cut-off date for work-in-process payments. All processed payments and work-
in-process fees and costs are included regardless of the WIP Pymt Cut-Off Date and Report Date
specified.

Accounts Receivable
0-30, 31-60,
61-90, 91-120,
121-180, 181+

The aging of amounts is determined each time the report is run. The number of days between the
Report Date and the statement date determines the aging period of each past due amount. All billed
and updated statement amounts are included in the report regardless of the report date. Work-In-
Process payments through theWIP Pymt Cut-Off Date (excluding payments on hold) are applied
to past due amounts. The aging periods are assigned on the Options tab in Tabs3 Customization.

WIP column
Hours (Hours to Bill)
Amount

Credit transactions and transactions on hold are included. Non-billable transactions are not
included. Type 6 “progress fee” transactions are not included in WIP Fees. Amounts for work-in-
process Fees, Expenses, Advances, Finance Charge, and WIP Totals are accumulated by primary,
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secondary or originating reporting timekeeper—not working timekeeper. All work-in-process fees
and costs are included regardless of the WIP Pymt Cut-Off Date and Report Date specified.

Unapplied Payments This figure includes unprocessed regular payments (Type “1”) through the report date and all
processed regular payments that exceed the Balance Due. Unapplied payments are also included in
the client Balance Due figure. Excess fee payments (Type 2) are shown as a credit amount in the 0-
30 bracket of the Fees column. Excess cost payments (Type 3) are shown as a credit amount in the
0-30 bracket of the Expenses or Advances column.

Balance Due Client’s Total Balance minus Unapplied Payments.

Progress WIP¹ Total amount of Type 6 “progress fees” in work-in-process.

Progress Billed¹ Total amount of Type 6 progress fees billed since the last time the client was “reconciled” (from the
Progress Billed field on the A/R & Fund Balances tab in the Client file). Progress WIP Tax is not
included.

Progress Paid¹ Progress Billed minus Fees Due (from the A/R & Fund Balances tab in the Client file).

¹ Not shown on the sample report.

Client Budget Report

Date: 11/28/2016 Tabs3 Client Budget Report Page: 1
Jensen, Martin & Anderson, P.C.

Primary Timekeeper:  3 Ronald P. Anderson

Hours Budget Fees Expenses Advances Total Budget

415.00 M MegaConstruction Corporation
Corporate Merger - Megabuilders and BuilderCorp
Billed 1,840.45 746,422.50 642.00 0.00 747,064.50

% of Budget 83% 0% 0% 83%
WIP 52.45 20,472.50 1.25 75.00 20,548.75

% of Budget 2% 0% 0% 2%
Total 1,892.90 0.00 766,895.00 643.25 75.00 767,613.25 900,000.00

% of Budget 85% 0% 0% 85%

Task Folder Reports | Client Setup Reports | Client Budget Report

The report above is a Client Budget Report. This report shows the hours and amount budgeted for a client as well as the
percentage of those budget amounts that have been billed and the percentage that are in work-in-process. The total percentage
is also shown. The Options tab includes parameters that enable you to include a date range for statements.

Definitions for Client Budget Report
(client) Client ID, name and work description. The letter after the Client ID represents the billing frequency.

An asterisk preceding the work description indicates the work description will not print on the
client’s statement.1

(Timekeeper)1 Primary timekeeper number and initials will print to the left of the work description if the report is
not printed in timekeeper order.

Billed Hours Total hours billed within the date range specified.

% Percentage comparison to Total Budget Hours.

Billed Fees Total fees billed within the date range specified.

% Percentage comparison to Total Budget Amount.
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Billed Expenses Total expenses billed within the date range specified.

% Percentage comparison to Total Budget Amount.

Billed Advances Total advances billed within the date range specified.

% Percentage comparison to Total Budget Amount.

Billed Total Total fees and costs billed within the date range specified.

% Percentage comparison to Total Budget Amount.

WIP Hours Total unbilled hours within the date range specified.

% Percentage comparison to Total Budget Hours.

WIP Fees Total unbilled fees within the date range specified. Type 6 transactions are not included.

% Percentage comparison to Total Budget Amount.

WIP Expenses Total unbilled expenses within the date range specified.

% Percentage comparison to Total Budget Amount.

WIP Advances Total unbilled advances within the date range specified.

% Percentage comparison to Total Budget Amount.

Total Total unbilled fees and costs within the date range specified.

% Percentage comparison to Total Budget Amount.

Total Total of hours, fees and costs (billed and unbilled) within the date range specified.

Budget (Hours) Budget hours from the Budget tab in the Client file.

Budget (fees & costs) Budget amount on the Budget tab in the Client file.

1Not shown on the sample report.

Task Code Budget Report

Date: 11/28/2016 Tabs3 Task Code Budget Report Page: 1

Jensen, Martin & Anderson, P.C.

A C T I V I T Y E X P E N S E
Phase/Task Billed WIP Total Budget Billed WIP Total Budget

550.00 M Federated Casualty, Ltd. Timekeeper:  1 MLJ
Andrew C. Gilbert v. Federated Casualty

L100 Case Assessment, Development and Administration 214% 84%575 281 856 400 60 24 84 100

L200 Pre-Trial Pleadings and Motions 25% 6%250 0 250 1000 7 0 7 125

L300 Discovery 0% 0%0 0 0 1000 0 0 0 125

L400 Trial Preparation and Trial 0% 0%0 0 0 2000 0 0 0 250

L500 Appeal 0% 0%0 0 0 750 0 0 0 100

Total 825 281 1106 21% 5150 67 24 91 13% 700
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Date: 11/28/2016 Tabs3 Task Code Budget Report Page: 1
Jensen, Martin & Anderson, P.C.

A C T I V I T Y E X P E N S E
Phase/Task Billed WIP Total Budget Billed WIP Total Budget

200.01 M Peterson Insurance Co. Timekeeper:  1 MLJ
General Legal Counsel

L110 Fact Investigation/Development 42% 0%0 125 125 300 0 0 0 100
L120 Analysis/Strategy 113% 0%8504 0 8504 7500 0 0 0 0
L130 Experts/Consultants 0% 0%0 0 0 400 0 0 0 0

Subtotal for L100 8504 125 8629 105% 8200 0 0 0 0% 100

Total 8504 125 8629 105% 8200 0 0 0 0% 100

200.02 M Peterson Insurance Co. Timekeeper:  3 RPA
Maintenance of Insurance Policies

L100 Case Assessment, Development and Adm 63% 24%3137 0 3137 5000 485 0 485 2000

Total 3137 0 3137 63% 5000 485 0 485 24% 2000

Task Folder Reports | Client Setup Reports | Task Code Budget Report

The Task Code Budget Report is available for task based billing clients only. It shows budgeted activity and expense amounts for
each task in each phase. Task code budget figures are assigned on the Budget tab of the Client file. The report makes a
percentage comparison of the billed amount and WIP amount to the budgeted amount. The Options tab allows you to specify a
date range for transactions.

Definitions for Task Code Budget Report
(client) Client ID, name and work description. The letter after the Client ID represents the billing frequency.

An asterisk preceding the work description indicates the work description will not print on the
client’s statement.1

Timekeeper Primary timekeeper number and initials will print to the right of the work description if the report is
not printed in timekeeper order.

Phase/Task Shows the phases or tasks that have been assigned budget amounts on the Budget tab of the Client
file. Budgets can be entered for a phase or the tasks within a phase, but not both.

Billed Amount billed for the phase or task. This information comes from the transactions in the archive
files within the date range specified.

WIP Amount in work-in-process for the phase or task.

Total The dollar amount is calculated by adding the Billed amount and the WIP amount. The percentage
is calculated by dividing the Total amount by the Budget amount.

Budget Budget amount for the phase or task that was entered on the Budget tab of the Client file.

1Not shown on the sample report.
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Productivity Report by Category for Each Timekeeper
Date: 11/28/2016 Tabs3 Productivity Report Page: 1

By Category For Each Timekeeper
Jensen, Martin & Anderson, P.C.

Billed YTD
Timekeeper Hours Amount Rate

  1 Michael L. Jensen
  1 Administrative 3.50    1% 875.00    1% 250.00
  5 Wills/Trusts/Estates 4.25    1% 1,062.50    1% 250.00
 15 Probate 4.75    2% 565.00    0% 118.95
 25 Real Estate 9.88    3% 1,888.30    1% 191.12
 35 Family Law 3.00    1% 750.00    1% 250.00
 40 Business Law 267.70   88% 133,550.00   95% 498.88
 50 Criminal Law 3.50    1% 875.00    1% 250.00
 55 Insurance Defense 2.50    1% 625.00    0% 250.00
 60 General Litigation 4.00    1% 1,000.00    1% 250.00

Total for 1 Michael L. Jensen 303.08 141,190.80 465.85

  2 Paula Ann Martin
  1 Administrative 1.75    1% 236.25    0% 135.00
  5 Wills/Trusts/Estates 1.00    0% 225.00    0% 225.00
 15 Probate 1.25    0% 312.50    0% 250.00
 25 Real Estate 9.50    3% 2,791.42    2% 293.83
 40 Business Law 263.50   94% 118,575.00   96% 450.00
 50 Criminal Law 3.30    1% 742.50    1% 225.00
 55 Insurance Defense 1.00    0% 225.00    0% 225.00

Total for 2 Paula Ann Martin 281.30 123,107.67 437.64

  3 Ronald P. Anderson
  1 Administrative 3.00    2% 375.00    1% 125.00
  5 Wills/Trusts/Estates 1.25    1% 200.00    0% 160.00
 15 Probate 4.25    3% 807.50    1% 190.00
 25 Real Estate 1.25    1% 279.14    0% 223.31
 40 Business Law 143.00   90% 64,350.00   96% 450.00
 50 Criminal Law 5.25    3% 840.00    1% 160.00
 55 Insurance Defense 1.75    1% 218.75    0% 125.00

Total for 3 Ronald P. Anderson 159.75 67,070.39 419.85

  4 Robert O. Burns
 40 Business Law 130.45  100% 97,837.50  100% 750.00

Total for 4 Robert O. Burns 130.45 97,837.50 750.00

Grand Total 874.58 429,206.36 490.76

Task Folder Reports | Productivity Reports | Category Report by Timekeeper

The report shown above is a Productivity Report By Category For Each Timekeeper. This report shows year-to-date billed hours,
amounts and effective billing rates by category for each timekeeper as well as a grand total figure. When selecting options for
this report, you are able to specify a range of working timekeepers and categories to include. This report can optionally be
generated in a graphical format (page 166).

Definitions for Productivity Report by Category for Each Timekeeper
Timekeeper Working timekeeper’s number and name.

(category) Category number and description.
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Hours Hours billed year-to-date (taken from the Hours to Bill field).

% Percentage comparison to the total hours for the timekeeper.

Amount Fees billed year-to-date. The Amount does not include write offs but does include credits.

% Percentage comparison to the total amount for the timekeeper.

Rate Effective billing rate (Amount divided by Hours).
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Productivity Report by Tcode for Each Timekeeper
Date: 11/28/2016 Tabs3 Productivity Report Page: 1

By Tcode For Each Timekeeper
Jensen, Martin & Anderson, P.C.

Billed YTD
Timekeeper Hours Amount Rate

  1 Michael L. Jensen
  1 265.63   88% 131,620.29   93% 495.50
  2 Outside conference with 5.00    2% 2,500.00    2% 500.00
  3 Telephone conference with 0.50    0% 87.50    0% 175.00
  5 Letter to 3.25    1% 575.69    0% 177.14
  7 Plan and prepare for 3.70    1% 925.00    1% 250.00
  8 Draft and revise 3.00    1% 896.44    1% 298.81
  9 Review and analyze 8.00    3% 1,402.60    1% 175.33
 10 Legal research 5.00    2% 933.28    1% 186.66
 14 Communicate with 6.50    2% 1,625.00    1% 250.00
 18 (miscellaneous fee) 2.50    1% 625.00    0% 250.00

Total for 1 Michael L. Jensen 303.08 141,190.80 465.85

  2 Paula Ann Martin
  1 261.80   93% 117,067.50   95% 447.16
  2 Outside conference with 5.00    2% 2,250.00    2% 450.00
  3 Telephone conference with 1.00    0% 225.00    0% 225.00
  6 Receipt of 0.25    0% 62.50    0% 250.00
  7 Plan and prepare for 1.00    0% 250.00    0% 250.00
  8 Draft and revise 3.00    1% 881.50    1% 293.83
 13 Attended 6.50    2% 1,909.92    2% 293.83
 14 Communicate with 2.75    1% 461.25    0% 167.73

Total for 2 Paula Ann Martin 281.30 123,107.67 437.64

  3 Ronald P. Anderson
  1 141.25   88% 61,000.00   91% 431.86
  2 Outside conference with 5.00    3% 2,250.00    3% 450.00
  5 Letter to 0.50    0% 103.33    0% 206.66
  8 Draft and revise 2.00    1% 348.31    1% 174.16
  9 Review and analyze 1.00    1% 125.00    0% 125.00
 10 Legal research 7.25    5% 2,900.00    4% 400.00
 14 Communicate with 2.75    2% 343.75    1% 125.00

Total for 3 Ronald P. Anderson 159.75 67,070.39 419.85

  4 Robert O. Burns
  1 125.45   96% 94,087.50   96% 750.00
  2 Outside conference with 5.00    4% 3,750.00    4% 750.00

Total for 4 Robert O. Burns 130.45 97,837.50 750.00

Grand Total 874.58 429,206.36 490.76

Task Folder Reports | Productivity Reports | Tcode Report by Timekeeper

The Productivity Report By Tcode For Each Timekeeper shows year-to-date billed hours, amounts and effective billing rates by
transaction code for each timekeeper as well as a grand total figure. When selecting options for this report, you are able to
specify a range of working timekeepers and transaction codes to include.

Definitions for Productivity Report by Tcode for Each Timekeeper
Timekeeper Working timekeeper’s number and name.
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(transaction code) Transaction code number and description.

Hours Hours billed year-to-date (taken from the Hours to Bill field).

% Percentage comparison to the total hours for the timekeeper.

Amount Fees billed year-to-date. The Amount does not include write offs but does include credits.

% Percentage comparison to the total amount for the timekeeper.

Rate Effective billing rate (Amount divided by Hours).

Conflict of Interest Report

Date: 11/28/2016 Tabs3 Conflict of Interest Report Page: 1

Jensen, Martin & Anderson, P.C.

Client Name Description File Field

 Phonetic Search Text:  "SMITH" 
200.03 Jefferson Insurance Co. Acquisition of Mid-State Insurance Archive Fee Arch Ref #: 10/19/2016

Office conference with Peter Smith, insurance salesman for company.

600.00 Ace Manufacturing Company General Legal Counsel Archive Fee Arch Ref #: 09/12/2016
Letter to Mr. Smith.

600.00 Ace Manufacturing Company General Legal Counsel Archive Fee Arch Ref #: 09/21/2016
Outside conference with Mr. Smith concerning personnel matters at Ace Manufacturing Co.

600.00 Ace Manufacturing Company General Legal Counsel Archive Fee Arch Ref #: 09/06/2016
Outside conference with Mr. Smith.

600.00 Ace Manufacturing Company General Legal Counsel Archive Fee Arch Ref #: 09/07/2016
Telephone conference with Mr. Smith, President of Ace Manufacturing Co.

800.00 ABC Insurance Company Death Benefits Client Misc. Desc. 1
Insured: Harvey Smith

800.00 ABC Insurance Company Death Benefits Archive Fee Arch Ref #: 09/07/2016
Letter to Mrs. Smith.

800.00 ABC Insurance Company Death Benefits Archive Fee Arch Ref #: 09/19/2016
Attended meeting with Mrs. Smith and family.

800.00 ABC Insurance Company Death Benefits Archive Fee Arch Ref #: 09/06/2016
Attended meeting with Mrs. Smith and ABC Insurance Co.

800.00 ABC Insurance Company Death Benefits Archive Fee Arch Ref #: 09/28/2016
Office conference with Mrs. Smith.

800.00 ABC Insurance Company Death Benefits Archive Fee Arch Ref #: 09/14/2016
Review and revise letter to Mrs. Smith.

800.00 ABC Insurance Company Death Benefits Archive Fee Arch Ref #: 09/14/2016
Draft and prepare letter to Mrs. Smith regarding insurance benefits.

900.00 Sherman/Natalie K. Divorce Archive Fee Arch Ref #: 10/12/2016 
Letter to Smith London & O'Neill requesting financial net worth of spouse.

Total finds for SMITH:  13

Task Folder Reports | Conflict Search

The report shown above is a Conflict of Interest Report. This report is generated after a Conflict of Interest Check is performed in
Tabs3. For each conflict found, the report shows the client name and work description as well as the file, field and text that
contains the conflict. Each text item searched for can optionally be started on a new page.

Definitions for Conflict of Interest Report
Date The date the report was generated.

Search Text The text searched for. The text “Phonetic Search Text” will be printed if the Use Phonetic Search
option was selected.

Client Client ID.

Name Client name.

Description Work description. An asterisk before the work description indicates the work description will not be
included on the client’s statement.1

File File where the conflict was found. The files that can optionally be searched include the client file,
the client notes file, the archive file, and the transaction files (i.e., the fee, cost, payment and client
funds files).
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Field The field where the conflict was found. If the conflict was found in the fee, cost, payment or client
funds file, the reference number will be included. If the conflict was found in the archive file, the
transaction date will be included. If the user running the report is assigned to certain timekeepers,
transactions for unassigned timekeepers will display “Insufficient Timekeeper Rights” in this column.

(text) Text containing the conflict. This information is shown on the line beneath the Client ID and name.
The specific search value will be shaded and underlined on the report.

1Not shown on the sample report.

E-mail Statements Report

Date: 11/30/2016 Tabs3 E-mail Statements Report Page: 1
Jensen, Martin & Anderson, P.C.

E-mail Date Contact E-mail Address PDF File Name Stmt Date User ID

101.00 Williams/John
RE: State v. Williams

11/30/2016 John Williams jw2000@net.com 101.00_Stmt_7580.pdf 11/30/2016 RON

121.01 Phillips/Marcus
RE: Real Estate Acquisition

11/30/2016 Marcus Phillips markp@emach.net 121.01_Stmt_7578.pdf 11/30/2016 RON

200.01 Peterson Insurance Co.
RE: General Legal Counsel

11/30/2016 Paul Franklin pfranklin@petersoninsurance.com 200_Stmt_7577.pdf 11/30/2016 RON

415.00 MegaConstruction Corporation
RE: Corporate Merger - Megabuilders and BuilderCorp

11/30/2016 James R. Tatiki, Sr. jt@megaconcorp.com 415.00_Stmt_7576.pdf 11/30/2016 RON

850.00 White/Kelly
RE: Divorce

11/30/2016 Kelly White kelly_white_la@hushmail.com 850_Stmt_7579.pdf 11/30/2016 RON
11/30/2016 Kelly White kelly@homeoffice.net 

850.00_Stmt_7579_Dup.pdf 11/30/2016 RON

Task Folder Statements | E-mail Statements Report

The E-Mail Statements Report shows all e-mail statements that are successfully sent to clients who are set up to receive e-mail
statements. This report does not show e-mails that were deleted from the E-mail Statements window, failed to send, or were
unbilled prior to updating statements.

The Options tab allows you to specify a range of contacts, statement dates, e-mail dates, or user IDs. For each e-mail that meets
the selected criteria, the client, e-mail date, recipient information, file name, statement date, and User ID of the sender are
included in the report.

Definitions for E-mail Statements Report
Date The date the report was generated.

(client) Client ID, client name, and work description.

E-mail Date Date the e-mail was sent to the Outlook Outbox or to the recipient via SMTP, based on the firm’s E-
mail Statements Method setting.

Contact Full name of the e-mail recipient. This is usually the Bill To Name, unless the To field is edited in the
E-mail Preview window.

E-mail Address E-mail address to which the e-mail was sent. This address is also displayed in the client’s Bill To
record, unless the To field is edited in the E-mail Preview window.

PDF File Name Name of the attached PDF statement. This file is stored in a Statements folder under the current
working directory, in a folder holding all statements for the statement date. Use the drill-down
feature to open the PDF statement in your PDF software associated with PDF files. This field will
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print with strike-through text if the updated statement is undone after the e-mail is sent.1 (Note: The
PDF file will not open if it is removed from the Statements folder.)

Stmt Date Statement Date of the PDF statement included with the sent e-mail. This field will appear as strike-
through text if the updated statement is undone after the e-mail is sent.1

User ID User ID of the user who sent the e-mail.

1Not shown on the sample report.

Top Client Report

Date: 11/28/2016 Tabs3 Top Client Report Page: 1

Ranked by Billed Fees
Jensen, Martin & Anderson, P.C.

From 10/01/2016 Thru 12/31/2016

Billed Fees Total Total Write
Rank Fees Paid Billed Paid Offs

1 415M  MegaConstruction Corporation 40,547.50 109,065.00 40,636.53 145,011.69 0.00

2 121M  Phillips/Marcus 5,000.00 1,270.40 5,252.25 5,269.93 0.00

3 200M  Peterson Insurance Co. 3,101.25 366.00 3,500.94 1,726.00 0.00

4 101M  Williams/John 3,057.50 1,491.65 3,147.60 1,617.65 0.00

5 850M  White/Kelly 840.00 840.00 990.00 1,115.00 0.00

Grand Totals

Billed Fees Total Total Write
Fees Paid Billed Paid Offs

Top Clients Total 52,546.25 113,033.05 53,527.32 154,740.27 0.00

Date: 11/28/2016 Tabs3 Top Matter Report Page: 1

Ranked by Fees Paid
Jensen, Martin & Anderson, P.C.

From 10/01/2016 Thru 12/31/2016

WIP Billed All Fees % Grand Current Prim
Rank Fees Fees Fees Paid Total Amount Due Tmkr

1 121.01M  Phillips/Marcus 2,337.50 4,254.10 6,591.60 5,102.90 66.1% 673.85 1 MLJ
RE: Real Estate Acquisition

2 200.02M  Peterson Insurance Co. 1,451.00 1,584.50 3,035.50 1,451.00 18.8% 704.75 3 RPA
RE: Maintenance of Insurance Policies

3 101.00M  Williams/John 4,482.50 0.00 4,482.50 887.50 11.5% -694.25 2 PAM
RE: State v. Williams

4 200.01M  Peterson Insurance Co. 5,600.00 1,516.75 7,116.75 275.00 3.6% 2,660.35 1 MLJ
RE: General Legal Counsel

5 100.00M  Larson/Michael 2,934.75 0.00 2,934.75 0.00 0.0% 0.00 1 MLJ
RE: Larson v. Bel-Cor

Grand Totals

WIP Billed All Fees % Grand Current
Fees Fees Fees Paid Total Amount Due

Top Matters Total 16,805.75 7,355.35 24,161.10 7,716.40 100.0% 3,344.70
Other Matters Total 4,505.47 0.00 4,505.47 0.00 0.0% 0.00

All Matters Total 21,311.22 7,355.35 28,666.57 7,716.40 100.0% 3,344.70
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Date: 11/28/2016 Tabs3 Top Matter Report Page: 1

Ranked by Total WIP
Jensen, Martin & Anderson, P.C.

Primary Timekeeper: 1 Michael L. Jensen
From 10/01/2016 Thru 12/31/2016

Total
Rank WIP

1 200.01M  Peterson Insurance Co. 5,612.00
RE: General Legal Counsel

2 100.00M  Larson/Michael 2,934.75
RE: Larson v. Bel-Cor

3 121.01M  Phillips/Marcus 2,337.50
RE: Real Estate Acquisition

Total for Primary Timekeeper 1 11,109.25

Task Folder Reports | Client Reports | Top Client Report

The reports shown on page 161 are Top Client Reports.

l The first report on the previous page shows the Top Client Report, sorted by Client ID and ranked by Billed Fees.
l The second report on the previous page shows the Top Matter Report, sorted by Client ID and ranked by Fees Paid. This
report includes Totals for other matters, includes the percent of total, and shows the grand totals for all clients.

l The report above shows the Top Matter Report, sorted by primary timekeeper and ranked by Total WIP.

The Top Client Report ranks clients or matters based on certain criteria. The criteria is selected by the user and can include work-
in-process information, billed information, or receipts from clients as allocated to individual working timekeepers; primary,
secondary, or originating timekeepers; or expenses, advances, taxes, and finance charge. The report can be printed by primary,
secondary, originating, or working timekeeper. The Options tab includes options that let you print a certain number of top
clients or matters, select ranking criteria, and include information based on ranked and unranked clients; define a reporting
period to include; select a range of working timekeepers; and use fee compensation amounts. The Format tab allows you to
select optional columns to include.

Definitions for Top Client Report
Date (heading) Used for reference only.

Title (heading) Displays whether the report is based on Clients or Matters (i.e., Top Client Report or Top Matter
Report).

Ranked by (heading) Displays the criteria by which clients have been ranked. The Ranked by column is shaded, provided
shading is enabled in Printer Setup.

Timekeeper The number and name of the report order timekeeper. If a report order other than Primary
Timekeeper is selected, the Prim Tmkr column will print as the last column on the report, as shown
on the second report on the previous page. This column will include the client’s primary timekeeper
number and initials.

Date Range The date range represents the period specified. This date range is used to select what transactions
will be used to calculate the top clients for each ranking criteria, and which transactions will be
used to calculate the totals for each included column. For billed transactions, the statement date is
used. For work-in-process transactions, the transaction date is used. Receipts use the payment date.
Write offs use the write off date.

WIP Hours to Bill Optional column. The number of hours to bill for each work-in-process fee transaction during the
period.

WIP Hours Worked Optional column. The number of hours worked for each work-in-process fee transaction during the
period.
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WIP Fees Optional column. The total amount of fees in work-in-process during the period. Credit transactions
and transactions on hold are included. Progress fee transactions (Type 6) and non-billable
transactions are included.

WIP Expenses Optional column. The total amount of expenses in work-in-process during the period. Credit
transactions and transactions on hold are included. Non-billable transactions are included.

WIP Advances Optional column. The total amount of advances in work-in-process during the period. Credit
transactions and transactions on hold are included. Non-billable transactions are included.

Total WIP Optional column. Total amount of transactions in work-in-process during the period. Credit
transactions and transactions on hold are included.

Billed Hours Optional column. The fee hours billed during the period.

Billed Hours Worked Optional column. The fee hours worked that were billed during the period.

Billed Fees Optional column. The total fee amount billed during the period.

Billed Expenses Optional column. The total expense amount billed during the period.

Billed Advances Optional column. The total advance amount billed during the period.

Finance Charges Optional column. The total finance charge amount billed during the period.

Total Billed Optional column. The total amount billed, including fees, expenses, advances, taxes and finance
charges during the period.

All Hours to Bill Optional column. The total number of hours to bill for work-in-process and billed fee transactions
during the period.

All Hours Worked Optional column. The total number of hours worked for work-in-process and billed fee transactions
during the period.

All Fees Optional column. The total amount for work-in-process and billed fees during the period.

All Expenses Optional column. The total amount for work-in-process and billed expenses during the period.

All Advances Optional column. The total amount for work-in-process and billed advances during the period.

Total WIP + Billed Optional column. The sum of Total WIP and Total Billed.

Write Offs Optional column. Write off amounts during the period. There can be a write off amount for each
working timekeeper, expense type, advance type, fee tax, expense tax, advance tax and finance
charge.

Fees Paid Optional column. Total amount of payments during the period that have been applied to fees. This
figure is based on the payment date and includes both work-in-process and processed payments.

Expenses Paid Optional column. Total amount of payments during the period that have been applied to expenses.
This figure is based on the payment date and includes both work-in-process and processed
payments.

Advances Paid Optional column. Total amount of payments during the period that have been applied to advances.
This figure is based on the payment date and includes both work-in-process and processed
payments.

Finance Charges Paid Optional column. Total amount of payments during the period that have been applied to finance
charges. This figure is based on the payment date and includes both work-in-process and
processed payments.

Unallocated Payments Optional column. Total amount of payments during the period that remain unapplied. This figure is
based on the payment date and includes both work-in-process and processed payments.

Total Paid Optional column. Total amount of payments during the period. This figure is based on the payment
date and includes both work-in-process and processed payments.
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Current Amount Due Optional column. The Current Amount Due figure shows what is currently due at the time the
report is run. It is important to note that the period specified does not affect this amount. This figure
includes the total amount billed (from the Client Ledger) minus all payments allocated minus any
Write Off (i.e., Billed minus Paid minus Write Off).

%Total Printed when the Include% of Total check box is selected. Percent calculated based on whether
the Include Totals for Other Clients/Matters check box is selected. If selected, the percent will
equal (Client or Matter Value) divided by (Total Ranked Clients + Total Other Clients or Matters). If
cleared, the percent will equal (Client or Matter Value) divided by (Total Ranked Clients or Matters).
If a Report Order other than None is selected, the percentages will be calculated separately for each
report order.

%Grand Total Printed when the Include% of Total and Grand Totals check boxes are selected. Percent calculated
based on whether Include Totals for Other Clients/Matters is selected. If selected, the percent will
equal (Client or Matter Value) divided by (Total Ranked Clients or Matters + Total Other Clients or
Matters for all sort orders). If cleared, the percent will equal (Client or Matter Value) divided by
(Total Ranked Clients for all sort orders). When a Report Order other than None is selected, the
percentages will be calculated based on report-wide totals.

Total for Other
Clients/Matters

Printed when the Include Totals for Other Clients/Matters check box is selected. Includes totals
for clients/matters that met the client range and date period criteria, but did not qualify to be
included on the Top Client Report.
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Client Inactivity Report

Date: 11/28/2016 Tabs3 Client Inactivity Report Page: 1
Jensen, Martin & Anderson, P.C.

No Activity From: 10/01/2016 Thru 10/31/2016

Client Name Last Date Activity User ID Pri

100.00  Larson/Michael 09/14/2016 Fee MLJ        1 MLJ
Larson v. Bel-Cor

101.00  Williams/John  09/30/2016 Statement RON 2 PAM
State v. Williams

102.00  Gilbert/Andrew C. 09/12/2016 Advance PAULA   2 PAM
Auto Accident

120.01  Klein/Daniel P. 09/09/2016 Fee RON       3 RPA
Klein vs. Simmons Construction

121.01  Phillips/Marcus  09/30/2016 Statement RON 1 MLJ
Real Estate Acquisition

200.01  Peterson Insurance Co.  09/30/2016 Statement RON 1 MLJ
General Legal Counsel

200.02  Peterson Insurance Co.  09/30/2016 Statement RON 3 RPA
Maintenance of Insurance Policies

300.00  McBride/John 08/16/2016 Fee MLJ        1 MLJ
Copyright Infringement

415.00  MegaConstruction Corporation  09/30/2016 Statement RON 3 RPA
Corporate Merger - Megabuilders and BuilderCorp

850.00  White/Kelly  08/31/2016 Statement RON 5 KIM
Divorce

850.01  White/Kelly  09/30/2016 Statement RON 5 KIM
Last Will & Testament

Number of Clients printed: 11
Number of Clients analyzed: 1058

Task Folder Reports | Client Reports | Client Inactivity Report

The Client Inactivity Report above can be used to easily identify clients and matters with no activity in a specified time frame.
This report helps you determine which matters need followup and makes it easy to identify matters that should be marked
inactive. The period of inactivity can be defined as the last number of days, weeks, months, or years.

The Options tab allows you to specify the period of inactivity and which records to search, including Fees, Costs, Statements,
Payments, Payment Adjustments, Write Offs, and Client Funds. Work-In-Process and Archived transactions will be searched for
all items selected. For each client that meets the selected criteria, the client, last activity date, activity, User ID who performed the
last activity, and client’s primary timekeeper are included in the report. The Date Opened and Date Closed fields in the Client file
are considered activity. Therefore, if the value of the client’s Date Opened or Date Closed field falls within the time frame
specified, the client will not be included on the report. Each record provides drill-down capabilities.

Definitions for Client Inactivity Report
Date The date the report was generated.

Client Client ID.

Name Client name. Listed under the name is the work description of the client.

Last Date The date of last activity for the client, based on the date in the associated record.

Fees The Transaction Date is used.

Costs The Transaction Date is used.

Statements The Statement Date is used.

Payments The Transaction Date is used.

Payment
Adjustments

The Adjustment Date is used.

Write Offs The Write Off Date is used.

Client Funds The Transaction Date is used.

- 165 -



Tabs3 Report Pack

Activity The type of record that contains the last activity for the client. Costs are listed as either Advances or
Expenses.

User ID User ID of the user who entered the last activity for the client.

Graphical Report Examples

Vertical Bar Graph Horizontal Bar Graph

Stacked Vertical Bar Graph Stacked Horizontal Bar Graph 3D Vertical Bar Graph

3D Horizontal Bar Graph 3D Pie Chart Line Plot

Line Plot (No Points) 3D “Manhattan” Bar Graph Strata Graph

The examples shown above are examples of the different types of graphs available in Tabs3. Graphs can be generated for the
Timekeeper Productivity Report, Category Productivity Report, Timekeeper Profitability Report and Productivity Report by
Category for each Timekeeper. A variety of information can be graphed for each report.
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There are 12 different types of graphs that can be generated. Bar Graph variations include vertical, horizontal, vertical 3D,
horizontal 3D, stacked vertical and stacked horizontal. Pie Chart variations include standard and 3D pie charts. Specialty Graphs
include “3DManhattan Bar Graph,” Strata Graph and two different Line Graphs.

A separate Graph tab is available for each of these reports. To generate a graph for one of these reports, select the Create Graph
from Report check box found on the respective report’s Graph tab. Select the remaining options and click OK. A separate
window will be opened with the graph shown in it. From this graph window, the graph can be printed.
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